After Vegas is installed and you start it for the first time, the registration wizard appears. This wizard offers easy steps that enable you to register Vegas online with Sonic Foundry. Alternatively, you may register Vegas online at www.sonicfoundry.com at any time.

Registering your product provides you with exclusive access to a variety of technical support options, notification of product updates, and special promotions exclusive to registered Vegas users.

**Registration Assistance**

If you do not have access to the Internet, registration assistance is available. Please contact our Customer Service Department.

Registration assistance is currently available Monday through Friday from 9:00 a.m. to 5:00 p.m. Central Standard Time (CST) by dialing the following numbers:

<table>
<thead>
<tr>
<th>Telephone/Fax</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>for all other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (Fax)</td>
<td>All countries</td>
</tr>
</tbody>
</table>

**Customer Service/Sales**

For a detailed list of Customer Service options, we encourage you to visit www.sonicfoundry.com. For support during normal office hours:

<table>
<thead>
<tr>
<th>Telephone/Fax/E-mail</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>for all other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (Fax)</td>
<td>All countries</td>
</tr>
<tr>
<td><a href="mailto:customerservice@sonicfoundry.com">customerservice@sonicfoundry.com</a></td>
<td></td>
</tr>
</tbody>
</table>

**Technical Support**

For a detailed list of Technical Support options, we encourage you to visit www.sonicfoundry.com/support.

- To listen to your support options, please call 608-256-5555.
- Customers who have purchased the full version of Vegas Video or Vegas Audio receive 60 days of complimentary phone support. The complimentary support begins when the product is registered. (Registration is required to received this complimentary support.) Please call (608) 204-7704 if you need assistance with your product.
The information contained in this manual is subject to change without notice and does not represent a commitment on the part of Sonic Foundry. The software described in this manual is provided under the terms of a license agreement or non-disclosure agreement. The software license agreement specifies the terms and conditions for its lawful use. No part of this manual may be reproduced or transmitted in any form or by any means for any purpose other than the purchaser's personal use, without written permission from Sonic Foundry, Inc.

Sonic Foundry and Vegas are trademarks of Sonic Foundry, Inc. The brands and products named here are the trademarks or registered trademarks of Sonic Foundry, its affiliates, or their respective holders.

© 1999-2002 Sonic Foundry, Inc.
# Table of Contents

## Introduction

- Welcome to Sonic Foundry Vegas ................................................................. 15
- System requirements .................................................................................. 15
- Technical support ....................................................................................... 16
- About this version of Vegas ....................................................................... 16
- Installing Vegas .......................................................................................... 17
- Registration .................................................................................................. 17
- Using online help ......................................................................................... 17
  - Accessing help .......................................................................................... 17

## Overview

- Main window ............................................................................................... 19
- Toolbar ......................................................................................................... 19
- Time display ............................................................................................... 20
- Ruler ............................................................................................................ 20
- Marker bar .................................................................................................. 20
- Command bar ............................................................................................. 20
- CD layout bar ............................................................................................. 21
- Track list ...................................................................................................... 21
- Track view .................................................................................................. 21
- Transport bar controls ............................................................................... 21
- Status bar ................................................................................................... 22
- Scrub control .............................................................................................. 22
- Window docking area ................................................................................ 22
- Keyboard command reference .................................................................. 28
- Cursor indications ...................................................................................... 32

## Audio Signal Flow

.................................................................................................................... 33

## Video Signal Flow

.................................................................................................................... 34

## Tutorial and Sample Projects

- Tutorial ....................................................................................................... 35
- Installing the tutorial ................................................................................ 36
## TABLE OF CONTENTS

1. Voiceover narration (01_voiceover.veg) ......................................................... 37
2. Voiceover editing (02_editing.veg) ................................................................. 41
3. Music bed (03_musicbed.veg) ................................................................. 44
4. Background video (04_background.veg) ......................................................... 46
5. Overlay titles (05_overlay.veg) ........................................................................ 48
6. Pan/Crop motion (06_panning.veg) ................................................................. 52
7. Fades (07_fades.veg) ..................................................................................... 54
8. Track Motion (08_trackmotion.veg) ................................................................. 55
9. Velocity (09_velocity.veg) ............................................................................. 57
10. Rendering the project as an AVI ................................................................... 58

### Sample projects

- Audio mix ................................................. 58
- TV spot .................................................... 59
- Web spot with captioning ................................. 60
- Panning with still images ................................. 61
- Compositing with masks ................................ 61
- Track motion .............................................. 62

### Getting Started ................................................. 65

- Creating projects ................................................. 65
- Setting video properties based on a media file ................................. 66
- Saving a project ................................................. 66
- Renaming a project (using Save As) ................................. 67

### Getting media files ................................................. 67

- Selecting media ................................................. 67
- Previewing a media file ................................................. 68
- Using the Media Pool ................................................. 68
- Adding media to the timeline ................................. 71

### Working with events ................................................. 73

- Understanding files and events ................................................. 73
- Moving events along the timeline ................................................. 73

### Working with tracks ................................................. 74

- Using the track view ................................................. 75
- Using the track header ................................................. 77

### Viewing playbacks and previews ................................................. 79

- Using playback from within Vegas ................................................. 79
- Scrubbing ................................................. 80
- Previewing to media player ................................................. 81
- Prerendering video previews ................................................. 81

### Rendering a Vegas project ................................................. 82

- Creating a movie ................................................. 82

---

### Getting Started

- Creating projects ................................................. 65
- Setting video properties based on a media file ................................. 66
- Saving a project ................................................. 66
- Renaming a project (using Save As) ................................. 67

### Getting media files ................................................. 67

- Selecting media ................................................. 67
- Previewing a media file ................................................. 68
- Using the Media Pool ................................................. 68
- Adding media to the timeline ................................. 71

### Working with events ................................................. 73

- Understanding files and events ................................................. 73
- Moving events along the timeline ................................................. 73

### Working with tracks ................................................. 74

- Using the track view ................................................. 75
- Using the track header ................................................. 77

### Viewing playbacks and previews ................................................. 79

- Using playback from within Vegas ................................................. 79
- Scrubbing ................................................. 80
- Previewing to media player ................................................. 81
- Prerendering video previews ................................................. 81

### Rendering a Vegas project ................................................. 82

- Creating a movie ................................................. 82
Basic Editing Techniques

Getting around ................................................................. 83
  Moving the cursor ............................................................ 83
  Changing focus ............................................................... 83
Making selections ............................................................... 84
  Selecting multiple events .................................................. 84
  Modifying events in selections ......................................... 85
  Selecting a time range ..................................................... 85
  Looping playback ............................................................ 86
  Selecting events and a time range ..................................... 86
Editing and ripple editing events .......................................... 87
  Copying events .............................................................. 87
  Cutting events ............................................................... 88
  Pasting events ............................................................. 90
  Duplicating events ......................................................... 92
  Inserting empty events and time ....................................... 92
  Trimming events ........................................................... 92
  Splitting events ............................................................ 94
  Slipping and sliding events ............................................. 95
  Deleting events ............................................................ 96
Crossfading events .......................................................... 97
  Using automatic crossfades .............................................. 97
  Manually setting a crossfade .......................................... 97
  Changing crossfade curves ............................................. 98
  Sliding a crossfade ....................................................... 98
Using undo and redo .......................................................... 98
  Using undo ................................................................. 98
  Using redo ................................................................. 99
  Clearing the edit history ................................................ 99
Adding project markers and regions ....................................... 100
  Working with markers .................................................... 100
  Working with regions ..................................................... 101
  Working with command markers ..................................... 103
  Working with CD layout markers .................................... 106
Using an external audio editing program ................................ 106
  Setting up an audio editing program ................................ 106
  Opening an audio editor from Vegas ................................. 106
Advanced Editing Techniques ............................................... 109
  Snapping events ......................................................... 109
  Enabling and disabling snapping ..................................... 109
<table>
<thead>
<tr>
<th>Working with Events</th>
<th>121</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting event switches</td>
<td>121</td>
</tr>
<tr>
<td>Mute</td>
<td>121</td>
</tr>
<tr>
<td>Lock</td>
<td>121</td>
</tr>
<tr>
<td>Loop</td>
<td>121</td>
</tr>
<tr>
<td>Invert phase (audio only)</td>
<td>122</td>
</tr>
<tr>
<td>Normalize (audio only)</td>
<td>122</td>
</tr>
<tr>
<td>Maintain aspect ratio (video only)</td>
<td>123</td>
</tr>
<tr>
<td>Resample (video only)</td>
<td>123</td>
</tr>
<tr>
<td>Reduce interlace flicker (video only)</td>
<td>123</td>
</tr>
<tr>
<td>Accessing event properties</td>
<td>124</td>
</tr>
<tr>
<td>Adjusting audio channels</td>
<td>124</td>
</tr>
<tr>
<td>Using audio event envelopes (ASR)</td>
<td>125</td>
</tr>
<tr>
<td>Setting an audio event’s volume</td>
<td>125</td>
</tr>
<tr>
<td>Setting an event’s fade in and out</td>
<td>125</td>
</tr>
<tr>
<td>Using video event envelopes</td>
<td>126</td>
</tr>
<tr>
<td>Using opacity envelopes</td>
<td>126</td>
</tr>
</tbody>
</table>
### Table of Contents

**Using velocity envelopes** ................................................................. 127

**Grouping events** .............................................................................. 128

- Creating a new group ................................................................. 129
- Adding an event to an existing group ........................................ 129
- Removing events from a group .................................................... 129
- Clearing a group ............................................................................ 129
- Selecting all members of a group ................................................ 129
- Disabling grouping temporarily .................................................. 129

**Working with Tracks** ................................................................. 131

- Managing tracks ............................................................................ 131
  - Adding an empty track .......................................................... 131
  - Duplicating a track .................................................................. 131
  - Deleting a track ...................................................................... 132
  - Naming or renaming a track .................................................... 132
- Organizing tracks .......................................................................... 132
  - Reordering tracks .................................................................... 132
  - Changing track color .............................................................. 133
  - Changing track height ............................................................ 133

- Using track headers ...................................................................... 134
  - Using the volume fader (audio only) ......................................... 134
  - Using the multipurpose slider (audio only) ................................. 134
  - Using the composite level slider (video only) ......................... 135
  - Phase inverting a track (audio only) ......................................... 136
  - Muting a track .......................................................................... 136
  - Muting all audio or video tracks ............................................ 136
  - Soloing a track ......................................................................... 136
- Setting default track properties ..................................................... 137

- Working with track envelopes ....................................................... 137
  - Adding track envelopes .......................................................... 137
  - Hiding track envelopes ............................................................ 139
  - Removing track envelopes ....................................................... 139
  - Using the Envelope Edit tool .................................................... 140
  - Locking envelopes to events .................................................... 141
  - Rendering to a new track .......................................................... 141

**Adding Audio Effects** ................................................................. 143

- Using audio effects ...................................................................... 143

- Using plug-in chains .................................................................... 144
  - Creating a plug-in chain ......................................................... 144
  - Adding plug-ins to a plug-in chain ........................................ 144
TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving customized plug-in presets</td>
<td>146</td>
</tr>
<tr>
<td>Arranging the order of plug-ins</td>
<td>146</td>
</tr>
<tr>
<td>Bypassing plug-ins on the chain</td>
<td>147</td>
</tr>
<tr>
<td>Removing plug-ins from a chain</td>
<td>147</td>
</tr>
<tr>
<td>Saving plug-in chains</td>
<td>148</td>
</tr>
<tr>
<td>Editing saved plug-in chains</td>
<td>148</td>
</tr>
<tr>
<td>Organizing your plug-ins</td>
<td>149</td>
</tr>
<tr>
<td>Applying non-real-time event effects</td>
<td>149</td>
</tr>
<tr>
<td>Using the Mixer</td>
<td>151</td>
</tr>
<tr>
<td>Using the Mixer window</td>
<td>151</td>
</tr>
<tr>
<td>Viewing the Mixer window</td>
<td>151</td>
</tr>
<tr>
<td>Using the Mixer toolbar</td>
<td>152</td>
</tr>
<tr>
<td>Using the Mixer Preview fader</td>
<td>152</td>
</tr>
<tr>
<td>Using busses</td>
<td>152</td>
</tr>
<tr>
<td>Adding busses to a project</td>
<td>153</td>
</tr>
<tr>
<td>Deleting busses from a project</td>
<td>153</td>
</tr>
<tr>
<td>Routing busses to hardware</td>
<td>154</td>
</tr>
<tr>
<td>Working with busses</td>
<td>154</td>
</tr>
<tr>
<td>Assigning audio tracks to busses</td>
<td>155</td>
</tr>
<tr>
<td>Using assignable effects chains</td>
<td>156</td>
</tr>
<tr>
<td>Assigning audio tracks to assignable effects chains</td>
<td>157</td>
</tr>
<tr>
<td>Routing assignable effects chains to busses</td>
<td>157</td>
</tr>
<tr>
<td>Recording Audio</td>
<td>159</td>
</tr>
<tr>
<td>Setting up your equipment</td>
<td>159</td>
</tr>
<tr>
<td>Basic setup</td>
<td>159</td>
</tr>
<tr>
<td>Setup with mixer</td>
<td>160</td>
</tr>
<tr>
<td>Setup with digital multitrack</td>
<td>160</td>
</tr>
<tr>
<td>Preparing to record</td>
<td>160</td>
</tr>
<tr>
<td>Arming the track for recording</td>
<td>161</td>
</tr>
<tr>
<td>Selecting recording settings</td>
<td>161</td>
</tr>
<tr>
<td>Using the metronome</td>
<td>162</td>
</tr>
<tr>
<td>Disabling playback during recording</td>
<td>162</td>
</tr>
<tr>
<td>Recording</td>
<td>162</td>
</tr>
<tr>
<td>Recording into an empty track</td>
<td>162</td>
</tr>
<tr>
<td>Recording into a time selection</td>
<td>163</td>
</tr>
<tr>
<td>Recording into an event</td>
<td>163</td>
</tr>
<tr>
<td>Recording into an event with a time selection</td>
<td>164</td>
</tr>
<tr>
<td>Triggering from MIDI timecode</td>
<td>165</td>
</tr>
<tr>
<td>Working with multiple recorded takes</td>
<td>165</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Specifying where recordings are stored</td>
<td>166</td>
</tr>
<tr>
<td>Changing where recorded files are stored when arming a track</td>
<td>166</td>
</tr>
<tr>
<td>Changing where recorded files are stored when starting to record</td>
<td>166</td>
</tr>
<tr>
<td>Changing where recorded files are stored in the Project Properties dialog</td>
<td>167</td>
</tr>
<tr>
<td>Burning Audio CDs</td>
<td>169</td>
</tr>
<tr>
<td>Understanding track-at-once and disc-at-once</td>
<td>169</td>
</tr>
<tr>
<td>Track-at-once</td>
<td>169</td>
</tr>
<tr>
<td>Disc-at-once (Single Session or Red Book)</td>
<td>169</td>
</tr>
<tr>
<td>Understanding tracks and indices</td>
<td>169</td>
</tr>
<tr>
<td>Setting up to burn audio CDs</td>
<td>170</td>
</tr>
<tr>
<td>Viewing the ruler and time display</td>
<td>170</td>
</tr>
<tr>
<td>Setting project properties</td>
<td>170</td>
</tr>
<tr>
<td>Setting preferences</td>
<td>170</td>
</tr>
<tr>
<td>Importing CD Architect files</td>
<td>170</td>
</tr>
<tr>
<td>Creating audio CD layout projects</td>
<td>171</td>
</tr>
<tr>
<td>Adding media as CD tracks to a new project</td>
<td>171</td>
</tr>
<tr>
<td>Marking tracks in an existing project</td>
<td>172</td>
</tr>
<tr>
<td>Working with tracks and indices</td>
<td>173</td>
</tr>
<tr>
<td>Navigating to and selecting tracks and indices</td>
<td>173</td>
</tr>
<tr>
<td>Moving track and index markers</td>
<td>173</td>
</tr>
<tr>
<td>Renaming track and index markers</td>
<td>173</td>
</tr>
<tr>
<td>Deleting track and index markers</td>
<td>174</td>
</tr>
<tr>
<td>Editing markers using the Edit Details window</td>
<td>174</td>
</tr>
<tr>
<td>Copying a track list from the Edit Details window</td>
<td>174</td>
</tr>
<tr>
<td>Burning CDs</td>
<td>174</td>
</tr>
<tr>
<td>Burning single tracks</td>
<td>174</td>
</tr>
<tr>
<td>Burning a disc</td>
<td>175</td>
</tr>
<tr>
<td>Using Advanced Video Features</td>
<td>177</td>
</tr>
<tr>
<td>Cropping video</td>
<td>177</td>
</tr>
<tr>
<td>Cropping</td>
<td>178</td>
</tr>
<tr>
<td>Rotating</td>
<td>179</td>
</tr>
<tr>
<td>Adding animation</td>
<td>180</td>
</tr>
<tr>
<td>Working with still images</td>
<td>180</td>
</tr>
<tr>
<td>Creating still images for use in Vegas</td>
<td>180</td>
</tr>
<tr>
<td>Capturing a timeline snapshot</td>
<td>181</td>
</tr>
<tr>
<td>Creating a slide show</td>
<td>182</td>
</tr>
<tr>
<td>Creating titles</td>
<td>182</td>
</tr>
<tr>
<td>Creating titles from images</td>
<td>183</td>
</tr>
</tbody>
</table>
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fading titles</td>
<td>184</td>
</tr>
<tr>
<td>Adding closed captioning to Windows Media Video (WMV) files</td>
<td>184</td>
</tr>
<tr>
<td>Adding closed captioning line-by-line</td>
<td>184</td>
</tr>
<tr>
<td>Adding closed captioning from a script</td>
<td>184</td>
</tr>
<tr>
<td>Displaying closed captioning</td>
<td>186</td>
</tr>
<tr>
<td>Resampling video</td>
<td>187</td>
</tr>
<tr>
<td>Using Edit Decision Lists (EDL).</td>
<td>188</td>
</tr>
<tr>
<td>Creating an EDL</td>
<td>188</td>
</tr>
<tr>
<td>Opening an EDL</td>
<td>188</td>
</tr>
<tr>
<td>Working in DV format</td>
<td>189</td>
</tr>
<tr>
<td>Selecting source media</td>
<td>189</td>
</tr>
<tr>
<td>Setting project properties</td>
<td>189</td>
</tr>
<tr>
<td>Selecting templates</td>
<td>189</td>
</tr>
<tr>
<td>Eliminating out-of-range colors</td>
<td>189</td>
</tr>
<tr>
<td>Modifying video properties</td>
<td>190</td>
</tr>
<tr>
<td>Modifying project video properties</td>
<td>190</td>
</tr>
<tr>
<td>Modifying media file properties</td>
<td>191</td>
</tr>
<tr>
<td>Modifying output properties</td>
<td>192</td>
</tr>
<tr>
<td>Using Video FX, Compositing, and Masks</td>
<td>193</td>
</tr>
<tr>
<td>Using video effects</td>
<td>193</td>
</tr>
<tr>
<td>Adding a video effects plug-in</td>
<td>194</td>
</tr>
<tr>
<td>Working with video effects plug-in chains</td>
<td>195</td>
</tr>
<tr>
<td>Modifying a video effects plug-in</td>
<td>197</td>
</tr>
<tr>
<td>Saving custom plug-in settings as a preset</td>
<td>197</td>
</tr>
<tr>
<td>Using keyframe animation with plug-ins</td>
<td>198</td>
</tr>
<tr>
<td>Using generated media</td>
<td>198</td>
</tr>
<tr>
<td>Adding a generated media event</td>
<td>198</td>
</tr>
<tr>
<td>Duplicating a generated media event</td>
<td>199</td>
</tr>
<tr>
<td>Compositing</td>
<td>199</td>
</tr>
<tr>
<td>Understanding the parent/child track relationship</td>
<td>199</td>
</tr>
<tr>
<td>Selecting compositing modes</td>
<td>200</td>
</tr>
<tr>
<td>Creating masks</td>
<td>203</td>
</tr>
<tr>
<td>Creating image masks</td>
<td>203</td>
</tr>
<tr>
<td>Creating video masks</td>
<td>204</td>
</tr>
<tr>
<td>Fine tuning masks</td>
<td>205</td>
</tr>
<tr>
<td>Using the Mask Generator</td>
<td>206</td>
</tr>
<tr>
<td>Chromakeying</td>
<td>208</td>
</tr>
<tr>
<td>Adding Video Transitions and Motion</td>
<td>211</td>
</tr>
</tbody>
</table>
## Table of Contents

- Understanding basic transitions.............................. 211
  - Cuts ..................................................... 211
  - Crossfades ............................................. 211
- Using transition effects......................................... 211
  - Adding a transition ..................................... 212
  - Adding a transition to the end of an event .......... 212
  - Understanding track layers ................................ 212
  - Converting a cut to a transition ....................... 213
  - Previewing a transition ................................ 214
  - Modifying a transition .................................. 214
  - Saving custom settings as a preset ..................... 214
- Using keyframe animation ...................................... 215
  - Understanding the keyframe controller ................. 215
  - Adding keyframes ....................................... 216
  - Deleting keyframes ..................................... 216
  - Navigating in the keyframe controller .................. 216
  - Modifying keyframes .................................... 216
  - Working with keyframes in track view .................. 217
- Sample uses for keyframe animation ......................... 218
  - Animating event panning and cropping ............... 218
  - Animating video effects plug-ins ..................... 221
  - Animating generated text ................................ 222
- Adding track motion ........................................... 223
  - Using the track motion shortcut menu ................. 224
  - Controlling the track motion workspace .............. 224
  - Using keyframes in track motion ....................... 225
  - Creating a picture-in-picture effect .................... 225
  - Animating the overlay ................................... 226
  - Rotating the overlay ..................................... 227
  - Flipping the overlay .................................... 227

- Previewing Video.................................................. 229
  - Understanding the Video Preview window ............... 229
  - Using the Video Preview window shortcut menu ...... 230
  - Optimizing the Video Preview window ................... 230
  - Reducing preview quality ................................ 231
  - Prerendering video ....................................... 231
  - Building dynamic RAM previews ......................... 232
  - Identifying safe areas .................................... 232
  - Using histograms ......................................... 233
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing projects for broadcast</td>
<td>233</td>
</tr>
<tr>
<td>Previewing in a player</td>
<td>234</td>
</tr>
<tr>
<td>Using an external monitor</td>
<td>235</td>
</tr>
<tr>
<td>Setting up an external monitor</td>
<td>235</td>
</tr>
<tr>
<td>Configuring an external monitor</td>
<td>236</td>
</tr>
<tr>
<td>Verifying the external monitor configuration</td>
<td>236</td>
</tr>
<tr>
<td>Saving, Rendering, and Printing Projects</td>
<td>237</td>
</tr>
<tr>
<td>Saving a project</td>
<td>237</td>
</tr>
<tr>
<td>Creating a copy of a project (using Save As...)</td>
<td>238</td>
</tr>
<tr>
<td>Saving a project with media</td>
<td>238</td>
</tr>
<tr>
<td>Autosaving a project</td>
<td>239</td>
</tr>
<tr>
<td>Rendering a project</td>
<td>239</td>
</tr>
<tr>
<td>Selecting a file format</td>
<td>240</td>
</tr>
<tr>
<td>More about the MPEG format</td>
<td>240</td>
</tr>
<tr>
<td>More about the Wave64 and Perfect Clarity Audio formats</td>
<td>240</td>
</tr>
<tr>
<td>More about video formats</td>
<td>241</td>
</tr>
<tr>
<td>Customizing the rendering process</td>
<td>241</td>
</tr>
<tr>
<td>Customizing the Render As settings</td>
<td>242</td>
</tr>
<tr>
<td>Saving custom settings as a template</td>
<td>242</td>
</tr>
<tr>
<td>Creating custom rendering settings for AVI files</td>
<td>243</td>
</tr>
<tr>
<td>Project tab</td>
<td>243</td>
</tr>
<tr>
<td>Video tab</td>
<td>243</td>
</tr>
<tr>
<td>Audio tab</td>
<td>244</td>
</tr>
<tr>
<td>Printing with Video Capture</td>
<td>245</td>
</tr>
<tr>
<td>Printing to DV tape</td>
<td>246</td>
</tr>
<tr>
<td>Establishing a connection to the recording device</td>
<td>246</td>
</tr>
<tr>
<td>Printing to DV tape</td>
<td>246</td>
</tr>
<tr>
<td>Burning Video CDs</td>
<td>248</td>
</tr>
<tr>
<td>Burning multimedia CDs</td>
<td>249</td>
</tr>
<tr>
<td>Customizing Vegas</td>
<td>251</td>
</tr>
<tr>
<td>Displaying frame numbers</td>
<td>251</td>
</tr>
<tr>
<td>Changing the ruler format</td>
<td>251</td>
</tr>
<tr>
<td>Editing the ruler offset</td>
<td>252</td>
</tr>
<tr>
<td>Changing grid spacing</td>
<td>252</td>
</tr>
<tr>
<td>Using the Time Display window</td>
<td>253</td>
</tr>
<tr>
<td>Changing the Time Display settings</td>
<td>253</td>
</tr>
<tr>
<td>Changing the Time Display colors</td>
<td>253</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Setting the Time Display to monitor MIDI timecode</td>
<td>254</td>
</tr>
<tr>
<td>Working with project properties</td>
<td>254</td>
</tr>
<tr>
<td>Video tab</td>
<td>254</td>
</tr>
<tr>
<td>Audio tab</td>
<td>255</td>
</tr>
<tr>
<td>Ruler tab</td>
<td>255</td>
</tr>
<tr>
<td>Summary tab</td>
<td>256</td>
</tr>
<tr>
<td>Audio CD tab</td>
<td>256</td>
</tr>
<tr>
<td>Setting Vegas preferences</td>
<td>256</td>
</tr>
<tr>
<td>General tab</td>
<td>256</td>
</tr>
<tr>
<td>Video tab</td>
<td>258</td>
</tr>
<tr>
<td>Audio tab</td>
<td>258</td>
</tr>
<tr>
<td>CD Settings tab</td>
<td>260</td>
</tr>
<tr>
<td>Editing tab</td>
<td>260</td>
</tr>
<tr>
<td>Sync tab</td>
<td>261</td>
</tr>
<tr>
<td>Video device tab</td>
<td>262</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>263</td>
</tr>
<tr>
<td>Troubleshooting resources</td>
<td>263</td>
</tr>
<tr>
<td>Common questions</td>
<td>263</td>
</tr>
<tr>
<td>Why are some of my DirectX plug-ins not working correctly?</td>
<td>263</td>
</tr>
<tr>
<td>Why do I hear gaps in my audio playback?</td>
<td>263</td>
</tr>
<tr>
<td>Why do mono events increase 6 dB when panning a track hard?</td>
<td>264</td>
</tr>
<tr>
<td>Why do buffer underruns occur during a test or real write to a CD?</td>
<td>264</td>
</tr>
<tr>
<td>Why can’t I work with footage captured using an MJPEG card?</td>
<td>264</td>
</tr>
<tr>
<td>Trouble-free video: software solutions</td>
<td>265</td>
</tr>
<tr>
<td>Trouble-free video: hardware solutions</td>
<td>265</td>
</tr>
<tr>
<td>Video subsystem</td>
<td>265</td>
</tr>
<tr>
<td>Hard disk</td>
<td>266</td>
</tr>
<tr>
<td>CPU and RAM (memory)</td>
<td>266</td>
</tr>
<tr>
<td>Audio proxy files (.sfap0)</td>
<td>267</td>
</tr>
<tr>
<td>Interlacing and field order</td>
<td>267</td>
</tr>
<tr>
<td>Timecode</td>
<td>269</td>
</tr>
<tr>
<td>SMPTE timecode types</td>
<td>269</td>
</tr>
<tr>
<td>Timecode in Vegas</td>
<td>270</td>
</tr>
<tr>
<td>Troubleshooting DV hardware issues</td>
<td>271</td>
</tr>
<tr>
<td>Glossary</td>
<td>273</td>
</tr>
<tr>
<td>Index</td>
<td>i</td>
</tr>
</tbody>
</table>
Introduction

Welcome to Sonic Foundry Vegas

Sonic Foundry Vegas™ is an innovative and advanced multitrack media-editing system. Vegas was designed to create an efficient audio/video production environment without sacrificing the quality and processing power that you expect from Sonic Foundry. Whether it's the standard and familiar Windows navigation commands or the clean and uncluttered interface, you'll find Vegas to be a tool that will be mastered in minutes. Beneath the unique and customizable interface, you'll find a product that is both powerful and flexible. This table lists some of the features available in Vegas, the perfect multitrack media-editing system for your studio or production environment:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nondestructive editing</td>
<td>Unlimited tracks</td>
</tr>
<tr>
<td>Unlimited undo/redo</td>
<td>Multiple file formats on a single track</td>
</tr>
<tr>
<td>Automatic crossfade functionality</td>
<td>Simultaneous multitrack record &amp; play</td>
</tr>
<tr>
<td>Quick-edit media trimmer with direct link to audio editor</td>
<td>EQ and compressor inserts available on every audio track</td>
</tr>
<tr>
<td>Loop recording</td>
<td>Print-to-tape directly from project timeline</td>
</tr>
<tr>
<td>Real time event resampling</td>
<td>32 assignable DirectX effects send</td>
</tr>
<tr>
<td>Audio/video scrub control</td>
<td>DirectX Plug-In support</td>
</tr>
<tr>
<td>Edit detail list management</td>
<td>Dual processor support</td>
</tr>
<tr>
<td>Red Book audio CD mastering and burning</td>
<td>Multiple I/O support</td>
</tr>
<tr>
<td>24-bit/96 kHz</td>
<td>MIDI timecode generate &amp; trigger</td>
</tr>
<tr>
<td>26 audio busses</td>
<td>Dual monitor support</td>
</tr>
<tr>
<td>Internet streaming file authoring (Windows Media Technologies and RealNetworks)</td>
<td>Ability to incorporate timeline metadata (markers/captions) for Internet content authoring</td>
</tr>
<tr>
<td>Imports: .aif, .avi, .bmp, .gif, .jpg, .mov, .mp3, .ogg, .pca, .png, .psd, .sfa, .tif (requires QuickTime), .tga, .w64, .wav, .wma, .wmv</td>
<td>Exports: .aif, .avi, .mov, .mp3, .mpg (with optional plug-in), .pca, .ogg, .rm, .w64, .wav, .wma, .wmv</td>
</tr>
</tbody>
</table>

Vegas includes MainConcept MPEG-1 and MPEG-2 transcoding and decoding software.

System requirements

**Minimum requirements**

- 400 MHz processor
- Windows-compatible sound card
- CD-ROM drive
- 7200 RPM hard-disk drive
- OHCI-compliant IEEE-1394/DV capture card (for DV capture and print-to-tape tools only)
- 24-bit color display recommended
- 128 MB RAM
- 40 MB hard-disk space for program installation
- Microsoft® Windows® 98SE, ME, 2000, or XP
- Microsoft DirectX® 8 or later (included on CD-ROM)
- Internet Explorer 4.0 or later to view online help (version 5.0 included on CD-ROM)
Technical support

The Web site at http://www.sonicfoundry.com/support has technical support, reference information, program updates, tips and tricks, and a knowledge base.

About this version of Vegas

The Vegas family of products includes Vegas Video and Vegas Video LE. Both versions boast a suite of professional level multitrack audio tools, while Vegas Video also includes advanced NLE (nonlinear editing) features, making it a true all-in-one multimedia editing solution.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Vegas Video</th>
<th>Vegas Video LE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video tracks</td>
<td>Unlimited</td>
<td>2</td>
</tr>
<tr>
<td>Audio tracks</td>
<td>Unlimited</td>
<td>4</td>
</tr>
<tr>
<td>Multiple compositing modes</td>
<td>X</td>
<td>Source alpha only</td>
</tr>
<tr>
<td>Dynamic RAM preview</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Video envelopes: fade to color, composite level, velocity</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Video effects</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Video transitions</td>
<td>X</td>
<td>Presets only</td>
</tr>
<tr>
<td>Audio effects (DirectX plug-ins) included</td>
<td>X (XFX 1, 2, and 3)</td>
<td>Express FX 1 and 2 only</td>
</tr>
<tr>
<td>Assignable effects chains</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Multiple audio busses</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Rubber audio (time-stretch and pitch-shift events)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Render to new track</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Customizable render to streaming media formats</td>
<td>X</td>
<td>Presets only</td>
</tr>
<tr>
<td>Print to tape from timeline</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>MPEG 1 and 2 encoding</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Project compacting (copy and trim media with project)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>External monitor support</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>CD burning</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Bit depth/sample rate</td>
<td>24/96Khz</td>
<td>16/48Khz</td>
</tr>
<tr>
<td>Overall level of video control</td>
<td>High</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

Most versions can be immediately upgraded to a more advanced version over the Internet. From the Help menu, choose Instant Upgrade to purchase a license and unlock these more powerful features.

This manual covers all of the features available in both Vegas Video and Vegas Video LE. Since different versions have different features, more advanced features available only in Vegas Video are marked with a special icon.
Installing Vegas

1. Insert the Vegas CD-ROM. The Vegas Installation screen appears (if CD-ROM AutoPlay is enabled).
   If CD-ROM AutoPlay is disabled, click the Start button and choose Run. In the Run window that appears, type the CD-ROM drive's letter and add \setup.exe. Click the OK button to start the installation.
2. Click Install Software. The installation process begins.
3. Follow the screen prompts and enter the necessary information when required.
4. At the last screen prompt, click Finish to conclude the installation.

Note: Vegas uses the Windows Installer for all versions of Windows (e.g., 98SE, ME). Vegas installs the Windows Installer and then asks you to restart your system.

Registration

The registration dialog that appears when you start Vegas allows you to quickly and easily register:

- **Register online** - instantly registers the product over the Internet.
- **Register from another computer** - if the computer Vegas is installed on does not have an Internet connection, but you have another computer that does.
- **Register over the phone** - call Sonic Foundry to register manually.
- **Register later** - allows you to continue using Vegas for a limited time without registering.

Follow the instructions in the registration dialog to complete your Vegas registration.

Using online help

Vegas includes online help. To view the online help, you must have Internet Explorer 4.0 or higher loaded on your system (IE 5.0 is included on the Vegas CD-ROM).

Accessing help

The online help is available in two forms: in a main help window or What's This? help window. Both forms are available via the keyboard (F1) or by clicking the Help menu.
Main help window

The main help window is accessed either by choosing Contents and Index from the Help menu or by pressing F1. This window has four tabs that you can use to find the information that you need.

The Contents tab provides a list of available help topics. Double-click a closed book ( ) to open the pages, and then click a topic page ( ).

The Index tab provides a complete listing of the help topics available. Scroll through the list of available topics or type a word in the Type in the keyword to find box to quickly locate topics related to that word. Select the topic and click the button.

The Search tab allows you to enter a keyword and display all of the topics in the online help that contain the keyword you have entered. Type a keyword in the Type in the word(s) to search for box and click the button. Select the topic from the list and click the button.

The Favorites tab allows you to keep topics that you revisit often in a separate folder. To add a topic to your favorites, click the button on the Favorites tab.

What's This? help

What's This? help allows you to view pop-up descriptions of Vegas menus, buttons, and dialog boxes.

1. Click the What's This Help button ( ) in the toolbar or the question mark ( ) in the upper-right corner of a dialog box. Alternately, you can choose What's This? from the Help menu or press Shift+F1.

2. The cursor changes to a question mark icon: ( ).

3. Click an item in the program's interface.

PDF manual

There is a PDF version of the manual available on the Vegas CD-ROM. To view this manual, you will need Adobe Acrobat Reader (also included on the Vegas CD-ROM). Please read the vegas_readme.doc for more information on the latest updates and changes.

Help on the Web

Additional Vegas help and information is available on the Sonic Foundry Web site. From the Help menu, choose Sonic Foundry on the Web to view a listing of Web pages pertaining to Vegas and Sonic Foundry.
Overview

Vegas is designed to be an easy-to-use program with many tools that provide power and flexibility when creating and working with multimedia files. Many Vegas operations, menu items, and shortcut keys are consistent with other popular Windows software applications. The following sections are a graphical tour of the Vegas workspace.

Main window

This is the window that appears when you open Vegas. The work area is subdivided into three primary areas: the track header, the track view (or timeline), and the window docking area.

Toolbar

The toolbar allows you to quickly access the most commonly used functions and features in Vegas. From the Options menu, choose Customize Toolbar to specify which buttons are displayed.
Time display

The Time Display window reflects the cursor’s position on the timeline and the end point of a time selection. The Time Display window’s time settings may be customized, including what time the window displays and color usage. For more information, see Using the Time Display window on page 253.

The Time Display window may be moved from its docked position above the track headers to float on the Vegas workspace. In addition, the Time Display window may be docked in the window docking area.

Ruler

The ruler is the timeline for your project. You may specify how the ruler measures time: seconds, measures and beats, frames, etc. For more information, see Changing the ruler format on page 251.

Marker bar

The marker bar is the area where markers and regions may be placed, named, and positioned along the project’s timeline. These informational tags can serve as cues or reminders highlighting important events in your project. For more information, see Adding project markers and regions on page 100.

Command bar

The command bar displays when you add a command to your project. Commands add metadata to media files to create effects such as closed captioning. For more information, see Adding project markers and regions on page 100.
CD layout bar

The CD layout bar displays tracks and indices in an audio CD layout project for disc-at-once (DAO) CD burning. For more information, see Burning Audio CDs on page 169.

Track list

This area identifies the track order in your project and contains controls used to determine track compositing and mixing. For more information, see Using the track header on page 77.

Track view

All arranging and editing is done in the track view or timeline. This area contains all of a project's events. For more information, see Using the track view on page 75.

Transport bar controls

The transport bar contains the playback and cursor positioning buttons frequently used while working on and previewing your project.
Status bar

The status bar is located at the bottom of the main program window and displays information about roughly how much space is left on your computer to record audio (Record Time). During the rendering processes, the left side of the status bar also contains information about the progress of the render.

The Video Preview window also has its own status bar that displays project specific information. For more information, see Understanding the Video Preview window on page 229.

Scrub control

The scrub control is used to play your project forward or backward for editing purposes. You may adjust playback speed by setting the speed control marker located beneath the scrub control. For more information, see Scrubbing on page 80.

Window docking area

This area allows you to keep frequently used windows available, but out of the way while you are working with a project. To dock a window, drag it to the docking area. Windows can be docked next to each other, subdividing the docking area, or they can be docked in a stack. When stacked, each window has a tab at the bottom with its name on it. Click the window’s tab to bring it to the top.

Drag the handle on the left side of a docked window to remove a window from the docking area and float it.
Explorer window - Alt+1

The Explorer window is similar to the Windows Explorer. Use the Explorer window to select media files to drag to the project timeline or add to the Media Pool. You can also use the Explorer to perform common file management tasks such as creating folders, renaming files and folders, deleting files and folders. Use the Start Preview ( ) and Auto Preview ( ) buttons to preview files before adding them to the project.

Trimmer window - Alt+2

The Trimmer window is a good place to edit any media file. When a media file is placed in the Trimmer window, you may take portions of the file and place them on separate tracks by dragging and dropping. For more information, see Using the Trimmer window on page 115.
Mixer window - Alt+3

The Mixer window gives you access to your project's audio properties, bus assignments, output levels, and plug-in chains. For more information, see Using the Mixer window on page 151.

---

Edit Details window - Alt+4

This window serves as a highly detailed and customizable database of all of the events in a project. The database can be organized and sorted according to a large number of attributes. For more information, see Using the Edit Details window on page 118.
**Media Pool - Alt +5**

The Media Pool is used to organize the media files that are being used by a project. The information about these files is displayed in a highly flexible database that can be instantly sorted. The Media Pool can also be used to apply effects and plug-ins to media files and can be used to set the specific properties of these files. *For more information, see Using the Media Pool on page 68.*

**Video Preview window - Alt-6**

This window displays a project’s video during project editing and playback. *For more information, see Previewing Video on page 229.*
Transitions window - Alt+7

The Transitions window contains all of the transitions available in Vegas. The thumbnails display animated examples of each transition. Transitions can be dragged from this window to the crossfade between two video events or to the fade-in or fade-out region of a video event. For more information, see Understanding basic transitions on page 211.

Video FX window - Alt+8

The Video FX window contains the video effects available in Vegas. The thumbnails display animated examples of each plug-in preset. You can drag plug-ins from this window to an event, track, or to the Video Preview window (video output effects). For more information, see Using video effects on page 193.
The Text/Backgrounds window contains the different media generators provided in Vegas. Media generators make it easy to create events containing text, credit rolls, test patterns, color gradients, and solid color backgrounds. You can drag a media generator to the timeline to create a new generated media event. For more information, see Using generated media on page 198.

Plug-Ins window - Ctrl+Alt+1

This window organizes all of the plug-ins available in Vegas, including video and audio effects, media generators, and transitions. The plug-ins, which are organized in a folder structure, can be dragged into the project. For more information, see Using audio effects on page 143 or Using video effects on page 193.
Keyboard command reference

### Project file commands
These commands refer to the overall project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open existing project or file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Open project’s properties</td>
<td>Alt+Enter</td>
</tr>
</tbody>
</table>

### Window view commands
These commands display the dockable windows included with Vegas.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus to track view</td>
<td>Alt+0</td>
</tr>
<tr>
<td>Explorer</td>
<td>Alt+1</td>
</tr>
<tr>
<td>Trimmer</td>
<td>Alt+2</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt+3</td>
</tr>
<tr>
<td>Edit Details</td>
<td>Alt+4</td>
</tr>
<tr>
<td>Media Pool</td>
<td>Alt+S</td>
</tr>
<tr>
<td>Video Preview</td>
<td>Alt+6</td>
</tr>
<tr>
<td>Transitions</td>
<td>Alt+7</td>
</tr>
<tr>
<td>Video FX</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Text/Backgrounds</td>
<td>Alt+9</td>
</tr>
<tr>
<td>Plug-ins</td>
<td>Ctrl+Alt+1</td>
</tr>
<tr>
<td>Next window</td>
<td>F6 or Ctrl+Tab</td>
</tr>
<tr>
<td>Previous window</td>
<td>Shift+F6 or Ctrl+Shift+Tab</td>
</tr>
<tr>
<td>Toggle focus between</td>
<td>Tab</td>
</tr>
<tr>
<td>list and timeline</td>
<td></td>
</tr>
</tbody>
</table>

### Playback and preview commands
These commands refer to playing back and previewing your project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playback</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Esc</td>
</tr>
<tr>
<td>Looped playback mode</td>
<td>Q</td>
</tr>
<tr>
<td>Pause</td>
<td>Enter</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Play back from any window</td>
<td>Ctrl+Spacebar or F12</td>
</tr>
<tr>
<td>Scrub playback</td>
<td>J/K/L (pg. 81)</td>
</tr>
<tr>
<td>Build dynamic RAM preview</td>
<td>Shift+B (pg. 232)</td>
</tr>
<tr>
<td>Preview in Player</td>
<td>Ctrl+Shift+M</td>
</tr>
<tr>
<td>Prerender video</td>
<td>Shift+M</td>
</tr>
</tbody>
</table>

### Edit commands
These commands refer to editing commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z or Alt+Backspace</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z or Ctrl+Y</td>
</tr>
<tr>
<td>Cut selection</td>
<td>Ctrl+X or Shift+Delete</td>
</tr>
<tr>
<td>Copy selection</td>
<td>Ctrl+C or Ctrl+Insert</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V or Shift+Insert</td>
</tr>
<tr>
<td>Paste repeat</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Paste insert</td>
<td>Ctrl+Shift+V</td>
</tr>
<tr>
<td>Delete selection</td>
<td>Delete</td>
</tr>
<tr>
<td>Split event(s)</td>
<td>S</td>
</tr>
<tr>
<td>Trim/crop selected events</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Normal Edit Tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Switch to next editing tool</td>
<td>D</td>
</tr>
<tr>
<td>Switch to previous editing tool</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Open in audio editor</td>
<td>Ctrl+E</td>
</tr>
</tbody>
</table>
Cursor placement commands

These commands refer to cursor navigation within the track view.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home</td>
<td>Move left to marker(s)</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End</td>
<td>Move right to marker(s)</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or W</td>
<td>Move left to event edit points including fade edges</td>
<td>Ctrl+Alt+Left Arrow</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End or E</td>
<td>Move right to event edit points including fade edges</td>
<td>Ctrl+Alt+Right Arrow</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
<td>Nudge cursor on timeline</td>
<td>Left or Right Arrow</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
<td>Move one frame</td>
<td>Alt+Left or Right Arrow</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
<td>Jump to next audio CD track region or index</td>
<td>Period</td>
</tr>
<tr>
<td>Jump to Marker #</td>
<td>0-9 keys (not numeric keypad)</td>
<td>Jump to previous audio CD track region or index</td>
<td>Comma</td>
</tr>
<tr>
<td>Jump to opposite side of selection</td>
<td>Numeric keypad 5</td>
<td>Jump to next audio CD track region</td>
<td>Ctrl+Period</td>
</tr>
<tr>
<td>Center in View</td>
<td>\</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Time selection commands

These commands refer to creating time selections or preview ranges.

Note: Many of the preceding cursor placement commands, when combined with the Shift key, are also selection commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap select to event edge</td>
<td>Ctrl+Shift+Alt+Left or Right Arrow</td>
<td>Recover previous selection areas</td>
<td>Backspace</td>
</tr>
<tr>
<td>Select loop region</td>
<td>Shift+Q</td>
<td>Select left by grid marks</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Recover previous selection areas</td>
<td>Backspace</td>
<td>Select right by grid marks</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Mark in/out locations</td>
<td>I (in) and O (out)</td>
<td>Create time selection while dragging on an event</td>
<td>Ctrl+Shift+drag with mouse</td>
</tr>
<tr>
<td>Expand selection one frame</td>
<td>Shift+Alt+Left or Right Arrow</td>
<td>Select to next audio CD track marker</td>
<td>Shift+. (period)</td>
</tr>
<tr>
<td>Select to previous audio CD track marker</td>
<td>Shift+. (comma)</td>
<td>Enter location for end of selection</td>
<td>Ctrl+Shift+G</td>
</tr>
</tbody>
</table>

View commands

These commands refer to magnification in the timeline and minimizing/maximizing different areas of the window.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase track height</td>
<td>Ctrl+Shift+Up Arrow</td>
<td>Zoom in on audio waveforms</td>
<td>Shift+Up Arrow</td>
</tr>
<tr>
<td>Decrease track height</td>
<td>Ctrl+Shift+Down Arrow</td>
<td>Zoom out on audio waveforms</td>
<td>Shift+Down Arrow</td>
</tr>
<tr>
<td>Minimize all tracks</td>
<td></td>
<td>Zoom in</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Set track height smaller</td>
<td>Shift+`</td>
<td>Zoom out</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>Set track height to default size</td>
<td>Ctrl+`</td>
<td>Show/hide window docking area</td>
<td>F11</td>
</tr>
<tr>
<td>Zoom in time (incremental)</td>
<td>Up Arrow</td>
<td>Show/hide track header area</td>
<td>Shift+F11</td>
</tr>
<tr>
<td>Zoom in time until each thumbnail represents one frame</td>
<td>Alt+Up Arrow</td>
<td>Show/hide window docking area and track header area</td>
<td>Ctrl+F11</td>
</tr>
<tr>
<td>Zoom out time (incremental)</td>
<td>Down Arrow</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Event commands
These commands apply to selected events.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move selected event(s) right one pixel</td>
<td>Right Arrow numeric keypad 6</td>
<td>Move selected event(s) right by the first selected event's length</td>
<td>Ctrl+Alt+Right Arrow numeric keypad 6</td>
</tr>
<tr>
<td>Move selected event(s) left one pixel</td>
<td>Left Arrow numeric keypad 4</td>
<td>Move selected event(s) left by the first selected event's length</td>
<td>Ctrl+Alt+Left Arrow numeric keypad 4</td>
</tr>
<tr>
<td>Move selected event(s) right on grid</td>
<td>Ctrl+Right Arrow numeric keypad 6</td>
<td>Move selected event(s) up one track</td>
<td>Up Arrow numeric keypad 8</td>
</tr>
<tr>
<td>Move selected event(s) left on grid</td>
<td>Ctrl+Left Arrow numeric keypad 4</td>
<td>Move selected event(s) down one track</td>
<td>Down Arrow numeric keypad 2</td>
</tr>
<tr>
<td>Move selected event(s) right by the project frame period</td>
<td>Alt+Right Arrow numeric keypad 6</td>
<td>Select next take</td>
<td>T</td>
</tr>
<tr>
<td>Move selected event(s) left by the project frame period</td>
<td>Alt+Left Arrow numeric keypad 4</td>
<td>Select previous take</td>
<td>Shift+T</td>
</tr>
</tbody>
</table>

### Event editing commands
These commands apply to event editing.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slip: move media within event without moving the event</td>
<td>Alt+drag inside the event</td>
<td>Trim Adjacent: trim selected event and adjacent event simultaneously</td>
<td>Ctrl+Alt+drag edge of event</td>
</tr>
<tr>
<td>Slip Trim: move the media with the edge as it is trimmed</td>
<td>Alt+drag edge of event</td>
<td>Stretch (compress) the media in the event while trimming</td>
<td>Ctrl+drag edge of event</td>
</tr>
<tr>
<td>Slide: trim both ends of event simultaneously</td>
<td>Ctrl+Alt+drag middle of event</td>
<td>Open in audio editor</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Slide Crossfade: move crossfade</td>
<td>Ctrl+Alt+drag over a crossfade</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Event selection commands
These commands apply to selecting events.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range selection</td>
<td>Shift+click range of objects</td>
</tr>
<tr>
<td>Multiple selection</td>
<td>Ctrl+click individual objects</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Unselect all</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Select all events in group</td>
<td>Shift+G</td>
</tr>
</tbody>
</table>
Track commands

These commands refer to editing functions related to the tracks in your project.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>New audio track</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>New video track</td>
<td>Ctrl+Shift+Q</td>
</tr>
<tr>
<td>Enable/disable snapping</td>
<td>F8</td>
</tr>
<tr>
<td>Quantize to frames</td>
<td>Alt+F8</td>
</tr>
<tr>
<td>Snap to markers</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Snap to grid</td>
<td>Ctrl+F8</td>
</tr>
<tr>
<td>Ripple edit mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Auto crossfade mode</td>
<td>X</td>
</tr>
<tr>
<td>Normal edit tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Next tool</td>
<td>D</td>
</tr>
<tr>
<td>Previous tool</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Render to new track</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Change the track that has focus</td>
<td>Alt+Shift+Up/Down Arrow</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group selected events</td>
<td>G</td>
</tr>
<tr>
<td>Remove event(s) from group</td>
<td>U</td>
</tr>
<tr>
<td>Clear group (without deleting events)</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Insert/show/hide track volume envelope</td>
<td>V</td>
</tr>
<tr>
<td>Remove track volume envelope</td>
<td>Shift+V</td>
</tr>
<tr>
<td>Insert/show/hide track panning envelope</td>
<td>P</td>
</tr>
<tr>
<td>Remove track panning envelope</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Insert region</td>
<td>R</td>
</tr>
<tr>
<td>Insert marker</td>
<td>M</td>
</tr>
<tr>
<td>Insert command</td>
<td>C</td>
</tr>
<tr>
<td>Insert audio CD track region</td>
<td>N</td>
</tr>
<tr>
<td>Insert audio CD track index</td>
<td>Shift+N</td>
</tr>
<tr>
<td>Insert transition</td>
<td>/, *, - (numeric keypad)</td>
</tr>
<tr>
<td>Insert cut transition</td>
<td>Ctrl+/.*, - (numeric keypad)</td>
</tr>
</tbody>
</table>

Note: Many of the shortcuts that apply to the timeline (e.g., cursor placement, selection commands, etc.) also work in the Trimmer.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Media From Cursor</td>
<td>A</td>
</tr>
<tr>
<td>Add Media to Cursor</td>
<td>Shift+A</td>
</tr>
<tr>
<td>Transfer time selection from timeline to Trimmer after cursor</td>
<td>T</td>
</tr>
<tr>
<td>Transfer time selection from timeline to Trimmer before cursor</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Toggle selected stream: audio/video/both</td>
<td>Tab</td>
</tr>
<tr>
<td>Toggle audio/video stream height</td>
<td>Ctrl+Shift+Up/Down Arrow</td>
</tr>
<tr>
<td>Next media file in Trimmer</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Previous media file in Trimmer</td>
<td>Ctrl+Shift+Tab</td>
</tr>
</tbody>
</table>

Trimmer commands

These commands apply to the Trimmer window.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make fine fader adjustments</td>
<td>Ctrl+drag fader</td>
</tr>
</tbody>
</table>

Miscellaneous commands

These commands allow you to move items, access help, and refresh the screen.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help</td>
<td>F1</td>
</tr>
<tr>
<td>What's This? help</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Change relative keyframe spacing</td>
<td>Alt+drag keyframes</td>
</tr>
<tr>
<td>Make fine fader adjustments</td>
<td>Ctrl+drag fader</td>
</tr>
<tr>
<td>Shortcut menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Rebuild audio peaks</td>
<td>F5</td>
</tr>
<tr>
<td>Move both region markers or audio CD track region markers</td>
<td>Alt+drag region marker</td>
</tr>
</tbody>
</table>
Mouse wheel shortcuts

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in/out on timeline</td>
<td>Default mouse wheel behavior</td>
</tr>
<tr>
<td>Zoom in/out in Event Pan/Crop or Track</td>
<td>Default mouse wheel behavior</td>
</tr>
<tr>
<td>Motion windows</td>
<td></td>
</tr>
<tr>
<td>Vertical scroll</td>
<td>Ctrl+wheel</td>
</tr>
<tr>
<td>Horizontal scroll</td>
<td>Shift+wheel</td>
</tr>
<tr>
<td>Move the cursor in small increments</td>
<td>Ctrl+Shift+wheel</td>
</tr>
<tr>
<td>Move cursor one frame at a time</td>
<td>Ctrl+Shift+Alt+wheel</td>
</tr>
<tr>
<td>Auto-scroll</td>
<td>Press mouse wheel and move mouse left or right</td>
</tr>
<tr>
<td>Move fader/slider</td>
<td>Hover over fader and use wheel</td>
</tr>
<tr>
<td>Move fader/slider with fine control</td>
<td>Ctrl+hover over fader and use wheel</td>
</tr>
</tbody>
</table>

Cursor indications

The cursor in Vegas changes depending on which functions are available. In Windows, for example, the cursor changes to an hourglass when the system is busy.

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Indicates</th>
<th>Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="cursor.png" alt="Standard" /></td>
<td>Standard</td>
<td>none</td>
<td>This is the standard arrow cursor that means events can be dragged.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Trim" /></td>
<td>Trim</td>
<td>none</td>
<td>Position the cursor over the edge of an event and drag to trim the event shorter or longer.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Slip Trim" /></td>
<td>Slip Trim</td>
<td>Alt</td>
<td>Position the cursor over the edge of an event, press Alt, and drag to trim. The media within the event moves with the edge. This is useful to preserve the beginning or end of an event while trimming.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Stretch" /></td>
<td>Stretch</td>
<td>Ctrl</td>
<td>Position the cursor over the edge of an event, press Ctrl, and drag the edge to stretch or compress it. This makes the media in the event play slower or faster.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Slip" /></td>
<td>Slip</td>
<td>Alt</td>
<td>Press Alt and drag on the middle of a clip to move the media within the event without moving the event itself.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Trim Adjacent" /></td>
<td>Trim Adjacent</td>
<td>Ctrl+Alt</td>
<td>Position the cursor over the boundary between two adjacent events, press Ctrl+Alt, and drag. Both events are edge trimmed simultaneously.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Slide" /></td>
<td>Slide</td>
<td>Ctrl+Alt</td>
<td>Position the cursor over the middle of an event, press Ctrl+Alt, and drag to simultaneously trim both ends.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Slide Crossfade" /></td>
<td>Slide Crossfade</td>
<td>Ctrl+Alt</td>
<td>Position cursor over a crossfade, press Ctrl+Alt, and drag on a crossfade to move it.</td>
</tr>
</tbody>
</table>
Audio Signal Flow

Multiple audio busses and assignable effects are only available in Vegas Video.
Video Signal Flow

Vegas Video provides unlimited video tracks and fourteen compositing modes. Vegas Video LE limits you to two video tracks and source alpha compositing.

Velocity envelope → Media interpretation → Media FX
(field order, frame rate, alpha channel, etc.)

Event opacity → Event FX → Event pan/crop

Transitions → Track FX → Track fade to color envelopes

Track motion + composite envelope + compositing

Video Output FX
This chapter is designed to familiarize you with the basic features and tools of Vegas while creating an actual project. This chapter also provides descriptions of several sample projects that demonstrate different Vegas features.

**Note:** The tutorial and sample projects demonstrate advanced video features (e.g., unlimited video and audio tracks, video envelopes) found only in Vegas Video.

**Tutorial**

This tutorial will teach you how to place media files in the project, edit them, and save them together into a video file. The files you need to create this sample project are included on the program’s CD-ROM in the \Sample Projects\Tutorial folder. The video length is approximately forty seconds. As you work, you will see how easy it is to master the powerful features that Vegas has to offer. Some of the techniques are only briefly demonstrated here, however, and many complex operations are described in a sentence or two.

There are nine separate sections in the tutorial. Each section has a completed project file included on the CD-ROM. When you have worked through section 1. **Voiceover narration**, your project should look something like the included project file 01_voiceover.veg. These complete project files can also be used as references if you find any of the explanations in this chapter to be unclear. If you make a mistake during the tutorial, just undo it by pressing **Ctrl + Z**. The following resources outside of this chapter may be useful as you work:

- Map of the user interface (pg. 19).
- Glossary of terms (pg. 273).
- Hold the mouse pointer over items in the user interface to see ToolTips that display the names of the various controls.
- Press **F1** and click an item for a What’s This? help definition.
Installing the tutorial

1. Insert the Vegas CD-ROM.
2. Locate the \Sample Projects\Tutorial folder on the CD-ROM and copy it to your hard drive.
3. After the folder is copied, start Vegas.

Note: After copying the files to your hard drive, you may need to re-establish the source media file links. When opening a project file (.veg) for the first time, Vegas may prompt you to find the media and relink it to the project. All of the files will be read only when copied to your hard drive. You will be unable to save changes to them unless you change their properties.

The finished project is called 09_velocity.veg and looks like the illustration below. The project is designed to highlight a few of the features of Vegas Video. Some aspects of the project are fairly complex. Use the map below to go to the tutorial section that explains a particular technique.
1. Voiceover narration (01_voiceover.veg)

The first section of this project is a talking-head video that contains the main message. The quality of the audio in the source video (talkinghead.avi) is poor and needs to be replaced with a new voiceover (voiceover.wav), recorded in a studio. The finished project can be used as a reference: 09_velocity.veg.

Creating a new Vegas project

You may set the properties of a project when you first create it. Once set, these properties can be edited at any time by choosing Properties from the File menu.

1. Start Vegas.
2. From the File menu, choose New. The New Project dialog appears.
3. On the Video tab, choose Multimedia (320x240) from the Template drop-down list.
4. On the Ruler tab, choose Time in the Ruler time format drop-down list.
5. Click OK.

Using the Explorer window

The Explorer window allows you to view and access your media files without leaving the work area. This window works just like Windows Explorer.

1. Locate the \Sample Projects\Tutorial folder on your hard drive.
2. Select the \Sample Projects\Tutorial folder so that its contents appear in the Explorer window.

Placing the video

In the media files list in the Explorer window, the media files needed for this project are displayed. We will place the talkinghead.avi file. Once a media file is placed into the project, it is contained in an event.

1. Move the cursor over the timeline.
2. Press Ctrl+Home to place the cursor at the beginning of the project.
3. Double-click the media file (talkinghead.avi) in the Explorer window. The video portion (stream) is placed on a video track and the audio portion (stream) is placed on an audio track at the cursor's position.

A media file on the timeline in Vegas is an event. There are two events on the timeline for talkinghead.avi: a video event that serves as a window into the video stream of the media file and an audio event that serves as a window into the audio stream. Edits that are made to either of these events do not affect the source media file, talkinghead.avi, in any way.

**Naming a track**

It is a good idea to label the tracks using the scribble strip on the track header.

1. Double-click the scribble strip on the track header of the video track.
2. Type “Talkinghead.”
3. Press **Enter**. The new track name appears on the scribble strip.

**Displaying a preview**

The Video Preview window shows a preview of your project.

To view the Video Preview window, from the **View** menu, make sure **Video Preview** is selected.
Playing back the video

1. Click the Play From Start button ( ) on the transport bar to start playback from the beginning.

   ![Transport bar](image.png)

2. Click the Stop button ( ) to stop playback.

3. Click the audio track’s Mute button ( ) to mute the audio track.

   ![Audio track](image.png)

We are preparing to place and work with the new voiceover. Eventually, we will delete the original audio, but for now it can be used as a reference.

Placing the new voiceover

A new voiceover was recorded in a studio to replace the original audio stream from talkinghead.avi.

**Note:** We could have recorded the new audio straight into Vegas. For more information, see Recording Audio on page 159.

1. In the Explorer, select the file titled voiceover.wav.
2. Drag the file into the timeline below the lowest track. Vegas creates a new track for it.
3. Double-click the scribble strip on the new track and name the track “Voiceover.”
4. Click either the Play ( ) or the Play From Start ( ) button to play the voiceover.
5. Click the Stop button ( ) to stop playback.

During playback, the narrator pauses to review notes and cough. These are the types of problems that will be fixed in the next section. The following is a map of the voiceover.

![Voiceover map](image.png)

These errors (B and D) will be removed in the next section. Also, during playback you probably saw that the new voiceover and the video are out of sync. Next, we will align the voiceover with the video.

Aligning the new voiceover with video

We will now position the voiceover so that it is roughly aligned with the video. We will use the poor-quality audio as a reference. Since we can see the audio waveform, synchronizing is made easier.

To make it easier to see the audio events, we can zoom in on the project. There are several ways to manage the project’s view. For more information, see Changing track height on page 133.

1. Press Alt + 0 or click the timeline so the track view (timeline) takes focus of keyboard commands.
2. Hold the Ctrl + Shift keys and then press either the ↑ or ↓ keys to toggle through different track heights.
3. Click the Zoom In Time button ( ) at the bottom-right corner of the track view to zoom in on the audio.
4. Drag the new audio event to align it under the original audio. Use the waveforms as a guide to align the event.

5. On the timeline, drag to select a time region that includes the beginning of the audio.

6. Click either the Play ( ) or the Play From Start ( ) button to play just the time selection. Click the Loop Playback button ( ) on the transport bar to have playback loop continuously within the selection.

7. Watch the Video Preview window to see if the new voiceover is roughly in the correct position. You will fine-tune the alignment in the next section.

8. Click the Stop button ( ) to stop playback.

Saving a Vegas project
A Vegas project file contains all of the information about a single project. However, it does not contain any media, but maintains the references to media files used in the project.

1. From the File menu, choose Save. The first time you save a project, the Save As dialog appears.

   ![Save As dialog](image)

2. Select the drive and folder where you want to store the project.

3. Type the project name “MyTutorial” in the File name box.

4. Click the Save button.

   The subsequent times you save the project, the Save As dialog is bypassed, your existing file name is retained, and your project is updated to include any changes.
Summary

In this section, we replaced the audio from the original video with a cleaner audio track recorded in a studio and saved the project. Here is what the project should look like at this point:

2. Voiceover editing (02_editing.veg)

When you played the new voiceover, you noticed the interruption errors that it contained. We will remove those errors and synchronize the remaining voiceover to the video. Vegas allows you to edit both time and events. We will use both methods to edit the voiceover.

Locking the original events

Time selection edits affect all tracks in the project unless a specific track is selected. Before we start editing the voiceover, we will lock the original audio and video events, which are our references, to prevent them from accidently being edited.

1. Select the original video and audio events. Hold the `Ctrl` key while clicking each of these events.
2. From the **Edit** menu, choose **Switches** and then **Lock**.

Editing a time selection

By looking at the waveform, you will see where the “um” and cough occur. You will also see where the narrator is speaking. We will delete the “um” using time selection.

1. Click the new voiceover event to select it.
2. On the timeline, drag to make a time selection where the “um” occurs.
3. Click the Play button (▶) to play back the error to ensure that your time selection does not include part of the voiceover that we need.
4. Increase or decrease the time selection by dragging an edge of the selection.
5. Once the time selection is made, choose **Delete** from the **Edit** menu, or press `Ctrl` to remove the “um.”

Next, we will split the event that contains the narrator’s cough and then delete the error.
Splitting an event using time selection

Splitting creates multiple events from an existing one. We will make a time selection that contains the narrator's cough and split it from the audio, then delete the cough.

1. On the timeline, drag to make a time selection where the cough occurs.

2. Click the Play button to play back the error to ensure that your time selection does not include part of the voiceover that we need.

3. Increase or decrease the time selection by dragging an edge of the selection.

4. Once the time selection is made, choose Split from the Edit menu, or press to split the event.

Editing an event

The cough is now a new event that can be deleted.

1. Click the event with the cough.

2. From the Edit menu, choose Delete or press to remove the cough event.

After you have made the edits, the voiceover should look something like this:
Aligning the remaining voiceover events

With the voiceover edited, we need to align the remaining audio to the video. When you move events, they snap to other event edges. You may extend or shorten an event's length by dragging its edges, which is useful for fine-tuning the alignment. Moreover, you may turn off snapping by choosing Enable Snapping from the Options menu.

1. Select the event that begins “This tutorial will introduce you....”
2. Drag the event to the approximate point where the narrator is saying this. Use the original audio as a reference.
3. On the timeline, drag the mouse to select a time region.
4. Click either the Play ( ) or the Play From Start ( ) button to play just the time selection. Click the Loop Playback button ( ) on the transport bar to have playback loop continuously within the selection.
5. Watch the Video Preview window to see if the new voiceover is synchronized and adjust the position of the event as needed.
6. Click the Stop button ( ) to stop playback.
7. Repeat the above steps for the event that begins “found in this new....”

Next, we will group the synchronized events with the video and delete the original audio from the project.

Unlocking the events

Earlier, the original video and audio events were locked to prevent changes from being made to them. Since the synchronizing work is done at this point, both of these events can be unlocked, permitting further modification.

1. Right-click the video event.
2. From the shortcut menu, choose Switches and choose Lock to clear the check mark that is displayed next to this command.

Grouping the new voiceover and video

The voiceover and video are synchronized, and we want to make sure that they stay together. First, we will delete the original audio, and then we will group the voiceover and video together.

1. Right-click the track header for the original audio track.

   **Note:** To avoid accidentally altering any other settings in the track header, right-click the track header on the track number.

2. From the shortcut menu, choose Delete. The entire track is removed from the project and the new voiceover becomes the second track.
3. Press [Ctrl] and click the video event and the voiceover events to select them.
4. From the Edit menu, choose Group and then Create New or press [G] to group the events.
Summary

In this section, we edited the new audio, synchronized it with the video, and grouped the events together. Here is what the project should look like at this point:

![Image of timeline with music bed and voiceover tracks]

3. Music bed (03_musicbed.veg)

Adding background music to the talkinghead event is very easy. You can use a track envelope to lower the volume while the narrator speaks and then raise it for the remainder of the video.

Placing the music bed
1. Press [Ctrl+Home] to move the cursor to the beginning of the project.
2. In the Explorer, drag the musicbed.wav file to the timeline below the lowest track (the voiceover track). A new track is created with the musicbed event on it. Position the new musicbed event at the beginning of the project.
3. Double-click the scribble strip on the new track and name the track “Musicbed.”
4. Click the Play button ( ) to play the project.

Repositioning the voiceover and video

The music bed is considerably longer than the voiceover portion of the project. Eventually, we will add video to fill out the project. If you were creating this project from scratch, you might not know exactly where to position the voiceover, but you could roughly position it and fine tune it later. In the case of this tutorial, however, we have a pretty good idea where everything needs to be.

1. Double-click the cursor position box at the bottom of the timeline.
2. Type 4.7 and press Enter. The cursor is positioned at 4.700 seconds on the timeline.
3. Drag the voiceover group (talking head video and voiceover audio) so that the beginning of the talkinghead event snaps to the cursor position.

Adding a volume envelope

The music bed’s volume needs to be lowered (ducked) as the narrator speaks. A track volume envelope can be used to lower the volume and then raise it again when the narrator finishes speaking. We will use the voiceover’s starting and ending points as a reference for the envelope.

1. Click the Musicbed track header.
2. From the Insert menu, choose Audio Envelopes and then choose Volume. A blue envelope line appears across the middle of the track.
3. On the Musicbed volume envelope line, place the mouse pointer slightly ahead of the voiceover’s starting point. The mouse pointer appears as a hand ( ).
4. Right-click and choose **Add Point** from the shortcut menu. A square point appears on the envelope line.

5. Repeat step 4 to add three more points on the line, for a total of four. The initial position of the points is unimportant.

**Setting the volume envelope**

Now we will use the points on the envelope to lower and raise the volume so that the music bed does not interfere with the voiceover. When you click or hover over a point, information about it appears.

1. Drag the points so that two are near the start of the voiceover and two are near the end.

2. Drag the two inner points so that their volume level is approximately -7.0 dB.

3. Set the outer points so that their volume level is 0.0 dB.

4. Click the **Play** ( ) or the **Play From Start** ( ) button to play the project and check the timing of the volume envelope.

5. Adjust the outer and inner points along the timeline as needed.

**Adding equalization (EQ) to the voiceover**

Now that the music is mixed in, you can hear the voiceover has a strong bass quality to it. We will adjust that quality slightly with EQ on the first band.

1. Click the **Track FX** button ( ) on the track header of the voiceover track. The Track FX window appears. Three plug-ins are applied to this track as a default.
2. Click the Track EQ plug-in ( ).

You can set the EQ settings by typing in the appropriate box, dragging the slider, or clicking the arrow buttons between the slider and the setting box. The easiest way to adjust the EQ is to drag the numbers on the EQ map, however.

3. Set the Frequency to 160 Hz.
4. Set the Gain to -inf.
5. Set the Rolloff to 12 (dB/oct).
6. Close the Track FX window.
7. Click the Play ( ) or the Play From Start ( ) button to play the project with the new EQ settings.

Summary
In this section, we added a music bed to a new track below the narration. The video and audio events from the last section were grouped together so they could be moved further down the timeline. The volume of the music was faded out (ducked) during the narration and was faded back in after it was over. In addition, equalization was used to improve the tone of the voiceover. Here is what the project looks like so far:

4. Background video (04_background.veg)
In this section, we will add some video clips to the background. The techniques we will focus on are inserting video, crossfading events, and adding transitions.

Creating a new video track
1. Browse for a video file (powderskier.avi) in the Explorer.
2. Drag the media file just below the musicbed audio track. Position the new powderskier event at the beginning of the project.
3. Double-click the scribble strip on the new track and name the track “Background.”
Since the new video event is being dropped at a location that does not already contain a video track, a new video track containing a new video event is created.
Crossfading to a new video event

One way to transition from one video scene to another is with a crossfade. This is a common technique where one scene fades out while another fades in.

1. Browse for the video file mountains.avi in the Explorer.
2. Drag this file to the background track.
3. Position the new event to the right of the first event (powderskier), overlapping by about a second. The overlapping region has an “X” across it, indicating a crossfade.

4. Repeat this procedure to add and automatically crossfade the remaining background video files: beach.avi, fireweed.avi, boat.avi, and sunset.avi.

If you preview the project, you can see the smooth transition between the crossfaded events. The total length of these events when overlapped should be the same as the music bed. The events can be repositioned by dragging them and can be trimmed slightly by dragging their edges. The background video track should look something like the illustration below.

Compositing, or video mixing, in Vegas occurs from the top down. Video in higher tracks obscures video in lower tracks. At this point, the talkinghead event obscures much of the underlying background video, especially the mountain and fireweed events. In section 8. Track Motion, you will add track motion to change this behavior. For now, you can preview the crossfades by soloing the background video track. Click the Solo button ( ) on the Background video track to do this. Click the Solo button again once you have previewed the video.

Inserting a transition effect

While almost all transitions in the movies and on television are either straight cuts (e.g., no transition) or some type of fade, Vegas also has a number of more interesting transition effects available.

1. From the View menu, choose Transitions to open the Transitions window. This window may already be open by default.
2. Click the Transitions tab in the docking area at the bottom of the workspace.
3. In the list of transition effects on the left side of the window, click Iris.
4. Locate the Diamond, Out, Center preset for the Iris transition.
5. Drag the Diamond, Out, Center transition preset to the crossfade between the beach event and the fireweed event. The Video Event FX window appears. The Iris transition is set up with the preset you selected.
6. Click the Close button (x) to close the Video Event FX window. The new transition replaces the crossfade between the two events.

[Image of dragging the transition to the crossfade and the completed transition]

Summary

In this section, a second video track with six new video events was added to the project. The events were arranged such that they overlapped each other by about one second. This created an automatic crossfade at each of the overlapping sections. The final duration of all of the events was made to equal the duration of the musicbed event. Finally, one of the crossfades was replaced with an Iris transition effect. Here’s what the project should look like so far:

[Image of the project timeline]

5. Overlay titles (05_overlay.veg)

In this step, we will insert some logos, or titles, into the beginning and ending of the project.

Repositioning the project

The core of the project (the voiceover, music, and background video) is finished. At this point, we want to add a flashy introduction and nice closing. To do this, all of the events in the current project must be repositioned. One way to do this is to group all of the events together and drag them. The Selection tool provides an easy way to select multiple events.

1. Make sure the Lock Envelopes to Events button ( ) on the toolbar is selected. This makes the volume envelope on the music bed track move with the musicbed event as it is moved.
2. Click the Selection Edit Tool button ( ) on the toolbar.
3. Drag a rectangle encompassing all of the events to be moved.
4. Right-click one of the selected events and, from the Group menu, choose Create New.
5. Click the Normal Edit Tool button ( ) on the toolbar.
6. Drag the group of events down the timeline so that the musicbed and powderskier events begin at the 13.000 second mark.

**Inserting the introduction splash**

In this section, we will insert an introductory sequence at the beginning of the project. Parts of the introduction will overlay, or appear on top of, other video events.

1. Locate implosion.avi in the Explorer.
2. Drag implosion.avi onto a blank location on the timeline below the lowest track so that a new track is created. This new event should start at the very beginning of the project.
3. Drag vegas_logo.bmp onto the same track. Position it so that it ends at 13.000, when the powderskier event begins. This means that it overlaps the implosion event by approximately two seconds and an automatic crossfade is created.
4. Click the track number on the left side of the new introduction track and drag the track to the top of the timeline, above the Talkinghead track. This is necessary if the logos are to appear as overlays on top of other video events.
5. Double-click the scribble strip on the new track and name the track “Introduction.”

The first track in the project now contains the introductory splash and logo. Like the talkinghead event that appears on top of the background video, the introduction also appears over all lower tracks.

**Inserting the overlay logo**

We will add a corporate logo to complete the introductory sequence.

1. Drag the corporate_logo.png to a new track at the bottom of the timeline.
2. Double-click the scribble strip on the new track and name the track “Overlay.”
3. Drag the track header of the new Overlay track to the very top of the timeline so that the Overlay track is track one, the Introduction track is track two, and the Talkinghead track is track three.
4. Position the corporate_logo event so that it also ends where the powderskier event begins.
5. The default duration for an image event is five seconds. Drag the left edge of the corporate_logo event back to the 6.000 second point in the timeline. The duration of the event is now seven seconds.
The corporate_logo event overlaps a large portion of the underlying implosion and vegas_logo events. Events in upper tracks normally completely obscure lower tracks. In this case, however, most of the logo is transparent, so the underlying video shows through, and the corporate_logo appears to float over the rest of the project.

Note: The corporate_logo.png image file is a PNG image file that was created in an image-editing program. It has a transparent alpha channel that allows the background video to show through. For more information, see Creating titles from images on page 183.

Duplicating events
To create a sense of a beginning, a middle, and an end to the project, we will duplicate both of the logos (the corporate_logo and the vegas_logo) and place the copies at the end of the project.

1. Press and hold the Ctrl key.
2. Drag the corporate_logo event horizontally on the Overlay track. This instantly creates an identical copy of the event.
3. Position the newly duplicated event so that it ends at the same time as the end of the music bed.
4. Drag the left edge of the event back to the 30.000 second mark. The duration of the event is now roughly ten seconds.
5. Duplicate the vegas_logo event in the Introduction track and position it so that it ends with the end of the music bed.
Adding sound effects to the introduction

We will add some sound effects to three new tracks at the bottom of the project.

1. Locate the introwarp.wav audio file in the Explorer.

2. Drag introwarp.wav to the timeline below the lowest track. This creates a new track with the new introwarp event.

3. Repeat with the remaining two sound effects:
   - introtabla.wav: start - 0.000.
   - introgong.wav: start - 3.500 (timed to match the action of the implosion event)

4. Double-click the scribble strip for each new track and name it as shown in the figure below.

Summary

All of the media files that are going to be used have now been inserted into the project. The events and tracks have all been repositioned to their final locations. The first track contains the transparent overlay corporate_logo event. The second track has an introductory splash video (implosion event) that fades into the product’s logo (vegas_logo event). That logo, as well as the corporate logo, is repeated at the end of the project. The next four tracks contain the earlier work: the voiceover, the background video, and the music bed. Finally, three audio events were added to three new tracks at the bottom of the project as sound effects for the introduction. Here’s what the project should look like so far:
6. Pan/Crop motion (06_panning.veg)

The Pan/Crop tool can add dynamic motion to video or still image events. We will use it here to animate the corporate_logo event at the end of the project. This is a powerful tool with many advanced features, such as keyframe animation. In this tutorial, we will highlight the tool without explaining the complexity of keyframe animation. For more information, see Using keyframe animation on page 215.

1. Right-click the second corporate_logo event and choose Video Event Pan/Crop. The Event Pan/Crop window appears.

2. Resize the crop area at the middle to roughly 336 X 252. Enter the numbers manually in the Size boxes on the left side of the dialog. This will zoom in on the corporate_logo event.

3. Reposition the crop area off of the left edge of the event at roughly -180 X 130 (as pictured). Use the Center boxes on the left side of the dialog to enter the coordinates.

4. On the project timeline, click a blank space on the timeline at 32.000 seconds to move the cursor to that position. Use the left and right arrow keys to position the cursor more precisely. Watch the Time Display window to the upper left of the timeline to find this position. Then, back in the Event Pan/Crop window, click the Sync Cursor button ( ) in the keyframe controller. This positions the cursor on the keyframe controller at 32.000 seconds to match the cursor on the timeline.

5. Drag the crop area to the right edge of the event to 1140 X 130. Use the Center boxes to enter the coordinates. This will animate the crop area, scrolling right across the corporate_logo event, ending at 32.000 seconds. Notice that a new, gray keyframe diamond has been created on the keyframe controller.
6. In the Smoothness box, enter 0. This will limit the first panning motion to a straight horizontal movement.

7. Click the project timeline at 33.000 seconds to move the cursor to that position. Use the left and right arrow keys to position the cursor more precisely. Watch the Time Display window to the upper left of the timeline to find this position.

8. Right-click the crop area and choose Restore from the shortcut menu. The crop area is restored to its original size (1,280 X 960) and position (640 X 480). A new keyframe is created.

9. In the Smoothness box, enter 100. This will smooth the arc of the second panning motion. The result is that the logo appears to zoom out and away between the two final keyframes.

Preview the project to see the results of this procedure (click the Play button below the timeline or press the Spacebar on your keyboard). Again, there is a lot going on here that we have only touched on briefly. If you are not familiar with keyframe animation techniques, much of this might be confusing. Even if you are familiar with keyframe animation, the Event Pan/Crop window is a complex and powerful tool. For more information, see Cropping video on page 177.

Summary
In this section, motion was added to the last corporate_logo event using the Event Pan/Crop window. The logo flies in from the right across the screen and finally zooms back to its final position. All of this was accomplished using keyframe animation techniques in the Event Pan/Crop window.

7. Fades (07_fades.veg)
Fading, whether fading the volume in and out on an audio event or fading to and from black on a video event, is an easy process in Vegas.

Fading into a video event
1. Position the cursor at the upper-left corner of the implosion event. The cursor changes to a fade icon (4).
2. Drag the corner toward the center (right) of the event to about 0.500 seconds.
The blue diagonal line represents a half-second fade in from black.

Fading the volume (gain) of an audio event
1. Position the cursor at the upper-right corner of the introgong event. The cursor changes to a fade icon.
2. Drag the corner left toward the center of the event to about 11.000 seconds.
A curved blue line represents the fade out.

Fading the remaining events
Apply the following fades to the rest of the project:
- Fade out of the introtabia audio event.
- Fade in and out of the first corporate_logo event.
- Fade in and out of the talkinghead event (very briefly).
- Fade out from the first vegas_logo event for a duration of about one second.
- Fade into the last vegas_logo event for a duration of about three seconds.

Summary
In this section, instant audio and video fades were created to fine tune and polish the project.
8. Track Motion (08_trackmotion.veg)

Another method of adding motion to video or still image events in Vegas is to add track motion. This feature adds motion to an entire track and can be used to create picture-in-picture effects and scrolling motion. In this project, you will use track motion to spin the talking head out of the way and into a picture-in-picture, revealing the previously covered background video.

Creating a picture-in-picture effect

1. Click the Track Motion button ( ) on the Talkinghead track. The Track Motion window appears.

2. On the project timeline, click at the 19.400 second mark to move the cursor to this position. Use the left and right arrow keys to position the cursor more precisely. 19.400 corresponds to where the first part of the speaking ends. The exact time may be slightly different in your recreation of this project.

3. Make sure that the Sync Cursor button ( ) in the Track Motion window keyframe controller is selected. This synchronizes the keyframe controller cursor with the cursor in the project timeline.

4. Click the Create Keyframe button ( ). The keyframe that is created at this point has the same attributes as the first keyframe at 0.000. Since there is no change between these two keyframes, no animation will occur between them.

5. Move the cursor one-half second down the keyframe controller.

6. Resize the track motion area to 180 X 135. Enter these values into the Size boxes on the left side of the Track Motion window. The numbers do not have to be precise.
7. Reposition the Track Motion Area to 102 X 162 (lower-left corner). Use the Center boxes to enter these values.

8. Select the Shadow check box. This adds a drop shadow behind the track's contents.

9. Click the last keyframe on the Position bar of the Keyframe controller. In the Angle box, type -360. This will make the track rotate fully in the half-second between the two final keyframes.

10. Close the Track Motion window.

The new track motion keyframes appear just below the Talkinghead track. You can adjust track keyframes right on the track. For more information, see Working with keyframes in track view on page 217.

Preview the new track motion effect. As a result of these track motion settings, the talkinghead event will quickly shrink from full screen to a smaller window and rotate into a new position in the lower-left corner, revealing the underlying background video.

Summary

In this section, you added track motion to create an animated picture-in-picture effect of the talking head narration. Keyframe animation techniques were used, and a drop shadow was added behind the picture for emphasis. As a result of these changes, the previously hidden background video was revealed.
9. Velocity (09_velocity.veg)

Speeding up and slowing down a video event in Vegas can be done in a number of ways. One of the easiest is to use a velocity envelope. We will use this feature to speed up the powderskier event and then dramatically slow it down again.

Velocity envelopes are only available in Vegas Video.

Changing the velocity of an event

1. Right-click the powderskier event and choose Insert/Remove Velocity Envelope. A horizontal blue line appears on the event. This is the envelope.

2. Drag the line up. A ToolTip appears telling you the new playback rate. Release the line at approximately 160%.

3. Right-click the envelope at the 16.000 second mark in the project and choose Add Point from the shortcut menu. This adds a point (node) to the line that serves as a type of keyframe.

4. Double-click further down the line to add another point. Reposition the new point below the first point you added. Set this point to about 28%. The entire line after this point moves.

The event now plays at 160% speed until it gets to the pair of points, where the video slows to 28% speed.

Summary

In this section, the powderskier event's speed was changed using a velocity envelope. The envelope was animated so that the video started out playing very quickly and then dramatically slowed near the end.
10. Rendering the project as an AVI

Rendering refers to the process of converting the Vegas project into one file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, etc. The Vegas project (.veg) itself is not altered during the rendering process.

Selecting the format and compression method

Multimedia video files can be rendered to a number of formats, such as AVI or MOV.

Compressing video files is an important part of creating a movie. In video, the program that compresses the video is called a codec. The codec is important in determining the quality and size of the final media file. We will use the Sonic Foundry DV (Digital Video) codec, which is part of the standard DV templates provided in Vegas.

1. From the File menu, choose Render As. The Render As dialog appears.

2. Select the drive and folder where you want to save the rendered project.

3. Type a new name in the File name box, if necessary.

4. In the Save as type drop-down list, select Video for Windows (.avi).

5. In the Template drop-down list, select NTSC DV.

   This template uses the Sonic Foundry DV codec. The Description box provides information on the template.

6. Clear the Render loop region only check box.

7. Click Save.

A status bar appears in the lower-left portion of Vegas and a dialog pops up displaying the progress of the render. Upon completion of the render, your new media file is ready for distribution and playback.

---

**Note:** You may cancel the rendering process by clicking the Cancel button on the status bar.

---

Sample projects

This section describes sample projects that demonstrate different Vegas features. The sample project files are included on the program's CD-ROM in the \Sample Projects\Sample Projects folder. Open each sample project file, preview the project, and examine all the different elements used to create the finished product.

Audio mix

This sample audio mix includes a voiceover track and 12 instrumental tracks. The rendered file is the audio track for the TV spot and Web spot with captioning projects.

Track effects

Track EQ and Track Compressor are used to add presence to the voiceover track. Click the Track FX button ( ) on the track header to view the effects. For more information, see Using audio effects on page 143.
Panning

The instrumental tracks use a variety of track panning settings. Examine the multipurpose slider on the track headers of the instrumental tracks to see the panning settings. For more information, see Using the multipurpose slider (audio only) on page 134.

Audio event envelopes

Events on tracks 4, 9, 12, and 13 fade out using audio event envelopes. For more information, see Using audio event envelopes (ASR) on page 125.

Volume envelopes

Tracks 7 and 8 use volume envelopes to control volume levels over time. For more information, see Adding track envelopes on page 137.

Tracks routed to busses

The instrumental tracks are organized by type (guitar strum, guitar rhythm, guitar melody, bass, and percussion) and routed to busses. This allows you to adjust the volume or to apply effects to multiple tracks at once. For more information, see Assigning audio tracks to busses on page 155.

Bus effects

Several effects plug-ins are applied to Bus C, the bus to which the guitar melody tracks are routed. The Master bus also has several plug-ins assigned to it. Click the Bus FX button ( ) on Bus C or the Master bus to view the effects settings. For more information, see Using audio effects on page 143.

TV spot

This short TV spot uses several video files, Vegas text generators, a background image, and the rendered audio file from the Audio mix project.

Markers

Markers are used to flag different key points in the spot. For more information, see Adding project markers and regions on page 100.
Video event envelopes

Opacity envelopes are used to fade in and out of each of the text generator events. For more information, see Using video event envelopes on page 126.

Crossfades

Crossfades occur between the first three video events on track 4. For more information, see Crossfading events on page 97.

Event effects

The final event on track 4 (ricepaper background image) has a Sepia effect applied to it. Click the Event FX button ( ) on the event to view the effect settings. For more information, see Using video effects on page 193.

Text generators

Vegas text generators provide the text events on tracks 1, 2, and 3. Click the Generated Media button ( ) on each event to view the generator settings. You can view other generated media options in the Text/Backgrounds window. For more information, see Using generated media on page 198.

Transitions

The crossfade between the final two events on track 4 was replaced with a Push transition. Right-click the transition and choose Transition Properties from the shortcut menu to view the transition settings. You can view other transition options in the Transitions window. For more information, see Using transition effects on page 211.

Selective prerendering and dynamic RAM previewing

You can prerender the project to see the project at full NTSC size and frame rate. From the Tools menu, choose Selectively Prerender Video. If you do not prerender, you may have a slower frame rate, depending on your workstation. For more information, see Prerendering video on page 231.

You can also build a dynamic RAM preview to increase the quality of your preview by pressing Shift+F. For more information, see Building dynamic RAM previews on page 232.

Web spot with captioning

This project creates the same short spot as the TV spot, but renders it as streaming media content for Web delivery. Commands are used to create closed captioning and to open a browser window to a URL.

Commands

The first five commands generate closed captions that match the voiceover script. The sixth command clears the display of the last caption in the Windows Media Player. The final command opens a browser window to a URL. Double-click a command marker to view the settings for the command.

You can also view all commands in the Edit Details window. Choose Edit Details from the View menu, and then choose Commands from the Show drop-down list. For more information, see Working with command markers on page 103 and Adding closed captioning to Windows Media Video (WMV) files on page 184.
Rendering for Web delivery

Render the project as a WMV file. Select a higher rate (Kbps) template in the Render As dialog to increase the video quality. For more information, see Rendering a project on page 239.

Play the rendered file in Windows Media Player 7 or later to view the closed captioning and open the URL.

Note: For the closed captions to display, select Now Playing Tools from the View menu in the Windows Media Player and choose Captions from the submenu.

Panning with still images

This sample project adds motion to still images using the Event Pan/Crop window.

Track effects

The video track has a Sepia effect applied to it to make the images look like old photographs. Click the Track FX button ( ) on the track header to view the effect settings. For more information, see Using video effects on page 193.

Event panning and cropping

The four still image events use panning and cropping to create motion. The markers indicate the motion generated for each event. Click the Event Pan/Crop button ( ) on each event to view the settings. In the Event Pan/Crop window, click each keyframe in the keyframe controller to view its settings. Each event uses the Match Output Aspect and Stretch to fill frame options. For more information, see Cropping video on page 177 and Animating event panning and cropping on page 218.

Compositing with masks

This project demonstrates a few simple examples of compositing using alpha channel masks.

Regions

Regions mark the three sections of the project. For more information, see Adding project markers and regions on page 100.
Event cropping
The fire events in track 2 have been cropped from the original media file. Click the Event Pan/Crop button ( ) on each event to see the cropping settings. For more information, see Cropping video on page 177.

Generated background events
The events on track 3 are Vegas generated media events. Click the Generated Media button ( ) on each event to view the settings. You can view other generated media options in the Text/Backgrounds window. For more information, see Using generated media on page 198.

Event effects
The fire events in track 2 use the Spherize effect. Click the Event FX button ( ) to view the effect settings. For more information, see Using video effects on page 193.

Parent/child compositing
Vegas reads the alpha channel in the simple black and white image files in track 1 (parent track) and uses them as masks over track 2 (child track). Parent/child compositing using alpha masks boils down to a simple relationship: the alpha mask in the parent track cuts the hole and the media in the child track fills the hole. For more information, see Creating masks on page 203.

Track motion
This simple project shows two floating video clips moving across the screen at different speeds.

Generated background events
The event on track 3 is a generated media event. Click the Generated Media button ( ) on each event to view the settings. You can view other generated media options in the Text/Backgrounds window. For more information, see Using generated media on page 198.

Track effects
Tracks 1 and 2 use the Border plug-in to create a beveled-edge effect. Click the Track FX button ( ) on the track headers to view the effect settings. For more information, see Using video effects on page 193.
Track motion

Tracks 1 and 2 use the Track Motion window to move video clips across the screen. Click the Track Motion button (S) in the track headers to view the track motion settings. In the Track Motion window, click each keyframe in the keyframe controller to view its settings. You can experiment with the settings to change the video placement or rate of movement, or you can add shadow or glow for additional effect. For more information, see Adding track motion on page 223.
Getting Started

Vegas is a new way of creating multimedia productions. Whether you are an experienced multimedia author or a budding novice, the powerful features and capabilities of Vegas are organized to increase your creativity and productivity. The following chapter summarizes the basic functions and operations of Vegas.

Creating projects

The process of creating a multimedia production can be a complicated undertaking, involving hundreds of shots, takes, voiceovers, music beds, audio tracks, and special effects. Organization is a critical issue in this process. In Vegas, organization is handled by a small project file (VEG) that saves information about source file locations, edits, cuts, insertion points, transitions, and special effects. This project file is not a multimedia file, but is instead used to create (render) the final file when editing is finished.

The advantage Vegas offers is not just organization, however, but the fact that Vegas edits a project file and not the original source files. When you copy, cut, paste, trim, and otherwise edit your project, the process is nondestructive. You can edit without worrying about corrupting your source files. This not only gives you a strong sense of security, but it also gives you the freedom to experiment.

1. From the File menu, choose New. The New Project dialog appears.

   Note: The first time you run Vegas, a new project will automatically be started for you.

2. Enter your project settings on the various tabs. For more information, see Working with project properties on page 254.

   - Video - Select the format and other video parameters.
   - Audio - Set up the basic audio settings.
   - Ruler - Choose the way the ruler is delineated (beats, seconds, etc.).
   - Summary - Enter any relevant information and reminders about your project.
   - Audio CD - Enter information for burning audio CDs from Vegas.

   Note: The easiest way to set the often complex properties on the Video tab is to select a template that matches your media (e.g., NTSC DV (720x480, 29.970 fps)).

3. Click OK.
4. From the **File** menu, choose **Save**. Enter a name, browse for a location, and click the **Save** button to save your project (VEG file).

The project settings can be changed at any time while you are working on a project. From the **File** menu, choose **Properties** to change any of these settings.

**Setting video properties based on a media file**

You can automatically set your project video properties to match an existing video file.

1. From the **File** menu, choose **Properties**.
2. In the Project Properties dialog, click the **Match Media Settings** button ( ).
3. Browse for a media file that has the settings you wish you use for the project.
4. Click **Open**.

Vegas automatically detects the frame size, frame rate, pixel aspect ratio, and field order of this file and sets the project properties to match. To save this information for future use, enter a name in the Template box and click the **Save Template** button ( ). If your projects typically use these settings, select the **Start all new projects with these settings** check box.

5. Click **OK** to save the new project properties.

**Saving a project**

When you save your work, it is saved in a project file (VEG). Project files are not rendered media files.

1. From the **File** menu, choose **Save**.

The first time you save a project, the Save As dialog appears. In subsequent saves, the above dialog is bypassed, your existing file name is retained, and your project is updated to include any implemented changes.

2. Select the drive and folder where you want to store the project.
3. Type the project name in the **File Name** box.
4. Click **Save**.

**Note:** Select the Copy and trim media with project check box to save both the project file and copies of the media files to a common location. For more information, see **Saving a project with media** on page 238.
Renaming a project (using Save As)

After you have been working with your project, you may use the **Save As** command in the **File** menu to save a copy of a project with a new name. This is useful for backing up different versions of a project. For more information, see *Creating a copy of a project (using Save As...)* on page 238.

Getting media files

You can add media from a variety of sources to a Vegas project. You can add audio and video files, record audio into a track, capture video from a video camera, or extract music from a CD. You can also create media such as text overlays, backgrounds, and credit rolls from within Vegas. For more information, see *Using generated media* on page 198.

Selecting media

Vegas supports a wide range of media file types. You may select any of the media file types listed below to add to your Vegas project.

### Format | Extension | Definition
---|---|---
GIF | .gif | 256 index color, lossless image and animation format widely used on the Internet.
JPEG | .jpg | True color, lossy Internet image format.
Macintosh AIFF File | .aif | Standard audio format used on Macintosh computers.
MPEG-1 and MPEG-2 | .mpg | MPEGs, files compressed using a lossy audio/video compression method, can be used with Vegas Video.
MPEG Layer 3 | .mp3 | Highly compressed audio file.
OggVorbis | .ogg | A patent-free audio encoding and streaming technology.
Photoshop | .psd | Adobe Photoshop® proprietary image format (flattened).
Portable Network Graphic | .png | True color or indexed color, lossy or lossless Internet image format.
QuickTime | .mov, .qt | Quicktime standard audio/video format used on Macintosh computers.
Sonic Foundry Audio | .sfa | Sonic Foundry proprietary uncompressed format that should only be used for compatibility with other Sonic Foundry applications.
Sonic Foundry Perfect Clarify Audio | .pca | Sonic Foundry proprietary lossless audio compression format.
Sonic Foundry Wave 64 | .w64 | Sonic Foundry proprietary Wave64 audio file that does not have a limited file size (unlike Windows WAV files that are limited to ~2GB).
TARGA | .tga | True color, lossless image format that supports alpha channel transparency.
TIFF | .tif | Tagged Image File Format, a common bitmap format. You must have QuickTime installed to use TIFF files in Vegas.
Video for Windows | .avi | Standard audio/video format used on Windows-based computers.
Wave (Microsoft) | .wav | Standard audio format used on Windows-based computers.
Wave (Scott Studios) | .wav | Standard audio format used with Scott Studios systems.
Windows Bitmap | .bmp | Standard graphic format used on Windows-based computers.
Windows Media Audio | .wma | The Microsoft audio-only format used to create files for streaming or downloading via the Web.
Windows Media Format | .wmv | The Microsoft standard used for streaming audio and video media via the Web.
Previewing a media file

You may preview files before placing them in your project. The Explorer window has a mini-transport bar with Play, Stop, and Auto Preview buttons (\(\text{Ω}\)). When you preview a file, its stream is sent to the Mixer window's preview bus (for audio files) or to the Video Preview window (for video files).

**Note:** You can use the same mini-transport bar buttons in the Media Pool window to preview files in the Media Pool.

1. Select a file in the Explorer window.
2. Click the Play button (\(\text{Ω}\)) to listen to the file.
3. Click the Stop button (\(\text{Ω}\)) or select a different file to stop previewing the file.

**Note:** To automatically preview selected files, click the Auto Preview button (\(\text{Ω}\)) on the Explorer window’s transport bar.

Using the Media Pool

Media files, both video and audio, tend to be the largest files on your hard drive. It is therefore not always easy to move them around and impractical to store multiple copies of these files. You can add media files to the Media Pool in Vegas to organize them before any editing begins. Once you begin working on a project, all files you add to the timeline are automatically included in the Media Pool. From the View menu, choose Media Pool to open this window if it is not already visible.

**Using Media Pool views**

You can control the information that is displayed in the Media Pool by clicking the Views button (\(\text{Ω}\)) and selecting a view.

The Detailed view displays all the properties for each file. The information is organized into a table format. You can customize the information displayed:

- Reorder columns (fields) by dragging the column label to a new position.
- Hide a column by dragging the column label off of the Media Pool window. To display a hidden column, right-click the Media Pool, choose View from the shortcut menu, and choose the column name from the submenu.
- Sort the files in the Media Pool according to a category by clicking the column label for that category.
- Use the Comments field to add your own annotations to a file’s entry in the Media Pool. Double-click the field to enter text. This information is saved with the project and is not saved with the media file itself.
Adding media to the Media Pool
1. Click the Import Media button ( ) in the Media Pool. The Import Media dialog appears.
2. Navigate to and select a media file to add to the Media Pool. You can use the Shift key or Ctrl key to select multiple files.
3. Click Open.
   The media file is added to the Media Pool.

Adding media to the Media Pool from an existing project
1. From the File menu, choose Open. The Open dialog appears.
2. Navigate to and select a project that uses media files to add to the Media Pool. You can use the Shift key or Ctrl key to select multiple project files.
3. Click the Merge media from Vegas project files into current project check box.
4. Click OK.
   The media files from the project you selected are added to the Media Pool.

Adding media to the Media Pool from the Explorer window
1. Navigate to and select a file to add to the Media Pool. You can use the Shift key or Ctrl key to select multiple media files.
2. Right-click the file and choose Add to Media Pool from the shortcut menu.
   The selected file is added to the Media Pool.

Replacing media in the Media Pool
You may replace a file in the Media Pool with a different file. When changing the media file that an event contains, every occurrence of the event on the timeline is updated with the new media file contents.
1. Right-click a file in the Media Pool.
2. Choose Replace from the shortcut menu.
3. In the Replace Media File dialog, browse for and select the file that you want to replace the current file.
4. Click the Open button. The selected file replaces the old file in the Media Pool, and any events in the timeline containing the old file are updated to contain the new media file.

Capturing video
You can use Sonic Foundry's Video Capture application (installed with Vegas) to capture video clips from your video camera and add them to the Media Pool window.

---

**Note:** You must have an IEEE-1394/ OHCI-compliant video capture card installed to use Video Capture.

---

1. If you have not already done so, connect your video camera to your video capture card using the cable provided with the card.
2. In the Media Pool window, click the Open Video Capture button ( ). The Sonic Foundry Video Capture application starts.

**Note:** If your video camera is properly connected, the Video Preview window in the center of the application area should display “Device connected.”

3. Capture your video. For information on how to capture video with Sonic Foundry Video Capture, click the Help menu within the Video Capture application, and choose Contents and Index. The Video Capture online help file displays.

Once you have captured your video, the file(s) are added to the Media Pool window. If any captured clips go offline, you can recapture the clips using Video Capture. Right-click an offline file in the Media Pool and choose Recapture from the shortcut menu.

**Getting images**
You can bring images directly into Vegas from your scanner, digital camera, or other TWAIN device. Vegas adds the images to the Media Pool as JPEG image files.

1. Make sure your device (scanner or digital camera) is on and connected to your computer.

2. In the Media Pool window, click the Get Photo button ( ). Vegas starts the software for the device.

3. Use the device software to get an image and send it to Vegas. Once the image has been sent, the Scanned Files dialog appears.
   - Click Rename to give the new image a more meaningful name.
   - Click Delete to cancel the process of adding the image.

4. Click Done. The new JPEG file is added to the Media Pool.

**Extracting audio from a CD**
You can extract tracks from a CD and add them to the Media Pool window as WAV files.

1. Insert the audio CD.

2. In the Media Pool window, click the Extract Audio from CD button ( ). The Extract Audio from CD dialog appears.

3. Choose the drive that has the CD in it from the Drive drop-down list. The information for each CD track displays.

4. Select the track to be extracted. Use the Shift key or Ctrl key to select multiple tracks.

5. Click OK. The Save As dialog appears.

6. Select a name and location for the new file.

7. Click OK to save the new WAV file.
Vegas extracts the track and displays a progress meter to indicate the percent complete. Once extraction is complete, the new WAV file appears in the Media Pool.

Vegas provides the option of automatically naming extracted tracks for you. To enable this option, choose Preferences from the Options menu, and on the CD Settings tab, select the Autoname extracted tracks check box. For more information, see CD Settings tab on page 260.

Adding a still-image sequence

If you've exported a video clip as a still-image sequence using another application (a 3D-rendering application, for example), Vegas can add the sequence to the Media Pool as a single event. Each image in the sequence will be displayed for one frame in the event.

1. Click the Import Media button ( ) in the Media Pool window. The Import Media dialog appears.
2. Choose the folder where the sequence you want to open is stored.
3. Select the first image in the sequence (or the image you want to start the event).
4. Select the Open still-image sequence check box.
5. In the Range box, enter the number of the last image you want to open. For example, if you'd selected AnimationOne_00001.tga in step 3, you could enter 120 in this box to create a new event using AnimationOne_00001.tga to AnimationOne_00120.tga.
6. Click Open. Vegas adds the still-image sequence to the Media Pool.

Adding media to the timeline

Media files may be added to your project from the Explorer or Media Pool by double-clicking them or by dragging them. Either method places the media file in an event in its entirety in the timeline.

Dragging a media file to the timeline

You can create a new track by dragging a media file to a blank area on the timeline and dropping it in place. Vegas tracks can contain multiple events, so you can place different events next to each other on a track.

Note: Video and audio events cannot be placed on the same track.

1. Locate a media file in the Explorer or Media Pool.
2. Drag the media file to the timeline.
   An event for the media file appears where you released the mouse.

Dragging multiple media files to the timeline

1. Select multiple media files in the Explorer or Media Pool. Select a range of adjacent media files by holding down the Shift key and clicking the first and last files in the range or select files that are not adjacent by holding down the Ctrl key and clicking individual files.
2. Right-click and drag the files to the track view (timeline).
3. When you release the mouse, a shortcut menu appears. Select a placement option from the menu.

- **Add Across Time**

![Image](image1)

- **Add Across Tracks**

![Image](image2)

- **Add As Takes**

![Image](image3)

You will see one event on the track. The other events are listed at takes “beneath” the topmost event.

For more information, see **Working with takes** on page 113.

- **Video Only** and **Audio Only** allow you to isolate either the video or audio, and add that stream from a multimedia file either across tracks, across time, or as takes.

**Note:** A left-click drag-and-drop automatically inserts files across time. The various modes can also be cycled through by right-clicking (without releasing the left mouse button) while performing the drag-and-drop operation.

Double-clicking a media file

This method places the event at the cursor’s position in the selected track. If the selected track is a video track, and you double-click an audio event (or vice versa), Vegas creates a new track for the event. Once an event is placed, you can move it from one track to another or change its position on the timeline.

Inserting a video file with associated audio

Media files with video frequently include associated audio. When you insert a media file into the timeline, the associated audio is automatically inserted into a separate audio track below the video track. The two associated events are grouped together and behave as a single unit when moved or otherwise edited. You can ungroup the events to move them independently. For more information, see **Clearing a group** on page 129.
Automatically crossfading inserted events

When inserting multiple events across time, the events (both video and audio) may be set to automatically crossfade one into the next. Two options must be enabled in order to create crossfades automatically when adding multiple events. First, verify that a check mark appears next to Automatic Crossfades in the Options menu. Second, from the Options menu, choose Preferences, and on the Editing tab, select Automatically overlap multiple selected media when added. For more information, see Using automatic crossfades on page 97.

Working with events

Events are the most basic objects in a project in Vegas. An event is something that happens in time, has a specific duration, and can be video or audio.

Understanding files and events

The objects you work with in Vegas are referred to as media files and events.

- **Files** are objects that are stored on your hard disk. In Vegas, you will mostly be working with media files, such as music and video files. Vegas neither operates on nor changes these files. Files can be accessed from the Vegas Explorer window.
- **Events** are periods of time on the timeline in Vegas that act as windows into media files, either whole or in part. When dragging a media file onto the timeline, you are automatically creating an event that contains that file's contents. An event can contain video, audio, still images, and some special generated media. The event window may contain only a small portion of a much larger media file. A single media file can be used repeatedly to create any number of different events, since each event can be trimmed independently.

Audio events are created from audio files on your computer (e.g., WAV, MP3) or can be a part of a video file (e.g., AVI). You can change many characteristics of an audio event, such as speed, volume, and equalization. Audio events can be mixed with other audio events.

Video events are created from video files captured to your computer (typically AVI, MOV, QT) or images (BMP, JPEG, PNG, or TGA). You can change many characteristics of a video event, such as speed, color, and size. Video events can overlay other video events and are visual elements that appear on top of a background video, image, or color.

Moving events along the timeline

You can move events along the timeline individually or as a group. Events may overlap each other or be placed on top of each other. You can crossfade overlapping events automatically or with envelopes.
Moving an event
You can move an event along the timeline within a track or move it to a different track.

1. Drag the event along the timeline.

   If you move the event along the original track’s timeline, the event’s appearance (color) remains the same.

   ![Image](image_url)

   However, you may move the event to a different track. When you do, the event appears as a simple outline and you will see its original track and position on the timeline. Once you release the mouse, the event assumes the new timeline position and track color.

   ![Image](image_url)

2. Release the mouse to place the event.

Moving multiple events
You can move multiple events along the timeline within a track or move them to a different track. Selected events do not need to be within the same track. Use the `Ctrl` key, the `Shift` key, or the Selection Edit Tool ( ) to select multiple events and drag them. To select all events on the track after a given event, right-click the event and choose Select Events to End. For more information, see Selecting multiple events on page 84.

Moving events by small increments
To move an event more precisely, click the event and press “4” or “6” on the numeric keypad to nudge it by small increments. The amount of movement caused by each nudge is determined by how far the timeline is zoomed in or out.

Moving grouped events
Groups allow you to move multiple events within their tracks as a single unit. While you can create your own groups as needed, Vegas automatically creates groups for you when video files with associated audio (e.g., AVI) are added to a project. When you add these video files, the audio portion of the video file is inserted into the timeline as a separate audio event. The video and audio events are grouped and can be moved as a single unit within their respective tracks.

To move grouped events, drag any event in the group to a new position. For more information, see Grouping events on page 128.

Working with tracks

Vegas Video includes unlimited audio and video tracks. Vegas Video LE limits you to two video tracks and four audio tracks.

A project consists of multiple audio and video tracks. The track view is the timeline in which all events appear. The track header provides information about the track and contains controls that affect all events in the track.
Using the track view

Vegas provides numerous options for viewing and navigating in track view.

Scrolling and zooming

There are several ways to scroll and zoom in the track view.

- Click the scroll bar arrows or drag the scroll bars to move up and down the tracks or to move forward and back along the timeline.
- Click the Zoom tools to reveal more or less of the timeline.
- Drag the edge of the scroll box, found on the scroll bar, to zoom.
- Press the up and down arrow keys to zoom in and out along the timeline.
- Click the Zoom Edit Tool button or, from the Edit menu, choose Editing Tool and then choose Zoom. In this mode, drag on the timeline to draw a rectangle that defines the zoom region.

**Note:** You can also access the Zoom Edit Tool from the lower-right corner of the track view.

Vegas also supports mouse wheel control. The default behavior of the wheel is to zoom horizontally.

- +wheel scrolls horizontally (through time).
- +wheel scrolls vertically.
- +Shift +wheel moves the cursor in small increments.
- +Shift +Alt +wheel moves the cursor in one-frame increments.
- Clicking the mouse wheel enables and disables auto-panning.

Zooming directly controls the accuracy of your editing. Each video event has thumbnail representations of the frames within the event. Depending on how far you have zoomed in on a video event, a thumbnail can represent the entire event or a single frame in the event.

**Note:** You can choose to display frame numbers, time, or timecode on video event thumbnails. For more information, see Displaying frame numbers on page 251.
Changing track height

The height of individual tracks can be resized by dragging their borders on the track header. In the example below, the main video track is fairly large to show the details of the scene while the two tracks above it, which are overlays, have been resized to a shorter height. For more information, see Changing track height on page 133.
Using the track header

This section describes the different controls in the track header of each track. Some controls are specific to either video or audio tracks.

### Video track header

<table>
<thead>
<tr>
<th>Button or Control</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅</td>
<td>Make compositing child</td>
<td>Creates a parent/child compositing relationship with the track above. Used when creating masks. For more information, see Understanding the parent/child track relationship on page 199.</td>
</tr>
<tr>
<td>🎤 🎥</td>
<td>Track number, type, and color</td>
<td>The icon identifies whether this is an audio track or video track. Track numbers and colors help organize a multitrack project. For more information, see Managing tracks on page 131.</td>
</tr>
<tr>
<td>🔍</td>
<td>Minimize track height</td>
<td>Minimizes track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>🔍</td>
<td>Maximize track height</td>
<td>Maximizes track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>🔍</td>
<td>Restore track height</td>
<td>Restores track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>🎤 🎥</td>
<td>Expand track layers</td>
<td>Displays the A/B roll. For more information, see Understanding track layers on page 212.</td>
</tr>
<tr>
<td>🎤 🎥</td>
<td>Expand track keyframes</td>
<td>Displays track keyframes on the timeline. For more information, see Working with keyframes in track view on page 217.</td>
</tr>
<tr>
<td>🤵</td>
<td>Track motion</td>
<td>Track motion is used to move a video track across a background. Picture-in-picture effects and scrolling title sequences are two simple cases where this tool is important. For more information, see Adding track motion on page 223.</td>
</tr>
<tr>
<td>🎤</td>
<td>Track FX</td>
<td>Adds track effects plug-ins. For more information, see Using video effects on page 193.</td>
</tr>
<tr>
<td>🔊</td>
<td>Mute</td>
<td>Temporarily disables playback of the track so that you can focus on other tracks. For more information, see Muting a track on page 136.</td>
</tr>
<tr>
<td>😶</td>
<td>Solo</td>
<td>Isolates a track for playback by muting the other tracks. For more information, see Soloing a track on page 136.</td>
</tr>
<tr>
<td>🎤 🎥</td>
<td>Track name (scribble strip)</td>
<td>Allows you name a track. To name a track, double-click the scribble strip and type the track’s name. For more information, see Naming or renaming a track on page 132.</td>
</tr>
<tr>
<td>🇨碲️</td>
<td>Composite level slider</td>
<td>Determines the opacity/transparency of the video track. Drag the slider to control the transparency or blending of the track. Left is 100% transparent and right is 100% opaque. You can also double-click the label to enter a specific numeric percentage.</td>
</tr>
<tr>
<td>🎤</td>
<td>Compositing mode</td>
<td>Determines how the transparency in a video track is generated. For more information, see Selecting compositing modes on page 200.</td>
</tr>
</tbody>
</table>
### Audio track header

<table>
<thead>
<tr>
<th>Button or Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track number, type, and color</td>
<td>The icon identifies whether this is an audio track or video track. Track numbers and colors help organize a multitrack project. For more information, see Managing tracks on page 131.</td>
</tr>
<tr>
<td>Minimize track height</td>
<td>Minimizes track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>Maximize track height</td>
<td>Maximizes track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>Restore track height</td>
<td>Restores track height. For more information, see Changing track height on page 133.</td>
</tr>
<tr>
<td>Track name (scribble strip)</td>
<td>Allows you name a track. To name a track, double-click the scribble strip and type the track’s name. For more information, see Naming or renaming a track on page 132.</td>
</tr>
<tr>
<td>Bus assignment</td>
<td>Assigns an audio track to a specific output bus. This option is available for projects being mixed for multiple stereo busses. For more information, see Assigning audio tracks to busses on page 155.</td>
</tr>
<tr>
<td>Arm for record</td>
<td>Prepares a track for recording. You may record directly into audio tracks. A track is ready when you see the recording meter appear on it. For more information, see Arming the track for recording on page 161.</td>
</tr>
<tr>
<td>Invert Track Phase</td>
<td>Inverts the audio track at its baseline, in effect reversing its polarity. For more information, see Phase inverting a track (audio only) on page 136.</td>
</tr>
<tr>
<td>Track FX</td>
<td>Adds track effects plug-ins. For more information, see Using audio effects on page 143.</td>
</tr>
<tr>
<td>Mute</td>
<td>Temporarily disables playback of the track so that you can focus on other tracks. For more information, see Muting a track on page 136.</td>
</tr>
<tr>
<td>Solo</td>
<td>Isolates a track for playback by muting the other tracks. For more information, see Soloing a track on page 136.</td>
</tr>
<tr>
<td>Volume fader</td>
<td>Controls the audio track volume relative to the other tracks. Drag the fader left or right to adjust the volume. For more information, see Using the volume fader (audio only) on page 134.</td>
</tr>
<tr>
<td>Multipurpose slider</td>
<td>Controls several features, including track panning, bus send levels, and assignable effects send levels. Select what the slider controls by clicking the label button. Each item's slider position is independent from the others. For more information, see Using the multipurpose slider (audio only) on page 134.</td>
</tr>
</tbody>
</table>
Viewing playbacks and previews

Vegas allows you to play back your project in two ways: directly from the timeline from within Vegas or by mixing the entire project to a preview file.

Using playback from within Vegas

The transport bar allows you to play back your entire project or portions of your project based on a time selection or the current cursor position.

If your project includes video, make sure the Video Preview window is displayed for playback: from the View menu, choose Video Preview or press Alt+P.

Playing an entire project

1. Click the Play From Start button ( ) to begin playback at the beginning of the project.
2. Click the Stop button ( ) to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a section. This can be done by creating a time selection.

Playing a time selection

1. Place the mouse pointer above the ruler on the marker bar. The mouse pointer changes to include a left/right arrow cursor ( ).
2. Drag to select the time region. To increase or decrease the time selection, drag its start and end points. The time selection is highlighted and the Loop bar appears above the ruler on the timeline.
3. Click the Play button ( ) to begin playback. Only the non-muted tracks and events within the time selection play back.
4. Click the Loop Playback button ( ) to continually play back the events within the time selection. Click the button again to toggle this feature off.
5. Click the Stop button ( ) to stop playback.

By looping the playback, you can repeatedly watch the same section of the project over and over as you make changes to filters and effects in real time. Selection areas can be quickly defined automatically, depending on what you would like to preview. For more information, see Selecting a time range on page 85 and Time selection commands on page 29.
Playback reference

The following table describes all the transport bar buttons and their keyboard equivalents. You may use these playback functions at any time while working in your project.

**Note:** Vegas also supports the use of many multimedia keyboards for controlling playback.

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Record button]</td>
<td>Ctrl+R</td>
<td>Begin recording into record-enabled tracks</td>
</tr>
<tr>
<td>![Loop button]</td>
<td>Q</td>
<td>Turn on/off loop playback during time selection playback</td>
</tr>
<tr>
<td>![Start button]</td>
<td>Shift + Space</td>
<td>Begin playback from the start of the project</td>
</tr>
<tr>
<td>![Start button]</td>
<td>Space</td>
<td>Begin playback from cursor position</td>
</tr>
<tr>
<td>![Stop button]</td>
<td>Enter</td>
<td>Pause playback, cursor stops and holds at pause position</td>
</tr>
<tr>
<td>![Stop button]</td>
<td>Space or Esc</td>
<td>Stop playback, cursor stops and returns to prior cursor position</td>
</tr>
<tr>
<td>![Home button]</td>
<td>Ctrl + Home</td>
<td>Place cursor at the beginning of project</td>
</tr>
<tr>
<td>![End button]</td>
<td>Ctrl + End</td>
<td>Place cursor at the end of the project</td>
</tr>
</tbody>
</table>

**Note:** You can use the Spacebar to stop or pause playback, depending on your preference. From the Options menu, choose Preferences, and on the General tab, select Make spacebar and F12 Play/Pause instead of Play/Stop to change the setting.

Scrubbing

Scrubbing is a type of timeline playback that gives you precise control over the speed and direction of playback. Vegas uses a logarithmic scale for scrubbing, but Vegas also provides the option of selecting linear scrubbing. For more information, see General tab on page 256.

Vegas provides three methods of scrubbing.

**Scrubbing with the scrub control slider**

The Scrub Control slider can be dragged back and forth. The farther from the center that the slider is dragged, the faster the playback, both forward and in reverse. Below the slider is a small yellow marker that can be used to set the Normal Rate playback speed. This is the speed at which the project plays when you click the Play button on the transport bar.

**Scrubbing on the timeline**

The second way that a project can be scrubbed is by positioning the mouse pointer over the timeline cursor at a location that is not over any events and holding down the Ctrl key on your keyboard. The cursor changes to a speaker icon. Now, when you left-click, the cursor icon changes again to a pan/scrub icon. When the mouse is dragged left or right, the timeline is scrubbed.

You can also choose to enable timeline scrubbing when the mouse is positioned over events. From the Options menu, choose Preferences, and select Allow Ctrl+drag cursor style scrub over events on the General tab.
Scrubbing with the keyboard

Vegas uses three letters (JKL) as a keyboard scrub control.

Press J for reverse and L for forward playback. Press R to pause playback.

There are several ways to adjust playback speed:

- Press J or L multiple times (twice for 1.5x playback or three times for 2.0x playback).
- Press and hold R while pressing J or L to emulate a shuttle knob mode. Press R+J to turn the knob to the left or R+L to turn the knob to the left. Press R again or Space to return to normal mode.

Previewing to media player

A preview file is mixed and rendered according to the project’s properties and is played back using the media player associated with the file type.

1. From the Tools menu, choose Preview in Player. The Preview dialog appears.
2. Select the file type from the drop-down list.
3. Click OK to begin the mixing and rendering process. A progress dialog appears indicating the percent complete of the new file.

Note: You may cancel the preview by clicking the Cancel button on the status bar.

When mixing is completed, the associated media player opens and begins playback.

Prerendering video previews

Playing a project using the transport controls can instantly show how a movie is progressing, but it does not actually render your movie as it will appear in its final form. The preview you see in the Video Preview window may be different from your final movie in a number of ways: frame size, frame rate, and quality. In most cases, the Video Preview is all you need for checking the timing of events in your project. Eventually, however, you may need to output a full-quality preview of a section of your project. To do this, from the Tools menu, choose Selectively Prerender Video. For more information, see Prerendering video on page 231.
Rendering a Vegas project

Rendering refers to the process of creating a new media file from a Vegas project. The project file is not affected (overwritten, deleted, or altered) during the rendering process. You may return to the original project to make edits or adjustments and render it again. The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>Vegas Video supports MPEG-1 and MPEG-2 file creation through the use of MainConcept MPEG technology.</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>.mp3</td>
<td>Compressed audio format. You may render up to 20 .mp3 files without registering the optional plug-in.</td>
</tr>
<tr>
<td>OggVorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov</td>
<td>Apple QuickTime multimedia format.</td>
</tr>
<tr>
<td>RealMedia</td>
<td>.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>A Sonic Foundry proprietary format that is compressed and completely lossless.</td>
</tr>
<tr>
<td>Sonic Foundry Wave64</td>
<td>.w64</td>
<td>A Sonic Foundry proprietary format that allows wave files that are (practically) unrestricted by file size.</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>

More detailed instructions for rendering to a specific format appear later in this manual. For more information, see Saving, Rendering, and Printing Projects on page 237.

Creating a movie

To create a movie, you render the Vegas project into an appropriate media file output. The final output format depends on the destination of the new media file. Some examples are AVI, MOV, and WMV.

1. From the File menu, choose Render As.
2. In the Render As dialog box, choose the appropriate option from the Save as type drop-down list.
3. Click the Custom button to select custom compression settings. The default compression options are set automatically according to your project’s properties. For more information, see Customizing the rendering process on page 241.
4. Enter a name and browse for a destination for your file.
5. Click OK.
Vegas projects are multitrack compilations of events that occur over time. The events in your project are references (pointers) to source media files. Vegas is a nondestructive editor, so editing events in your project does not alter the source media files in any way.

### Getting around

When editing and playing back the project, the cursor identifies where you are along the project’s timeline.

#### Moving the cursor

The cursor may be controlled using the following keyboard commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or W</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End or E</td>
</tr>
<tr>
<td>Go to beginning of selection or view (if no selection)</td>
<td>Home</td>
</tr>
<tr>
<td>Go to end of selection or view (if no selection)</td>
<td>End</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Go to Ctrl+G</td>
<td></td>
</tr>
<tr>
<td>Center in view</td>
<td></td>
</tr>
<tr>
<td>Move left/right to marker(s)</td>
<td>Ctrl+Left/Right Arrow</td>
</tr>
<tr>
<td>Move to marker #</td>
<td>0-9 keys (not numeric keypad)</td>
</tr>
<tr>
<td>Move left/right to event edit points including fade edges (see figure below)</td>
<td>Ctrl+Alt+Left/Right Arrow</td>
</tr>
<tr>
<td>Nudge cursor on timeline</td>
<td>Left or Right Arrow</td>
</tr>
<tr>
<td>Move left/right one frame</td>
<td>Alt+Left/Right Arrow</td>
</tr>
<tr>
<td>Move left/right one frame</td>
<td>Ctrl+Alt+Shift+Mouse wheel</td>
</tr>
<tr>
<td>Jump to opposite side of selection</td>
<td>Numeric keypad 5</td>
</tr>
</tbody>
</table>

### Changing focus

Focus is used to describe which objects have the attention of a program. For example, when you click a file in the Media Pool, the Media Pool window has focus. To instantly switch the program’s focus to the track view (timeline), press Alt+B or, from the View menu, choose Focus to Track View.

In Vegas, it matters which track has focus when you perform a task. For example, when you double-click a media file in the Explorer, it is inserted into the track that has the focus. You can click a track on its track number to make it the focus track. A blinking white line under the track number and purple shading on the track header indicates a track has focus.
Making selections

Vegas gives you the flexibility to select one or more events, a time range, or events and a time range. All selection options can apply to a single track or to multiple tracks.

To select an event, click it.

Selecting multiple events

By using the \texttt{Ctrl} key, the \texttt{Shift} key, or the Selection Edit tool ( ), you may select individual or multiple events in your project. Multiple events may be selected within a track or across tracks.

You may include or exclude events from a selection area by holding the \texttt{Ctrl} key and clicking an event. The most common mode of operation is to select events by clicking them while in Normal Edit mode, which is the default editing mode. Click the Normal Edit Tool button ( ) or, from the \texttt{Edit} menu, choose \texttt{Editing Tools} and the choose \texttt{Normal} to switch back to this mode.

Selecting nonadjacent events
1. Hold the \texttt{Ctrl} key.
2. Select the events by clicking them. To deselect an event, simply click it again to toggle the event selection on or off.

Selecting a range of events
1. Hold the \texttt{Shift} key.
2. Click the first event that you want to select.
3. Click the last event that you want to select. All events between the first and last selected events are highlighted and selected.

Selecting a block of events
1. On the toolbar, click the Selection Edit Tool ( ).
2. Position the cursor in a corner of the area that you want to select.
3. Click and hold the left mouse button.
4. Drag the cursor to the opposite corner of the area you want to select. A rectangle is drawn on the workspace. All events within this rectangle are selected.

To deselect individual events in the middle of a selection area, hold the \texttt{Ctrl} key while clicking the events. To deselect all of the events, click anywhere in the workspace outside of the selected events.

Hold the left mouse button and right-click to toggle through the three types of selection boxes: free, vertical, or horizontal.
Selecting all events to the end of the track

1. Right-click an event. A shortcut menu appears.

2. From the shortcut menu, choose Select Events to End. All events on the track after the selected event are selected.

You may also use the Select Events to End command with events selected on different tracks. Hold the key to select events on different tracks, and then right-click to access the shortcut menu. This provides an easy way to move large blocks of events.

Once events have been selected, they can be grouped together. For more information, see Grouping events on page 128.

Modifying events in selections

Selections can be made of multiple video events only, multiple audio events only, or a combination of both video and audio events. Only commands and operations that apply to both types of events can be used for multiple selections that are composed of both audio and video events. For example, Normalize is an audio event switch. Therefore, when you right-click an audio event and, from the shortcut menu, choose Switches, the Normalize command is unavailable if the selection includes video events.

Selecting a time range

Time selections are indicated by a shaded box and a bar that appears on the top of the timeline. You may use the time selection bar for playing back a smaller portion of your project or to apply cross-track edits.

Unless an event is locked, a selected time range affects all events, or portions of events, that occur within the range.

Dragging to select a time range

1. Position the mouse pointer above the ruler (on the marker bar). The mouse pointer changes to a left/right arrow cursor.

2. Drag to select a region. All events, or portions of events within the region are highlighted.

3. Drag the yellow handles on either end of the time selection to increase or decrease your time range selection.

   Note: You may move the entire selection range by dragging the time selection bar.

Selecting a time range during playback

1. Click the Play ( ) or the Play From Start ( ) button to begin playback.

2. Press  or  where you want the time selection to begin.

3. Press  or  where you want the time selection to end.

4. Click the Stop button ( ) to stop playback.
Using shortcuts for time selections

These shortcuts can speed up the process of making precise time selections.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set time selection duration equal to an event’s duration</td>
<td>Double-click the event</td>
</tr>
<tr>
<td>Extend selection to the end of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Right Arrow</td>
</tr>
<tr>
<td>Extend selection to the beginning of the currently selected event edge</td>
<td>Ctrl+Shift+Alt+Left Arrow</td>
</tr>
<tr>
<td>Drag a time selection on an event without selecting/deselecting the event</td>
<td>Ctrl+Shift+drag on the event</td>
</tr>
</tbody>
</table>

**Note:** Press **Backspace** to recall the last five time selection areas.

Looping playback

If you want to play back the time range, click **Play** (▶) to play only the events within the time range. Click the Loop Playback button (⃣) or press **Q** on your keyboard to toggle loop playback on and off. Vegas continually plays back the portion of the timeline within the time selection when loop playback is toggled on.

Selecting events and a time range

Selecting a time range does not automatically select events. Excluding locked events, all items within the time range play back and are affected by **Edit** menu commands. However, you may select specific events to edit, and then select a time range.

1. Use the **Ctrl** key, the **Shift** key, or the Selection Edit Tool (†) to select the events. For more information, see Selecting multiple events on page 84.
2. Place the mouse pointer above the ruler (on the marker bar). The mouse pointer changes to a left/right arrow cursor (.lr.).
3. Drag to select the region. Notice that events that were not initially selected in step 1 remain unselected (not highlighted).
Editing and ripple editing events

How Vegas cuts and pastes material depends on whether or not ripple editing is enabled. Vegas is in ripple edit mode when the Ripple Edits button ( ) is selected. In ripple edit mode, cutting, pasting, or deleting material can affect the position of events appearing later in the track. The effect of a ripple edit depends on what is being cut, deleted, or pasted. For example:

- Cutting or deleting a time selection eliminates that section of the timeline across all tracks.
- Cutting an event or selected events has no effect on the events that follow.
- Pasting an event in a track pushes all events after the pasted event down the timeline.
- Pasting events to several tracks at once pushes all events after the pasted events down the timeline. Only the tracks where events are pasted are affected.

Ripple editing also affects how Vegas adds material from the Trimmer window. For more information, see Using the Trimmer window on page 115.

Copying events

Vegas allows you to copy events, or portions of events, to the Clipboard and paste them into your project. You may copy a single event or multiple events. Copying preserves the original event information, edits, and other modifications.

1. Click the events to select them. For more information, see Selecting multiple events on page 84.
2. Select a time range, if applicable.
3. Click the Copy button ( ) on the toolbar.

Copying selected events

When copied, selected events are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>
Copying a time selection

Events within the time selection and across all tracks are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Waveform" /></td>
<td><img src="Image" alt="Clipboard" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Copying a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard.

<table>
<thead>
<tr>
<th>Events before copy</th>
<th>Clipboard contents</th>
<th>Events after copy</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Waveform" /></td>
<td><img src="Image" alt="Clipboard" /></td>
<td>The original events are not affected and do not change.</td>
</tr>
</tbody>
</table>

Cutting events

Cutting events removes them from their respective tracks, but places the cut information (events and time) on the Clipboard. Once on the Clipboard, you may paste the information into your project.

1. Click the events to be cut to select them or select a time range.
2. Click the **Cut** button ( ) on the toolbar.

Cutting selected events

When cut, selected events are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting selected events, ripple edit mode has no effect on later events.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in ripple edit mode ( )</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Waveform" /></td>
<td><img src="Image" alt="Clipboard" /></td>
<td><img src="Image" alt="Waveform" /></td>
<td><img src="Image" alt="Waveform" /></td>
</tr>
</tbody>
</table>
Cutting a time selection

Events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting a time selection, ripple edit mode affects the position of material on all tracks after the cut.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in ripple edit mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Waveform" /></td>
<td><img src="image2" alt="Waveform" /></td>
<td><img src="image3" alt="Waveform" /></td>
<td><img src="image4" alt="Waveform" /></td>
</tr>
</tbody>
</table>

Cutting a time selection and events

Events and portions of selected events within the time selection are reproduced and placed on the Clipboard. Time information is also placed on the Clipboard. When cutting a combination of time selection and event selection, ripple edit mode affects the position of material on the tracks of selected events after the cut.

<table>
<thead>
<tr>
<th>Events before cut</th>
<th>Clipboard contents</th>
<th>Events after cut</th>
<th>Events after cut in ripple edit mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Waveform" /></td>
<td><img src="image2" alt="Waveform" /></td>
<td><img src="image3" alt="Waveform" /></td>
<td><img src="image4" alt="Waveform" /></td>
</tr>
</tbody>
</table>
Pasting events

Once information is copied to the Clipboard, you may choose a variety of ways to paste the Clipboard items. Vegas always pastes from the insertion point’s position along the timeline. When ripple edit mode is enabled, Vegas pushes material down the track to make room for pasted material. The exact behavior of the ripple depends on what is being pasted. If one or more events are pasted, only those tracks where pasted material appears are ripple edited.

1. Move the cursor to the desired location on the timeline.

2. Click either the track number or within the track where you want to paste the event. This track is the focus track; there can be only one focus track at a time. If you are pasting multiple events from different tracks, Vegas automatically creates new tracks as needed.

3. Click the Paste button ( ) on the toolbar.

Clipboard events are pasted at the cursor position on the track. Existing track events can be overlapped with newly pasted information.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Paste position</td>
</tr>
<tr>
<td></td>
<td>(at cursor)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Events after paste</th>
<th>Events after paste in ripple edit mode ( )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste position</td>
<td>Paste position</td>
</tr>
<tr>
<td>(at cursor)</td>
<td>(at cursor)</td>
</tr>
</tbody>
</table>

Events bisected by the cursor position are split.
Using paste repeat

Use paste repeat to specify how many times the Clipboard events are pasted at the cursor position on the selected track and to specify the space between each pasted event.

1. Copy a selection to the Clipboard.
2. From the **Edit** menu, choose **Paste Repeat**. Vegas displays the Paste Repeat dialog.
3. Specify the number of times to paste the Clipboard contents and the space between successive copies.
4. Click **OK** when finished.

Using paste insert

When using paste insert, Clipboard events are placed at the cursor position on the selected track and existing events on a track are moved further down the timeline by the total length of pasted information. This action differs from ripple edit mode because pasting in ripple edit mode affects only the tracks in which material is pasted, while paste insert affects all tracks in the project.

1. Copy a selection to the Clipboard.
2. From the **Edit** menu, choose **Paste Insert**.

<table>
<thead>
<tr>
<th>Clipboard contents</th>
<th>Events before paste insert</th>
<th>Events after paste insert</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Clipboard image]</td>
<td>![Events before paste insert]</td>
<td>![Events after paste insert]</td>
</tr>
</tbody>
</table>

Events on all tracks (not just tracks with pasted material) are pushed down the timeline.

Punching-in and crossfading events

You can insert events into the middle of (on top of) existing events without altering the timing of the project. When the inserted event ends, the original event continues playing as if it had never stopped.

1. From the **Options** menu, choose **Preferences**. The Preferences dialog appears.
2. Click the Editing tab.
3. Select Fade edit edges of audio and Fade edit edges of video events. Specify a duration for each transition.
Events that have previously been inserted or punched-in are not affected by this change. The concept of punching in and out only applies when you are inserting an event that is shorter than the event that it is being inserted into. In the following illustration, every frame is numbered so that you can see how the original event continues after the inserted event ends, as if it continued to play underneath the original.

Duplicating events

Duplicating is a combination of copying and pasting in one action. The process is like moving the event to a new position while leaving a copy behind.

1. Hold the [Ctrl] key on your keyboard.
2. Drag the event you want to duplicate to the place where you want the new event to be positioned.

Inserting empty events and time

You can insert events into the timeline that do not have any contents and are not references to any media files. Empty events are useful as placeholders in the timeline that can be filled with media or recorded into at a later time. In either case, the new media is added to the empty event as a take. For more information, see Working with takes on page 113. To add an empty event to a track, from the Insert menu, choose Empty Event.

It is also possible to make space in a project by inserting a length of time across all tracks. To insert a period of time into the timeline, from the Insert menu, choose Time.

Trimming events

This section describes simple ways to trim events. You may also use the Trimmer window to trim events. For more information, see Using the Trimmer window on page 115.

Trimming an event

During the trimming process for a video event, the last thumbnail image on the event shows the last frame in the event, allowing you to edit events very accurately.

1. Move the cursor over the edge of the event.
   The cursor changes when properly positioned ( )
2. Drag the edge of the event to trim it.

Since a multimedia file often has both a video and an audio component, both events are trimmed (or extended) as a group unless you ungroup them or temporarily disable grouping by clicking the Ignore Event Grouping button ( ). For more information, see Grouping events on page 128.
Trimming an event beyond its end

You can trim an event beyond its end, extending it as a result. Once extended, the event loops as a default. A notch indicates where the looped event repeats.

Alternately, you can disable looping and make the last frame of a video event repeat (a freeze frame) for the remaining duration. A notch appears at the point in the event where the video ends and the freeze frame begins. For more information, see Loop on page 121.

Trimming adjacent events

You can trim adjacent events simultaneously. Hold Ctrl+Alt while dragging the common edge between two adjacent events. The trim adjacent cursor appears ( ).

Trimming a time selection

Trimming events removes all media outside the time selection. The removed information is not placed on the Clipboard. Trimming is different from cutting in that the events within the time selection are preserved.

1. Select a time range. For more information, see Selecting a time range on page 85.
2. Press Ctrl+T or, from the Edit menu, choose Trim.

The material outside the time selection (across all tracks) is removed from the project. However, the time information (space) between events is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Events before trim" /></td>
<td>Trimmed information is not placed on the Clipboard.</td>
<td><img src="image2" alt="Events after trim" /></td>
</tr>
</tbody>
</table>

Trimming a time and event selection

1. Select the events to be trimmed.
2. Select a time range. For more information, see Selecting events and a time range on page 86.
3. Press Ctrl+T or, from the Edit menu, choose Trim.

Only the portion of selected events outside the time selection is trimmed. Unselected events remain. The time information (space) between events is not removed.

<table>
<thead>
<tr>
<th>Events before trim</th>
<th>Clipboard contents</th>
<th>Events after trim</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Events before trim" /></td>
<td>Trimmed information is not placed on the Clipboard.</td>
<td><img src="image4" alt="Events after trim" /></td>
</tr>
</tbody>
</table>
Splitting events

Vegas allows you to create multiple, independently functioning events from a single event by splitting it. Splitting creates a new ending point for the original event and creates a starting point for the newly created event.

Splitting an event does not alter the original media. The original media file’s information is there, but omitted for playback based on where the event’s starting or ending point occurs on the timeline.

When split, the two new events are flush against one another. The two events can be moved independently.

Splitting an event

1. Select the event to be split.

   To split multiple events, use the [Ctrl] key, the [Shift] key, or the Selection Edit Tool ( ) to select the events. For more information, see Selecting multiple events on page 84.

2. Place the cursor at the timeline position where the split will occur.

3. From the Edit menu, choose Split.

Splitting all events at the cursor

All events are split at the cursor’s position (unless the event is locked). The split occurs across all tracks (if no events are selected).

Splitting selected events

Only the selected events are split at the cursor’s position.
Splitting a time selection

Unless locked, all events within the time selection are split at the starting and ending points of the time range, meaning that two splits are made. The split occurs across all tracks.

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Before Split" /></td>
<td><img src="image2" alt="After Split" /></td>
</tr>
</tbody>
</table>

Splitting a time selection across selected events

Only selected events within the time selection are split at the starting and ending points of the time range.

<table>
<thead>
<tr>
<th>Events before splitting</th>
<th>Events after splitting</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Before Split" /></td>
<td><img src="image2" alt="After Split" /></td>
</tr>
</tbody>
</table>

Slipping and sliding events

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or the underlying media to adjust the media that is played by an event:

- When you slip an event, your event maintains its place on the timeline, but the media file moves in the direction you drag.
- When you slide an event, the media file maintains its place on the timeline, but the event moves in the direction you drag.

You can slip or slide grouped events (all at the same time) or slide a crossfade between two events. For more information, see Grouping events on page 128 or Sliding a crossfade on page 98.

Shifting the contents of (slipping) an event

Hold [Alt] while dragging an event. The slip cursor appears ( ).

As you drag the event, the contents of the event shift, but the event does not move. You can use this technique when you want to maintain an event’s length and position, but have the event play a different section of the source media file.
Slip-trimming an event

Hold Alt while dragging the right or left edge of an event. The slip-trim cursor appears ( ).
As you drag the event edge, the media moves with the event edge.

Sliding an event

Hold Ctrl+Alt while dragging an event. The slide cursor appears ( ).
As you drag, the relative position of the media remains fixed on the track, and the event position changes.
You can use this technique when you want to maintain an event’s length, but have the event play a different section of the source media file at a different point in your project.

Deleting events

Deleting an event removes it from its track. Multiple events can be deleted and time selections can be used to modify the process. Ripple editing also applies to delete actions. Deleting operates exactly like a cutting operation, but the removed information is not placed on the Clipboard. For more information, see Cutting events on page 88.

1. Select the events to be deleted.
2. Press Delete.
Crossfading events

Vegas allows you to crossfade between two events (audio and video) on the same track. For audio events, crossfading fades out one audio event's volume while another event's volume fades in. For video events, crossfading creates a transition between two events, one fading out while the other fades in. Lines appear indicating how and when the event's volume or transparency is being affected.

Using automatic crossfades

The automatic crossfade feature turns the overlapping portions of two events into a smooth crossfade. This feature is enabled as a default. Click the Automatic Crossfades button ( ) or press X to disable or enable automatic crossfades.

Vegas also provides an option for creating automatic crossfades when you add multiple media files to a track. For more information, see Automatically crossfading inserted events on page 73.

Manually setting a crossfade

Vegas does not insert an automatic crossfade if a shorter event is placed on top of and within the same time frame of a longer event. In this case, the longer event begins playing, then the shorter event plays, and then the longer event resumes playing at the timeline position. You can manually create a crossfade to fade in and out of the shorter event.

1. Place the mouse pointer on one of the shorter event’s handles. The envelope cursor appears ( ).
2. Drag the handle to the desired position.

This is a fast and effective method of inserting a voiceover on top of a background music track (although the music fades out completely) or to replace a bad section of audio. For more information, see Punching-in and crossfading events on page 91.
Changing crossfade curves

You can set the crossfade curves that Vegas uses to fade in and out between two events.

1. Right-click anywhere in the crossfade region to display a shortcut menu.
2. From the shortcut menu, choose **Fade Type** to display the fade types submenu.
3. Select the desired fade type.

Sliding a crossfade

You can “slide” a crossfade between two events without affecting the total length of the two overlapping events. This process is similar to sliding and slipping events. For more information, see [Slipping and sliding events on page 95](#).

Hold `Ctrl` + `Alt` while dragging the overlapping area between two events. The slide crossfade cursor appears ( ).

As you drag, the relative position of the media remains fixed on the track, and the crossfade position changes, effectively trimming the edge of the event in the direction you drag. You can use this technique when you want to maintain the length of two combined events but want the transition to occur earlier or later.

Using undo and redo

Vegas gives you unlimited undo and redo functionality while working on your project, even to the extent of being able to undo changes made before the last time a project was saved (but not closed). While you are working with a project, Vegas creates an undo history of the changes that you have performed. Each time you undo something, that change is placed in the redo history.

When you close the project or exit Vegas, both the undo and redo histories are cleared.

Using undo

Pressing `Ctrl` + `Z` or clicking the **Undo** button ( ) on the toolbar reverses the last edit performed. Repeatedly using the keyboard command or toolbar button continues undoing edits in reverse order, from most recent to oldest. In addition, you may undo the last edit by choosing it from the **Edit** menu.
Undoing a series of edits

You can undo a series of edits by using the drop-down list on the Undo button.

1. Click the arrow to the right of the Undo button ( ).

2. From the drop-down list, choose the edit that you want to undo. Items above it (subsequent edits) are selected automatically. Vegas restores your project to the state prior to those edits.

When you undo an edit or a series of edits, they are added to the redo history. This feature allows you to restore your project to a previous state.

Note: From the Edit menu choose Undo All to undo all edits in the history. All edits are undone and added to the redo history.

Using redo

Pressing Ctrl + Shift + Z or clicking the Redo button ( ) on the toolbar redoes the last undo performed. Repeatedly using the keyboard command or toolbar button continues redoing undos in reverse order, from most recent to oldest. In addition, you may redo the last edit by choosing it from the Edit menu.

Redoing a series of edits

The redo history may be viewed by clicking the arrow on the right side of the Redo button ( ) on the toolbar, revealing a drop-down list composed of previously undone edits. The top item is the most recent undo edit. If you redo a specific edit that appears farther down the list, all subsequent edits above it are redone as well.

When you redo an edit or a series of edits, they are added to the undo history again. The redo history is cleared when a new edit is performed.

Clearing the edit history

You may clear both undo and redo histories without closing your project or exiting Vegas. Once the histories have been cleared, Vegas begins creating a new edit history as you continue working on the project. While clearing the edit history is not usually necessary, it can free up disk space. To clear the edit history, from the Edit menu, choose Clear Edit History.
Adding project markers and regions

Vegas provides several types of project markers that identify parts of your project, serve as cues, and provide additional functionality:

- **Markers** - points that you mark along the project’s timeline. They are typically used to mark locations in the project for later reference or to mark timing cues.
- **Regions** - ranges of time that you mark along the timeline. Regions identify ranges of time for your reference and can function as permanent time selections.
- **Command markers** - markers that enable metadata in streaming media files. These markers can be used to display headlines or closed captions, link to Web sites, or perform any other function you define. For more information, see Adding closed captioning to Windows Media Video (WMV) files on page 184. In addition, these markers can be used to embed Scott Studios data information, which is used extensively in broadcasting. The Sonic Foundry Web site (http://www.sonicfoundry.com) has a number of metadata examples complete with source code.
- **CD layout markers** - markers that indicate tracks and indices for an audio CD layout. Vegas uses these marks to create tracks and index points when burning an audio CD. For more information, see Understanding tracks and indices on page 169.

Working with markers

Markers are useful for identifying and navigating to specific locations in longer projects. As you place markers in your project, Vegas automatically numbers them in the order that they are placed. Markers appear as orange tags above the ruler. You may name them and reposition them along the project’s timeline.

Inserting a marker at the cursor

1. Position the cursor where you want to place the marker.
2. From the **Insert** menu, choose **Marker**, or press M.
3. Type a name for the marker and press Enter. If you do not want to name the marker, simply press Enter.

Inserting a marker during playback

During playback, press M. The marker appears on the marker bar. You may name the marker after it has been set.
Naming (or renaming) a marker
1. Place the mouse pointer on the marker you want to name or rename. The pointer changes to a hand icon.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Rename. A text box opens next to the marker.
4. Type the marker name.
5. Press Enter to set the marker's name.

You can also double-click an existing name or double-click the space just to the right of a marker to rename it.

Moving markers
Markers can be repositioned by dragging them on the marker bar.

Navigating to markers
You can jump the cursor to any marker on the timeline by clicking the marker. You can also jump to a marker by pressing the number keys along the top of the keyboard (not the numeric keypad).

Note: Jump the cursor to the next or previous marker by pressing Ctrl+ or .

Deleting markers
1. Place the mouse pointer on the marker that you want to delete. The pointer changes to a hand.
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The marker is removed from your project.

Vegas does not renumber the tags as you remove them. For example, if you have five markers in your project and delete markers 3 and 4, the remaining markers will be listed as 1, 2 and 5. However, as you add markers again, Vegas begins numbering the missing sequence first, in this case 3 and 4, then 6, 7, 8, etc.

Deleting all markers and regions
1. Right-click the marker bar.
2. From the shortcut menu, choose Markers/Regions.
3. From the submenu, choose Delete All.

Working with regions
Regions identify ranges of time and provide a way to subdivide your project. A region is defined as the area between two region markers that share the same number. Regions can function as semi-permanent time selections. Region information can be displayed in the Explorer by clicking the arrow next to the View button and selecting Region View.
Inserting regions
1. Make a time selection. For more information, see Selecting a time range on page 85.
2. From the Insert menu, choose Region, or press \[R\].
3. Type a name for the region and press \[Enter\]. If you do not want to name the region, simply press \[Enter\]. Region markers display at the beginning and end points of a time selection.

Moving regions
Drag a region marker to reposition it. To move both region markers (start and end markers) at once, hold \[Alt\] while dragging a region marker.

Naming regions
1. Place the mouse pointer on the left region marker you want to name or rename. The pointer changes to a hand icon (\[\]
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Rename. A text box appears next to the region marker.
4. Type the region's name.
5. Press \[Enter\] or click anywhere in the track view to set the name.

Selecting regions
You may select the events, across all tracks, within the region for editing or playing back.
1. Right-click one of the region markers to display a shortcut menu.
2. From the shortcut menu, choose Select Region.

Note: You can also select a region by pressing a number on your keyboard (not the numeric keypad) or by double-clicking a region marker.
Navigating to regions
You can move the cursor to the start or end of a region by clicking either region marker. You may press [Ctrl]+[←] or [→] to move the cursor to the next or previous region markers.

Right-click a region marker to display a shortcut menu that allows you to navigate to the beginning (Go to Start) or the end (Go to End) of a region.

Deleting regions
1. Place the mouse pointer on the region marker's starting or ending point. The pointer changes to a hand icon (usahaan).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The region is removed from your project.

Vegas does not renumber the tags as you remove them. For example, if you have five regions in your project and delete region 3 and 4, the remaining regions are listed at 1, 2 and 5. However, as you add regions again, Vegas begins numbering the missing sequence first, in this case 3 and 4, and then 6, 7, 8, etc.

Deleting all regions and markers
1. Right-click the marker bar.
2. From the shortcut menu, choose Markers/Regions.
3. From the submenu, choose Delete All.

Working with command markers
Command markers add interactivity to a multimedia presentation streamed over the Internet by inserting metadata into streaming media files. As your video plays, any number of other actions can be programmed to occur. These commands are a part of the Microsoft WMV and RealMedia streaming formats. Most frequently, these actions add text or open a related Web site where the viewer can find more information about the topic at hand. The specific commands available vary depending on the final format of your project.

You can use command markers to add closed captions to your project. For more information, see Adding closed captioning to Windows Media Video (WMV) files on page 184.

Command markers can also indicate when an instruction (function) will occur in a WAV file being used in a radio broadcast environment (Scott Studios data). The following two sections define the markers for both streaming media and Scott Studios files.

Note: While streaming media files can be played on any hard drive or CD-ROM, they require a special streaming media server (provided by your ISP) to stream properly across the Internet.
Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any other function you define. Vegas includes several command types that you may add to a streaming media file. Some command types are exclusive to either the Windows Media (WMV) or the RealMedia (RM) player.

<table>
<thead>
<tr>
<th>Command</th>
<th>Player type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Windows Media and RealMedia</td>
<td>Indicates when an instruction is sent to the user’s internet browser to change the content being displayed. With this command, you enter the URL that displays at a specific time during the rendered project’s playback.</td>
</tr>
<tr>
<td>Text</td>
<td>Windows Media</td>
<td>Displays text in the captioning area of the Windows Media Player located below the video display area. You enter the text that will display during playback.</td>
</tr>
<tr>
<td>WMClosedCaption</td>
<td>Windows Media</td>
<td>Displays the entered text in the captioning window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextBodyText</td>
<td>Windows Media</td>
<td>Displays the entered text in the text window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextHeadline</td>
<td>Windows Media</td>
<td>Displays the entered text in the headline window that is defined by an HTML layout file.</td>
</tr>
<tr>
<td>Title</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text on the RealPlayer’s title bar.</td>
</tr>
<tr>
<td>Author</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text (Author’s name) when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered copyright information when a user selects About This Presentation from the RealPlayer’s shortcut menu.</td>
</tr>
<tr>
<td>HotSpotPlay*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to another RealMedia file.</td>
</tr>
<tr>
<td>HotSpotBrowse*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a Web page that you specify.</td>
</tr>
<tr>
<td>HotSpotSeek*</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a point in the current RealMedia file.</td>
</tr>
</tbody>
</table>

* Hotspots are defined:

HotSpotPlay MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" FILENAME
HotSpotBrowse MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" URL
HotSpotSeek MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" MM:SS

The parameters for a typical HotSpotBrowse command for a hotspot rectangle that is 50 pixels wide by 20 pixels tall and lasts for 10 seconds would look like this:

HotSpotBrowse 00:10 (0, 0, 50, 20) "Sonic Foundry" http:\\www.sonicfoundry.com

All parameters are optional except the last. The hotspot defaults to the entire duration of the file and the entire video frame if the duration and dimensions are not specified.

Defining Scott Studios data commands

For WAV files using Scott Studios data, command markers can be used to define information about the WAV file.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCOTT EOM</td>
<td>Calculates when the next queued clip starts playing in a Scott Studios system. For more information, please refer to your Scott Studios documentation.</td>
</tr>
<tr>
<td>SCOTT Cue In</td>
<td>Set the beginning of a file in a Scott Studios System without performing destructive editing. For more information, please refer to your Scott Studios documentation.</td>
</tr>
</tbody>
</table>
Inserting command markers

Command markers appear as blue tags on the command bar, which is above the marker bar.

1. Position the cursor where you want to place the command marker.
2. From the Insert menu, choose Command, or press [C].
3. Complete the Command Properties dialog:
   - **Template** - Select a custom template. For more information, see *Saving command properties as a custom template* on page 105.
   - **Command** - Select the type of command.
   - **Parameter** - Enter parameters to define the behavior of the command.
   - **Comments** - Enter your own notes or comments.
   - **Position** - Specify the timing of the command. Otherwise, command markers are automatically set to the current cursor position.
4. Click OK. The new command marker appears on the command bar.

Editing command properties

Double-click any command marker to open the Command Properties dialog and edit its contents. You can also right-click a command marker and choose Edit from the shortcut menu.

Saving command properties as a custom template

If you plan to use a command more than once, you can save command properties as a template. You can then reuse the command properties by selecting the template from the Template drop-down list.

1. Create a command and complete the Command Properties dialog.
2. Click in the Template box and enter a name for the template.
3. Click the Save Template button ( ).

**Note:** Vegas saves your metadata command templates in the cmdtemp.xml file in the Vegas program folder. You can edit this file directly to modify your templates.
Deleting command markers

1. Place the mouse pointer on the command marker. The pointer changes to a hand icon ( jihadists).
2. Right-click to display a shortcut menu.
3. From the shortcut menu, choose Delete. The command marker is removed from your project.

Working with CD layout markers

Markers on the CD layout bar indicate the locations of tracks and indices in an audio CD layout project. These markers are discussed in a later chapter. For more information, see Understanding tracks and indices on page 169.

Using an external audio editing program

Vegas is a nondestructive editing environment, which means that the original source files remain unchanged by any editing done in Vegas. Destructive (constructive) edits that modify the actual source media file may be done in a separate application such as Sonic Foundry's Sound Forge®. By setting up a separate audio editor, you can quickly access the program from Vegas via the Tools menu or by pressing Ctrl+E.

Setting up an audio editing program

If you already have Sound Forge loaded on your computer when you installed Vegas, the installation should have detected it and made it your default audio editing program. However, if you do not have Sound Forge or want to specify a different audio editor, you may do so in the Preferences dialog.

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. In the Preferences dialog, choose the Audio tab.
3. Click the Browse button to the right of the Preferred audio editor box. The Preferred Audio Editor dialog appears.
4. From this dialog, navigate to the application to use for editing audio files.
5. Select the application’s executable icon (.exe) and click Open to set the application as your default audio editor.

Opening an audio editor from Vegas

All events in your Vegas project are references to media files on a storage device. When you edit an audio event in an audio editor, you can choose to open the original media file or a copy of the file.

Opening a file in an audio editor

You can directly edit the media file to which an audio event is referenced. Any changes you make and save in the audio editor are permanent and are reflected in the event in your Vegas project.

1. Select the event to be edited.
2. From the Tools menu, choose Audio.
3. From the submenu, choose Open in Audio Editor.
Your selected audio editing application opens the event’s referenced media file. Make the necessary changes and save the file in the audio editor. If you keep the media file’s name and location the same, its event is updated immediately in your Vegas project. However, if you change the media file’s name or location (Save As), you must import the edited (new) file into Vegas.

**Opening a copy of a file in an audio editor**

You can also create a copy of an audio file and open it in an audio editor. Opening a copy of a file has the advantage of preserving the original file unchanged. The modified copy is inserted into the event as a take and is automatically added to the Media Pool.

1. Select the event to be edited.
2. From the Tools menu, choose Audio.
3. From the submenu, choose Open Copy in Audio Editor.

When you are finished editing, save the file. Vegas adds “Take X” to the end of the filename to distinguish it from the original and adds it to the project as a take. If you save it to a new file (Save As), you must manually add it as a take into the project. For more information, see Working with takes on page 113.
This chapter builds on the techniques that were introduced in the last chapter. Ripple editing, pitch shifting, and takes are just three of the more advanced editing topics that are covered in this chapter.

**Snapping events**

Vegas is preset to snap events into place as you drag them. Events can snap to another event’s edges, to the cursor position, or to a time selection. Vegas also allows events to snap to grid lines and markers. As you move an event along the timeline, its edge automatically aligns to designated snap points. At the highest level, all features in Vegas can quantize to individual frames.

**Enabling and disabling snapping**

You can quickly enable or disable all snapping by clicking the Enable Snapping button ( ) on the toolbar. Vegas also allows you to selectively enable and disable snapping options in the Options menu:

- **Enable Snapping** - controls all snapping behavior except quantizing to frames.
- **Snap To Grid** - controls snapping to grid markers. Vegas provides a variety of grid measurements. For more information, see Changing grid spacing on page 252.
- **Snap To Markers** - controls snapping to markers. The Snap To Markers option applies to markers, regions, command markers, and CD layout markers. For more information, see Adding project markers and regions on page 100.

**Quantizing to frames**

The Quantize To Frames command in the Options menu takes snapping one step further. With this feature enabled, everything snaps to the starting edge of individual video frames. Quantizing affects how you can move events, place markers, make selections, and position the cursor.

Quantizing to frames means that the position of markers, regions, events, and the cursor are limited to the start of an individual video frame.
Using the event snap offset

Each event in your project has a snap offset flag that can be moved along the length of the event. The flag is the white triangle that is located in the lower-left corner of each event. This flag allows you to designate where snapping occurs. This is useful if you need to align the snap with a beat in the event instead of the edge.

1. Place the mouse pointer on the snap offset triangle. The pointer changes to a hand icon (דה).
2. Drag the snap offset flag to the new position in the event. As the flag moves, a time display appears. This time display indicates where the snap offset flag occurs in time in the event.
3. Release the mouse to set the snap offset flag.

Snapping to the cursor or a selection

Two clips in the same track always automatically snap to their ends, but how can you snap two events on separate tracks? You can easily snap to specific event boundaries in any track by making a time selection for the event.

1. Double-click the event you want to snap to. The time selection area on the ruler sets to the length of the event.
2. Drag another clip in a different track near the end of the first clip. It snaps into position.

In this example, Vegas snaps the second event to the edge of the time selection. Because events also snap to the cursor, you could accomplish the same task by pressing \( \text{Ctrl} + \text{Alt} + \) or \( \text{Shift} + \text{Alt} + \) to position the cursor on the edge of the first event. Once the cursor is on the event edge, you can snap the second event to the cursor.
Pitch shifting audio events

Pitch shifting while preserving length is only available in Vegas Video.

A pitch shift is a way to raise or lower the pitch of an audio event. Vegas provides two ways to pitch shift:

- **Change pitch, preserve length**: Shift the pitch without altering the length of the event.
- **Change length and pitch**: Speed up or slow down the audio and change the pitch at the same time. You can shorten the event duration and raise the pitch, or lengthen the event duration and lower the pitch.

The semitone range in Vegas is -24 to 24. Twelve semitones equal one octave, so you may increase or decrease the pitch of an event within a two-octave range. Within each semitone is a finer pitch adjustment called cents. There are one hundred cents in one semitone.

1. Right-click an audio event to display a shortcut menu.
2. From the shortcut menu, choose Properties.
3. From the Method list, select Change Pitch, Preserve Length or Change Length and Pitch.
4. Adjust the pitch shift in the Semitone, Cents, or both by using the arrows or by typing the desired value.
5. Select the desired crossfade mode from the Crossfade dropdown list.
6. Click OK to set the pitch shift for the event.
Time compressing/stretching events

Time compressing/stretching audio while maintaining pitch is only available in Vegas Video.

Time stretching and compressing events is the process of using the same amount of source media to fill a shorter or longer event. While this can be done to both video and audio events, the two cases are fundamentally different.

1. Hold the Ctrl key.
2. Drag the edge of the event toward the center of the event to compress (shorten) it or drag the edge out away from the center to stretch (lengthen) it.

You can see the results of the time compression or stretching by viewing the properties of the event. Right-click the event and choose Properties from the shortcut menu. Time compressing/stretching an audio event affects the Time stretch/pitch shift settings, while Time compressing/stretching a video event affects the Playback rate setting.

Note: You can time compress/stretch several events at once by grouping them first. For more information, see Grouping events on page 128.

Time compressing/stretching video

Time stretching video allows you to fill a given duration with a set amount of actual video, sometimes called fit-to-fill. For example, if you have a five-second video event and you want this event to fill an eight-second slot, hold the Ctrl key and drag the edge of the event to eight seconds. The resulting video is in slow motion, but the contents (footage) remain the same. If you had used a velocity envelope to slow the video to the same rate, the event would also be in slow motion, but its duration would remain unchanged at five seconds. Stretched video has a zigzag line between thumbnails. Video can also be compressed (sped up and shortened in length) by using this method.

When stretching video events or slowing video down, a set number of frames are extended across a period of time. For example, if you take source footage at 30 frames in a second and slow it so that only 15 source frames run during that same second, an additional 15 frames must be created to maintain the project’s 30 fps frame rate. Simply duplicating frames is the easiest way to do this. A more sophisticated method is to resample the frames of an event, allowing Vegas to interpolate and redraw these intervening frames. For more information, see Resample (video only) on page 123 and Resampling video on page 187.
Working with Takes

A take is a version of a scene or audio recording, as in “Scene 10, Take 7”, which means the seventh time that scene number ten has been shot. Vegas allows you to include a number of takes in the same location (event) of the project. You can then rapidly switch between these separate takes to see which one fits into the project the best. Although this is what takes are designed for, you can actually use any media files you want as a take, even completely different sounds or scenes. Since an event is just a container of a specific length and at a specific location, the actual content (media file) is easily changed.

Adding Takes

Multiple media files can be added to the timeline at the same time to a single event as takes. You can also add regions within media files as takes. For more information, see Adding regions as takes on page 118.

Adding media files to the timeline as takes

1. Locate the media files that you want to insert as takes in the Explorer and select them. Select a range by holding Shift and clicking the first and last file in the range, or select nonadjacent files by holding Ctrl and clicking the various clips individually.
2. Right-click and drag one of the selected clips in the group to the timeline.
3. From the shortcut menu, choose Add as Takes.

Note: To add either just the audio or just the video portions of files as takes, choose Video Only: Add Video as Takes or Audio Only: Add Audio as Takes from the shortcut menu.

Adding takes to existing events

Media files can also be added to existing events as takes.

1. Right-click a media file in the Explorer and drag it to an existing event.
2. From the shortcut menu, choose Add as Takes.

Selecting takes

When you add an event with multiple takes, a single event is inserted into a track. The last clip that was selected determines the duration of the event and is set as the active take.

1. Right-click an event with multiple takes.
2. From the shortcut menu, choose Take.
3. From the submenu, choose Next Take or Previous Take or choose the name of the take from the list at the bottom of the submenu. Alternately, click the event and press T to select the next take or Shift + T to select the previous take.
Previewing and selecting takes

Vegas allows you preview the takes for a given event.
1. Select the event containing multiple takes.
2. Right-click to display a shortcut menu or, from the Edit menu, choose Take to display a submenu.
3. Choose Choose Active... from the submenu. The Take Chooser dialog appears.
4. Select the take that you want to preview and use the Play ( ) and Stop ( ) buttons within the dialog.
5. To use a take, select it and click OK. The selected take is now the active take.

Using takes to copy event attributes to a new event

You can duplicate an event and replace it with another event while retaining the attributes (switches, envelopes, filters, etc.) of the original. Adding takes to a duplicated event in this way is an excellent method of maintaining consistency between a number of events in a project that may use a complex set of effects or plug-ins. First, duplicate an event by holding the Ctrl key while dragging an event. Then, replace the original event by adding the new file as a take and then deleting the original take. This is a quick way to copy all the attributes of an existing event to a new event.

Deleting takes

Individual takes can be deleted from an event at any time.
1. Right-click an event with multiple takes.
2. From the shortcut menu, choose Take.
3. From the submenu, choose Delete Active to immediately remove the active take or choose Delete to open a dialog with a list of all of the takes contained in this event.

Working with take names

Displaying take names on events

Take names may be displayed on the events in the timeline.
1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. On the General tab, select the Show active take name in events check box to enable it.
3. Click OK.
Changing take names

Changing the name of a take does not affect the source media file in any way. Typically, you may want to change an event’s name after recording multiple takes into a track or event. For more information, see Working with multiple recorded takes on page 165.

1. Select the take to be renamed. For more information, see Selecting takes on page 113.
2. Right-click the event to display a shortcut menu.
3. From the shortcut menu, choose Properties. The Properties dialog opens.
4. Type the new name in the Active take name box.
5. Click OK to set the new take name.

Using the Trimmer window

The Trimmer allows you to work with and edit one media file at a time. The entire file is opened into the Trimmer, in contrast to events on the timeline that may only contain a portion of the actual source file.

The main function of the Trimmer window is to allow you to trim a media file and place portions of it on a track. You can also add regions and markers to a file, preview the media file, or open it in an external audio editing program.

You can open any number of files in the Trimmer at the same time, selecting the one you currently want to work on from the Trimmer history drop-down list.

From the View menu, choose Trimmer or press Alt + 3 to display the Trimmer window, if it is not already visible. The Trimmer window may be placed in the window docking area of Vegas or float over the work area. For more information, see Window docking area on page 22.

Opening a file in the Trimmer

1. Right-click an event. A shortcut menu appears.
2. Choose Open in Trimmer.

You can also drag files to the Trimmer from the Explorer or the Media Pool.
Double-clicking a file to open it in the Trimmer

You can set Vegas to open a file in the Trimmer when you double-click the file in the Media Pool or Explorer windows.

1. From the Options menu, choose Preferences.
2. Click the General tab.
3. Choose Double click on media file loads into Trimmer instead of tracks.

Moving frame-by-frame in the Trimmer window

As you navigate through a video file in the Trimmer, the exact frame that the cursor is over in time is displayed as in a thumbnail image under the cursor. When using the left and right arrow keys, this allows you to edit with frame accuracy. Make sure Animate video frames in Trimmer is selected in the Preferences dialog to use this feature.

Making selections in the Trimmer

After you have opened a media file in the Trimmer, you may select a segment of it and place it in your project. Make a time selection to select a segment in the Trimmer in the same way you do in the project timeline. For more information, see Selecting a time range on page 85.

You can make a selection during playback by using the keyboard. Press $[$ or $[$ to mark the start of the selection, and press $]$ or $]$ to mark the end.

If you know the exact timecode of the point where you want to begin and end a time selection, you can enter it into the boxes at the lower right part of the Trimmer window.

Note: Press Backspace to recall the last five time selection areas in the Trimmer.

Adding selections to the timeline

You can use the Trimmer window to do traditional three-point and two-point editing. These editing techniques allow you to add smaller sections of files to the timeline.

Ripple edit mode affects how a selection is added to the timeline from the Trimmer. When the Ripple Edits button ( ) is selected on the toolbar, adding a selection from the Trimmer selection affects the position of later events on the track. When Vegas is not in ripple edit mode, adding a selection from the Trimmer has no effect on other events. For more information, see Editing and ripple editing events on page 87.

Adding selections at the cursor (three-point editing)

1. Open a media file in the Trimmer.
3. Select the track in the timeline where the selection will be added.
4. Position the cursor in the timeline at either the start or end point where you want to add the selection.

5. Add the selection to the timeline in one of the following ways:
   
   • Click the Add Media from Cursor button ( ) or press \( A \) on the keyboard to insert the event after the cursor.
   • Click the Add Media up to Cursor button ( ) or press \( \text{Shift} + A \) on the keyboard to insert the event before the cursor.

Alternately, you can drag the selection from the Trimmer to the timeline.

Ripple editing (if enabled) applies to clips inserted from the Trimmer. For more information, see Editing and ripple editing events on page 87.

Filling a time selection on the timeline (two-point editing)

You can select a range of time on the project timeline and then fill it with the same length selection from the Trimmer.

1. Create a time selection in the timeline where you want to add the event. This sets the duration and position of the event that you will create.

2. Open the media file you want to use to fill the time selection in the Trimmer window.

3. Right-click the file in the Trimmer window and choose Sync Track View Selection Time from Cursor or Sync Track View Selection Time up to Cursor from the shortcut menu. A time selection is automatically created on the file in the Trimmer window.

4. Adjust the location of the time selection in the Trimmer as needed by dragging the time selection (the area between the yellow triangles) on the Trimmer marker bar.

5. Drag the event from the Trimmer to the timeline and allow it to snap into place within the time selection.

Adding selections from a media file with audio and video

You can open a file in the Trimmer that has both audio and video streams (e.g., AVI). When you add a selection from this type of file to the timeline, both streams are added:

• If you select a video track before adding the selection, Vegas adds the video to the selected track and adds the associated audio to the track below it.
• If you select an audio track before adding the selection, Vegas adds the audio to the selected track and adds the associated video to the track above it.

Vegas creates new tracks for the added media if necessary.
Adding and saving regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file in the same way that you add them to your project. Media file markers and regions are different from project markers and regions. The difference between the two is simply that project markers and regions affect a project, while media file markers and regions are embedded in, and saved with, a media file. For more information, see Adding project markers and regions on page 100.

Markers and regions that are added in the Trimmer are only temporary. You must save them by clicking the Save button ( ) in the Trimmer window if you want to use them again after you close the project. After the markers and regions are added and saved to the media file, they are available when you open the media file in an audio editor program or in the Trimmer.

Note: Markers cannot be saved to media files with properties set to read-only in Windows.

Automatically saving Trimmer markers and regions with media files

1. From the Options menu, choose Preferences.
2. On the General tab, select Automatically save trimmer markers and regions with media file.

Adding regions as takes

Once regions are saved with a media file, either in the Trimmer window or in another application, you can add the regions as takes to the timeline from the Explorer window. In the Explorer window, click the arrow next to the View button and select Region View from the drop-down list. A single media file may contain a number of separate regions. These regions can be selected individually or as groups and inserted as takes into the timeline. This is especially useful when loop-recording numerous takes to a single file. For more information, see Working with takes on page 113.

Opening a file in an external audio editor from the Trimmer

The Trimmer allows you to open your selected audio editing application (e.g., Sound Forge) to perform permanent edits to the media file. After you make the necessary changes and save the file in the audio editor, Vegas automatically updates the event. Make sure that the media file’s name and location remain the same. For more information, see Using an external audio editing program on page 106.

To open the audio editor from the Trimmer, click the Open in Audio Editor button ( ).

Using the Edit Details window

The Edit Details window displays a database for all of the media in your project. It shows information about how the files are being used and allows you to modify many of those properties. You may sort, add or change information, rearrange columns, and edit items in the project.

This window provides an alternate method for working with events, audio CD track list items, command markers, markers, and regions after they are placed in your project.
The Edit Details window may be docked in the window docking area or may float on the workspace. For more information, see Window docking area on page 22.

Viewing the Edit Details window

To view the Edit Details window, choose Edit Details from the View menu or press Alt+E. The Show drop-down list allows you to view categorized project information. Most entries can be edited by double-clicking them or by right-clicking them to display a shortcut menu.

Audio CD track list

The Audio CD track list category displays information about the track and index markers placed on the CD layout bar. Vegas uses this information to burn audio CDs. For more information, see Understanding tracks and indices on page 169.

Commands

The Commands category displays information about commands that are placed along the project's timeline. This category displays four columns: the command's position along the timeline, the command type, its parameters, and any comments that were entered when the command marker was placed in your project. Right-click a command entry to display a shortcut menu. For more information, see Working with command markers on page 103.

Events

The Events category displays information about all of the events in your project. You may sort any of the information by clicking a column's header. The number of columns in the Events category requires that you use the scroll bar to view them all.

The following table explains each column in the Events category and describes its function.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Edit function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Displays the track number where the event is located.</td>
<td>Move the event to a different location by entering a different track number (pg. 74).</td>
</tr>
<tr>
<td>Start</td>
<td>Displays when on the timeline the event starts playback.</td>
<td>Enter a different value to cause the event to begin playback sooner or later in the project (pg. 73).</td>
</tr>
<tr>
<td>End</td>
<td>Displays when on the timeline the event ends playback.</td>
<td>Enter a different value to cause the event to end playback sooner or later in the project (pg. 73).</td>
</tr>
<tr>
<td>Length</td>
<td>Displays the total length of the event.</td>
<td>Enter a different value to increase or decrease the event's playback time.</td>
</tr>
<tr>
<td>Number of Takes</td>
<td>Displays the amount of recorded takes contained in the event.</td>
<td>Cannot be edited (display only).</td>
</tr>
<tr>
<td>Active Take Name</td>
<td>Displays the event's current take name.</td>
<td>Enter a different name for the current take (pg. 115).</td>
</tr>
</tbody>
</table>
Markers

The Markers category displays information about markers that are placed along the project’s timeline. This category displays two columns: the marker’s position along the timeline and the marker’s name. For more information, see Working with markers on page 100.

Regions

The Regions category displays information about regions that are placed along the project’s timeline. This category displays four columns: each region’s start position, end position, length, and name. For more information, see Working with regions on page 101.

Selected Events

The Selected Events category is visually identical to the Events category except that the Edit Details window only displays information about events that are selected in your project.

Customizing the Edit Details window

You may arrange and delete columns from each category and save the changes to a personal template. Vegas has one template from which you may create your own display options. All Fields Display is the default.

1. From the Show drop-down list, choose the category that you want to customize.
2. Drag a column’s header to the new position. The cursor changes to a column icon ( ) as you move the column. If you want to remove the column so that it does not display, drag the icon off the Edit Details window. Release the mouse to drop the column in its new position.
3. The Template drop-down name changes to “Untitled.” Enter a new name in the Template drop-down.

4. Click the Save button ( ) on the Edit Details window to save the custom display.

You may delete a custom display by selecting it from the template drop-down list and clicking the Delete button ( ).

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Edit function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Take Start</td>
<td>Displays the offset into the source media file when the placed event begins playback.</td>
<td>Enter a different value to cause the take to playback sooner or later from the source media file.</td>
</tr>
<tr>
<td>File Path</td>
<td>Displays the path of the event’s media file.</td>
<td>Enter a new media file reference path for the event to use.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>Displays the name of the source media tape name.</td>
<td>Change the tape name here or in the properties dialog for the media file (pg. 191).</td>
</tr>
<tr>
<td>Select</td>
<td>Displays whether the event is selected in the project.</td>
<td>Toggle the event’s selection by clicking the check box. A check mark in the box indicates that the event is selected (pg. 84).</td>
</tr>
<tr>
<td>Mute</td>
<td>Displays whether the event is muted.</td>
<td>Toggle the event’s mute switch by clicking the check box. A check mark in the box indicates that the event is muted (pg. 121).</td>
</tr>
<tr>
<td>Loop</td>
<td>Displays whether the event is looped for playback.</td>
<td>Toggle the event’s loop switch by clicking the check box. A check mark in the box indicates that the event is looped for playback (pg. 121).</td>
</tr>
<tr>
<td>Lock</td>
<td>Displays whether the event is locked.</td>
<td>Toggle the event’s lock switch by clicking the check box. A check mark in the box indicates that the event is locked (pg. 121).</td>
</tr>
<tr>
<td>Normalize</td>
<td>Displays whether the event is normalized.</td>
<td>Toggle the event’s normalize switch by clicking the check box. A check mark in the box indicates that the event is normalized (pg. 122).</td>
</tr>
<tr>
<td>Snap Offset</td>
<td>Displays when in the event the snap offset is positioned.</td>
<td>Enter a different value to change the snap offset position in the event (pg. 110).</td>
</tr>
</tbody>
</table>
Events are windows into media files in a project and are the most basic unit of editing in Vegas. Media files that are inserted into the timeline are automatically contained within an event. Trimming and editing an event does not affect the source media file in any way.

Setting event switches

Event switches are important functions that are used to determine the basic behavior of events in Vegas. Switches may be applied to a single event or to multiple events at the same time.

1. Right-click an event.
2. From the shortcut menu, choose Switches and then choose the specific switch from the submenu. Active switches have a check mark next to them. Click an active switch on the menu again to turn it off.

Note: You may also access switches on the Edit menu, in the Edit Details window, or by right-clicking an event and choosing Properties.

Mute

Use the Mute switch to mute an event. This prevents the event from playing back.

Lock

The Lock switch locks an event to prevent it from being moved or edited.

Loop

You may loop an event so that you can extend it along the timeline by dragging the right edge of the event. Notches appear in the top of the event to mark where the media in the event ends and then repeats.
For video events, disabling the Loop switch makes the last frame repeat for the duration of the event beyond its original length, creating a freeze frame effect (as in the middle example below). The Loop switch is enabled for the event in the last example below.

Invert phase (audio only)

This switch inverts the audio event at its baseline, in effect reversing its polarity. Inverting an event, while creating no audible difference, is occasionally useful for matching transitions when mixing audio on separate tracks or fine-tuning a crossfade.

You can also phase invert a track. If a track is inverted and you invert an event on the track, the event is doubly-inverted (restored to its original state). For more information, see Phase inverting a track (audio only) on page 136.

Normalize (audio only)

You may normalize an event to maximize its volume, based on the waveform’s highest peak, without clipping the event during playback.

Recalculating the normalization

When you normalize an event, Vegas analyzes the event and raises the volume based on the waveform’s highest peak and then adjusts the rest of the event accordingly. If you have adjusted the edge of an event to exclude the (formerly) highest waveform peak, you may want to recalculate the event’s normalization.

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog opens.
3. Click Re-calculate to normalize the event again.

**Note:** You may set the maximum decibel level used by Vegas to calculate the event during normalization. For more information, see *Audio tab* on page 255.

**Maintain aspect ratio (video only)**

Video and image files of various sizes and formats can be included in a single project. The project itself may have a different frame size aspect ratio from the source media files. This is not a problem, but you must specify how Vegas handles these differences. If the length-to-width ratio between the source media and the project’s frame size are the same (e.g., source media at 320x240 and project frame size of 640x480), no aspect ratio distortion occurs. If the ratios are not the same, the source material may become distorted (stretched or squashed). By maintaining the aspect ratio of the original, Vegas keeps the video from becoming distorted by letterboxing around the edges. This is the default setting.

The BMP media file in this example is 320x100, while the project is set to 320x240.

**Resample (video only)**

Resampling allows Vegas to redraw or re-render a video file and possibly to interpolate frames in an event when the frame rate of a media file is significantly different from the project’s frame rate. This may solve some interlacing problems and other jittery output problems. For more information, see *Resampling video* on page 187.

**Reduce interlace flicker (video only)**

This switch can be useful in cases where the source material didn’t originate as video and contains extremely high spatial or temporal frequencies. When you watch the rendered (interlaced) output on video of this sort of media, you may see flickering or crawling edges if this switch is not applied.
Accessing event properties

The properties of an event are automatically determined by Vegas and are based on the properties of the source media file. In addition to the event switches (mute, loop, etc.) described in the previous section, event properties include playback and undersample rates for video and pitch shifting for audio.

1. Right-click the event to display a shortcut menu.
2. From the shortcut menu, choose Properties. The Event Properties dialog appears.

The first tab in the dialog, either Audio Event or Video Event, contains the properties that are exclusively Vegas related. The second tab, the Media tab, contains many properties that are an inherent part of the media file itself.

In addition to the event switches discussed in this chapter, event properties include the following:

- **Playback rate:** Sets the rate of playback. For example, a playback rate of 1 plays at normal speed, while a playback rate of 0.5 plays at half speed. For more information, see Time compressing/stretching events on page 112.
- **Undersample rate:** Simulates a lower frame rate. For example, an Undersample rate of 0.5 plays the event at half its original frame rate. Each frame plays twice as long as in the original media file, creating a strobe effect.
- **Time stretch/pitch shift:** Changes pitch, duration, or both pitch and duration of an audio event. For more information, see Pitch shifting audio events on page 111.

**Pitch shifting while preserving length and time stretching while preserving pitch are only available in Vegas Video.**

Adjusting audio channels

A stereo audio event has two channels: right and left. You can adjust how Vegas plays these channels by right-clicking an event and choosing Channels from the shortcut menu:

- **Both:** Plays both channels in stereo. This is the default setting.
- **Left Only:** Plays only the left channel. Playback is mono and is centered between the two channels.
- **Right Only:** Plays only the right channel. Playback is mono and centered.
- **Combine:** Adds the two channels into a single channel and divides level in half to prevent clipping. Playback is mono and is centered between the two channels.
- **Swap:** Exchanges the right and left channels (stereo playback).

You can also pan from one channel to the other using either the multipurpose slider or a pan envelope. For more information, see Adjusting stereo panning on page 135.
Using audio event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, sustain, and release), give you the ability to control an audio event's fade-in, fade-out, and overall volume level.

**Note:** Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see Working with track envelopes on page 137.

When you place an event into your project, Vegas adds handles that are used to set the envelope. As you use these handles on audio events, a volume line appears indicating how the event is being affected. The waveform also graphically displays the volume change.

**Setting an audio event’s volume**

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor ( ) that you may use to lower the event's overall volume.

1. Place the mouse pointer at the top of the event.
2. When you see the envelope cursor ( ), drag the volume line to the desired level. As you drag the volume line down, Vegas displays the event’s decibel level.

**Setting an event’s fade in and out**

The event handles allow you to affect an audio event’s fade in and out volume. The type of curve that the event uses to control the volume's fade in or out can also be changed.

1. Place the mouse pointer on a handle (upper corners of the event) and the pointer changes to the envelope cursor ( ).
2. As you drag the cursor, the volume line appears. Vegas displays both the time in the event when the volume will be maximized and its decibel level.
Changing an event’s fade curve

You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to raise or lower the volume over time. To access the different fade curves, right-click anywhere in the event’s fade-in or -out region and choose **Fade Type** from the shortcut menu.

Using video event envelopes

Velocity envelopes are only available in Vegas Video.

Envelopes are a method of controlling some of the attributes of an event over time. Video event envelopes include Opacity and Velocity. Envelopes appear as blue or white lines on an event. The Velocity envelope offers the added control of creating and dragging edit points.

**Note:** Event envelopes only affect an event. Track envelopes affect the entire track. For more information, see *Working with track envelopes* on page 137.

Using opacity envelopes

Opacity envelopes set the overall opacity and allow you to fade video events in and out. This affects the transparency of the event in relation to background events on lower tracks. These background events can be other video events or background colors. For more information, see *Using generated media* on page 198.

Setting a video event’s opacity

When you place the mouse pointer at the top of the event, the pointer changes to a hand cursor that you may use to lower the event’s overall opacity.

1. Place the mouse pointer at the top of the event.
2. When you see the envelope cursor, drag the opacity line to the desired level. As you drag the line down, Vegas displays the event’s opacity level.
Setting an event’s fade in and out
The event handles allow you to affect an video event’s fade in and out opacity. The type of curve that the event uses to control the fade in or out can also be changed.

1. Place the mouse pointer on a handle (upper corners of the event) and the pointer changes to the envelope cursor (+).)
2. As you drag the cursor, the opacity line appears. Vegas displays both the time and the opacity level as you drag.

Changing an event’s fade curve
You can set the shape of the fade curve (fast, linear, slow, sharp, or smooth) that an event uses to increase or decrease the opacity over time. To access the different fade curves, right-click anywhere in the event’s fade-in or -out region and choose Fade Type from the shortcut menu.

Using velocity envelopes
Velocity envelopes are only available in Vegas Video.

Velocity envelopes are used to change the speed of a video event over time. To view a Velocity envelope, right-click the event and choose Insert/Remove Velocity Envelope.

1. Right-click the event and choose Insert/Remove Velocity Envelope. The Velocity envelope appears on the event as a blue line.
2. To increase the speed, drag the line up. To slow the video down, drag the line down.

Adding velocity envelope points (nodes)
When combined with points (nodes), envelopes can be used to animate velocity changes.

1. Double-click the envelope where you want to add a point.
2. Drag the point to adjust it. Vegas displays the time and velocity level of the point as you drag.
3. Right-click the envelope between two points to choose a fade type (Linear, Fast, Slow, Smooth, or Sharp) to set the shape of the curve.

Note: To delete a point, right-click the point and choose Delete.

Making a video play at twice its normal speed makes the duration of the video half as long. Likewise, slowing a video down makes it longer (with 0% being an infinite freeze frame). For example, if you decrease the speed of a ten-second video event by 50%, only five seconds of video play (played over the course of the ten-second event), meaning that only half as much actual footage from the original event plays. On the other hand, if the speed is increased 200%, the ten seconds of content play in only five seconds. The remaining five seconds of the event are filled either with a freeze of the last frame or with ten additional seconds of video content from the longer file.

You may want to resample the frame rate of an event that has been significantly slowed. To resample an event, right-click the event and choose Properties. Then, on the Video Event tab, choose Resample. For more information, see Resampling video on page 187.
Using the Envelope Edit Tool

While envelopes can be edited while in Normal Editing mode, you can limit your editing to envelopes only by clicking the Envelope Edit Tool (E) button. Events cannot be moved, trimmed or otherwise modified in this mode, protecting them from unwanted changes. For more information, see Using the Envelope Edit tool on page 140.

Reversing a video event

Setting the velocity to a negative value reverses the video, working backwards from the point where the negative value occurs. An event that has been reversed plays backwards until it gets to the first frame and then holds that frame for the duration of the event.

1. Right-click the event and choose Insert/Remove Velocity Envelope.
2. Trim the beginning of the video event to the place where you want the reversal to begin, e.g., the last frame in the media file that you want to play if it were playing forward.
3. Drag the velocity down to -100% for a normal speed reversal.

Removing a velocity envelope

To remove an envelope and all of its settings, right-click the event and choose Insert/Remove Velocity Envelope from the shortcut menu.

Grouping events

Vegas allows you to group events together within tracks or across separate tracks. Once a group is created, all the events within it may be moved within their tracks as a unit and have event-specific edits applied at the same time.

You may still edit properties of individual events within a group without affecting the other events in a group.
Creating a new group

Grouping is useful when you want to preserve timing of events and move them together along the timeline.

1. Select the events you want to group. Press Ctrl, Shift, or use the Selection Edit tool ( ) to select them. For more information, see Selecting multiple events on page 84.

2. From the Edit menu, choose Group to display a submenu and then choose Create New.

Adding an event to an existing group

1. Select an event in the existing group.

2. Right-click the event and choose Group. Choose Select All from the submenu to select all of the members of the group.

3. Press Ctrl and click the event to be added to the group.

4. Right-click the event and choose Group. Choose Create New from the submenu.

---

Note: Events can only be in one group at a time. Adding an event to an existing group essentially deletes the old group and creates a new one that includes all of the selected events.

---

Removing events from a group

Individual events may be removed from a group without affecting the other members of the group. The event you are removing from the group is not deleted from the project and remains on the timeline.

1. Right-click the event you want to remove from the group.

2. From the shortcut menu, choose Group and then choose Remove From on the submenu. The event is removed from the group. The rest of the grouped events remain intact.

Clearing a group

You may ungroup all events by clearing the entire group. Clearing a group does not delete or remove events from your project.

1. Right-click one of the members of the group.

2. From the shortcut menu choose Group and, from the submenu, choose Clear.

Selecting all members of a group

While grouped events move together within their tracks, selecting one member of a group does not automatically select every member of that group. To select all members of a group, right-click one of the members of the group and, from the shortcut menu, choose Group and then choose Select All. With all events in a group selected, you can move the group to other tracks, or cut and paste the group to a new location.

Disabling grouping temporarily

The grouping behavior of all groups (including video media files with included audio streams) in Vegas can be temporarily disabled by clicking the Ignore Event Grouping ( ) button.
Tracks contain the media events on the timeline of a project. There are two types of tracks: video and audio. Each type of track has its own features and controls. While tracks can be organized and mixed in any order, track hierarchy can be important in determining the final output, especially for video. Because tracks are containers for events, effects that are applied to a track apply to every event in that track.

Vegas Video provides unlimited audio and video tracks and fourteen compositing modes. Vegas Video LE limits you to four audio tracks, two video tracks, and source alpha compositing.

Managing tracks

Once you have added a track to your project, you may perform basic editing tasks on it such as duplicating, deleting, and renaming.

Adding an empty track

Vegas creates tracks for you when you drag events to empty spaces in the timeline. You can also add empty (eventless) tracks to a project. These tracks can be used to directly record into or serve as placeholders for specific media that you will add later. For example, you may want to create an empty track and then record a voiceover directly into a project.

1. Right-click in either the track view or the track header to display a shortcut menu.

2. Choose Insert Audio Track or Insert Video Track.

You may also add an empty track from the Insert menu by choosing Audio Track or Video Track. Vegas adds an empty track at the bottom of the Track List.

Duplicating a track

You may duplicate a track in your project including all of the events contained on it. When a track is duplicated, it is placed directly below the original track. Other existing tracks are moved down on the track header. You may duplicate one track or select multiple tracks to duplicate.

1. Click the track that you want to duplicate.

To select multiple tracks, click each one while holding either the Shift key to select adjacent tracks or the Ctrl key to select nonadjacent tracks.

2. Right-click and choose Duplicate Track from the shortcut menu.
Deleting a track

You may delete a track from your project and all of the events contained on it. You may delete one track or select multiple tracks to delete.

1. Click the track that you want to delete. To select multiple tracks, click each one while holding down either the Shift key to select a range of adjacent tracks or the Ctrl key to select discontinuous tracks.
2. From the Edit menu, choose Delete.

Naming or renaming a track

Every track in your project has a scribble strip where you can type a name for the track. The track name may be up to 255 characters long. If the scribble strip is not visible, you may need to increase the height of the track by dragging the track’s edge to reveal it. For more information, see Changing track height on page 133.

1. Double-click the scribble strip. Any existing name is highlighted on the strip.
2. Type the new track name.
3. Press Enter to save the track’s name.

Organizing tracks

Vegas is flexible in how tracks can be organized. Tracks may be rearranged and sized to fit your particular needs.

Reordering tracks

When you create tracks, Vegas arranges them in the order that they were added. It is a simple process to reorder tracks to fit your needs. You may reorder one or more tracks at a time.

**Note:** Track hierarchy can be critical in video compositing. For more information, see Compositing on page 199.

1. On the track header, place the mouse pointer on the track that you want to move.
2. Drag the track to the new position in the track header.

**Note:** When moving a track, you may want to place the mouse pointer on the track number when dragging. This helps avoid accidental modifications to other track header controls.
Changing track color

When you add a track to Vegas, a color is automatically assigned to the track. This color is easily changed. This feature is useful if you want to use color to organize similar tracks.

1. In the track header, right-click a track to display a shortcut menu.
2. From the shortcut menu, choose Track Display Color to display a submenu.
3. From the submenu, choose a color.

Changing track height

You can control track height by dragging the bottom edge of a track in the track list. You can also change track height by clicking the buttons (↑, ↓, ) on the track.

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Resulting Track height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize Track Height</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore Track Height</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximize Track Height</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also use several different keyboard shortcuts to change all track heights at once:

- Press Ctrl + Shift + ↑ or Ctrl + Shift +↓ to change the height of all tracks in your project at once.
- Press Shift to minimize all tracks. Press the key again to restore the tracks to their previous height.
- Press Shift +↑ to make all tracks a uniform height slightly shorter than the default.
- Press Ctrl +↑ to make all tracks the default height.

Resizing a track

Tracks can be resized by dragging the bottom or the right border. Place the mouse pointer at the bottom of the track. The pointer turns into an up/down arrow (↑↓). Drag up or down and release the mouse to set the desired track size. The width of the track header can be resized in a similar way.
Using track headers

Each track in your project has its own controls, faders, and sliders that are contained in the track header on the left side of the track. You can work with these controls to affect the event(s) that are contained on the track.

Using the volume fader (audio only)

This fader controls the volume of the events on a particular audio track. The fader’s range is \(-\infty\) to 12 dB. To adjust the fader, drag it to the desired volume level. As you drag the fader, the volume level displays to the left of the fader. Double-click the fader to set it to 0.0 dB, or double-click the current volume value to enter a specific number.

Note: Press \(\text{Ctrl}\) while dragging or use the mouse wheel for finer control of the fader. You may also move the fader by clicking it and using the right or left arrow keys.

Volume envelopes provide greater control over track volume. For more information, see Working with track envelopes on page 137.

Using the multipurpose slider (audio only)

This slider controls several features, including panning, bus send levels, and assignable effects send levels. The options for the multipurpose slider depend on what your project contains and what version of Vegas you are using. You may select what the slider controls by clicking the multipurpose slider button. Each item’s slider position is independent from the others.

Note: If you do not see this slider on a track, increase the track height.
Adjusting stereo panning

When you choose Pan from the multipurpose slider button, the slider controls the position of a track in the stereo field. Vegas audio tracks are preset to center the signal. Move the slider to adjust the signal’s output left or right. As you move the slider, Vegas displays the signal’s percentage going to either the left or right channel. For example, moving the slider to 60%L means that sixty percent of the signal is mixed to the left channel, while forty percent is mixed to the right.

You can further control the panning by right-clicking the multipurpose slider and selecting an option from the shortcut menu:

- **Add Channels**: The Add Channels panning model is most useful for panning stereo source material. This model makes the stereo image appear to move as a unit between the speakers. As the fader is moved from the center to a side, more and more of the signal from the opposite side is “folded” into the side you are panning towards, until at the extreme, both channels are fed at full intensity into a single channel. This panning model uses a linear panning curve.

- **Balance**: The Balance panning model is most useful for adjusting the relative signal levels of the right and left channels in stereo source material. In this model, moving from the center to a side, the opposite side starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. The signal in the side you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. This panning model uses a linear panning curve.

- **Constant Power**: The constant power panning model is most useful for panning mono source material. As you move the fader from side to side, this model creates the illusion of the source moving around the listener from one side to the other, in a semi-circle. This model uses the constant-power panning curve.

You may add a pan envelope for more advanced panning effects. For more information, see Working with track envelopes on page 137.

Adjusting bus levels and assignable effects send levels

If you add a bus or an assignable effects chain to your project, Vegas adds it to the multipurpose slider button. When a bus or assignable effects chain is selected in the multipurpose slider button menu, the slider controls the level of the track sent to the bus or effect chain. Bus and assignable effects send levels are preset to -inf. dB (mute) for playback. Move the slider to adjust the send level. For more information, see Adjusting a bus send level on page 156 or Assigning audio tracks to assignable effects chains on page 157.

**Note**: Multiple busses and assignable effects are only available in Vegas Video.

Using the composite level slider (video only)

This slider determines the opacity of the video track. Drag the slider to control the transparency or blending of each track. Left is 100% transparent and right is 100% opaque. You can also double-click the percent to enter a specific value.
Phase inverting a track (audio only)

The Invert Track Phase button ( ) inverts the audio track at its baseline, in effect reversing its polarity. Inverting a track, while creating no audible difference, is occasionally useful for matching transitions when mixing audio on separate tracks or fine-tuning a crossfade.

You can also phase invert an audio event. If an event on a track is inverted and you invert the track, the event is doubly-inverted (restored to its original state). For more information, see Invert phase (audio only) on page 122.

Muting a track

The Mute button ( ) on the track header temporarily disables playback of the track so that you can focus on another track. When a track is muted, it appears grayed out on the track view. You may mute more than one track at a time.

To mute a track, click the Mute button. To mute several tracks, select the tracks and click the Mute button on any of the selected tracks. Click the Mute button again to restore the track(s).

Note: Press [Ctrl] and click the Mute button to mute only the selected track (and restore any other muted tracks). If the selected track is already muted, press [Ctrl] and click the Mute button to restore all tracks.

Muting all audio or video tracks

You may mute either all audio or all video tracks in a project. From the Options menu, choose Mute All Audio or Mute All Video.

Soloing a track

The Solo button ( ) on the Track header isolates a track’s events for playback and mutes the other non-soloed tracks. This allows you to focus on a track’s contents without the distraction of other tracks. You may solo more than one track at a time.

To solo a track, click the Solo button on that track. To solo several tracks, select the tracks and click the Solo button on any of the selected tracks. Click the Solo button again to restore the track(s) for playback.

Note: Press [Ctrl] and click the Solo button to solo only the selected track (and restore any other soloed tracks). If the selected track is already soloed, press [Ctrl] and click the Solo button to restore all tracks.
Setting default track properties

You can use the settings of a selected track to determine the default settings for all new tracks in your project. Properties that can be set appear in the Set Default Track Properties dialog.

1. Set up a track in your project with the properties to use as default settings for new tracks.
2. Right-click the track number and choose Set Default Track Properties. The Set Default Track Properties dialog appears.
3. Select the check boxes that you want to set as defaults.
4. Click OK.

Vegas creates any new tracks in the project with these defaults. To return to the original settings for new tracks, select the Restore original defaults check box in the Set Default Track Properties dialog.

Working with track envelopes

Track envelopes allow you to control and automate volume, audio panning, opacity, and fade to color effects of a particular track over time. The following are available envelope types.

<table>
<thead>
<tr>
<th>Track Type</th>
<th>Envelope type</th>
<th>Description</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Volume</td>
<td>Controls track volume.</td>
<td>Blue</td>
</tr>
<tr>
<td>Audio</td>
<td>Bus send volume</td>
<td>Controls track level sent to bus.</td>
<td>Lilac</td>
</tr>
<tr>
<td>Audio</td>
<td>Assignable effects send volume</td>
<td>Controls track level sent to assignable effects control.</td>
<td>Green</td>
</tr>
<tr>
<td>Audio</td>
<td>Pan</td>
<td>Controls the position of a track in the stereo field (pan).</td>
<td>Red</td>
</tr>
<tr>
<td>Video</td>
<td>Composite level</td>
<td>Controls track opacity/opacity/transparency.</td>
<td>Blue</td>
</tr>
<tr>
<td>Video</td>
<td>Fade to color</td>
<td>Controls fading of a track to color. Designate a top and bottom color by right-clicking the track, choosing Fade Colors from the shortcut menu, and choosing Top or Bottom from the submenu.</td>
<td>Blue</td>
</tr>
</tbody>
</table>

Composite Level envelopes and Fade to Color envelopes are only available in Vegas Video.

Adding track envelopes

You may add any type of envelope by following the same basic steps.

1. Select the track where you want to add the track envelope. Multiple tracks may be selected.
2. From the Insert menu, choose either Audio Envelopes or Video Envelopes and then choose the type of envelope you want to add from the submenu.

Alternately, right-click an empty area of a track, choose Insert/Remove Envelope from the shortcut menu, and choose an envelope type from the submenu.
Adding envelope points

Once an envelope is placed, you may add points to it. These points are used to edit the envelope line in order to automate the control.

1. Place the mouse pointer on the envelope's line. The pointer changes to a hand icon (esture).
2. Right-click and choose Add Point from the shortcut menu or double-click to add an envelope point. A square point appears on the envelope line.

Deleting envelope points

Points may be deleted by right-clicking the point and choosing Delete from the shortcut menu. All envelope points may be deleted by selecting Reset All from the shortcut menu.

Moving envelope points

Once the envelope points have been added, you may raise and lower them to different levels along the timeline. You may move one point at a time, even during playback and check the results in real time. Also, you may set the type of fade curve after each envelope point.

1. Place the mouse pointer on an envelope point. The pointer changes to a hand icon (esture).
2. Drag the point to the desired position. As you move an envelope point, a ToolTip displays both the point’s location on the timeline and its decibel level/percent pan.
3. Click the Play ( gesture) or the Play From Start ( gesture) buttons to play back the project and check the timing of the envelope.

**Note:** You may also set the value of the point by right-clicking an envelope point and choosing a setting from the shortcut menu or choose Select All from the shortcut menu to raise or lower all points on the envelope.
Changing the envelope fade curves

Between each envelope point, you may set the type of fade curve: linear, fast, slow, smooth, or sharp. You can select either a point or a portion of the envelope to set the fade curve. If you select a portion of the envelope, Vegas applies the fade curve to that envelope segment. If you select a point, Vegas applies the fade curve to the segment of the envelope after the selected point.

1. Right-click a point or a portion of the envelope to display a shortcut menu.
2. From the shortcut menu, choose the curve type.

Hiding track envelopes

After you have set your envelopes on the tracks, you may hide them from the track view. Hiding track envelopes does not affect playback. The points that you set still automate the controls, even though the envelopes are not visible.

1. From the View menu, choose either Show Audio Envelopes or Show Video Envelopes. A submenu appears. Envelopes that are currently displayed are selected in the submenu.
2. From the submenu, choose an envelope name. All envelopes in your project of that type no longer appear in the track view.

Removing track envelopes

When an envelope is removed, the events on the track no longer have automated control and the envelope line no longer displays.

1. Select a track by clicking its track number.
2. From the Insert menu, choose either Audio Envelopes or Video Envelopes. A submenu appears. Envelopes that are currently displayed are selected.
3. From the submenu, click an envelope name. The envelope of that type is removed from the selected track.

Alternately, right-click an empty area of a track, choose Insert/Remove Envelope from the shortcut menu, and choose an envelope type from the submenu to remove that envelope.

Note: When you remove a track envelope from a track and then add it again, all points are reset.
Using the Envelope Edit tool

Envelopes can also be edited by using the Envelope Edit tool. To use this tool, click the Envelope Edit Tool button ( ) on the toolbar. The advantage of switching to this tool to edit envelopes is that events cannot be moved when this tool is selected, thereby protecting them from changes. This effectively locks all of the events and effects in a project while the various envelopes are being modified.

Selecting and adjusting envelope points
1. Select the Envelope Edit Tool button ( ) on the toolbar. The Envelope Edit tool is active.
2. Click within a track to select it.
3. Drag along the timeline to select envelope points.
4. Drag the selected envelope points to a new position.
To deselect envelope points, click anywhere in the event that is not part of the envelope.

Cutting, copying, and pasting envelope points
1. Select the Envelope Edit Tool button ( ) on the toolbar. The Envelope Edit tool is active.
2. Click within a track to select it.
3. Drag along the timeline to select envelope points.
4. From the Edit menu, choose Cut or Copy.
5. Click to position the cursor where you want to paste envelope points. Click within a different track if you want to paste envelope points across tracks.
6. From the Edit menu, choose Paste. The envelope points are pasted in the new position.

Copying an envelope to another track
1. Select the Envelope Edit Tool button ( ) on the toolbar. The Envelope Edit tool is active.
2. Click within a track to select it.
3. From the Edit menu, choose Select All.
4. From the Edit menu, choose Copy.
5. Click within a track to select it.
6. Click Go to Start ( ) if you want the envelope to appear exactly as it was in the original track, or click to position the cursor where you want the envelope to start.
7. From the Edit menu, choose Paste. The envelope is pasted on the track.
Locking envelopes to events

Track envelopes extend for the length of a track and are independent of the events on the track. This means that the envelope remains in place when you move the events in the track. Carefully adjusted track envelopes can be set to move with the underlying events, thus preserving this timing. To lock all of the envelopes in a project to the events they are contained in, click the Lock Envelopes to Events button ( ) on the toolbar or, from the Options menu, choose Lock Envelopes to Events. The lock can be toggled off by clicking the button again.

Rendering to a new track

Rendering to a new track is only available in Vegas Video.

Rendering or mixing multiple tracks to a single track can be a good method of decreasing the complexity of a project and speeding up future renders. The original tracks and their events are unaffected when you render (mix) to a single track.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them. When you render multiple tracks, any envelope or track effects that you have applied are rendered into the new track. The original source files remain unaffected and the new track(s) are saved to a new file.

When working with DV files, select a DV template to avoid any loss of quality. For more information, see Working in DV format on page 189.

Note: Every video render that uses compression results in a loss of quality from the original source material. The number of video renders performed should therefore be minimized.

1. Select the tracks that you want to combine. To mix specific events, make a time selection.

2. From the Tools menu, choose Render to New Track or press Ctrl+M. The Render to New Track dialog appears.
3. Complete the dialog as follows:

- From the **Save in** drop-down list, select the drive or folder to save the new media file.
- Type a file name in the **File name** box.
- From the **Save as type** drop-down list, choose the file format (e.g., .wav for audio or .avi for video).
- From the **Template** drop-down list, choose a format from the template list. Alternately, click **Custom** to set custom rendering settings. For more information, see *Customizing the rendering process* on page 241.
- Select **Render loop region only** if you only want to render the time selection area.
- Select **Stretch video to fill output frame size (do not letterbox)** to adjust the aspect ratio so the output frame is filled on all edges. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterbox).

4. Click **Save** to render to a new track.

As the tracks are being rendered (mixed down), a small dialog appears displaying the progress of the render. A status bar also appears in the lower-left portion of Vegas.

![Rendering Progress](image)

**Note:** You may cancel the rendering process by clicking the **Cancel** button on the status bar.

After Vegas renders the new track, it appears at the bottom of the track view. If you render the entire project, you may delete (or mute) the other tracks from the project, since they are all contained on the new track.
Adding Audio Effects

Audio effects, or plug-ins, can be used to improve the quality of the audio in a production, or can be used as special artistic effects. Additional DirectX plug-in effects, both from Sonic Foundry and other third-party plug-ins, can also be used.

Using audio effects

Vegas Video contains the complete set of audio effects plug-ins, while Vegas Video LE contains a subset. Multiple audio busses and assignable effects chains are only available in Vegas Video.

There are three ways to use audio plug-ins in Vegas: track effects, bus effects, and assignable effects. These plug-ins can be accessed by clicking the Track FX, Bus FX or Assignable FX buttons. The mix of these various methods of applying audio effects is important to the final mix of a project. For more information, see Audio Signal Flow on page 33.

- **Track effects** are applied to all events in a single track.
- **Bus effects** are applied to a bus (including the Master bus). When you add plug-ins to a bus, the tracks that are assigned to the bus are processed by the plug-in(s). Since multiple tracks can be assigned to a single bus, using bus-level audio effects is an efficient method of applying carefully customized chains of audio effects to multiple tracks. Busses reside in the Mixer window. If plug-ins are assigned at the track level, the track's signal flows through the track's plug-in(s) before the bus plug-ins. For more information, see Using busses on page 152.
- **Assignable effects** allow you to send various levels of multiple tracks to a single effect chain. Like busses, these controls reside in the Mixer window and support plug-in chains. In addition, assignable effects outputs can be routed to project busses. Click the Insert Assignable FX button in the Mixer window to add assignable effects to your project. For more information, see Using assignable effects chains on page 156.
A plug-in chain is a sequence of plug-ins to be applied to tracks, busses, or assignable effects. A plug-in chain can contain one or more plug-ins. The same plug-in can be added to a chain more than once.

After the plug-in chain is created, the audio is processed by each plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired effect.

Creating a plug-in chain

Audio tracks have a built-in plug-in chain with three default plug-ins applied as a default. For bus effects and assignable effects, however, you must first create a plug-in chain. For assignable effects, you must take the added step of creating an assignable effects chain in the Mixer window.

Creating a bus effects plug-in chain

1. Click the Bus FX button ( ) on a bus in the Mixer window. The Plug-In Chooser dialog appears.
2. Choose a plug-in and click OK. The Bus FX window displays with your selected plug-in as the first in the new plug-in chain.
3. Adjust the settings for the plug-in to create the desired effect and click outside the Bus FX window to close it.

Creating an assignable effects plug-in chain

1. Click the Insert Assignable FX button ( ) on the Mixer window. The Plug-In Chooser dialog appears.
2. Choose a plug-in and click OK. The Assignable FX window displays with your selected plug-in as the first in the new plug-in chain.
3. Adjust the settings for the plug-in to create the desired effect and click outside the Assignable FX window to close it.

Adding plug-ins to a plug-in chain

There are two ways to add plug-ins to a chain: via the Plug-In Chooser dialog and via the Plug-Ins window.

Adding plug-ins via the Plug-In Chooser dialog

The Plug-In Chooser dialog is accessed from the track, bus, or assignable effects chain into which you are adding the plug-in.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.
2. Click the Plug-In Chain button ( ) on the window. The Plug-In Chooser dialog appears. Plug-ins already in the chain appear at the top of the dialog.

3. Select a plug-in and click the Add button.

4. Repeat step 3 to add as many plug-ins as you need to create the desired effect.

5. Click OK to save the track's plug-in chain and close the Plug-in Chooser dialog. The plug-in chain appears just below the title bar in the FX window.

Adding plug-ins via the Plug-Ins window

The Plug-Ins window is a dockable window that allows you to view and choose plug-ins to be added to a track, bus, or assignable effects chain.

1. If the Plug-Ins window is not displayed, press Ctrl + Alt + I.

2. On the Plug-Ins window, navigate to the Audio folder and select the FX folder.

3. Drag a plug-in to a track, bus, or assignable effects chain.

   **Note:** You may add multiple plug-ins at the same time when you click them while pressing Shift or Ctrl and then dragging them to the desired location.

4. Confirm that the plug-ins were added by clicking the Track FX, Bus FX or Assignable FX button ( ) to view the FX window. The effects may be customized at this time.
Saving customized plug-in presets

Each plug-in has a number of preset settings that can be used to quickly determine the behavior of the plug-in. There are also a number of plug-in controls to customize the effect. Any custom configurations can be saved to a new preset.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.
2. In the plug-in chain at the top of the window, click the plug-in you want to customize.
3. Set the controls for the effect.
4. Enter a preset name in the drop-down list.
5. Click the Save button ( ) to save the preset.

Note: You may delete any presets that you have saved by selecting it from the list and clicking the Delete button ( ).

Arranging the order of plug-ins

Plug-ins are cumulative during playback. Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in's processing does not adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins, but some plug-ins work better when arranged in a particular order.

Arranging the plug-in order in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.
2. On the plug-in that you want to move, right-click to display a shortcut menu and choose Move Left or Move Right. Alternately, drag a plug-in to a new position.
3. Once the chain's plug-ins are in the order that you want, click anywhere outside the window to close it and save the new chain order.
Arranging the plug-in order from the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.

3. Rearrange the plug-in order. Drag a plug-in to a new location in the chain, or select a plug-in and click either the Shift Plug-In Left ( ) or Shift Plug-In Right ( ) button.

4. Once you arrange the plug-ins in the order that you want, click OK to save your changes and close the Plug-In Chooser dialog.

Bypassing plug-ins on the chain

You may bypass plug-ins on the chain by clearing the check box on a specific plug-in or by right-clicking the plug-in and choosing Bypass from the shortcut menu. The plug-in remains bypassed until you enable it again. Bypassing a plug-in prevents it from being processed on the track or bus.

Removing plug-ins from a chain

Plug-ins may be removed from a chain in either the appropriate FX window or the Plug-In Chooser dialog.

Removing a plug-in from the chain in the FX window

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.

2. Select the plug-in that you want to remove.

3. Click the Remove Selected Plug-In button ( ).

Removing a plug-in from the chain in the Plug-In Chooser dialog

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.

2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.

3. Select the plug-in that you want to remove and click Remove to remove it from the chain.

4. Click OK to save the chain and close the Plug-In Chooser dialog.
Saving plug-in chains

You may save and edit the plug-in chains that you added to tracks or busses or created as assignable effects chains. Saved chains retain the order of plug-ins and the settings that have been applied. Vegas stores these chains as effect packages for use in future projects. If you use the same plug-in chains regularly, saving them as packages is faster and more consistent than recreating the chain manually.

Once a chain is saved as a package, it may be used as either a track, bus or assignable effects plug-in chain. Saved plug-in chain packages appear in the Plug-In Chooser dialog.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.
2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the plug-in chain displayed at the top.
3. Click Save As. The Save Plug-in Package dialog appears.
4. Enter a name for the package.
5. Click OK or press Enter to save the package.

Editing saved plug-in chains

Plug-ins on package chains may be added, deleted, and rearranged at any time. Editing is performed in the Plug-In Chooser dialog.

1. Click the Track FX, Bus FX or Assignable FX button ( ). The appropriate FX window (Track FX, Bus FX, or Assignable FX) appears.
2. Click the Plug-In Chain button ( ). The Plug-In Chooser dialog appears with the package in the chain area.
3. Add, delete, rearrange, or change the settings of plug-ins in the package chain.
4. Click OK or press Enter to save the new settings.

Note: Click the Save As button to save the newly edited chain as a package.
Organizing your plug-ins

Within the Plug-in Chooser dialog, you may create folders to organize the plug-ins. This is useful if third-party DirectX plug-ins are installed on your computer. You may then move these plug-ins to the newly created folders.

Applying non-real-time event effects

Non-real-time event effects are a different method of applying audio effects in Vegas. In all other cases, event editing in Vegas is nondestructive, meaning that edits and effects are applied to events in real time and not to the source media files, which remain unaltered. There may be times, however, when you want to create a permanent file using an effect or effects. This may be useful in a very complicated project or when a slower computer cannot process the effects quickly enough for a real-time preview.

By applying non-real-time event effects, you can make a new copy of a media file with the effects applied to it. This new media file is saved and added to the project as a take. For more information, see Working with takes on page 113.

1. Select an audio event.
2. From the Tools menu, choose Audio.
3. From the submenu, choose Apply Non-Real-Time Event FX.
4. In the Plug-In Chooser dialog, add plug-ins to create a plug-in chain. For more information, see Adding plug-ins via the Plug-Ins window on page 145.
5. Click OK. The Plug-In Chooser dialog closes and the Non-Real-Time Event FX window appears.
6. In the Non-Real-Time Event FX window, adjust the settings for the plug-in(s) to create the desired effect.
7. Preview the effect by clicking the Preview button ( ) in the Non-Real-Time Event FX window.
8. Click OK.
9. In the Apply Non-Real-Time Event FX dialog, click Save to save the newly processed media file. The new media file is saved and added to the project as a take.
The Mixer window is where you control the project’s busses and assignable effects chains. Multiple audio busses and assignable effects chains are only available in Vegas Video.

Using the Mixer window

The Mixer is a dockable window where you can control audio busses and assignable effects chains within your project and adjust the outgoing signal’s volume and routing.

Viewing the Mixer window

The Mixer window appears in the window docking area by default when you first start Vegas. However, you may drag the Mixer within the workspace at any time to float it. For more information, see Window docking area on page 22.

To hide/view the Mixer window, choose Mixer from the View menu or press Alt+3.
Using the Mixer toolbar

The Mixer’s toolbar allows you to access project properties, add busses, and add assignable effects chains to the Mixer.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>The Project Audio Properties button accesses the project properties dialog (pg. 255).</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>The Insert Assignable FX button adds an assignable effects chain to your project. You can route tracks to the assignable effects chain (pg. 157).</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>The Insert Bus button adds a bus to your project. You can route tracks or assignable effects chains to the bus (pg. 155).</td>
</tr>
</tbody>
</table>

Using the Mixer Preview fader

The Preview fader allows you to adjust the volume and monitor output levels of media files when you preview them from the Explorer window or Media Pool, or play them back from the Trimmer window. The Preview fader also controls the metronome volume. For more information, see Using the metronome on page 162.

Viewing/hiding the Preview fader

The Preview fader is hidden as a default to make more room for other busses and assignable effects chains. To view or hide the Preview fader, simply right-click anywhere within the Mixer and choose Show Preview fader from the shortcut menu.

Adjusting the Preview fader

You may adjust the Preview fader while you are previewing a media file from the Explorer window. Drag the fader up or down, or hold the Ctrl key while dragging to move in smaller increments. Double-click the fader to reset it.

You may select a preferred meter resolution at which the Preview fader displays the media file’s volume level. For more information, see Changing bus meter resolution on page 154. You may also adjust the Preview fader to correct clipping in the same way you adjust a bus. For more information, see Adjusting a bus for clipping on page 155.

Using busses

Multiple audio busses are only available in Vegas Video.

A bus is a master control for the audio-signal mix of one or more tracks. Tracks can be assigned to play back on a specific bus. For more information, see Assigning audio tracks to busses on page 155.

However, to assign a track to a bus, you must have more than one bus in your project. Each project has a master bus as a default, but you may add up to 25 additional busses to the Mixer window. A bus is the last stage in the signal’s flow through Vegas. For more information, see Audio Signal Flow on page 33. You may configure each bus to use a specific hardware output. For more information, see Audio tab on page 258.
Adding busses to a project

You may add up to 25 busses at any time during the development of your project.

Adding a bus

Click the Insert Bus button ( ) on the Mixer window.

Adding multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio tab displaying.

2. In the Number of stereo busses box, enter the desired number of busses (up to 25) to appear in the Mixer window.

3. Click OK to add the specified number of busses and close the Project Properties dialog. The new busses are labeled with letters and appear in the Mixer window.

Deleting busses from a project

You may remove busses from your project at any time. When you remove a bus from a project, any tracks assigned to it are reassigned to the previous bus in the Mixer window. For example, if you have tracks assigned to four additional busses (Busses A-D) in your project and remove Bus D, the tracks that were assigned to Bus D are reassigned to Bus C.

Deleting a bus

1. Right-click the bus to be deleted in the Mixer window.

2. Choose Delete from the shortcut menu.

Deleting multiple busses

1. Click the Audio Properties button ( ) on the Mixer window. The Project Properties dialog appears with the Audio tab displaying.

2. In the Number of stereo busses box, enter the desired number of busses to appear in the Mixer window.

3. Click OK. All tracks assigned to a deleted bus are reassigned to the preceding bus in the Mixer window.
Routing busses to hardware

You may assign busses to use specific hardware for output. When you installed Vegas, it automatically detected the hardware available for output on your computer. For more information, see Audio tab on page 258.

1. From the Options menu, choose Preferences and click the Audio tab.
2. From the Audio device type drop-down list, choose Windows Classic Wave Driver.

   \[\textbf{Note: If you have selected Microsoft Sound Mapper in the Audio device type drop-down list on the Audio tab, you will not be able to assign the bus to a different device.}\]

3. Click OK to close the Preferences dialog.
4. In the Mixer window, click the Playback Device ( ) button on the bus you want to route.
5. Choose a hardware device from the menu.

   \[\textbf{Note: Multiple busses may be mapped to a single sound card.}\]

Working with busses

Busses in the Mixer window are fully independent and may be adjusted separately. You can adjust the bus volume, change the bus meter resolution, and adjust the bus fader to eliminate clipping.

Adjusting bus volume

You may adjust a bus’s volume during project playback by dragging the handles on the fader. The fader on a stereo bus is split so that you can adjust the levels of the two stereo channels independently.

The faders are locked (ganged) so that the left and right channels of stereo files move together. Click the Lock/Unlock Fader Channels button ( ) to unlock or lock the faders. You can also hold [Shift] while dragging a fader to temporarily override a fader’s locked or unlocked state.

   \[\textbf{Note: Double-click the fader to reset it to 0.0 dB. If you have set each channel independently, double-click either the left or right fader to have the other fader match the other’s volume setting.}\]

You may adjust the volume of several busses simultaneously by selecting the busses and adjusting any of their faders. If you select an assignable effect along with the busses, the output fader of the assignable effect moves along with the bus volume faders.

Changing bus meter resolution

You may select a meter resolution at which a bus displays the signal levels that are being mixed. When you change the meter resolution on this control, the other meters (assignable effects and preview) are automatically changed to match.

1. Right-click the meter to display a shortcut menu.
2. From the shortcut menu, choose a meter resolution.
Adjusting a bus for clipping

If the volume level is set too high, it may cause clipping. The clipping is displayed on a meter in red at the top with the clipping value displayed in decibels (dB). Adjust the fader control and click the red area with the clipping value to reset the meter. Continue to adjust the fader and reset the meter until clipping is eliminated.

The meter can be set to remember and display the highest and lowest levels by right-clicking and selecting Hold Peaks and Hold Valleys.

Muting a bus

This bus button enables you to temporarily suspend playback of the bus. When a bus is muted, the word Muted appears at the bottom of the meter. You may mute more than one bus at a time.

To mute the bus, simply click the Mute button ( ). Click the button again to restore the bus.

Soloing a bus

Soloing isolates a bus’s playback and mutes the other busses so that you can focus on a specific output. You may solo more than one bus at a time. To solo the bus, simply click the Solo button ( ). Click the button again to restore all busses for playback.

Naming or renaming a bus

Every bus that appears in the Mixer window has an editable name.
1. Double-click the bus name.
2. Enter a new name.
3. Press Enter to save the name.

Assigning audio tracks to busses

If your project contains multiple busses, you may assign a track to a specific bus.

Multiple audio busses are only available in Vegas Video.
1. Click the Bus button ( ) on the track header to display a drop-down list of available busses. This button appears only if the project contains multiple busses. For more information, see Adding busses to a project on page 153.
2. From the drop-down list, choose the bus for the track's output.

Adjusting a bus send level

You can adjust the level of a track that is sent to a bus using the multipurpose slider in the track header. Each bus send level is preset to -inf. dB (mute) by default.

1. Click the label on the multipurpose slider and choose a bus from the menu.

2. Drag the slider to adjust the level of the track sent to the bus.

**Note:** Bus sends are pre-volume by default. To change to post-volume, right-click the multipurpose slider and choose Post Volume from the shortcut menu.

Using assignable effects chains

Assignable effects are only available in Vegas Video.

Assignable effects allow you to send various levels of multiple tracks to a single audio effect chain. Like busses, these controls reside in the Mixer window and support plug-in chains. In addition, assignable effects outputs can be routed to project busses.

Click the Insert Assignable FX button ( ) in the Mixer window to add an assignable effects chain to your project. For more information, see Adding Audio Effects on page 143.

<table>
<thead>
<tr>
<th>Number/Name</th>
<th>Number and name of assignable effects. Double-click the name to edit it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Prevents the assignable effects chain from processing the track's signal.</td>
</tr>
<tr>
<td>Solo</td>
<td>Plays only the output of that assignable effects chain.</td>
</tr>
<tr>
<td>Assignable FX</td>
<td>Displays the Assignable FX window and allows you to adjust the plug-in settings.</td>
</tr>
<tr>
<td>Bus assignment</td>
<td>Allows to you assign the assignable effects chain to a bus.</td>
</tr>
<tr>
<td>Input Fader</td>
<td>Adjusts the input volume.</td>
</tr>
<tr>
<td>Output Fader</td>
<td>Adjusts the output volume.</td>
</tr>
<tr>
<td>Meter</td>
<td>Displays the incoming and outgoing signal level to the assignable effects chain.</td>
</tr>
<tr>
<td>Lock/Unlock Fader Channels</td>
<td>Locks the faders so the left and right channels of stereo files always move together. Click again to unlock the faders.</td>
</tr>
</tbody>
</table>
**Note:** To use the Output fader to control the wet/dry mix of the assignable effects chain, make sure you set each plug-in to 100% wet. Use the Output (effects return) fader to balance the dry track signal with the wet plug-in signal.

You can work with assignable effects controls in much the same way you work with busses. Use the same methods described earlier in this chapter for adjusting volume, adjusting for clipping, muting, soloing, and renaming. For more information, see Working with busses on page 154.

### Assigning audio tracks to assignable effects chains

Assignable effects are only available in Vegas Video.

Assignable effects chains are made up of one or more plug-ins that are used to add audio effects to a track’s signal. You can adjust the level of a track that is sent to an assignable effects chain using the multipurpose slider in the track header.

1. Click the label on the multipurpose slider to display a drop-down list.
2. Choose the assignable effects chain that the track will use.
3. Drag the slider to adjust the level of the track sent to the assignable effects chain.

**Note:** Assignable effects sends are pre-volume by default. To change to post-volume, right-click the multipurpose slider and choose Post Volume from the shortcut menu.

### Routing assignable effects chains to busses

When assignable effects are added to your project, they may be assigned to a specific bus for output. The bus mixes the assignable effects chain’s plug-ins along with any tracks that may be routed to the same bus. For more information, see Audio Signal Flow on page 33.

This option is only available if the project contains multiple busses. For more information, see Adding busses to a project on page 153.

1. Click the Bus button ( ) on the assignable effect control. A menu displays all the busses in your project.
2. Choose the bus to which you want to route the assignable effects chain.

The assignable effects chain displays the letter of the bus to which it is routed.
Vegas can record audio into multiple mono or stereo audio tracks while simultaneously playing back existing audio and video tracks. You are limited only by the performance of your computer system and audio hardware. Audio is recorded to a media file on your computer and into an event on the timeline. You may record into an empty track, a time selection, an event, or a combination of time and event selection. Audio output from your computer during recording is not necessarily recorded with the new audio.

Recording in Vegas does not alter any of the source media files in your project. Even when recording into an existing event, you are not overwriting the data in that event. Instead, the data is recorded into a new take for that event and saved to a media file on your hard drive.

**Setting up your equipment**

There are numerous ways to connect your equipment to your system. Refer to your equipment's documentation for specific setup instructions. The following are some possible general configurations.

**Basic setup**

This setup includes a simple microphone and speaker that are connected to the computer's sound card. With a more sophisticated microphone, you would typically want to use a preamplifier for input to the sound card.
Setup with mixer

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer's sound card. Mixers usually have pre-amps built into them. This diagram does not show you an instrument or a physical preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setups vary widely based on your mixer, instrument, and pre-amp type. Refer to your components' documentation for specific setup configurations.

Setup with digital multitrack

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would have a mixer, a microphone, etc. connected to these components. Your particular setup will vary depending on your equipment. Refer to your components' documentation for specific setup configurations.

Synchronizing MIDI timecode

Vegas can generate (output) MIDI timecode to synchronize external devices with project playback or can be triggered by MIDI timecode generated by an external device. To output, from the Options menu, choose Timecode, and from the submenu, choose Generate MIDI Timecode. To allow Vegas to be triggered by an external MIDI device, choose Trigger from MIDI Timecode from the same submenu. For more information, see Triggering from MIDI timecode on page 165 and Sync tab on page 261.

Preparing to record

Before you record, you must arm the tracks into which you will record the new audio. You must also select the recording settings for the tracks. You have the additional options of using a metronome or disabling playback during recording.
Arming the track for recording

Whether recording into an existing track, an empty track, a selected event, or a time selection, a track must be prepared for recording. You may arm multiple tracks prior to recording.

1. Click the Arm for Record button ( ) in the track header.

The first time you arm a track to record in a project, the Project Recorded Files Folder dialog displays.

2. Browse to the location where you want Vegas to save your recorded audio files.

3. Click OK.

Note: You can change the location where Vegas saves recorded files at any time. For more information, see Specifying where recordings are stored on page 166.

Once a track is armed, a record meter appears on the track header. Depending on your hardware, a record gain fader may also appear.

In addition, one of two Record Device Selector buttons appears: ( ) or ( ). The button that appears is based on the Audio device type selected in the Audio tab of the Preferences dialog. For more information, see Audio tab on page 258.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>This button appears when Use Microsoft Sound Mapper has been selected as the audio device type on the Preferences Audio tab. The Sound Mapper allows you to choose how the signal will be recorded: stereo or mono. Click this button to view a menu with Stereo, Left, or Right.</td>
</tr>
<tr>
<td>Mono left</td>
<td>This button appears when Windows Classic Wave Driver has been selected as the audio device type on the the Preferences Audio tab. When you choose this option, you can specify which device (e.g., sound card) you will record from on any given track prior to recording. Click this button to view a menu with Stereo or Mono, and a submenu with all available devices for either option.</td>
</tr>
</tbody>
</table>

Selecting recording settings

After the track has been armed for recording, select whether the track records the signal in stereo, in mono from the left channel, or in mono from the right channel. If you are using the Windows Classic Wave Driver, you also must select the device from which the track will record.

Selecting recording settings for Sound Mapper

1. Click the Record Device Selector button ( ). A menu appears.

2. From the menu, choose the recording method (Stereo, Left, or Right).
Selecting recording settings for Windows Classic Wave Driver

1. Click the Record Device Selector button ( ). A menu appears.
2. Choose either Stereo or Mono from the menu.
3. From the submenu, choose the input device.

Using the metronome

Vegas has a built-in metronome that marks time to help with the timing and tempo when recording a performance. The metronome’s sound is not mixed in the final rendering of the project. Use the Preview fader in the Mixer window to control the metronome volume. For more information, see Using the Mixer Preview fader on page 152.

To use the metronome, from the Options menu, choose Metronome. You can customize the sound of the metronome in the Audio tab of the Preferences dialog. For more information, see Audio tab on page 258.

Disabling playback during recording

By default, the project plays back while you are recording the new events. There may be times where you want to turn this off. To disable this feature, click the Options menu and make sure Simultaneous Play & Record is not selected.

Recording

You may record into an empty track, a time selection, an event, or a combination of time and event selection. The recording is added to the timeline as new take and saved into a media file on your hard drive.

Vegas also supports triggering recording from MIDI timecode.

Recording into an empty track

1. Select a track. Alternately, to record to a new track, choose Audio Track from the Insert menu.
2. Place the cursor on the timeline where you want to begin recording.
3. Arm the track by clicking the Arm for Record button ( ) on the track.
   
   If this is the first time you arm a track for recording in this project, Vegas prompts you to identify the location where the new audio files will be saved. For more information, see Arming the track for recording on page 161.
4. Start recording by clicking the Record button ( ) on the transport bar.
   
   Depending on the recording selection, a waveform is created along the timeline as you record into the armed track(s).
5. Stop recording by clicking the Record button ( ) again or the Stop button ( ) on the transport bar.
6. A small dialog opens displaying the name and location of the file or files that were just created. Click Done to return to the main workspace.

Note: The Recorded Files dialog does not appear if you are triggering from MIDI timecode, as this would interrupt the synchronizing. Instead, files are automatically named and saved according to your preferences.

Recording into a time selection

By making a time selection, you specify where along the timeline to record. The time selection also determines how long Vegas records. Any selected events that occur within the time selection are split and the recorded data is placed into the time selection. For more information, see Recording into an event with a time selection on page 164.

Vegas displays the event’s waveform as it is recorded and automatically stops recording when the cursor reaches the end of the time selection.

Recording into an event

By recording into an event, you automatically create a new take containing the recorded material that is the same duration as the selected event. The edges of the selected event serve as the punch-in and -out points that Vegas uses for recording. Recording into an event allows you to establish a pre-roll before recording, which gives you time to prepare before recording starts.

Because Vegas saves the entire recording to the media file (not just the material between the edges of the take), you are not limited to the recorded material contained in the length of the new take. You can adjust the edges of the event or slip the contents of the event if necessary. For more information, see Shifting the contents of (slipping) an event on page 95.

The existing event that you record into is not affected or deleted. Instead, the event now contains two media files, each listed as a separate take in the event. For more information, see Working with multiple recorded takes on page 165.
1. Place the cursor before the event to allow for pre-roll.

2. Press Ctrl and click the event to select it.

```
Selected event

Non-selected event
```

Note: You may record into multiple events by pressing Ctrl and making selections.

3. Click the Arm for Record button ( ) on the event’s track. When recording into multiple selected events, arm their respective tracks at this time.

4. Click the Record button ( ) on the transport bar to begin recording.

5. Click the Record button ( ) again or the Stop button ( ) on the transport bar to stop recording.

Recording into an event with a time selection

Recording into a time selection allows for a pre- and post-roll during recording. The time selection is adjustable to increase or decrease the pre- and post-roll duration. During recording, the selected event’s edges serve as the punch-in and -out points. Multiple punch-in and -out points can be created by selecting more events within the time selection.

You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record into. For more information, see Splitting events on page 94.

1. Click the Arm for Record button ( ) on the desired track(s).

2. Select the event to record into.

```
Note: You may record into multiple events by pressing Ctrl and making your selections.
```

3. On the marker bar, drag a time selection. You may adjust the time selection by dragging the selection bar’s starting and ending points. Make the time selection start before the event for a pre-roll.

4. Click the Record button ( ) on the transport bar to begin recording.
Using a pre-roll

The previous technique allows you to define the playback region with a time selection and sets the punch-in and punch-out points in the recording to the event boundaries. When the Record button is pressed, playback begins at the beginning of the time selection. The event is then filled with the newly recorded material. The audio file that is recorded to your hard disk is the full duration of the time selection. The event only contains a portion of the full recorded performance and can therefore be trimmed (both shorter and longer) and repositioned within the event.

Triggering from MIDI timecode

Recording can be triggered and synchronized in Vegas by an external MIDI device that outputs (generates) MIDI timecode (MTC). When triggering from MIDI timecode, you should have your audio devices connected together via a master digital word clock. The word clock keeps the audio hardware locked together, eliminating the need for the software to constantly vary its playback rate to stay synchronized. The incoming timecode is only used for an absolute time reference. For more information, see Sync tab on page 261.

1. From the Options menu, choose Preferences and go to the Sync tab.
2. From the Trigger from MIDI Timecode settings drop-down list, select the device that you want to trigger Vegas.
3. Click OK. The Preferences dialog closes.
4. Click the Arm for Record button ( ) on the desired track(s).
5. Right-click the Time Display and choose MIDI Timecode In. The Time Display now shows the timecode being generated from your MIDI device. The top of the display reads MTC Input Waiting.
6. Begin generating MTC from your MIDI device. The top of the Time Display now reads MTC Input Locked, the time updates from the MIDI device, and Vegas automatically begins recording. Typically, there is a short delay between when you begin generating MTC and synchronization.

Working with multiple recorded takes

Clicking the Loop Playback button ( ) on the transport bar enables you to continually create takes during recording. Takes are different versions of a recorded event that you can quickly switch between to choose the best one. Each take within an event references a different source media file.

During recording with loop playback enabled, Vegas continually repeats the time selection and starts recording a new take until you stop recording. Takes can be previewed, selected, renamed, and deleted. For more information, see Working with takes on page 113.
Specifying where recordings are stored

When you record into Vegas, the event appears on the timeline while its media source file is written to your hard drive. The first time you arm a track to record in a project, Vegas prompts you to identify the location where the recordings will be stored. By default, Vegas stores recorded media source files in the Vegas program folder.

Changing where recorded files are stored when arming a track

1. Press \text{Shift} and click the \textit{Arm for Record} button ( \text{\textbullet} ) on a track. The Project Recorded Files Folder dialog appears.
2. Browse for the location where you want Vegas to save recorded files.
3. Click \textit{OK}.

Changing where recorded files are stored when starting to record

1. Press \text{Shift} and click the \textit{Record} button ( \text{\textbullet} ) on the transport bar. The Project Recorded Files Folder dialog appears.

\textbf{Note:} You can also press Ctrl+Shift+R to specify the location for recorded files when starting to record.

2. Browse for the location where you want Vegas to save recorded files.
3. Click \textit{OK}.
Changing where recorded files are stored in the Project Properties dialog

1. From the File menu, choose Properties. The Project Properties dialog appears.
2. Click the Audio tab to display the project’s audio properties.

3. Click the Browse button. The Recorded Files Folder dialog appears.
4. Browse for the location where you want Vegas to save recorded files.
5. Click OK.
   
   You can select Start all new projects with these settings in the Project Properties dialog to store recorded media source files to the same location in every new project.

   ![Project Properties dialog]

   Path where recorded media source files are written and stored.
You created your audio project in Vegas, and now you are ready to write the project to a CD. With the CD-burning capabilities of Vegas, you can place and arrange audio files to produce professional audio CDs. You can burn CDs for multiple- or single-track projects and build audio CD layouts automatically or manually.  

\textit{CD burning is only available in Vegas Video.}

Understanding track-at-once and disc-at-once

Vegas provides two ways of recording audio to a CD-R disc: track-at-once and disc-at-once.

\textbf{Track-at-once}

Track-at-once writing records individual tracks to the disc and results in a partially recorded disc. However, the CD-R disc remains unplayable on most systems until you “close” the disc. The advantage of track-at-once writing is that you can record tracks onto the disc as you finish them versus waiting until you have finished your whole album. Track-at-once writing burns the entire Vegas project as a single track.

\textbf{Disc-at-once (Single Session or Red Book)}

Disc-at-once writing is the most common burning method in the music industry. This writing mode is used when creating a master disc to be sent to a disc manufacturer for mass replication. Disc-at-once works just as it sounds. Multiple tracks of audio are written to the CD in one recording session.

Understanding tracks and indices

You are ready to burn an audio CD. If you plan to use track-at-once to record a single track, you can proceed right on to writing the entire project to an audio CD. However, you are more likely to set up tracks—and perhaps indices—within your project and burn several tracks at once.

\textbf{Tracks} distinguish songs in the project and have a starting and ending point. Tracks are used to indicate to the CD-R device where to mark the beginning and ending of a track during the writing process.

\textbf{Indices} are single markers that subdivide a track. Indices are useful for navigating to specific areas within a track. For example, a sound effects CD may have one track of breaking glass. The track is then indexed to allow navigation to a specific glass-breaking effect within the track. However, be aware that not all CD players allow navigation to indices.

Tracks and indices are identified in a \textbf{track list}, which is a chronological text list of all tracks and indices defined in the audio CD project.
Setting up to burn audio CDs

CD burning is only available in Vegas Video.

You can adjust the Vegas environment to help you work on audio CD layout projects. You can set the project properties and adjust Vegas preferences to better accommodate writing audio CDs. Vegas sets up the ruler and Time Display window for you automatically.

Viewing the ruler and time display

Vegas automatically changes the ruler and Time Display window to audio CD time for you when CD tracks are marked.

Audio CD time formats are as follows:

<table>
<thead>
<tr>
<th>Display</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler</td>
<td>hh:mm:ss (hours:minutes:seconds) or</td>
</tr>
<tr>
<td></td>
<td>hh:mm:ss:ff (hours:minutes:seconds:frames, with fps=75) when zoomed in tightly</td>
</tr>
</tbody>
</table>

| Time Display window | tt+mm:ss:ff (track number +/- minutes:seconds:frames, with fps=75)   |

Setting project properties

Click the Properties button ( ) on the toolbar to access project properties. On the Audio CD tab, you can set the Universal Product Code/Media Catalog Number (UPC/MCN) or set the number for the first track on the CD. For more information, see Audio CD tab on page 256.

Setting preferences

From the Options menu, choose Preferences to access the Preferences dialog. On the CD Settings tab, you can select the CD drive or set the speed at which you will burn the CD. For more information, see CD Settings tab on page 260.

You can also enter the number of seconds Vegas adds between tracks when adding Media Pool files as CD tracks. In the same Preferences dialog, click the Editing tab, and enter a value in the Default time between CD tracks box.

Finally, you may want to turn off the Quantize to Frames command in the Options menu. When quantizing to frames is active, your edits are limited to the starting edge of frame boundaries. In a CD layout project, you can turn this feature off to allow greater precision in editing and track placement. For more information, see Quantizing to frames on page 109.

Importing CD Architect files

You can use Vegas to open projects created in Sonic Foundry CD Architect.

1. From the File menu, choose Open. The Open dialog appears.
2. Browse to the location of the project file.
3. In the Files of type drop-down list, select CD Architect Project Files (.cdp).
4. Select the file.
5. Click Open.
Creating audio CD layout projects

Vegas provides several ways to create an audio CD layout project. If you have a set of audio files you wish to burn to a CD, you can add the files as tracks to a new audio CD layout project. Or, if you want to burn an audio CD from an existing project, you can mark the tracks in your project either automatically or manually.

Adding media as CD tracks to a new project

You have a collection of completed audio files that you want to write to a CD. Vegas can quickly assemble an audio CD layout project from sound files in the Media Pool. You can add the tracks one at a time, or use the Media Pool to sort them into track order and add them all at once.

1. Create a new project in Vegas.

2. Add all the media to be included in the project to the Media Pool. For more information, see Adding media to the Media Pool on page 69.

3. To add all tracks at once, use the following steps to sort the files into track order:
   - In the Media Pool, click the arrow on the Views button ( ) and choose Details from the menu. The Media Pool changes to Details view.
   - In the Comments column, enter the track number for each media file (01, 02, etc.).
   - Click the Comments column header to sort the list into track order.
   - Select the sorted files in the Media Pool.

4. Right-click a media file (or the selected media files) and choose Add as CD Track from the shortcut menu.

Vegas adds the files to a new track and marks the audio CD tracks on the CD layout bar. Vegas uses the name of the media file to name each track. If necessary, you can edit the information for the new audio CD tracks using the markers on the CD layout bar or using the Edit Details window. For more information, see Working with tracks and indices on page 173.

Right-click files in the Media Pool to add them as CD tracks to a audio CD layout project.
Marking tracks in an existing project

Once you have laid out your audio project with the appropriate pauses, you can mark tracks and indices either automatically or manually.

**Note:** In DAO CD burning, Vegas burns from the beginning of the timeline to the last track marker, regardless of the location of the first track marker. Material before the first marker is included as a “hidden” track on the disc (if your drive supports burning this material).

Adding pauses

Each audio CD track in your project should have a two-second pause following it. This default setting is based on the Red Book specification for audio CDs. The exception to this standard is a continuous recording, such as a live concert CD. For a continuous recording, you can omit the pauses after tracks for continuous playback. For more information, see Red Book specification on page 279.

**Note:** The Red Book specification also requires a two-second pause at the beginning of an audio CD. If the first track in your project begins before the two-second mark, Vegas adds a ruler offset to ensure the project begins with the required two-second pause.

If you use the Add as CD Track command to add tracks from the Media Pool, Vegas adds the appropriate pauses automatically. However, if you are laying out your project manually, you must create these pauses between audio CD tracks.

1. Position the cursor where you want to insert the pause.
2. From the Insert menu, choose Time. The Insert Time dialog appears.
3. Enter two seconds in the Amount of time to insert box.
4. Click OK. Two seconds are inserted in the timeline at the cursor position.

Marking tracks automatically

Vegas can examine the events in your project and mark the audio CD tracks for you. Once Vegas marks the tracks, you can adjust them manually if necessary. For more information, see Moving track and index markers on page 173.

1. Lay out your project with two-second pauses between tracks.
2. From the Tools menu, choose Lay Out Audio CD from Events.
The new audio CD track markers appear on the CD layout bar above the timeline. Vegas uses the name of the media file for each event to name the tracks.

**Marking tracks manually**

You may make a time selection and then mark that selection as an audio CD track.

1. Make a time selection that includes the audio for the new track.
2. From the **Insert** menu, choose **Audio CD Track Region**. The markers for the new audio CD track appear on the CD layout bar.

**Marking indices**

You may create an index marker in much the same way as you create track markers.

1. Position the cursor where you want the index mark to appear.
2. From the **Insert** menu, choose **Audio CD Track Index**. The new index marker appears on the CD layout bar.

**Working with tracks and indices**

Once you have marked your tracks and indices, you can edit, move, rename, or delete them as needed.

**Navigating to and selecting tracks and indices**

Vegas provides several shortcuts for navigating to and selecting audio CD tracks on the CD layout bar.

- Double-click a track marker to select the track.
- Press \. (period) to jump the cursor to the next track or index marker.
- Press , (comma) to jump the cursor to the previous track or index marker.
- Press Ctrl + . (period) to jump the cursor to the next track marker (index markers are skipped).
- Press Ctrl + , (comma) to jump the cursor to the previous track marker (index markers are skipped).
- Add Shift to any of these keystrokes to select rather than jump. For example, press Ctrl + Shift + . (period) to select from the cursor position to the next track marker.

The shortcut keystrokes can be used to jump the cursor while working on a project or during playback.

**Moving track and index markers**

Track and index markers function just like markers and regions in Vegas (pg. 100). You can drag a track or index marker to move it along the CD layout bar. Alternately, you can use the Edit Details window to make precise adjustments.

---

**Note:** Move both the starting and ending markers for a track by pressing Alt and dragging either of the markers.

---

**Renaming track and index markers**

1. Right-click a marker and choose **Rename** from the shortcut menu that appears.
2. Type a new name for the marker and press Enter.
Deleting track and index markers

You can delete a single track or index marker by right-clicking it and choosing Delete from the shortcut menu. To delete all markers at once, right-click the CD layout bar and choose Delete All from the shortcut menu.

Editing markers using the Edit Details window

The Edit Details window provides a way to adjust the settings for a track or index.

1. From the View menu, choose Edit Details. The Edit Details window displays.
2. From the Show drop-down list, choose Audio CD Track List. The track settings display.
3. Double-click a setting to edit it:
   - Position: Adjust the track starting position or index position.
   - End: Adjust the track ending position.
   - Length: Adjust the track length.
   - Name: Enter the name of the track or index.
   - Copy protection: Determine whether or not a track may be copied from the final disc.
   - Emphasis: Enable a simple noise reduction process that is implemented by a CD player. For more information, see Emphasis on page 276.
   - ISRC: Enter ISRC number (if used).

Copying a track list from the Edit Details window

You can use the Edit Details window to copy your track list and paste it into another application.

1. Click the gray box in the upper-left corner of the Edit Details window to select all the cells.
2. Press \( \text{Ctrl} + \text{C} \) to copy the cells.
3. Switch to another application and paste the information into a document or spreadsheet.

Burning CDs

CD burning is only available in Vegas Video.

You can burn either single tracks (track-at-once) or the entire disc (disc-at-once).

Burning single tracks

You can burn your Vegas project as a single track. Once you have burned all your tracks to the CD, you must close the disc before it can be played.

Burning a track-at-once CD

1. From the Tools menu, choose Burn CD, and choose Track-at-Once Audio CD from the submenu. The Create CD dialog appears.
2. Click the Add Audio button. The approximate time remaining for the writing process displays at the bottom of the dialog box.
3. When the writing process is complete, a confirmation message displays. Click OK to clear the message.

**Note:** Do not click the Cancel button after the disc-writing process has begun. As with any CD-creation process, interrupting the writing process makes your disc unusable.

**Closing a track-at-once CD**

1. From the **Tools** menu, choose **Burn CD**, and choose **Track-at-Once Audio CD** from the submenu. The Create CD dialog appears.

2. Click the Close Disc button.

3. When the disc is closed, a confirmation message displays. Click OK to clear the message.

**Burning a disc**

1. From the **Tools** menu, choose **Burn CD**, and choose **Disc-at-Once Audio CD** from the submenu. The Burn Disc-at-Once Audio CD dialog appears.

2. Complete the information in the dialog.

   If your project uses many tracks or effects, rendering speed may be slower than a fast CD-R drive burn speed. Check the **Prerender to temporary file** check box or select a slower option in the **Speed** drop-down list to prevent buffer underruns.

3. Click OK. A progress meter displays as Vegas burns the CD.

4. When the writing process is complete, a confirmation message displays. Click OK to clear the message.

**Note:** Do not click the Cancel button after the disc-writing process has begun. As with any CD-creation process, interrupting the writing process makes your disc unusable.
While simple to learn, Vegas is a powerful application with many advanced features. This chapter covers some of the advanced video features of this powerful tool.

**Cropping video**

With the Event/Pan Crop window, you can resize media in a video event or selectively crop media without resizing. The Stretch to fill frame check box allows you to resize the media to fill the output frame (when selected), or to crop out a portion of the media without resizing (when cleared).

When keyframes are added, you can use this window to create scrolling, panning, or zooming effects. For more information, see [Using keyframe animation on page 215](#).
Open the Event Pan/Crop window by clicking the Event Pan/Crop button ( ) on the event.

![Event Pan/Crop window](image)

Note: If any controls shown in the figure above are not visible, enlarge the Event Pan/Crop window by dragging the lower right corner until all controls are revealed.

The Smoothness control and the keyframe controller are used when adding keyframe animation to create panning, zooming, or scrolling effects. For more information, see Animating event panning and cropping on page 218.

Cropping

Cropping is the process of removing the outside edges from an image or video, thereby re-framing the subject. In the following example, the Event Pan/Crop window on the left has been used to create a selection area around the subject, removing extraneous information from the outside of the video. This creates a zoom effect that is similar to zooming in with a camcorder. The Video Preview window on the right displays the event after cropping.
1. Click the Event Pan/Crop button ( ) on the event.
2. Drag the handles (small boxes) located around the perimeter of the selection area to change the size.
3. Move the mouse to middle of the selection area until the cursor changes to a move icon ( ). Drag the selection area to reposition it.

Be aware of the following as you crop a video event:

- To keep the selection area centered as you resize, select the Size About Center button ( ).
- To maintain the proportion of the selection area, select the Lock Aspect Ratio button ( ).
- To prevent distortion of the source media file, ensure that Maintain aspect ratio is selected.
- To restore the selection area to full frame, right-click the image and choose Restore from the shortcut menu.
- To set the selection area to a standard aspect ratio proportion, choose a preset from the Preset drop-down list.

The cropping occurs instantly and the results are updated in the Video Preview window. Cropping applies to the entire event and can be animated with keyframes. For more information, see Using keyframe animation on page 215.

**Rotating**

You can also rotate the selection area in the Event Pan/Crop window. If you rotate the entire frame, the background behind the video shows through. Position, size, and rotation can all be animated with keyframes. For more information, see Using keyframe animation on page 215.

1. Click the Event Pan/Crop button ( ) on the event.
2. Resize and move the selection area as desired. For more information, see Cropping on page 178.
3. Move the mouse outside the selection area until it becomes a rotate icon ( ). Drag to rotate the selection area. Alternately, you may enter precise rotation values in the Angle (degrees) box.

**Understanding the rotation clock**

As you drag to rotate the selection area, the rotation clock displays. The rotation clock works like an altimeter on an airplane. The larger hand represents the degree of rotation relative to 0°, which is straight up. The smaller hand shows the number of times the crop area has been rotated through 360°.
Adding animation

Keyframe animation dramatically increases the variety of panning, zooming, and rotating effects you can create using the Event Pan/Crop window. A later chapter provides examples of zooming in on a still image and using pan-and-scan techniques. For more information, see Animating event panning and cropping on page 218.

The tutorial at the beginning of this manual uses the Event Pan/Crop window to create a scrolling effect. For more information, see 6. Pan/Crop motion (06_panning.veg) on page 52.

Working with still images

Still images can be used in Vegas for a number of purposes including slide shows, overlay graphics, and titles. You can insert still images into projects just like any other media files. The default length for a still image event when it is first added to a track is five seconds (this is an adjustable preference), but this duration can be modified by dragging the edges to create a still image event of any length. Images cannot be looped, but share many characteristics with video files, including transparency. In addition, you can use many of the same tools on image events that you can on video events, such as track motion, panning and cropping, and video effects plug-ins. For more information, see Zooming in on a still image on page 218.

One of the sample projects included on the Vegas CD demonstrates options for working with still images. For more information, see Panning with still images on page 61.

Creating still images for use in Vegas

Many image formats can be imported into Vegas: BMP, GIF, JPG, PNG, TIFF (requires QuickTime), PSD (flattened), and TGA. If you have the option to create PNG files in your graphics software, this is the recommended file type. PNG files use lossless compression and can also include alpha channel information, which is one of the cleanest methods of creating transparency for overlays. Vegas can automatically detect an alpha channel, if present, in PNG files.

**Note:** Vegas may not automatically detect the alpha channel in TGA images. Right-click a TGA image in the Media Pool or an event on the timeline and choose Properties. Then, in the Media Properties dialog, select the type of alpha channel from the list.

If you know your media file has an alpha channel and Vegas is not detecting it properly, right-click the media file in the Media Pool or an event on the timeline and choose Properties from the shortcut menu. Then, in the Media tab, select the appropriate alpha channel type from the Alpha channel drop-down list. **Premultiplied** is the recommended setting. You can save this setting so that Vegas will properly detect the alpha channel on other media files with the same properties. For more information, see Setting custom stream properties on page 191.
Correcting images for DV pixel aspect ratios

For best results when importing still images into Vegas, create images that account for the pixel aspect ratio of your desired output format. Vegas does a good job stretching images to fit the output format, but some distortion occurs if the pixel aspect ratio for the source format does not match the destination format.

To calculate pixel aspect ratio correction, use this formula:

\[ \text{Output frame pixel width} \times \text{Output format pixel aspect ratio} = \text{Still image pixel width} \]

For example, this is the formula for NTSC DV format:

\[ 720 \text{ (DV screen frame pixel width)} \times 0.9091 \text{ (DV pixel aspect ratio)} = 655 \text{ (pixel width)} \]

Use these figures as a guide when creating images:

- Full frame, pixel-aspect-corrected still images for use in NTSC DV projects are 655x480.
- Full frame, pixel-aspect-corrected still images for use in PAL DV projects are 787x576.

Capturing a timeline snapshot

You can create still images of a single frame of your project. Once saved, the snapshot can be used just like any other still image.

1. Position the cursor on the frame of the project you wish to capture as a still image.
2. Click the Save Timeline Snapshot to File button ( ) on the Video Preview window. The Image Filename dialog appears.
3. Select a file format (JPEG or PNG) and enter a name for the new still image file.
4. Click Save. The image is added to the Media Pool.
Creating a slide show

A slide show composed of still images and an accompanying soundtrack can be an excellent way to show off your pictures. Multiple images can be inserted to instantly create a slide show, complete with crossfades.

Importing high-resolution still images and using panning, cropping, and track motion tools can add interest to an otherwise static slide show. For more information, see Cropping video on page 177 and Adding track motion on page 223.

1. In the Options menu, verify that Automatic Crossfades is selected.

2. From the Options menu, choose Preferences. Adjust the following settings on the Editing tab:
   - Enter the length for the still images in the New still image length box.
   - Select Automatically overlap multiple selected media when added.
   - Enter the length of the automatic overlap in the Amount box in the Cut-to-overlap conversion section of the dialog.

3. Click OK. The Preferences dialog closes.

4. Select all of the images you want to use in the Explorer.

5. Right-click and drag these files to the timeline.

6. From the shortcut menu, choose Add Across Time.

   The crossfades between images can be replaced later by dragging transitions to the crossfade regions. For more information, see Using transition effects on page 211.

   It is best to use images that are the same size as your project’s frame size. You may also need to change the pixel aspect ratio of an image file to get it to display correctly. For more information, see Modifying media file properties on page 191.

Creating titles

Most video projects include titles and credits. There are two ways to add text to your project. You can use the Vegas titling engine (text generator) or you can use an external image-editing program to create titles. For more information, see Using generated media on page 198.
Creating titles from images

While every software application is slightly different, the general procedure for creating titles with a transparent background is as follows.

1. Start your image-editing application.

2. From the **File** menu, choose **New**. Set the dimensions of the new image to be the same as the frame size for the project. For more information, see Correcting images for DV pixel aspect ratios on page 181. Make the default canvas (background) color a solid color. The background will be transparent in the final image, so any solid color works.

3. Select the Text tool and enter the text for your title.

   **Note:** Size and position your titles carefully to fit within the Title Safe Area or the titles may extend beyond the edges of your television. For more information, see Identifying safe areas on page 232.

4. From the **File** menu, choose **Save As**.

5. From the **Save as type** drop-down list, choose TGA, PNG, PSD or BMP (PNG is recommended). Make sure that you save the alpha channel information (for TGA and PNG), which is used for transparency.

6. Enter a name and click **Save**.

7. In Vegas, insert the image in a track just above the one with the video that will be in the background.

8. Click the Compositing Mode button ( ) on the title track and choose **Source Alpha** (default) if your image has an alpha channel associated with it. If it does not, you may need to add a Chromakey filter to the image and key out the background. For more information, see Chromakeying on page 208.

   **Note:** The alpha channel is saved as a selection area in some programs. If you cannot save the alpha channel, use a black background and Vegas will create a mask from the background. The alpha channel of TGA images may not be detected automatically. For more information, see Modifying media file properties on page 191.
Fading titles

Another common technique is to fade a still title in and out. This effect can be accomplished by using an Opacity envelope on a title event. For more information, see Using opacity envelopes on page 126.

You may also create multiple title images and then use crossfades or custom transitions between them. For more information, see Using transition effects on page 211.

Adding closed captioning to Windows Media Video (WMV) files

Closed captioning makes your final video accessible to a wider audience. You can use text commands to add captions line-by-line to a Windows Media Video (WMV) file, or for longer projects, you can add captioning from a script.

Adding closed captioning line-by-line

1. Position the cursor where you want the closed captioning text to appear.
2. From the Insert menu, choose Command. The Command Properties dialog appears.
3. From the Command drop-down list, choose Text.
4. In the Parameter box, enter the closed captioning text you want to display.
5. Click OK.
6. Repeat steps 1-5 for each line of closed captioning text you want to add.
7. Render your file in Windows Media Video format. For more information, see Rendering a project on page 239.

Note: Take steps to ensure that the closed captioning displays when the video is played. For more information, see Displaying closed captioning on page 186.

Adding closed captioning from a script

Using a script to generate closed captioning involves several steps. First, you must copy and paste the lines from the script into a spreadsheet. You can create the spreadsheet from scratch (using the steps that follow) or use the sample shell (Vegas Captioning Shell.txt) provided in the Samples folder on the Vegas CD. You can open this tab-delimited shell with a spreadsheet application or, in the absence of a spreadsheet application, any text editor.

Once the spreadsheet is complete, you can copy and paste the lines into the Edit Details window. You can set the position for each line of closed captioning during playback in Vegas.
Creating a script spreadsheet

1. Create a four-column, tab-delimited spreadsheet.
2. In the first column, enter 00:00:00:00 in each of the cells as a placeholder. You will set the actual position of each line during playback in Vegas.
3. In the second column, enter TEXT in each of the cells to specify the command type.
4. In the third column, enter the text that you want to display as a closed caption. Enter each line in its own cell.

**Note:** If you have a script, you can copy and paste individual lines into the cells.

5. In the fourth column, enter a label to identify your captions. An entry such as Line 001 can help you sort the captions once you paste them into Vegas.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>But, soft! What light through yonder window breaks?</td>
<td>Line 001</td>
</tr>
<tr>
<td>2</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>It is the east, and Juliet is the sun</td>
<td>Line 002</td>
</tr>
<tr>
<td>3</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Arise, fair sun, and kill the envious moon</td>
<td>Line 003</td>
</tr>
<tr>
<td>4</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Who is already sick and pale with grief</td>
<td>Line 004</td>
</tr>
<tr>
<td>5</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>That lends her maid art far more fair than she</td>
<td>Line 005</td>
</tr>
<tr>
<td>6</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>But not her maid, since she is wondrous</td>
<td>Line 006</td>
</tr>
<tr>
<td>7</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>Her vestal livery is but sick and green</td>
<td>Line 007</td>
</tr>
<tr>
<td>8</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>And none but fools do wear it, cast it off</td>
<td>Line 008</td>
</tr>
<tr>
<td>9</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>It is my lady, O, it is my love</td>
<td>Line 009</td>
</tr>
<tr>
<td>10</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td>O, that she knew she were</td>
<td>Line 010</td>
</tr>
<tr>
<td>11</td>
<td>00:00:00:00</td>
<td>TEXT</td>
<td></td>
<td>Line 011</td>
</tr>
</tbody>
</table>

**Note:** The final caption displays in the Windows Media Player until the end of the video. To clear the final caption sooner, add a final command with no text (as shown above).
Copying and pasting captions into Vegas

1. Select the cells in the spreadsheet and copy them.
2. Switch to Vegas and choose Edit Details from the View menu. The Edit Details window appears.
3. From the Show drop-down list, choose Commands.
4. Right-click the gray box in the upper-left corner and choose Paste from the shortcut menu. Vegas pastes the spreadsheet data into the Edit Details window.
5. Click the column header for the Comments column. This sorts the captions by line number.
6. Render your file in Windows Media Video format. For more information, see Rendering a project on page 239.

Setting closed captioning timing

1. Position the cursor shortly before where you want the first caption to occur.
2. Select the row for the first caption in the Edit Details window.
3. Click the Play button (▶) to start playback.
4. When playback reaches the place where the first caption should occur, press Ctrl + K. Vegas inserts the first caption at the cursor position, updates the Position setting in the Edit Details window, and selects the next caption.
5. Press Ctrl + K to insert each subsequent caption.

Displaying closed captioning

You may use one of two methods for displaying the closed captioning when the video is played:

- Instruct your audience to turn on captioning. In Windows Media Player 7 and 8, choose Now Playing Tools from the View menu and choose Captions from the submenu.
- Create an HTML page with the Windows Media player embedded in it. See Vegas online help for a sample HTML page.
Resampling video

Resampling allows Vegas to interpolate frames in an event when the frame rate of a media file is lower than the project’s frame rate. With resampling, the intervening frames are interpolated from the source frames, much like a crossfade between the original frames.

You can instruct Vegas to resample the video of a single video event or to resample the entire project at the time of final rendering:

- **Resample event:** Right-click a video event and choose Properties from the shortcut menu. In the Video Event tab of the Properties dialog, select the Resample check box. For more information, see Accessing event properties on page 124.
- **Resample project:** From the File menu, choose Render As. In the Render As dialog, click the Custom button to access custom rendering settings. Select the Resample the frame rate of all video check box. For more information, see Customizing the rendering process on page 241.

Resampling at either the event or project level perform the same function. There are few cases where resampling may be particularly important:

- When the frame rate of the source media for an event is slower than the project's frame rate. For example, when you are using a source media file that has a 10 fps rate in a 29.97 fps rate project, resampling is recommended.
- When changing the speed of a video event. For example, when slowing a clip to 30% using a velocity envelope, resampling is recommended.
- When creating vertically scrolling titles.
When any of the above situations is true, there are only ten frames of source material for every second of project time. When the project is rendered, there must be roughly thirty frames in each second. Vegas must create the frames between the source media frames, sometimes known as padding. The easiest way to do this is to simply duplicate the previous frame. This can result in less than smooth video playback. Resampling allows Vegas to interpolate the intervening frames more smoothly.

Using Edit Decision Lists (EDL)

Vegas Edit Decision Lists (EDL) are text lists of all of the media files used, where they are placed, and how they are trimmed. As such, Vegas EDLs are not the same as EDLs used in traditional linear edit suites. These simple text lists can be used as a printed summary of your project, can be used to open a Vegas project in another compatible application, or can be used to convert a project from another application into a Vegas project. There are some necessary limitations to this conversion process because of the great disparity between video editing applications.

Creating an EDL

1. From the File menu, choose Save As. The Save As dialog appears.
2. From the Save as type list choose EDL Text File (.txt).
3. Enter a name for the file and browse for a destination.
4. Click Save.

EDLs created in another application can also be used to open a rough copy of a project created in another application in Vegas. For example, you could create an EDL from a project in a third-party editing application and then import the project into Vegas via the EDL. For best results, save the EDL file and source media files in a single folder before opening the EDL in Vegas.

Opening an EDL

1. From the File menu, choose Open.
2. Locate the EDL file, select it, and click the Open button. If you are working on another project, Vegas prompts you to save your work before it opens a new project.

Note: EDLs do not contain any information about the location of source media. Therefore, the EDL file should be saved in the same directory as the source media. If it is not, or if media is stored in a number of different locations, Vegas prompts you to relink these files when the EDL is imported.

Because of the significant differences between editing applications, third-party (CMX and Sony) EDL files may not bring all of the project data into Vegas. Among other differences, events are inserted into the timeline on a single track, all transition effects are replaced with crossfades, and only four audio tracks can be imported.
Working in DV format

Vegas is optimized for DV editing. If your project is destined for tape or television, the DV format is an excellent choice. The new Sonic Foundry DV codec provides video with excellent image quality, even over multiple generations, and provides audio that is better than CD-quality. If you start with well-shot DV footage and stay within the DV format throughout the editing process, you can output broadcast-quality video programs from Vegas. This section provides guidelines for working in the DV format in Vegas.

Selecting source media

Wherever possible, use DV source video clips. You can capture video from DV cameras and decks using an IEEE-1394 card with no quality loss. You can also convert analog footage to DV using a device like the Sony DVMC-DA2 media converter, or the PowerR Director's Cut analog/DV converter (a good choice for PAL).

Setting project properties

Set your project to match the DV format of your final output. This provides a true WYSIWYG view of the project when you use an external monitor for previewing. This also prevents you from stretching output or changing field order unnecessarily. You can match the project settings to a DV source file by using the Match Media Settings button ( ) in the Project Properties dialog. For more information, see Setting video properties based on a media file on page 66 and Modifying project video properties on page 190.

Selecting templates

Always select a DV template when performing any of the following tasks in a DV project:

- prerendering video (pg. 231)
- rendering to a new track (pg. 141)
- printing video to tape from the timeline (pg. 246)
- rendering a project (pg. 239)

Rendering to a new track and printing video to tape from the timeline are only available in Vegas Video.

When prerendering video or rendering to a new track, a DV template not only optimizes playback performance, but also helps you avoid needless recompression of DV footage. Vegas recompresses DV material only when necessary. Cuts-only DV sequences are not recompressed when you output the project to DV from the timeline or in Video Capture.

The DV templates are designed to provide high quality, pixel aspect-correct, DV-compliant renders when rendering a project or printing to tape from the timeline. Do not select an uncompressed setting when choosing rendering or print-to-tape options. An uncompressed setting produces a large file that will not print back to DV tape from Video Capture or from the timeline.

Eliminating out-of-range colors

The DV format allows color values to exceed NTSC and PAL color level standards. If you have a scene you know is too “hot”, or if you want to be sure that your video stays within legal broadcast levels, apply the Broadcast Colors effect to specific events or the entire project. Set the effect to the Clamp preset. You can use a histogram to help identify out-of-range colors. For more information, see Preparing projects for broadcast on page 233.
Be aware that applying the Broadcast Colors effect results in recompression of the video. As a result, render times can increase significantly when the effect is applied to the entire project.

With the Sonic Foundry DV codec and the smooth clamping capability of the Broadcast Colors effect, you will not see any serious degradation in picture quality. The only noticeable difference will be in pure white portions of the video, which will be smoothly clamped to legal broadcast levels.

**Modifying video properties**

**Modifying project video properties**

Project video properties can be accessed by clicking the *File* menu and choosing *Properties* or by clicking the Project Video Properties button ( ) on the Video Preview window. Many of these settings are identical to the settings found on the Project tab of the Custom Settings dialog. Final render properties set up in the Custom Settings dialog override the following Project Properties settings. *For more information, see* Video tab on page 243.

These properties control all of the default settings for your project. Without making any changes, these are also the settings that are used to create a final rendered movie file.

- **Template:** Select a preset template to automatically configure the remaining video controls in this dialog. Many popular formats are included, but you should consult your hardware manuals if you have any questions. You can also save your own custom template.

- **Match Media Settings ( )** allows you to set your project properties to match the properties of a media file of your choosing.

- **Width** and **Height:** Sets the frame size of your final movie.

- **Field order:** Video that is displayed on a television is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first can be important. Choose None (Progressive) for video to be viewed on a computer monitor. For DV output, choose Lower Field First. If the output is jittery or shaky, or your hardware’s manual specifies it, choose Upper Field First. *For more information, see* Interlacing and field order on page 267.

- **Pixel aspect ratio:** Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.9091 (NTSC DV, D1), 1.0926 (PAL DV, D1), or other rectangular variations. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. Select the aspect ratio for the final movie’s destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

- **Frame rate:** The television frame rate in the US, North and Central America, parts of South America, and Japan (NTSC) is 29.97 frames per second (fps). In many parts of the world, including Europe and much of Asia, the television standard is PAL at 25 fps. France, Russia, and most of Eastern Europe use SECAM, which is a variation on PAL and also uses 25 fps.

- **Full resolution rendering quality:** For most projects, Good is the recommended setting. If you have critical material where nothing but the highest quality rendering will do, select Best. Please note that rendering time may increase dramatically as large amounts of extra processing is required for the Best setting.

- **Prerendered files folder:** Vegas saves prerendered preview files to this location. *For more information, see* Prerendering video on page 231.

- **Start all new projects with these settings:** Select this option to always use these settings for new projects.
Modifying advanced video properties

Click the Advanced button in the Project Properties dialog to access these attributes. In most cases, the default settings for this dialog are adequate. These settings affect how Vegas renders transitions, effects, overlays, and changes in velocity.

- **Motion blur type**: Some effects and transitions can involve motion or animation. This list allows you to select whether the frames are blurred slightly to create the illusion of motion on individual frames. This can make computer generated animation appear more smooth and natural. Gaussian is the best choice in most situations where blurring is required.

- **Exposure time (seconds)**: This determines the time frame of the blurring. Longer exposures (>0.100) result in greater and more exaggerated blurring.

- **Deinterlace method**: Source video from a television is interlaced. When Vegas renders effects, it needs to deinterlace the two fields that make up a frame. The exact method used can be selected here, although the default Blend fields is adequate in most situations.

Modifying media file properties

Vegas tries to automatically detect the properties of your media files. In most cases, these properties do not need to be modified, but there are times when you may need manual control over some of these attributes, depending on the type of file and your specific hardware configuration.

1. Right-click a file in the Media Pool or an event on the timeline and, from the shortcut menu, choose Properties.
2. Modify the parameters on the Media tab as needed.
3. Click OK.

**File name**: Displays the file name (cannot be edited).

**Tape name**: This can be used to display the name of the tape for media files captured in Video Capture. The name can be edited here or in the corresponding field in the Edit Details window.

**Timecode** (not all video files include timecode information):
- **Use timecode in file**: This is the default.
- **Use custom timecode**: This option allows you to set the timecode manually.
- **Timecode format list**: If you have selected Use Custom timecode above, this list contains the available timecode formats. SMPTE Drop (29.97 fps, Video) for example, is the timecode format for NTSC DV. Changing the timecode format does not change the source media file in any way. It merely changes how the file is measured in time. For more information, see Timecode on page 269.

Setting custom stream properties

Media files are opened in Vegas with a set of default values. When you change any of the values for a media file, these changes are saved for that file in the current project only. If you want to change the default settings for a particular type of video file whenever that type of file is used in Vegas, click the Save settings to video profiles for future auto-detection button ( ) to the right of the Stream list. This adds an entry to a file called vegas video profiles.ini that can be referenced for future use.

- **Stream**: If the file has more than one stream of the given type, this allows you to select the particular stream to work with.
- **Attributes/Format/Frame rate**: Displays basic information about the file.
- **Field order**: This is used to control how the video file is handled on a television monitor and depends on your hardware. If a media file is jittery or jumpy when played on a television, changing this setting may help.
- **Pixel aspect ratio**: This can be changed, but should always match the source video's properties.
- **Alpha channel**: The alpha channel determines how transparency is handled in a file. The default Alpha Channel setting for most video files is None. PNG image files can have an alpha channel that is automatically detected by Vegas.

**Modifying output properties**

Final output properties can be adjusted when you render your final movie. For more information, see *Creating custom rendering settings for AVI files* on page 243.
Using Video FX, Compositing, and Masks

Video plug-ins in Vegas include effects and generators. Effects cover a broad range of electronic modifications that can be used to improve substandard video or artistically enhance a production. Generators can be used to create custom video events such as credit rolls or gradient overlays.

Vegas provides a variety of options in compositing video and using masks. Compositing involves mixing visual elements together into a final output. Vegas provides multiple compositing modes from which to choose. Masks, which are used extensively in television and movies, are an important part of creating overlays. Together, these professional tools can help you polish your productions.

Vegas Video provides multiple compositing modes and parent/child video track grouping (for masks), while Vegas Video LE limits you to source alpha compositing.

Using video effects

Vegas provides a great variety of video effects plug-ins that are ready for you to drag-and-drop onto your projects, media files, tracks, and events. Previews of the different effect presets appear in the Video FX window. In addition to the presets, each plug-in has individual controls that allow you to customize the effects in precise detail. Video effects can be animated using keyframes. For more information, see Using keyframe animation on page 215.

The mix of video effects applied at different levels (to events, tracks, files, etc.) is important to the final mix of a project. For more information, see Video Signal Flow on page 34.

In general, effects are applied in the following order:

- to files in the Media Pool
- to events
- to tracks
- to the project (video output effects)
Adding a video effects plug-in

Video effects can be applied to events, tracks, files in the Media Pool, or to an entire project. You can add a plug-in by selecting it in the Plug-In Chooser dialog, or you can drag-and-drop the plug-in from the Video FX or Plug-Ins windows.

Adding a plug-in using the Plug-In Chooser

1. Click the Video FX button ( ) in one of the following locations (see the illustration):
   - Media FX are applied before a media file is inserted into an event on the timeline. Every occurrence of this media file in a project has the effect applied to it.
   - Event FX are applied to events on the timeline.
   - Track FX are applied to the output of a particular track.
   - Video Output FX are applied to the final output and affect every event in a project.

2. In the Plug-In Chooser dialog, select the effect that you would like to apply and click OK.

3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.
Adding a plug-in from the Video FX or Plug-Ins window

1. If the Video FX or Plug-Ins window is not currently visible, choose either Video FX or Plug-Ins from the View menu to view the appropriate window.

2. Drag and drop a plug-in from the window onto one of the following locations. The mouse cursor changes to indicate when you can drop the plug-in.
   - file in the Media Pool
   - event
   - track header or empty section of a track
   - Video Preview window (video output effects)

3. Modify the effect in the Video FX window and close the window when you are finished. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Working with video effects plug-in chains

Plug-ins can be used in chains of two or more for even greater flexibility. A plug-in chain is a sequence of all of the plug-ins to be applied to a media file, event, track, or project. The same plug-in can be added to a chain more than once. Use the same steps to add additional plug-ins to a chain as you use to add a single plug-in. For more information, see Adding a video effects plug-in on page 194.

After the plug-in chain is created, the video is processed by each plug-in in order. The plug-ins are cumulative so, in some cases, you may want to rearrange their order to achieve the desired effect.
To view and work with a plug-in chain, click the Video FX button ( ) for the event, track, Media Pool file, or Video Preview window to open the Video FX window.

Bypassing plug-ins
Video effects plug-ins can also be temporarily bypassed (turned off) by deselecting them (clearing the check box on the plug-in). Since the effects are rendered very quickly in the Video Preview window, turning a plug-in on and off allows you to see the results of the plug-in on your project.

Changing the plug-in order
Video effects plug-ins are applied in the order that they appear in the chain. You can change this order by dragging the plug-in button to a new location in the chain. Alternately, you can click the Plug-In Chain button ( ) in the Video FX window and reorder the plug-ins in the Plug-In Chooser dialog.

In the following illustration, you can see how the order of plug-ins is important.

The goal of the above example is to use video effects plug-ins to create a very high-contrast mask out of a video clip of fire. In the image on the left, a Brightness and Contrast plug-in is applied first and then a Black and White plug-in. In the image on the right, the Black and White plug-in was applied first, removing the color, and then the Brightness and Contrast plug-in was applied. The mask created by the second example is much cleaner, even though all of the settings of the two plug-ins are identical.
Removing a plug-in

1. Click the FX button ( ) on the event, track, Media Pool file, or Video Preview window that has the plug-in applied to it. The Video FX window appears.
2. Click the plug-in that you want to remove.
3. Click the Remove Selected Plug-In button.

Modifying a video effects plug-in

Video effects plug-ins are highly customizable. You may select from a variety of presets or adjust the settings for custom effects. You may also save custom settings to be used again as a new preset.

1. Click the FX button ( ) on the event, track, Media Pool file, or Video Preview window that has the plug-in applied to it. The Video FX window appears.
2. Select a preset from the Preset drop-down list or adjust the parameters as needed. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Changes you make are automatically updated in the Video Preview window, using the current cursor position as the example. To see the effect as applied to the video in motion, create a time selection (looped region) and preview in loop playback.

Saving custom plug-in settings as a preset

1. Click the Preset text box. The name of the current preset is highlighted.
2. Type a new name for the preset and click the Save button ( ).

To use a saved custom preset, simply choose it from the drop-down list.
Using keyframe animation with plug-ins

Keyframe animation can be used to control a plug-in over time. Keyframes are added to the keyframe controller at the bottom of the Video FX window. Since a number of plug-ins can be added to a single event, track or project, click the plug-in’s button in the chain and modify the particular attributes and keyframe controller for that plug-in. For more information, see Using keyframe animation on page 215 and Animating video effects plug-ins on page 221.

Using generated media

Generated media is a special class of plug-in that creates virtual media files contained in events on the timeline. These virtual files are stored in the Media Pool and their properties can be viewed and modified there.

Generated media provide an easy way to add text, backgrounds, or test patterns to your project. You can view the generators by choosing Text/Backgrounds from the View menu to display the Text/Backgrounds window.

Generated media events can be animated using keyframes. For more information, see Using keyframe animation on page 215 and Animating generated text on page 222.

<table>
<thead>
<tr>
<th>Generated media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color gradient</td>
<td>Creates gradient colored events to be used behind overlays, as masks, or for fades.</td>
</tr>
<tr>
<td>Credit roll</td>
<td>Creates events that format your test into credits.</td>
</tr>
<tr>
<td>Solid color</td>
<td>Creates solid colored events to be used behind overlays or for fades.</td>
</tr>
<tr>
<td>Test pattern</td>
<td>Creates standard test patterns that can be used to calibrate your video output stream. Many studios and broadcast facilities require a color bar pattern at the beginning of your video so that engineers can calibrate their equipment.</td>
</tr>
<tr>
<td>Text</td>
<td>Creates events containing text for titles or simple credits. Text can be formatted with color, shadows, and other effects.</td>
</tr>
</tbody>
</table>

Adding a generated media event

You may add a generated media event by choosing Generated Media from the Insert menu. This adds the event at the cursor position in the selected track. But perhaps the simplest way to add generated media is through drag-and-drop.

1. From the View menu, choose Text/Backgrounds. The Text/Backgrounds window displays.
2. Drag a generator from the Text/Backgrounds window to the project. The mouse cursor changes ( ) to indicate when you can drop the generator.
3. Modify the generator in the Video FX window and close the window when you are finished. To modify settings at a later time, click the Generated Media button ( ) on the event. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

A generated media event is ten seconds long as a default. However, you may trim the event to any length. For more information, see Trimming an event on page 92.
Duplicating a generated media event

Once you have added a generated media event and modified its settings, you may duplicate it. For more information, see Duplicating events on page 92. When you duplicate a generated media event, you have two options:

- **Create a new copy.** The new event may be modified on its own and is completely independent of the original event.
- **Create a copy that references the original.** The new event remains linked to the original generated media event. Any change to either event is mirrored in the other.

Compositing

Compositing is the process of mixing visual elements together into a final output. In Vegas, this means mixing tracks together vertically. Masks, generated text, and chromakeying all involve compositing. Understanding how compositing works in Vegas is important to understanding these and many other video track mixing techniques.

Vegas Video provides multiple compositing modes and parent/child video track grouping (for masks), while Vegas Video LE limits you to source alpha compositing.

Understanding the parent/child track relationship

The key to understanding overlays, masks, transparency, and compositing is to understand the parent/child relationship between tracks. In general terms, the parent track is the highest track in a group of tracks (often only two) and the behavior of the child tracks (i.e., how they are composited together) is determined by the parent track.

One of the sample projects included on the Vegas CD demonstrates compositing. For more information, see Compositing with masks on page 61.

The following three examples demonstrate different compositing relationships.

The first example shows two independent tracks. The top track contains a generated text event that has a transparent background. The second track therefore shows through the transparent areas in the Video Preview window. Since the second track does not have any transparent areas, any tracks below it would be completely obscured.
In the second example, track two is the child track of track one (the parent track). This parent/child relationship was set up by clicking the Make Compositing Child button ( ) on track two's track header. This makes the text in track one act as a mask over track two, allowing the fire to show through the mask (i.e., the text). The region outside of the text is still transparent, but there is nothing below these tracks, so it appears black.

Parent/child video track grouping using the Make Compositing Child button is only available in Vegas Video.

In the third example, a generated media event was added to the track below the first two tracks, which are already paired in a parent/child relationship. The color gradient event in track three shows through the transparent area of the top two paired tracks.

Selecting compositing modes

Vegas Video provides multiple compositing modes, while Vegas Video LE limits you to source alpha compositing.

The Compositing Mode button ( ) determines how the transparency in a video track is generated. Since lower tracks show through higher tracks, it is the compositing mode of the higher track that determines how much of the lower track shows through.

The compositing mode of the lowest video track is a special case. Selecting a mode for the lowest track affects its transparency against a black background.

To select a compositing mode, click the Compositing Mode button and choose a mode from the menu that appears.
The sample below uses a generated text event that is partially transparent. For more information, see Using generated media on page 198.

The following table shows how these two sample tracks are blended using each of the compositing modes.

<table>
<thead>
<tr>
<th>Compositing mode</th>
<th>Sample</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td><img src="image1.png" alt="Sample" /></td>
<td>Adds the overlay color values to the background.</td>
</tr>
<tr>
<td>Subtract</td>
<td><img src="image2.png" alt="Sample" /></td>
<td>Subtracts the overlay color values from the background.</td>
</tr>
<tr>
<td>Multiply (Mask)</td>
<td><img src="image3.png" alt="Sample" /></td>
<td>Multiplies the overlay color values by the background color values. This makes overlay colors stronger and more present and results in a darker video image. The opposite of this mode is Screen.</td>
</tr>
<tr>
<td>Source Alpha</td>
<td><img src="image4.png" alt="Sample" /></td>
<td>Uses the alpha channel to determine transparency in the overlay. This compositing mode is based on the alpha channel characteristics of an event or media file. If no alpha channel is present in the overlay, the Source Alpha compositing mode has no effect.</td>
</tr>
<tr>
<td>Cut</td>
<td><img src="image5.png" alt="Sample" /></td>
<td>Cuts out the overlay color values from the background.</td>
</tr>
<tr>
<td>Screen</td>
<td><img src="image6.png" alt="Sample" /></td>
<td>Multiplies the inverse of the overlay color values with the background color values. This makes overlay colors weaker and less present and results in a lighter video image. The opposite of this mode is Multiply.</td>
</tr>
</tbody>
</table>
### Adjusting opacity with the Composite level slider

The transparency or blending of the overlay can be precisely controlled with the Composite level slider. Left is transparent and right is 100% opaque. You can also double-click the current value to enter a specific numeric percentage.

<table>
<thead>
<tr>
<th>Compositing mode</th>
<th>Sample</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlay</td>
<td><img src="overlay.png" alt="Overlay Sample" /></td>
<td>Heightens contrast by using Multiply mode on darker colors and Screen mode on lighter colors.</td>
</tr>
<tr>
<td>Hard Light</td>
<td><img src="hard_light.png" alt="Hard Light Sample" /></td>
<td>Adds overlay colors as if the overlay were lit by a bright, focused spotlight.</td>
</tr>
<tr>
<td>Dodge</td>
<td><img src="dodge.png" alt="Dodge Sample" /></td>
<td>Brightens the background based on the overlay color values.</td>
</tr>
<tr>
<td>Burn</td>
<td><img src="burn.png" alt="Burn Sample" /></td>
<td>Darkens the background based on the overlay color values.</td>
</tr>
<tr>
<td>Darken</td>
<td><img src="darken.png" alt="Darken Sample" /></td>
<td>Compares the overlay and background pixel by pixel and selects the darker color value for each pixel.</td>
</tr>
<tr>
<td>Lighten</td>
<td><img src="lighten.png" alt="Lighten Sample" /></td>
<td>Compares the overlay and background pixel by pixel and selects the lighter color value for each pixel.</td>
</tr>
<tr>
<td>Difference</td>
<td><img src="difference.png" alt="Difference Sample" /></td>
<td>Compares the overlay and background pixel by pixel and subtracts the darker color value from the lighter color to generate a new color value (difference).</td>
</tr>
<tr>
<td>Difference Squared</td>
<td><img src="difference_squared.png" alt="Difference Squared Sample" /></td>
<td>Remaps color values along a parabolic curve. The color values of the layers in the composite group are subtracted, and then the subtracted values are squared. The resulting image will have less extreme changes in color values as the colors approach black (RGB 0,0,0) and more extreme changes in color values as colors approach white (RGB 255,255,255).</td>
</tr>
</tbody>
</table>
Creating masks

Masks are used to create overlays, limit the effects of a filter, and to create transparent titles. In their simplest form, masks work by making a particular color in an image or video transparent. More complex effects can be created with gradients (smoothly blending transparent areas together) and by altering the sensitivity of the mask.

*Parent/child video track grouping using the Make Compositing Child button is only available in Vegas Video.*

Creating image masks

You can use Vegas generated media to create simple masks. You can also create masks from just about any image file.

1. Create an image of a solid white circle on a black background in any paint program. This will be the mask.
2. Add the mask image file as an event into the top-most track on the timeline.
3. Insert a video event just below the mask track. This is the background video behind the mask and is the event that is masked.
4. Click the Make Compositing Child button ( ) located on the track header of the background video (lower) track. This makes the lower track the child of the mask track (the parent track).

In the following example, the white circle is a BMP image file. Black is 100% opaque and white is completely transparent.
Masks can also be partially transparent. By using gradients and grayscale images, smooth blending can be achieved. Black is still 100% transparent and white is opaque, but the grays in between are only partially opaque.

The effects of the masks are very clear in these examples, but this is not how they would actually be used in a real production. Masks are commonly used to isolate a portion of the video from an effect. Masks do not need to be black and white, or grayscale, nor do they need to be still images.

**Note:** It is best to use images that are the same size as your project’s frame size. You may also need to change the pixel aspect ratio of an image file to get it to display correctly. For more information, see Correcting images for DV pixel aspect ratios on page 181 and Modifying media file properties on page 191.

Creating video masks

Video files can also be used to create masks, although the process can be more complicated than using an image as a mask. The key to any mask is contrast. Increasing difference between the light and dark areas of a video file can be accomplished using video effects plug-ins.

1. Insert the video that you want to use as a mask into a video track.
2. Drag a Black and White plug-in from the Video FX window to the event to remove the color. For more information, see Adding a video effects plug-in on page 194.
3. Drag a Brightness and Contrast plug-in from the Video FX window to the event.
4. Adjust the Brightness and Contrast to create the mask. Watch the Video Preview window for a real-time preview of the mask. Adjust the effect so that parts of the video are completely black (opaque) and other parts are completely white (transparent). This can often mean increasing the Contrast while decreasing the Brightness.
5. If necessary, mask areas can be inverted (reversing the black and white areas) with an Invert plug-in or by selecting the Invert check box in the Mask Generator window. For more information, see Using the Mask Generator on page 206.

After you have created the mask, place it in the highest track. Add another video event to another track below the mask and click the Make Compositing Child button ( ) on that track. Any video that appears in a lower track below the Parent mask track and its Child shows through the areas outside of the mask. The entire setup is pictured in the following illustration.

**Fine tuning masks**

Depending on the source material, creating a clean mask can be a tricky exercise. A few tools and tricks can be used to fine tune a mask.

- **Solo the track** - Click the Solo button ( ) on the track header to mute all of the other video tracks in a project. This allows you to concentrate exclusively on the mask.
- **Toggle effects** - Turn individual plug-ins on and off to isolate effects in a plug-in chain. Keep in mind that the order of the plug-ins in the chain is important in determining the final composited output.
- **Isolate channels** - Isolate individual color channels in the Video Preview window by clicking the Overlays ( ) button. Click the arrow button to the right of the main button to select the specific channel to be isolated and whether to display this channel in grayscale only. Then click the main button to toggle the channel display on and off. The Alpha as Grayscale option isolates the alpha channel mask and displays it in grayscale. For more information, see Understanding the Video Preview window on page 229.
Using the Mask Generator

The Mask Generator is a plug-in that controls the transparency of events to be used as masks. Apply the plug-in to an event (or a track) in the same way as any other plug-in: just drag-and-drop. The Mask Generator plug-in can be found in the Video FX window (from the View menu, choose Video FX).

The Mask Generator and parent/child video track grouping is only available in Vegas Video.

The Mask Generator is also an automatic part of the compositing process between parent and child tracks. To open the Mask Generator window, click the Mask FX button ( ) on any track that is the parent of another. For more information, see Compositing on page 199.
How the Mask Generator works

The following illustration demonstrates some of the effects of the Mask Generator. The background image is the original mask. There are five ellipses on the mask: white, red, green, blue and an invisible alpha channel. Note especially the dashed-line ellipse in the lower left of the mask; this is the alpha channel. Alpha channels can be based on a color or can be defined in a graphics program that supports alpha channel creation. Masks with alpha channels must be saved in a format that supports this method of transparency, such as PNG or TGA. As in this example, the alpha channel may be invisible in the actual mask.

The top-right example uses luminance to determine the transparency in the mask. The white area is completely transparent. Since white is made up of 100% values of red, green, and blue (255,255, and 255), those three colors are all 33% transparent as well. In the lower-right example, blue is the selected transparent index. The blue area is 100% transparent and so are all areas that have a value of 255 for blue (0,0,255), including white (255,255,255).
Chromakeying

Chromakeying or blue screening is a special case of overlay transparency. A color key is a specific color or a range of similar colors in an image that are made transparent, allowing a background video to show through. The idea is to take a video subject and film it against a solid, uniform background color. It is critical that the color be smooth and uniformly lit with no shadows, and that the color chosen for the background not be used in the subject.

The most important factors in successful blue screening happen during shooting, well before the footage is imported into Vegas. Compression of the source video is also an important consideration. While almost all video is compressed in some way, highly compressed video does not key well because colors can be smeared together and edges tend to not be very sharp.

If your source footage is good and the captured video file is also of high quality, color keying is an easy process.

1. Insert a video with a blue (or any solid colored) background into a track. This is the overlay video.
2. Insert the background video that will show through the blue areas into the next lower track.

**Note:** You do not need to set the lower track as a child track when using the Chroma Keyer plug-in as you would with a mask.

3. Click the overlay video (foreground, higher track) to select it.
4. Drag a Chroma Keyer plug-in from the Video FX window onto the overlay video. The Video Event FX window displays.
5. Click the Bypass All Video FX button ( ) on the Video Preview window. This will bypass the effect of the Chroma Keyer plug-in until you are ready to view the effect.
6. In the Video Event FX window, click the Eyedropper button ( ). The cursor changes to an eyedropper icon.

7. Draw (click and drag) a small rectangular selection area around the color(s) to key out. Although you can select the color range from just about anywhere, the Video Preview window is the best location.

**Note:** Other effects that may change the color of the event should be turned off when using the Eyedropper tool.

8. Click the Bypass All Video FX button ( ) on the Video Preview window to restore the video effects. The Video Preview window shows the result of the Chroma Keyer plug-in.

When a subject is filmed against a solid colored background in a studio, the background color can be keyed out and made transparent using the Mask Generator or the Chroma Keyer plug-in. A wider range of colors can be selected using the Chroma Keyer plug-in, making it the perfect tool for less-than-perfect blue screens.

This procedure selects a small range of colors to use as a key. In the example above, the blue sky around the dome is far from uniform and it would be difficult to key it out with a traditional blue screen key. The color is uniform enough however, that a range of blues can be selected directly from the preview image in Vegas. Use the controls at the bottom of the dialog box to determine the sensitivity of the colors selected. Since the filter selects a range of colors, it is a good idea to try to select a relatively small range of similar colors. Drawing a color selection area that spans both blue and red colors would make very large sections of an overlay transparent. It is possible to use multiple Chroma Keyer plug-ins on a single event, keying out the blues with one and the reds with the other, without keying out any colors between blue and red.
One of the most fun and exciting aspects of editing video on a computer is adding special effects. When you combine all of the transitions, filters, and motion generators, Vegas has an almost unlimited variety of effects.

Transitions are customizable in Vegas Video. Vegas Video LE provides standard presets only.

Understanding basic transitions

Transitions occur between two video events. Most professional productions, on television or on the big screen, use only two types of transitions. The first is a simple cut, where one scene immediately cuts to the other without delay or effects. The other is a fade, otherwise known as a crossfade or a dissolve.

Cuts

A cut is actually not a transition. Instead, the last frame from an event is immediately followed by the first frame of the next event. This is what happens with two adjacent events on the Vegas timeline, either in the same track or in different tracks. This can also happen when an event is punched into another (with fade edge edits turned off).

Crossfades

You can fade one event out and fade into the next event by simply overlapping the two. The duration of the transition is determined by the amount of overlap. For more information, see Crossfading events on page 97.

Using transition effects

Transition effects are more complex than a simple cut or crossfade. While each effect can be customized in different ways, the procedure for adding a transition effect is uniform.
Adding a transition

1. Insert a video event onto the timeline.

2. Insert another event so that it overlaps the first to create an automatic crossfade.

3. In the Transitions window, browse for a transition effect. If the Transitions window is not visible, choose Transitions from the View menu.

4. Drag the effect onto the crossfade between the two events.

The duration of a transition is automatically determined by the amount of overlap between the two events. As with other events in Vegas, the precise duration of a transition can be controlled by dragging the edges in and out. You can also slide a transition for more precise control. For more information, see Sliding a crossfade on page 98.

The original crossfade... ...and the new transition effect.

One of the fastest ways to convert a crossfade to a transition event is to right-click the automatic crossfade, choose Transition from the shortcut menu, and choose the transition that you want to insert (e.g., Insert Sonic Foundry Iris). Some transitions also have their own shortcut keys. On the numeric keypad, press [F] to insert a crossfade, [S] to insert a dissolve, and [W] to insert a linear wipe. Holding the Ctrl key while pressing any of these keys converts the transition to a cut at the cursor position.

Adding a transition to the end of an event

Typically, a transition occurs between two events on a track, but transitions can also be used to fade to and from the background, whether that is an underlying image, video, or background color. For example, you can drag a Clock Wipe transition to the end of a video event and have the wipe go from the video event to black.

Understanding track layers

Transitions can also be viewed and modified in a different mode. Click the Expand Track Layers button (A) to expand the track to reveal three layers within the main track. These layers are called A roll, B roll, and Transition roll.

The concept of an A/B roll is fundamentally different from the Vegas multitrack philosophy. Every track is in some way mixed (composited) into the final output in a multitrack system, but events are not mixed on the A/B roll. Instead, either the A roll or the B roll is playing, with the two trading places during a transition. You could mix the two for as long as you want with a transition, but they do not blend without an intervening transition. Transitions move from one roll and into the other. This could be from A to B or from B to A. The direction of the transition is automatically set by Vegas. The small arrows on the side of the transition event indicate this direction.
As the sequence at the right shows, the video output can shift from the A to the B and back to A many times during a production, but there is only one video output from any particular roll at a time. This means that the A and B rolls are not composited.

**Converting a cut to a transition**

The transition between two events that are adjacent to each other on the same track is instantaneous and is called a cut. If the first event is trimmed back from the end and the second event is trimmed back from the beginning (both have enough media to overlap), the cut can be transformed to a transition effect, using this extra media.

1. Right-click the line between two adjacent events at the cut position.
2. From the shortcut menu, choose Transition and then choose the transition that you want to insert (e.g., Insert Sonic Foundry Iris).

You can also drag a transition to the cut from the Transitions window.

The duration of the newly inserted transition event is determined by the Cut-to-overlap conversion time set in the Editing tab of the Preferences dialog. To access this dialog, choose Preferences from the Options menu.

---

**Note:** There must be enough media in the respective events to cover the transition (e.g., the end of the first event must not be the end of the media file).

Cuts between audio events can also be converted to crossfades. Position the timeline cursor on the cut and press [F] on the numeric keypad to create a crossfade. There must be enough media on either side of the cut to create the crossfade.
Previewing a transition

The easiest way to preview a transition is to set the preview area to the duration of the transition and then loop the playback. You can then adjust the transition while it is playing, quickly making your changes in real time.

1. Double-click the transition. This automatically creates a time selection equal to the length of the transition.
2. Click the Loop Playback button ( ) to toggle automatically repeated playback. The selection area bar is dark blue when Loop is turned on.
3. Click the Play button ( ).

To preview complicated transitions, you may want to build a dynamic RAM preview or prerender the effect. For more information, see Building dynamic RAM previews on page 232 or Prerendering video on page 231.

Modifying a transition

Transitions are customizable in Vegas Video. Vegas Video LE provides standard presets only.

All of the transitions in Vegas include several presets that create standard transitions. Most transitions are highly customizable with many attributes that can be changed. In addition, transitions can be animated using keyframes. For more information, see Using keyframe animation on page 215.

1. Click the Transition Properties button ( ) on the transition or right-click the transition and choose Transition Properties from the shortcut menu. The Video Event FX window appears.
2. Change the parameters. Changes are updated in real time in the Video Preview window. For help on the different controls in the Video FX window, click the Plug-In Help button ( ) to access online help.

Saving custom settings as a preset

After modifying a transition, it is possible to save the changes as a preset for use at a later time. Default and custom presets can be accessed from the Preset drop-down list.

1. Modify the settings in the window to create your desired transition effect. For help on the different controls in the window, click the Plug-in Help button ( ) to access online help.
2. Click the name in the Preset drop-down list. The current text (Untitled) is highlighted.
3. Enter a name for the new preset.
4. Click the Save Preset button ( ).

Any additional changes can be instantly saved to the custom preset by clicking the Save Preset button.
Using keyframe animation

Keyframe animation is a technique that computer artists use to quickly make complex animated sequences. Instead of drawing every frame of a title scrolling in from top to bottom by hand, an animator simply has to set a starting and ending position for the animation and let the computer interpolate the intermediate frames. The animation pictured on the right has three keyframes: a starting, middle, and ending keyframe. More complex animations use more keyframes.

While keyframing motion may be the most obvious use for keyframe animations, just about any parameter of an effect can be animated with keyframes. Vegas uses keyframe animation techniques in many areas, including transition effects, video effects, event panning and cropping, generated media, and track motion. Color, brightness, transparency, motion, size, perspective, and many other parameters can be controlled this way.

Understanding the keyframe controller

The keyframe controller appears at the bottom of the Video FX window (used for transitions, effects, and generated media), the Track Motion window, and the Event Pan/Crop window.

The cursor position is marked by a flashing line on the controller. This position can also be automatically updated on the timeline, with the Video Preview window also updating in real time to reflect changes. Click the Sync Cursor button ( ) on the keyframe controller to sync the keyframe cursor with the timeline cursor.
Adding keyframes

Every effect has a starting keyframe at the beginning (left side) of the keyframe controller. This sets the initial parameters for the effect. In order to animate the effect, it is necessary to add another keyframe to the effect and change some of the parameters. When you first add a new keyframe, it has the same settings (for the transition, effect, pan/crop, etc.) as the first keyframe. You can then modify the settings of the new keyframe to create the animation from the first keyframe settings to the second.

1. Click the keyframe controller timeline to move the cursor where you want to add a keyframe. The current position is marked by a blinking cursor.
2. Click the Create Keyframe button ( ).
3. Modify the settings in the window for the new keyframe as desired.

Alternately, you can automatically add a new keyframe by positioning the cursor in the keyframe controller and changing any parameters in the window. Vegas adds a keyframe with the new settings at the cursor position.

Deleting keyframes

1. Select a keyframe in the keyframe controller.
2. Click the Delete Keyframe button ( ).

Navigating in the keyframe controller

Use the keyframe navigation buttons (First, Previous, Next, and Last) to quickly jump to a keyframe. Alternately, press \[\text{Ctrl} + \text{<} \] or \[\text{Ctrl} + \text{>} \] to move to the previous or next keyframe.

Modifying keyframes

After you create your keyframes, you can move them, copy and paste them, and change the interpolation curves between them.

Moving keyframes

You can move a keyframe within the keyframe controller by dragging it to a new position. For track-level keyframes, you can also move the keyframes from track view. For more information, see Working with keyframes in track view on page 217.

Copying and pasting keyframes

Keyframes on the controller can be copied, pasted, and duplicated.

1. Right-click a keyframe.
2. From the shortcut menu, choose Copy.
3. Right-click the keyframe controller at the position where you want to paste the keyframe.
4. From the shortcut menu, choose Paste.

Duplicating keyframes

1. Right-click and drag a keyframe to a new position.
2. From the shortcut menu, choose Copy. A duplicate keyframe is created at the new position.

You can also duplicate a keyframe by holding the \[\text{Ctrl} \] key while dragging it.
Changing the interpolation curve

You can right-click a keyframe to choose a different shape for the interpolation curve. The shortcut menu provides five options: Hold, Linear, Fast, Slow, and Smooth. Selecting Hold from the shortcut menu prevents any animation from being interpolated between two keyframes. The color of the keyframe indicates which interpolation curve is being used.

Changing the relative spacing of keyframes

The relative positions of the keyframes can be changed as a group. This can be useful if you need to change the overall length of an animated sequence or if you need to copy a set of keyframes to another event that has a different duration than the original.

1. Hold the Shift key and click the first and last keyframes in the sequence to select all of the keyframes.
2. Hold the Alt key and drag to scale the keyframes.

When copying keyframes from longer events to shorter events, you must temporarily lengthen the duration of the shorter event so that all of the keyframes appear on the keyframe controller. Once you have pasted the keyframes, you can rescale the keyframes using the above procedure, and then resize the event to its original length.

Working with keyframes in track view

Track keyframes can be moved in track view. These keyframes are used in the following three track-level effects:

- Track effects plug-in (pg. 194)
- Track motion (pg. 223)
- Mask generator plug-in on a parent compositing track (pg. 206)

Viewing and moving track keyframes

Once you have added keyframes to one of these track-level effects, the track keyframes appear at the bottom of the track on the timeline. Click the Expand Track Keyframes button ( ) to view the keyframes.
You can drag a keyframe on the track in the same way you would in the keyframe controller. To move several keyframes at once, use the Envelope Edit tool ( ) to select and drag multiple keyframes.

Adding new track keyframes
You can add new track keyframes to an existing track-level effect by double-clicking the track keyframe area.

Editing track keyframes
Double-click a track keyframe to open the associated window and adjust the settings. To change a keyframe interpolation curve, right-click the keyframe and choose a curve type from the shortcut menu.

Locking track keyframes
When track keyframes are locked, you can move events along the track and the keyframes move along with them. Only keyframes that occur within the selected events move.

Select the Lock Envelopes to Events button ( ) to lock track keyframes to the events on the track.

Hiding track keyframes
If track view becomes too cluttered, you may hide track keyframes from view.
1. From the View menu, choose Show Video Envelopes.
2. From the submenu, choose Track Keyframes to hide track keyframes.

Sample uses for keyframe animation

The following section provides several examples of how keyframe animation can be used with features such as event panning and cropping, video effects plug-ins, and generated text events.

Animating event panning and cropping
You can combine event panning and cropping tools with keyframe animation to create several special effects. For more information, see Cropping video on page 177.

Zooming in on a still image
By using keyframe animation in the Event Pan/Crop window, you can zoom in and out on a still image. In this example, four keyframes are used to zoom in on faces in an old photograph and zoom back out again. A generated color gradient event masks the edges of the image during the zoom to enhance the effect. For more information, see Using generated media on page 198.
1. Click the Event Pan/Crop button ( ) on the still image event.

2. Click the keyframe controller to position the cursor for the second keyframe.

3. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a portion of the image.

4. Click the keyframe controller to position the cursor for the third keyframe.

5. Click the Add Keyframe button ( ). Resize and move the selection area to zoom in on a different portion of the image.

6. Click in the keyframe controller near the end of the event to place the final keyframe.

7. Click the Add Keyframe button ( ).

8. Right-click in the selection area and choose Restore from the shortcut menu. The selection area is zoomed out to include the full image for the last keyframe.

9. Preview the event in the Video Preview window. Adjust the settings in the Event Pan/Crop window as you preview the zoom effect.

Using pan-and-scan

Another way to use keyframe animation in the Event Pan/Crop window is panning, or pan-and-scan. Pan-and-scan is a technique commonly used when film is converted for television. Movie screens and film are usually wider (~2.35:1) than television (~1.33:1). When you transfer the film to video, you have four choices: (1) squash the film horizontally to fit, distorting it in the process; (2) crop it, possibly losing
information on the sides; (3) letter box it so the top and bottom have black areas and the picture is shorter overall; and (4) pan-and-scan. Pan-and-scan is a variation of cropping, where someone goes through the movie and moves the crop area back and forth to follow the action or subject.

1. Click the Event Pan/Crop button ( ) on the event. The Event Pan/Crop window appears.
2. Confirm that the Stretch to fill frame check box is selected.
3. Right-click the selection area and choose Match Output Aspect from the shortcut menu.
4. Select a starting position, size, and angle of rotation for the crop rectangle. This is the start position (first keyframe).
5. Click in the keyframe controller and press Ctrl+End. This moves the cursor to the end of the event.
6. Click the Create Keyframe button ( ). A new keyframe appears in the keyframe controller at the end of the event.
7. Change the position, size, and angle of rotation. This is the final position (last keyframe).
8. Preview the event. Add and adjust keyframes as needed to create the desired effect. You can adjust both temporal and spatial interpolation for each keyframe:

   - **Temporal interpolation** (how the pan occurs over time) is controlled by the keyframe interpolation curve type. Experiment with temporal interpolation by right-clicking a keyframe to change the interpolation curve type (hold, linear, fast, slow, smooth) and previewing the result. For more information, see Changing the interpolation curve on page 217.

   - **Spatial interpolation** (how the pan occurs within the video image) is controlled by the Smoothness setting of each keyframe. If you have three or more keyframes, the blue arc in the window shows the path of the center of the frame during the panning. A smoothness value of 0 makes the movement linear from one keyframe to the next. A higher smoothness value makes the path of the pan more curved. Select a keyframe and change the Smoothness value to adjust spatial interpolation.
Keyframe animation can be used to smoothly and gradually apply an effect to an event. This example uses the Add Noise plug-in. The Add Noise plug-in adds static or noise to a video sequence. When added to a simple solid-colored background with a monochrome setting and animated, a pattern is produced that is similar to a television that is not tuned to any station.

1. Add an Add Noise plug-in to an event. For more information, see Adding a video effects plug-in on page 194. The Video FX window appears with the keyframe controller at the bottom of the window.

2. Add two keyframes to the event for a total of three including the one at the beginning. New keyframe attributes are copied from the previous keyframe.

3. Click the first keyframe to select it. Drag the Noise level slider to 0.

4. Click the last keyframe to select it. Drag the Noise level slider to 0.

5. Click the second keyframe to select it. From the Preset drop-down list, select Grainy.

6. Hold [Ctrl] and drag the second keyframe to duplicate it. Position this new keyframe between the second and final keyframes.
The effect is off at the first keyframe and smoothly transitions to a grainy effect at the second keyframe, at which point the effect remains constant until the third keyframe. Then the effect gradually fades out until it reaches a minimum value at the last keyframe.

Keyframe 1
Noise = None

Keyframes 2 and 3
Noise = Grainy

Keyframe 4
Noise = None

The results of gradually transitioning into an effect using keyframe animation.

Animating generated text

You can add a generated text event to a project by dragging a text generator from the Text/Backgrounds window. For more information, see Using generated media on page 198. You can then animate the text by adding keyframes.

Not all attributes of generated text media can be animated using keyframes, however. You cannot, for example, morph one text message into a different one. Some aspects can be easily and smoothly animated using the keyframe controller, such as text, color, transparency, leading, tracking, and position.

Other aspects of generated text do not allow interpolated keyframe animation. For example, if you set the text to “One” initially and then at five seconds change it to “Two”, the text will suddenly jump to the new value at the five second keyframe. This behavior is different from the behavior of other keyframe animation techniques.

In this example, keyframes are used to make a title appear one letter at a time across the screen.

1. Drag a text generator from the Text/Backgrounds window to the timeline.
2. Right-click the new event and choose Edit Generated Media.
3. Enter the first letter of the title, for example “T”.
4. Click the keyframe controller at the 1.000 second mark and enter the second letter, for example “y”. The title now reads “Ty”. A new keyframe is added to the keyframe controller at the 1.000 second mark.
5. Proceed down the keyframe controller to 2.000 and enter the letter “p”.
6. Proceed down the keyframe controller repeating this process until the title is finished: “Typing”.
7. Preview the event in the Video Preview window. The word “Typing” appears one letter per second until finished.

![Video Preview Window]

**Adding track motion**

The Track Motion window is used to move a video track across a background. This background can be a solid color, another video event, or an image. Picture-in-picture effects and scrolling title sequences are two simple cases where this tool is important.

The gray area in the center of the window (covered by the blue/gray rectangle) represents the actual screen or area that is visible in the movie. The area outside of the main screen, which is filled with dotted lines, is the general workspace. The video you are moving can be positioned off of the visible screen and then animated onto and across the screen. The dots are markers to help position the video window. If snapping is enabled, these serve as “snap to” points. The main window allows you to control the placement, size, and
orientation of the overlay video through time. The blue and gray rectangular overlay in the middle represents the video on the track. The large “F” is used to represent the orientation of the track and is especially useful in indicating a track that has been flipped.

You can also create blue guide lines to help you align objects by moving to the edge of the ruler and dragging towards the center of the workspace to create a new line. Existing guides can be repositioned by dragging. Guidelines can also be used to snap the video window.

Using the track motion shortcut menu

When you right-click anywhere in the Track Motion window, a shortcut menu appears:

- **Restore** returns the overlay to its original state.
- **Center** moves the overlay to the center of the frame.
- **Flip Horizontal** flips the overlay backwards or left to right.
- **Flip Vertical** flips the overlay upside-down.
- **Match Output Aspect** sets the aspect ratio to the frame value.
- **Match Source Aspect** sets the x,y ratio to the overlay value.
- **Background** sets the color of the overlay window.

Controlling the track motion workspace

The track motion workspace allows you to position the video within the project frame. As you move the mouse around the workspace, it changes shape to indicate when you can move ( ), resize ( ), or rotate ( ) the overlay. When the mouse cursor changes to a hand ( ), you can click and drag to move around the workspace.

Select the **Zoom Edit Tool** ( ) to zoom using the mouse. Click the workspace to zoom in or right-click the workspace to zoom out. You can also use a mouse wheel to zoom in and out on the workspace.
Using keyframes in track motion

Keyframes are what create the motion in the track motion feature. You can create, modify, and remove keyframes in the keyframe controller in the same way as with any other Vegas feature that uses keyframes. *For more information, see Using keyframe animation on page 215.*

The keyframe controller in the Track Motion window has three attributes that can be animated: Position, Shadow, and Glow. Each effect can be animated independently. The Shadow and Glow effects can be turned on and off. Each effect has its own set of controls that appear on the left-hand side of the window. These controls can be accessed by clicking the respective item on the keyframe controller.

**Note:** If any controls described in this section are not visible on the screen, enlarge the Track Motion window by dragging the lower right corner until all controls are revealed.

### Position

Controlling the position of the overlay is easily accomplished in the main window by dragging the blue/gray overlay. However, the controls in the dialog are invaluable when you need precision in resizing, moving, or rotating the overlay. The smoothness option allows you to modify the smoothness of the interpolation curve among three or more keyframes.

Zooming can be used to shrink or expand the video overlay. The Grid Density is used to control the ruler settings and snap to points.

This creates a simple drop shadow that appears under the entire window or only under the opaque (nontransparent) parts of the overlay. The size and offset of the shadow can be controlled and animated, and you can specify the shadow color. A shadow is especially effective under a picture-in-picture window or to emphasize text and titles. Use the Eyedropper tool to select a specific color from anywhere on the screen.

### Shadow

### Glow

Glow is a bright haze surrounding an overlay. In general, light colors are used for glow effects, but you can emphasize bright text on complex backgrounds by using a very small black glow, with little or no feathering, and 100% intensity.
Creating a picture-in-picture effect

Picture-in-picture is an easy effect to reproduce using track motion. This effect is used in the tutorial at the beginning of this manual. For more information, see 8. Track Motion (08_trackmotion.veg) on page 55. Track motion is also used in one of the sample projects included on the Vegas CD. For more information, see Track motion on page 62.

1. Insert the background video into a track.
2. Insert the overlay video into another track just above the background video track.
3. Click the Track Motion button ( ) on the upper overlay track.
4. In the Track Motion window, position and resize the track area.

The illustration below shows some of the relevant parts of this procedure. Note the shadow cast by the overlay video. This is added by selecting the Shadow check box on the keyframe controller. The Video Preview window displays the results.

Note: While overlay picture-in-picture windows are often completely opaque, you can fade them in and out using opacity envelopes. For more information, see Using opacity envelopes on page 126.

Animating the overlay

Many aspects of an overlay can be animated using the keyframes at the bottom of the Track Motion window.

1. Insert a video event onto the timeline.
2. Click the Track Motion button ( ) on the track header.
3. In the Track Motion window, resize the overlay by dragging the handles at the edges of the overlay.
4. Drag the middle of the overlay to position it. This will be the size and position for the start of the animation.
5. Click the timeline of the keyframe controller at a later time to move the cursor to that position.
Note: With the Sync Cursor button ( ) enabled, you can also navigate to a new position on the main timeline. Vegas automatically moves the cursor on the keyframe controller to the same location.

6. Reposition the overlay. A new keyframe is automatically added to the keyframe controller at the new cursor position.

Note: You can constrain your movement as you reposition the overlay by clicking the Move Freely button ( ) until it changes to Move in X only ( ) or Move in Y only ( ).

When you preview the video, Vegas interpolates the position of the overlay between the two keyframes with a smooth animation.

Rotating the overlay

You can also rotate the overlay. To rotate the overlay by a precise number, enter a value in the Angle (degrees) box. Alternately, you can use the mouse for freehand rotation.

1. Move the cursor outside of the track area box. The cursor changes to a rotate icon ( ).
2. Drag to rotate. The clock icon in the Track Area shows the orientation of the track and the exact angle is displayed in a small ToolTip below the cursor.
3. To change the center of rotation, drag the clock icon to a new location.

Flipping the overlay

You can flip the overlay horizontally or vertically to further augment a track motion effect.

1. Right-click the overlay. A shortcut menu appears.
2. Choose either Flip Horizontal or Flip Vertical. The overlay flips and the Video Preview window shows the effect.
As you work in Vegas, you can preview your video by using the Video Preview window or by connecting to an external monitor. You can optimize previews by adjusting preview quality, prerendering video, or building a dynamic RAM preview. The Video Preview window also provides features such as safe area overlays and histograms to further enhance your productivity.

External monitor support and dynamic RAM previews are only available in Vegas Video.

Understanding the Video Preview window

The workspace for editing video can get quite crowded, so the Video Preview window can be configured in a number of ways to make it more useful. The Video Preview window can be used on a separate monitor (if your video hardware supports this feature), docked at the bottom of the workspace, or floated freely on the screen.
Using the Video Preview window shortcut menu

Right-click the Video Preview window to adjust the following options:

- Choose **Default Background**, **Black Background**, or **White Background** to set the background color for the window.
- **Display Square Pixels** displays the output in square pixels. This can prevent distortion of the preview when using sources with rectangular pixels. This does not affect the final render.
- **Display at Project Size** displays the output at the project’s dimensions only.
- **Show Toolbar** toggles the toolbar at the top of the window.
- **Show Status Bar** toggles the information display at the bottom of the window.

Optimizing the Video Preview window

Timing and synchronization are critical aspects of any multimedia production. Because complex multimedia projects are challenging for any computer, Vegas provides a number of tools to maintain real-time playback even though the computer may not be able to process the data quickly enough.
Reducing preview quality

The resolution of the Video Preview window and the quality of the preview rendering can be adjusted to improve playback. Lower-resolution previews are less clear but allow Vegas to display more frames. This may be particularly important with projects that use overlays, transitions, and effects. Click the Preview Quality button to choose different preview resolutions.

Prerendering video

There are times where nothing but a full, high-quality preview will do. In these cases, Vegas can take the time necessary to selectively render only the portions of your project that need extra processing. Vegas prerenders these sections and creates short files to use for previews. The prerendering can take anywhere from a few seconds to a few minutes, depending on the length and complexity of the video.

Once these temporary files have been created, Vegas uses them whenever it plays back those sections of the project, increasing playback quality and performance. As long as no changes are made to the events in the prerendered sections, Vegas continues to use the newly created files for previews, even if changes are made to other sections of the project.

1. To prerender a portion of the project, create a selection containing the portion you want to prerender.
2. From the Tools menu, choose Selectively Prerender Video. The Prerender Video dialog appears.
3. Select the type of preview file to create in the Prerender as drop-down list. Click the Custom button to configure any custom compression options.
4. To preview just a portion of the project, verify that Render loop region only is selected. To create a preview of the entire project, clear this check box.
5. Click OK. A progress bar displays the progress of the render.

When prerendering is complete, green bars appear at the top of the timeline indicating the sections that have been prerendered.

As a default, Vegas saves these preview files when a project is closed. To delete these files when you close the project, from the Options menu, choose Preferences and, on the General tab, clear the Save active previews on project close check box.

The location of these preview files can be set by clicking the Properties button (Attitude) on the toolbar and choosing a Prerendered files folder in the Project Properties dialog. Ideally, this folder should be on a different physical drive from where Windows is installed. Prerendered preview files can be deleted from your hard disk by choosing Clean Up Prerendered Video from the Tools menu.
Building dynamic RAM previews

Dynamic RAM previews are only available in Vegas Video.

Vegas automatically drops video frames when previewing if the computer can't keep up with processing demands. This means that you may not be seeing all video frames as you preview your project. If you prefer not to prerender your project, there is another option for improving previews of selected portions of a project. Vegas dedicates a portion of your RAM to cache video frames that Vegas cannot render in real time. Vegas automatically maintains a cache of 16 MB for dynamic RAM previews. To change the cache amount, choose Preferences from the Options menu and change the Dynamic RAM Preview Max value on the Video tab.

Note: Although not all frames appear in previews of a project, all frames are included when you render a file. For more information, see Rendering a project on page 239.

You can make a time selection and add each frame in the selection to the cache. Once the frames are cached, Vegas can display all video frames in a selection.

1. Select a region containing the frames you want to cache.
2. From the Tools menu, choose Build Dynamic RAM Preview.

Vegas plays through the time selection and builds the cache frame by frame.

Identifying safe areas

The Video Preview window in Vegas displays the entire video frame data. However, most television monitors do not display all of this data. Previewing the video on a television monitor is the only way to verify what frame information will display. You should also note that individual television monitors vary in what they display. While there is no substitute for previewing on a television, safe areas are a good method of estimating the extent of the masking.

1. Click the down arrow on the Overlays button ( ) and choose Safe Areas.
2. Click the Overlays button to toggle the safe areas display on or off. The display shows two areas:
   - The Safe Action area is the frame area that is visible on a television screen.
   - The Safe Title area is a suggested area to limit the extent of titles. It is always smaller than the Safe Action area.

To customize the safe areas, choose Preferences on the Options menu, and on the Video tab, enter the Action safe area and Title safe area values as a percent of the frame size.

For more information, see Video tab on page 254.
Using histograms

A histogram helps you evaluate the color levels and contrast of your video. Use the Video Preview window’s histogram before rendering your project to find and correct out-of-range color values that could cause problems on the destination playback device.

The bar graph plots the number of pixels that exist for each color intensity. For example, when using the Histogram - Blue setting, the vertical axis represents the number of pixels, and the horizontal axis represents the RGB color range from 0,0,0 to 0,0,255.

The Mean value indicates the average intensity of all pixels in the graph. The Standard Deviation value indicates the average percentage by which pixels in the graph vary from the Mean value.

To get comfortable using the histogram, use an external monitor to preview your video and watch the video output and histogram as you use plug-ins to modify the colors. For more information, see Using an external monitor on page 235.

1. Position your cursor on the frame or clip you want to examine.
2. Click the down arrow on the Overlays button ( ) in the Video Preview window.
3. Choose a histogram type from the menu that displays:
   - Luminance: Charts the luminance or brightness of colors in your video.
   - Red: Charts the red tones in your video.
   - Green: Charts the green tones in your video.
   - Blue: Charts the blue tones in your video.
   - Alpha: Charts the alpha channel (transparency) in your video.
4. Use the histogram to evaluate the colors in your video.
5. Use plug-ins such as Brightness and Contrast, Broadcast Colors, and Levels to adjust the color. For more information, see Using video effects on page 193.

Preparing projects for broadcast

Broadcast television uses a narrower range of color than standard RGB. When you broadcast a project that contains out-of-range colors, you can introduce noise into the audio stream or force color bleeding on the display device. Use the histogram to determine whether your project contains out-of-range colors and adjust accordingly before rendering.

1. Click the Go to Start button ( ) to position your cursor at the beginning of your project.
2. Click the down arrow next to the Overlays button ( ) in the Video Preview window. A menu displays.
3. Choose **Histogram - Luminance** from the menu.

4. Play your project. Bars that appear in the shaded areas of the histogram are out of range.

5. Use the Broadcast Colors plug-in to smooth the upper and lower bounds. For help on the different controls in the plug-in, click the **Plug-In Help** button ( ) in the Video FX window to access online help. For more information, see *Using video effects on page 193*.

---

**Previewing in a player**

You may create a full-quality preview that automatically plays in the appropriate media player. You can preview the entire project or select a portion.

1. To preview a portion of the project, create a selection containing the portion you want to preview.

2. From the **Tools** menu, choose **Preview in Player**.

3. Select the type of preview file to create. Select a template or click the **Custom** button to configure any compression options.

4. To preview just a portion of the project, verify that **Render loop region only** is selected. To create a preview of the entire project, clear this check box.

5. Click **OK**.

A progress bar displays the progress of the render. When finished, the file automatically plays in the appropriate media player.
Using an external monitor

Support for external monitors is only available in Vegas Video.

Vegas allows you to feed video directly from the timeline to a television monitor. With this feature, you can make your final editing decisions on a broadcast monitor (which differs significantly from a computer monitor) before printing the project to tape. To use an external monitor, you must have:

- OHCI-compliant IEEE-1394 DV card
- DV camcorder or DV-to-analog converter box

While configuring your computer for DV external monitor previewing is not difficult, the setup may require some troubleshooting. The Sonic Foundry Vegas Forum is a good resource for peer-to-peer system troubleshooting:

http://www.sonicfoundry.com/forums

Setting up an external monitor

The diagram below shows the preferred setup for sending video from the Vegas timeline to an external television monitor.

Vegas conforms the video to DV format and feeds it through the 1394 card to the DV device (camcorder or DV-to-analog media converter). The DV device sends analog output to the television monitor.

**Note:** The DV device must support “pass through” in order to use an external monitor. Some PAL camcorders do not support this feature.

Previewing audio

External monitor previewing differs in one respect from printing to tape from the timeline: no audio is sent through the 1394 card. As shown in the illustration above, Vegas routes the audio to the sound card and then on to the mixer (if present) and speakers. This allows you to mix your audio on better speakers than are typically found in television monitors.

Before printing to tape, you may wish to preview the audio through the television monitor speakers to ensure a good “TV mix.” You can use the print-to-tape feature to send the full video and audio to the external monitor. Follow the steps for printing to tape from the timeline (pg. 246) but do not set the camcorder to record. Vegas sends both the video and audio through the 1394 card to the external monitor.
Optimizing preview quality

Keep in mind that complex effects and/or transitions may not play back in real time from the timeline. What effects can and cannot be played back depends on the speed of your computer. You may want to prerender more complex portions of a project. *For more information, see Prerendering video on page 231.*

**Note:** The compression settings used to create the prerendered video must be identical to your captured files for timeline playback to work.

Configuring an external monitor

1. Connect your camera to the IEEE-1394 card and turn it on in VTR mode.
2. Run Vegas.
3. From the Options menu, choose Preferences.
4. Click the Video Device tab.
5. Select your device from the Device list (e.g., OHCI Compliant IEEE-1394/DV).

Vegas directs the output to the camcorder through the IEEE-1394 card. You can preview this output on the camcorder's LCD screen or connect the camera to a television monitor to preview the output there. Once you have verified that the external monitor settings are working correctly, you can use it to preview your project.

Verifying the external monitor configuration

1. Click the Preview on External Monitor button ( ) on the Video Preview window.
2. Open a properly formatted AVI (e.g., a DV AVI) file in the Trimmer window in Vegas.
3. Click the Play button ( ) in the Trimmer window to test the output.

This can be a complex hardware issue. More detailed information is available at the Sonic Foundry Web site: [http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp](http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp)  
*For more information, see Video device tab on page 262.*
Saving, Rendering, and Printing Projects

Vegas allows you to save and render projects into many different multimedia formats. When you render a Vegas project to a different format, your project is not affected, and a single project may be rendered in any number of different formats.

This chapter explains saving a project and using the Save As and Render As functions. In addition, you will find reference information for the rendering options available in Vegas. This chapter also describes the different options for delivering your projects, such as printing to DV tape, burning a Video CD, or burning a multimedia CD.

Using custom settings to render to streaming media formats is available only in Vegas Video. Printing to tape from the timeline and CD burning are only available in Vegas Video.

Saving a project

A project in Vegas is saved as a small VEG file. This file contains all of the information Vegas needs to recreate your project: source file locations, trimming, track and bus plug-ins, volume and panning envelopes, bus assignments, assignable effects settings, etc. This is not the same as creating a final media file, which is done with the Render As command.

Vegas also provides the option of saving a project as an Edit Decision List (EDL). For more information, see Creating an EDL on page 188.

1. Click the Save button ( ). The first time a project is saved, the Save As dialog appears.

   In subsequent saves, the Save As dialog is bypassed, your existing file name is retained, and your project is updated to include any changes.

2. Select Vegas Project File (.veg) from the Save as type list (default).

3. Select the drive and folder where you want to store the project.

4. Type the project name in the File name box.

5. Click Save.
Creating a copy of a project (using Save As...)

After you have been working with your project, you may use the Save As command in the File menu to create a copy of the small project file with a different name. Since multimedia projects can be very complex, and since Vegas project files are so small, saving a number of different versions of a project is a low-risk way to try new techniques.

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and folder where you want to store the project.
3. Type a new name in the File name box.
4. Click the Save button on the Save As dialog.

Saving a project with media

Vegas also provides the option of saving both the project file (VEG) and the media files to a common location. You can choose to save all media files along with the project file or allow Vegas to consolidate and trim the media for you. With this second option, Vegas optimizes media storage by saving only those portions of files that are used in the project and by eliminating unused takes.

**Note:** Peak files (.sfk) and audio proxy files (.sfap0) are not saved with the project when Copy and trim media with project is selected. Because Vegas can regenerate these files as needed, they do not need to be archived. For more information, see Peak File (.sfk) on page 278 or Audio proxy files (.sfap0) on page 267.

1. From the File menu, choose Save As. The Save As dialog appears.
2. Select the drive and folder where you want to store the project.
3. Type the project name in the File name box.
4. Select the Copy and trim media with project check box.
5. Click Save. The Copy Media Options dialog appears.
6. Select the appropriate option:
   - **Copy all media:** Copies all media files to the same location as the Vegas project file.
   - **Create trimmed copies of source media:** Optimizes media storage by saving only those portions of media files used in events and discarding unused takes. Audio media is saved as Wave64 files (.w64) and DV video media is saved as AVI files. Non-DV video files are copied in full.

   Enter an Extra Head and Tail (seconds) value to indicate how much time Vegas should include before and after the trimmed media. For example, if the project contains a 2-minute media file, but the event on the timeline for that file lasts only from 1:00 to 1:20, you could enter 5 seconds in the Extra Head and Tail box to have Vegas save the media file from 0:55 to 1:25 (5 seconds added to the head and tail of the event). Including this extra material allows space for future edits.

7. Click OK. Vegas saves the project file and the related media files to the location you specified.
Autosaving a project

Vegas automatically saves a backup copy of your project every five minutes. If your system crashes, Vegas prompts you to open the backup file the next time you start the program.

Backup files are saved in the location specified in the Temporary files folder box on the General tab of the Preferences dialog. Files are saved with the .autosave.veg extension and are deleted when you close Vegas.

If you prefer not to autosave your project, you can clear the Enable autosave check box on the General tab of the Preferences dialog.

Vegas also creates .veg.bak files in your project folder when you save a project to allow you to return to the project’s last-saved state. Creation of .veg.bak files is independent of autosaving.

Rendering a project

Rendering refers to the process of converting the Vegas project into a single new multimedia file and formatting it for the desired playback method: media player, Internet streaming media, CD-ROM, video tape, etc. The project file is not overwritten, deleted, or altered during the rendering process. You may return to the original project to make edits or adjustments and render it again later.

Rendering a video file can take quite a bit of time, depending on the complexity of your project, the speed of your CPU, and the final format you have selected. For longer movies, you might want to plan to render your movie overnight or when you are not using your computer.

The process for rendering a project is essentially the same, regardless of the final format of the rendered file.

Using custom settings to render to streaming media formats is only available in Vegas Video. Vegas Video LE requires you to select from several predefined templates.

1. From the File menu, choose Render As. The Render As dialog appears.
2. Select the drive and folder where you want to save the rendered file.
3. Type a new name in the File name box, if necessary.
4. In the Save as type drop-down list, choose the appropriate format. For more information, see Selecting a file format on page 240.
5. In the Template drop-down list, select the appropriate template.
   - If your source media is in DV format, select a DV template. For more information, see Working in DV format on page 189.
   - You can customize the rendering settings by clicking the Custom button. For more information, see Customizing the rendering process on page 241.
6. Select any check boxes as needed:
   - **Render loop region only:** Renders only the portion of your project within the loop selection.
   - **Stretch video to fill output frame size (do not letterbox):** Adjusts the aspect ratio so the output frame is filled on all edges. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterbox). This option is useful when the desired output format does not match the frame aspect ratio of your project.
   - **Save project markers in media file:** Saves any regions and markers in your project to the final rendered file.
7. Click the Save button. A small dialog box appears displaying the progress of the render and a status bar appears in the lower-left portion of Vegas. You may cancel the rendering process by clicking the Cancel button on the status bar.

Selecting a file format

The following table describes the formats available for rendering your Vegas project:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Extension</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Interchange File Format</td>
<td>.aif</td>
<td>The standard audio file format used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>Some versions of Vegas also support MPEG-1 and MPEG-2 file creation through the use of MainConcept MPEG technology (see notes following table).</td>
</tr>
<tr>
<td>MPEG Layer 3</td>
<td>.mp3</td>
<td>Compressed audio format. You may render up to 20 .mp3 files without registering the optional plug-in.</td>
</tr>
<tr>
<td>OggVorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov</td>
<td>Apple QuickTime multimedia format.</td>
</tr>
<tr>
<td>RealMedia</td>
<td>.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>A Sonic Foundry proprietary format that is compressed and completely lossless (see notes following table).</td>
</tr>
<tr>
<td>Sonic Foundry Wave64</td>
<td>.w64</td>
<td>A Sonic Foundry proprietary format that allows wave files that are (practically) unrestricted by file size (see notes following table).</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>The standard video file format used on Windows-based computers. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Wave (Microsoft)</td>
<td>.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Wave (Scott Studios)</td>
<td>.wav</td>
<td>Standard audio format used with Scott Studios systems.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio-only format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Format</td>
<td>.wmv</td>
<td>The Microsoft standard used for streaming audio and video media via the Web.</td>
</tr>
</tbody>
</table>

More about the MPEG format

Vegas Video supports MPEG-1 and MPEG-2 file creation through the use of MainConcept MPEG technology.

MPEG renders can sometimes take more time than renders with some other formats. MPEG video files can be played back on most computer systems. MPEG video files can also be burned to CDs or DVDs for playback in standalone VCD, SCVD, and DVD players. Sonic Foundry cannot guarantee the compatibility of MPEG files with VCD/DVD authoring software or VCD, SCVD, and DVD standalone players. Consult your specific authoring software’s documentation for information on what constitutes a valid file and then customize the MPEG rendering properties to match.

More about the Wave64 and Perfect Clarity Audio formats

The Wave64 (.w64) and Perfect Clarity Audio (.pca) formats are proprietary formats developed by Sonic Foundry to work around some limitations inherent in other formats. Currently, neither is compatible with many other applications and may not be playable in other media players, but both are excellent choices for Sonic Foundry projects.

- **Wave64** files work around the maximum file size limitation inherent in the WAV format. The Wave64 format has no maximum file size and is useful in long format productions.
- **Perfect Clarity Audio** is the Sonic Foundry Perfect Clarity Audio (PCA) format, a compressed format that is completely lossless. Unlike MP3 and other highly compressed formats which are lossy, 100% of the quality of your audio is maintained by using the PCA format.
More about video formats

When you create a final movie, you will find that there are dozens of formats to choose from, each having dozens of options. The destination of your final movie is the most important factor in selecting a format. Movies created for broadcast television must be of the highest quality, but for many other destinations, such as a CD-ROM or the Internet, you may have to sacrifice some quality when you render the file. Heavy compression may create visible artifacts in the video, such as when you create streaming video for the Internet. Every case is different and it is necessary to experiment to obtain the best results.

VCR or television

If you are creating a movie that you want to send back out to a television, a VCR or a camcorder, there is only one choice: use the same settings as the original video.

There is no way to improve upon the quality of your original video (as far as compression is concerned). If you have captured your video at 640X480, at 24 fps in an MJPEG codec, then that is how you should set up your final movie. This is the only way to maintain 100% quality. For more information, see Working in DV format on page 189.

Computer

This can be the most complicated case because you have to decide exactly which computer it is going to be played back on, how fast it is, what software is installed, and how you are going to get it there (e.g., burn to a CD). Your biggest concern with creating a video file is compatibility. When you create a movie, you must select a specific codec to compress the video. That same codec must then be used to view the movie. This is not a problem if you are viewing the movie on your own computer, since the appropriate codec is already installed. To ensure that your audience has the appropriate software, you should use a fairly universal codec. Intel Indeo, Cinepak, and QuickTime (which is not a codec, but installs with a number of different codecs) are all widely available.

Internet

When video on the Internet is discussed, people almost always mean streaming. There are two streaming media formats that come with Vegas: RealMedia and Windows Media Format. There is nothing particularly magical about streaming video, and the three rules of creating video files for the Internet are as follows: compress, compress, and compress. The smaller the file size the better, and this inevitably results in a loss of quality. There are two main places where you can save space: frame dimensions and frame rate. Typical Internet video files should be about 160X120 and should rarely exceed 320X240. This is not very big, and video with lots of detail does not translate well to this frame size. The frame rate should also be as low as possible, with 15 fps being a good maximum. Fast action, pans, and moving backgrounds (e.g., tree leaves or ocean waves) do not compress well. Streaming media files must be placed on a special Internet server in order to stream properly.

Customizing the rendering process

Using custom settings to render to streaming media formats is only available in Vegas Video. Vegas Video LE requires you to select from several predefined templates.

Every media file format has different variables and controls. Vegas has a number of templates that appear on the Render As dialog’s Template drop-down list to automatically configure a particular format for a particular destination.

You may also choose to create custom settings for your render by clicking the Custom button. Once you have customized the settings, you may create your own template so that you can reuse the custom settings at a later time.
Customizing the Render As settings

1. From the **File** menu, choose **Render As**.
2. In the Render As dialog, choose the format [e.g., Video for Windows (.avi)].
3. Click the Custom button. The Custom Settings dialog appears.
4. Adjust the settings in each of the tabs as desired.
5. Click **OK** to close the Custom Settings dialog.
6. Enter a name and location for the new file and click **Save**.

The customized settings that have been chosen here can be saved for future use. One of the most important reasons to save a new template is to save the specific compression codec used to create the final media file, since this is not predetermined by the project properties.

Saving custom settings as a template

1. Modify the parameters in the Custom Settings dialog.
2. In the **Template** drop-down list, enter a name for the new template.
3. Click the **Save Template** button ( ).

Changes cannot be made to the default template. To use the new template in the future, simply select it from the **Template** list in the **Save As** dialog. Custom Audio and Video settings are saved in the same template.

**Note:** To delete a template, select it from the drop-down list and click the **Delete** button ( ).
Creating custom rendering settings for AVI files

The options that appear in the Custom Settings dialog depend on which format you choose for your rendered file. This section provides descriptions of the Custom Settings options for creating a Video for Windows (AVI) file. For descriptions of the options used to customize other formats, use the What's This button ( ) in the specific Custom Settings dialog for that format. For more information, see What's This? help on page 18.

Some of the rendering settings are identical to your Project Properties and can be saved as a part of a project template. Final render settings override Project Properties settings. For more information, see Modifying project video properties on page 190.

The Custom Settings dialog for rendering to an AVI file has three tabs: Project, Video, and Audio.

Project tab

Video rendering quality
Higher quality settings result in longer rendering times. Good is the default.

Motion blur type
Motion blur can be used to smooth any animated effects created in Vegas, including track motion, panning, and cropping effects.

Exposure time (seconds)
This determines the amount of Motion blur to apply. Specify a duration over which the blur will occur. Smaller fractions of a second are recommended.

Resample the frame rate of all video
This option resamples the frame rate for all source media files in a project that differ from the target frame rate of the final movie where necessary. This may or may not improve the quality of the final video, but will almost certainly increase rendering times. For more information, see Resampling video on page 187.

Video tab

Frame size
Frame size contributes to quality and file size. The appropriate frame size is determined by the final destination of the movie. See your video capture card’s manual for more information. The final frame size of the movie can be different from the project’s default settings.

Frame rate
Frame rate is important in determining the quality and size of the final media file. The appropriate frame rate is determined by the final destination of the movie. See your video capture card’s manual for more information. The final rendered multimedia file can have a different frame rate from the project itself.

Field order
Video that is displayed on a television monitor is interlaced. This means that every frame of video is actually composed of two fields, each of which is made up of half of the lines that make the final frame. These two fields are woven together in alternate lines, but which of the two fields is displayed first can be important. The interlace can be ignored for video that is going to be displayed on a computer: choose None (progressive scan). For video on a television, most hardware supports Lower Field First. If the output is jittery or shaky on a television, or your hardware’s manual specifies it, choose Upper Field First.
Pixel aspect ratio

A pixel is a single picture element or dot on a television or computer screen. Computers display pixels as squares: 1.0. Televisions display individual pixels as rectangles: 0.909, 0.899, or anything other than square. Using the wrong pixel aspect ratio can result in distortions or stretching of the video. Select the aspect ratio for the final movie’s destination. Consult your hardware manual if you are in doubt about the appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

Video format

Codec, which stands for COmpressor/DECompressor, is the mathematical algorithm used to compress a media file. The codec directly determines the size and quality of the movie, as well as its compatibility with various playback devices. The final destination for the movie dictates the choice of codec. Many of the codecs used for specific rendering formats are updated periodically by their creators. For information about specific codecs, contact the codec’s manufacturer.

Each codec is a small program that may have additional custom controls used to fine tune the output. Click the Configure button to adjust these parameters manually.

Quality slider

If the codec chosen in the Video format list supports it, use this slider to adjust the quality of the compression applied by the codec chosen from the Video format list.

Interleave every

When enabled, this control allows you to specify how often the audio and video streams are interleaved. Interleaving relates directly to how the data is saved in the file. For example, during the rendering process, the audio data is written in between the video data based on the frame setting that you specified. Interleaving allows for optimal playback of the AVI file.

Keyframe every

If the codec chosen in the Video format list supports compression keyframes, select this option to set compression keyframes to adjust the quality of the compression. More keyframes typically produce higher quality video, but a larger file size (and thus a higher data rate).

Data rate

If the codec chosen in the Video format list supports a data rate ceiling, select this option and enter a maximum data rate for the final file.

Render alpha channel

If the codec chosen in the Video format list supports alpha channel transparency, select this option to save this information with the file.

Create an OpenDML (AVI version 2.0) compatible file

Select this check box if you want to save your file as an OpenDML file. OpenDML files allow you to create files that are limited in size only by the format of your hard disk: 2GB using FAT32 or 4GB using NTFS.

Audio tab

Audio format

This lists the audio rendering codecs that are available.

Attributes

If the codec chosen in the Audio format list supports it, select the appropriate attributes for the codec from this list.
Sample rate

The sample rate directly affects the audio’s quality. The sample rate is defined as the number of times a second that data is sampled in an audio file. It is similar to the concept of resolution in an image file. The higher the setting you choose, the better the quality, but the larger the file size.

Bit-depth

The bit depth directly affects the audio’s quality. The bit depth is defined as how much data is used to save each sample. The higher the setting you choose, the better the quality, but the larger the file size.

Channels

A project may be rendered in either stereo or mono.

Printing with Video Capture

Once you have rendered your project, you can use Sonic Foundry’s Video Capture application (installed with Vegas) to print your finished video onto DV tape in your video camera or VTR.

Note: You must have an IEEE-1394/ OHCI-compliant video capture card installed to use Video Capture.

1. If you have not already done so, connect your video camera to your video capture card using the cable provided with the card.

2. In the Media Pool window, click the Open Video Capture button ( ). The Sonic Foundry Video Capture application starts.

Note: If your video camera is properly connected, the Video Preview window in the center of the application area should display “Device connected.”

3. Follow the instructions for printing to tape provided in the Video Capture online help. To access online help, click the Help menu within the Video Capture application, and choose Contents and Index. The Video Capture online help file displays.
Printing to DV tape

Print to tape from the timeline is only available in Vegas Video.

You can print either a portion of your project or the entire video right from the project timeline. Vegas examines your project, prerenders any complex portions, and then prints to DV tape all in one action. For more information, see Prerendering video on page 231.

Note: Printing to tape from the timeline can require significant drive space for temporary prerendered files. Set the Prerendered files folder on the Video tab of the Project Properties dialog to an A/V-capable drive with sufficient space. Prerendering a DV project uses approximately 228 MB/minute, so plan accordingly.

To print to DV tape, you must first establish a connection to the video camera or VTR to which you will print. For more information, see Video device tab on page 262.

Establishing a connection to the recording device

1. On the Tools menu, choose Preferences. The Preferences dialog appears.
2. Click the Video Device tab.
3. In the Device drop-down list, select OHCI Compliant IEEE 1394/DV.
4. Click OK. The Preferences dialog closes.

Printing to DV tape

1. To print just a portion of your project, make a time selection in the timeline.
2. From the Tools menu, choose Print Video to DV Tape. The Conform Timeline to DV Format dialog appears. Complete the following information:
   • In the DV Template drop-down list, select the appropriate template for rendering your video or click Custom to select custom settings. For more information, see Customizing the rendering process on page 241.
   • To print just a portion of your project, select the Render loop region only check box.
3. Click Next. The Leader and Trailer dialog appears. Complete the following information:

- In the Leader section, select a test pattern, and indicate the test pattern and black duration that will precede the video. To print without a test pattern or black leader, enter 0 for the Duration value. Select the Play 1 kHz tone with test pattern check box to include a tone in the leader.
- In the Trailer section, indicate the duration of the black to follow the video. To print without a trailer, enter 0 for the Duration value.

4. Click Next. The Device Setup dialog appears. Choose the device control mode:

- **Manual**: You must manually cue the device and set it to record.
- **Use device control**: Enter a timecode value where the device will begin recording. The device must support OHCI 1394-DV device control to use this option.

5. Click Finish. Vegas begins printing the selected video to the device. A progress meter appears indicating the percent completed.

**Note**: The tone that can be included in the leader is fixed at -12 dB. If you need a different tone level (to match your audio mix), create a test pattern and tone clip that is calibrated to your record deck.
Burning Video CDs

CD burning is only available in Vegas Video.

You can render your project as an MPEG and burn it to a Video CD all in one step. Video CDs can be played in many home DVD players and on computers with a CD-ROM drive and VCD player software.

1. From the Tools menu, choose Burn CD, and choose Video CD from the submenu. The Burn Video CD dialog appears.

2. Select the options for burning the Video CD:
   - Select the Render loop region only check box to burn only a portion of your project.
   - Select the Stretch video to fill output frame check box to have Vegas reformat your video so that it fills the output frame size listed in the Description field. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterboxing).
   - Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video. Turning off this option can correct the artifacts, but it increases rendering time.
   - From the Burn speed drop-down list, choose the speed at which you want to record. The Max option records using the fastest speed possible with your drive. Decrease the speed if you have difficulty recording.

3. Click OK.

Note: You can use this same command to burn an existing MPEG file to a Video CD. Select the Use an existing file option in the Burn Video CD dialog to record an MPEG.
Burning multimedia CDs

CD burning is only available in Vegas Video.

You can render and burn your finished project to a CD in one step. Vegas provides the options of embedding the finished video in an HTML file or including a media player installer on the CD.

1. From the Tools menu, choose Burn CD, and choose Multimedia CD from the submenu. The Burn Multimedia CD dialog appears.

2. Select the options for burning the multimedia CD:
   - Choose the appropriate format and template for rendering the project from the Format and Template drop-down lists.
   - Select the Render loop region only check box to burn only a portion of your project.
   - Select the Stretch video to fill output frame check box to have Vegas reformat your video so that it fills the output frame size listed in the Description field. When the check box is cleared, Vegas maintains the current aspect ratio and adds black borders to fill the extra frame area (letterboxing).
   - Clear the Fast video resizing check box if you see unacceptable artifacts in the rendered video. Turning off this option can correct the artifacts, but it increases rendering time significantly.
   - Select the Play movie inside web page check box to create an HTML page and embed the finished video in it.
   - Select the Include movie player installer check box to include a media player installer on the CD. Click the Browse button to locate the installer file.
   - From the Speed drop-down list, choose the speed at which you want to record. The Max option records using the fastest speed possible with your drive. Decrease the speed if you have difficulty recording.

3. Click OK.

Note: You can use this same command to burn an existing file to a CD. Select the Use an existing file option in the Burn to Data CD dialog to record a file to the disc.
Customizing Vegas

Vegas may be customized to your project needs and working preferences. Many of the settings depend on your equipment or studio setup. Vegas can be set to work with the components that you use in your studio.

In this chapter, you will find information about functions that allow you to customize the appearance of Vegas, set a project’s properties, and set the application’s preferences.

Displaying frame numbers

You may display frame numbers on video events. Once you have enabled frame numbering, a small box appears at the bottom of the event thumbnail with the frame offset, time or timecode. The small black arrow marks the exact position of that frame in time.

When the workspace is zoomed in far enough, each thumbnail represents a single numbered frame in the source video file. At intermediate zoom levels, marks between the frame numbers show the location of intermediate frames. These frame marks are not visible at lower magnifications.

1. From the Options menu, choose Preferences.
2. Click the Video tab.
3. Select an option from the Show source frame numbers on event thumbnails as drop-down list.
4. Click OK.

Changing the ruler format

The ruler in Vegas can be customized to display a number of different standard formats. The format that you select affects how the ruler and Time Display window display time units. For more information, see Timecode in Vegas on page 270.

To change the ruler’s format, right-click the ruler and select the desired time format from the shortcut menu or, from the Options menu, choose Ruler Format and select the desired time unit. You may also change ruler settings on the Project Properties dialog’s Ruler tab. For more information, see Ruler tab on page 255.
The following is a description of the different time units available in Vegas (hh=hours, mm=minutes, ss=seconds, and ff=frames):

<table>
<thead>
<tr>
<th>Time format name</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>numbered (starting with zero)</td>
</tr>
<tr>
<td>Time</td>
<td>hh:mm:ss.sss</td>
</tr>
<tr>
<td>Seconds</td>
<td>ssrss.sss (to three decimal places)</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>Absolute Frames</td>
<td>frames are numbered starting with 0</td>
</tr>
<tr>
<td>Measures &amp; Beats</td>
<td>measures,beats,ticks, where 64 ticks = 1 beat</td>
</tr>
<tr>
<td>Feet &amp; Frames 16mm (40 fps)</td>
<td>feet+frames, where 40 frames = 1 foot</td>
</tr>
<tr>
<td>Feet &amp; Frames 35mm (16 fps)</td>
<td>feet+frames, where 16 frames = 1 foot</td>
</tr>
<tr>
<td>SMPTE Film Sync (24 fps)</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>SMPTE EBU (25 fps, Video)</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97 fps, Video)</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>SMPTE Drop (29.97 fps, Video)</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>SMPTE 30 (30 fps, Audio)</td>
<td>hh:mm:ss.ff</td>
</tr>
<tr>
<td>Audio CD Time (75 fps)</td>
<td>hh:mm:ss or hh:mm:ss:ff when zoomed in tightly</td>
</tr>
</tbody>
</table>

**Editing the ruler offset**

The ruler doesn’t necessarily need to start with zero at the far left side. You can enter an offset to change the orientation of the ruler in a project. One use of this is to create a lead-in into a project. A five-second offset would mean that the ruler would start at -5 seconds and would be at 0 five seconds into the project.

1. Position the cursor to the desired location along the timeline.
2. Right-click the ruler and choose Set Time at Cursor from the shortcut menu. The current ruler value is highlighted.
3. Enter a time value.
4. Press Enter to set the ruler’s time. The value that you enter at the cursor’s position affects the entire ruler.

**Changing grid spacing**

Grid spacing is different from the ruler and provides an alternate method of subdividing a project’s time. This may be useful if you want the ruler to display SMPTE video timecode, but you need to create your music in terms of beats and measures. The grid spacing may be set in time, frame, measure, or note units. The grid may also be set to match the ruler’s time format. The grid appears across all tracks in your project and the grid’s lines can be used as snap points.

Ruler and grid increments can be different.
This new project is set with Ruler = SMPTE non-drop and Grid = Quarter notes.
1. From the **Options** menu, choose **Grid Spacing**. A submenu appears.

2. From the submenu, choose the desired time unit. The grid spacing changes to reflect your selection.

---

**Note:** In some cases, the grid lines and the ruler do not match. This is because they are two independent functions.

---

### Using the Time Display window

The Time Display window reflects the cursor's position on the timeline and the end point of a time selection. The Time Display window's time settings may be customized, including what time the window displays and what colors it uses.

The Time Display window may be moved from its docked position above the track headers to float on the Vegas workspace. In addition, the Time Display window may be docked in the window docking area. For more information, see Window docking area on page 22.

### Changing the Time Display settings

The Time Display window always reflects the ruler settings that are selected. You may change the ruler settings via the Time Display window or vice versa. For more information, see Changing the ruler format on page 251.

1. Right-click the Time Display window. A shortcut menu appears.

2. From the shortcut menu, choose **Time Format**, and choose the desired time format from the submenu.

   Both the Time Display window and ruler display the chosen time format.

### Changing the Time Display colors

You may change the background color and text color used in the Time Display window.

1. Right-click the Time Display window to display the shortcut menu.

2. From the shortcut menu, choose **Text Color** or **Background Color**. The Time Display Color dialog appears.

3. On the Color dialog, choose the color setting that you want.

4. Click **OK** to set the text or background color or click **Cancel** to keep the existing color settings and close the Color dialog.

---

**Note:** To return the Time Display window’s text or background color to its default settings, choose either **Text Color** or **Background Color** from the shortcut menu, and then choose **Default** from the submenu.
Setting the Time Display to monitor MIDI timecode

The Time Display window can be set up to monitor the status of incoming or outgoing MIDI timecode. Vegas can monitor MIDI timecode being generated from an external device or monitor MIDI timecode and MIDI clock information that is being generated. From within Vegas, the Time Display settings work in conjunction with your project's properties and MIDI setup options. For more information, see Sync tab on page 261.

1. Right-click the Time Display window.
2. From the shortcut menu, choose the type of MIDI monitoring for Vegas to display.

Once you have made your selection, the Time Display window displays both the MIDI timecode being input or output and a status message.

Working with project properties

Vegas supports a large range of formats and various types of media files. Some settings in a project's properties are simply informational details about the project, while others control how Vegas handles your project and its output. If you have multiple projects, Vegas stores the settings used for each project. These settings can be saved as templates for future use.

To view and modify project properties, choose Properties from the File menu. The Project Properties dialog has five tabs: Video, Audio, Ruler, Summary, and CD. An overview of each tab and its settings follows.

Video tab

This tab allows you to set different characteristics the project uses to handle the video. Also, this tab displays information about the video contained in your project. For more information, see Modifying project video properties on page 190.
Audio tab

This tab allows you to set different characteristics the project uses to handle the audio. This page also displays the available drive space where Vegas stores recorded audio.

Multiple audio busses are only available in Vegas Video. Sample rates are limited in Vegas Video LE to 48,000 Hz, while Vegas Video allows up to 96,000 Hz.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of stereo busses</td>
<td>Enter the number of stereo busses that you want in your project. You may add up to 25 additional busses. The busses appear in the Mixer.</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz to 96,000 Hz (Vegas Video) or 2,000 Hz to 48,000 Hz (Vegas Video LE). Higher sample rates result in better quality sound, but also mean larger audio files.</td>
</tr>
<tr>
<td>Bit-depth</td>
<td>Choose a bit depth from the drop-down list. A higher bit-depth results in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Resample quality</td>
<td>Choose Preview, Good, or Best resample quality.</td>
</tr>
<tr>
<td>Recorded files folder</td>
<td>Displays the path where recorded audio is stored. The Browse button allows you to select a new location to store recordings.</td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>Displays the available disk space where recorded audio is stored.</td>
</tr>
</tbody>
</table>

Ruler tab

This tab allows you to change ruler settings used in your project. You may also change ruler settings on the track view. For more information, see Changing the ruler format on page 251.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler time format</td>
<td>Choose a ruler time format from the drop-down list.</td>
</tr>
<tr>
<td>Ruler start time</td>
<td>Enter a value that the ruler will use at the beginning of your project. This feature is useful for synchronization purposes.</td>
</tr>
<tr>
<td>Beats per minute (tempo)</td>
<td>Enter the desired number of beats per minute for the project.</td>
</tr>
<tr>
<td>Beats per measure</td>
<td>Enter the desired number of beats to occur per measure for the project.</td>
</tr>
<tr>
<td>Note that gets one beat</td>
<td>The value entered will determine the time signature used by the ruler when its format is set to Measures and Beats. For example, if the entered value is 4, then a quarter note gets one beat.</td>
</tr>
</tbody>
</table>
Summary tab

This tab allows you to enter information about the project. The boxes on this tab may be left blank or, if information exists, you may change it at any time.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the name or title of the open project.</td>
</tr>
<tr>
<td>Artist</td>
<td>Enter the name of the narrator, band, or artist(s) being recorded into the project.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name(s) of the people who mixed and edited the project.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Enter the date and ownership rights of the project.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter information that identifies and describes the project.</td>
</tr>
</tbody>
</table>

Audio CD tab

This tab allows you to enter information used when burning audio CDs in Vegas.

*CD burning is only available in Vegas Video.*

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Product Code/Media Catalog Number</td>
<td>If your CD-R device supports writing UPC/MCN codes, you may specify the value in this field. If you leave the field blank, no UPC/MCN value will be written to the CD. Otherwise, the value consists of 13 digits.</td>
</tr>
<tr>
<td>First track number on disc</td>
<td>This sets the number for the first track on the disc.</td>
</tr>
</tbody>
</table>

Setting Vegas preferences

The preferences options are different from project properties. Project properties are unique to each project, while preferences affect how Vegas functions. Any changes that you make to the preferences remain set until you change them again or reset Vegas to use the default presets.

The Preferences dialog may be accessed by choosing Preferences from the Options menu. This dialog contains seven tabbed pages: General, Video, Audio, CD Settings, Editing, Sync, and Video Device. The following sections explain the settings on each tab.

General tab

The General tab includes a variety of settings. The following is a list of these preferences and their meaning. An “x” means this preference is selected by default.

<table>
<thead>
<tr>
<th>Default</th>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>Automatically open last project on startup</td>
<td>When Vegas is run, the last project saved automatically opens.</td>
</tr>
<tr>
<td>x</td>
<td>Show logo splash screen on startup</td>
<td>Briefly shows the Vegas logo while the program is loading. The logo does not increase loading time.</td>
</tr>
<tr>
<td></td>
<td>Show active take name in events</td>
<td>Display the name of the take that is active in an event.</td>
</tr>
<tr>
<td>x</td>
<td>Draw waveforms and frames in events</td>
<td>Draws a graphical representation of an audio file’s waveform and thumbnail images of a video file’s frames.</td>
</tr>
<tr>
<td>x</td>
<td>Show video event button</td>
<td>Shows/hides the Event FX, Pan/Crop, and Generated Media buttons on video events.</td>
</tr>
<tr>
<td>x</td>
<td>Animate video frames in Trimmer</td>
<td>Animates the thumbnail representations of frames in a media file opened in the Trimmer. This can visually aid trimming.</td>
</tr>
<tr>
<td>x</td>
<td>Prompt to keep files after recording</td>
<td>Opens a dialog where you can enter a name and select a location where audio will be saved after recording into a track.</td>
</tr>
<tr>
<td>Default</td>
<td>Preference</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>x</td>
<td>Create undos for FX parameter changes</td>
<td>Allows you to undo changes made in the FX, Transition, Event Pan/Crop and Track Motion windows.</td>
</tr>
<tr>
<td>x</td>
<td>Confirm media file deletion when still in use</td>
<td>When deleting media in the Explorer or Media Pool, Vegas warns you if any events in the project are using these files.</td>
</tr>
<tr>
<td></td>
<td>Double-click on media file loads into Trimmer instead of tracks</td>
<td>The default Explorer double-click behavior is to insert an event at the cursor position on the timeline. Select this option to open the media file in the Trimmer instead.</td>
</tr>
<tr>
<td>x</td>
<td>Show Trimmer history with file name first, then folder</td>
<td>The Trimmer history drop-down list displays the media file's name first, followed by the folder it is in. Select this to reverse the names.</td>
</tr>
<tr>
<td></td>
<td>Automatically save Trimmer markers and regions with media file</td>
<td>Markers and regions created at the media file level in the Trimmer can be saved to the file.</td>
</tr>
<tr>
<td>x</td>
<td>Show progress in Video Preview window while rendering</td>
<td>Frames can be displayed in the Video Preview during a render. This will slow a render somewhat.</td>
</tr>
<tr>
<td></td>
<td>Save active prerenders on project close</td>
<td>Full quality preview renders are cleaned up and deleted when a project is closed. Select this if you want these prerendered files to be available later.</td>
</tr>
<tr>
<td>x</td>
<td>Close media files when not the active application</td>
<td>This allows media files to be edited in external editors (audio, image, etc.) while they are contained in events in Vegas.</td>
</tr>
<tr>
<td>x</td>
<td>Enable multimedia keyboard support</td>
<td>This allows you to use a multimedia keyboard to control playback of a project.</td>
</tr>
<tr>
<td></td>
<td>Render large Wave files as Wave64</td>
<td>The WAV format is limited by a maximum file size of ~2GB. You can choose to render larger files as Sonic Foundry Wave64 files.</td>
</tr>
<tr>
<td>x</td>
<td>Automatically name regions and markers if not playing</td>
<td>When regions and markers are added, this option automatically prompts you for a name. This does not happen when adding markers on-the-fly during playback.</td>
</tr>
<tr>
<td>x</td>
<td>Ignore third party DV codecs</td>
<td>Clear this check box to enable third-party DV codecs.</td>
</tr>
<tr>
<td></td>
<td>Use Microsoft DV codec</td>
<td>Vegas uses the Sonic Foundry DV codec (which offers improved DV video quality over the Microsoft codec) as a default. Select this option to have Vegas use the Microsoft codec to read DV files instead.</td>
</tr>
<tr>
<td></td>
<td>Strictly conform to AVI2 specification</td>
<td>Select this option to create 100% AVI2 compliant files. While these files conform to the standards, not all applications follow these specifications and some programs may not be able to read them.</td>
</tr>
<tr>
<td></td>
<td>Disable multi-processor DV rendering</td>
<td>Disables dual processor rendering for AVI files. Selecting this option does not affect other dual processor operations.</td>
</tr>
<tr>
<td>x</td>
<td>Create project file backups (.veg.bak)</td>
<td>Automatically create backups of your project files.</td>
</tr>
<tr>
<td>x</td>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
<td>Select this option to have Vegas periodically display information from Sonic Foundry at startup.</td>
</tr>
<tr>
<td></td>
<td>Enable autosave</td>
<td>Creates a temporary project file that can aid in crash recovery. When enabled, autosave occurs every five minutes. The autosave process does not overwrite the original project file.</td>
</tr>
<tr>
<td>x</td>
<td>Use linear scrub range</td>
<td>When enabled, the scrub control uses a linear range. When disabled, the scrub control uses a logarithmic range.</td>
</tr>
<tr>
<td></td>
<td>Allow Ctrl+drag cursor style scrub over events</td>
<td>Vegas allows scrubbing on empty sections of the timeline using Ctrl+drag on the cursor. Select this option to enable timeline scrubbing over events as well.</td>
</tr>
<tr>
<td></td>
<td>Make spacebar and F12 Play/ Pause instead of Play/Stop</td>
<td>Changes the spacebar and F12 keys to start and pause playback rather than start and stop.</td>
</tr>
<tr>
<td></td>
<td>Always draw marker lines</td>
<td>Marker and region lines do not appear when snapping is disabled. Select this option to make Vegas draw marker and region lines even when snapping is disabled.</td>
</tr>
<tr>
<td></td>
<td>Build 8-bit peak files</td>
<td>Vegas builds 16-bit peak files as a default. Select this option to build 8-bit peak files instead.</td>
</tr>
<tr>
<td></td>
<td>Disable pop-up animations</td>
<td>Disables the animation applied to windows such as Video FX, Event Pan/Crop, and Track Motion when these windows are opened.</td>
</tr>
<tr>
<td>N/A</td>
<td>Recently used project list</td>
<td>Select the number of files to be listed at the bottom of the File menu.</td>
</tr>
<tr>
<td>N/A</td>
<td>Temporary files folder</td>
<td>Select a location for all temporary files.</td>
</tr>
</tbody>
</table>
Video tab

The Video tab in the Preferences dialog controls the display of video media, video events and video tracks in Vegas.

**Dynamic RAM Preview max**: Determines the size of the RAM cache for building dynamic RAM previews in the Video Preview window. For more information, see Building dynamic RAM previews on page 232.

*Dynamic RAM previews are only available in Vegas Video.*

**Show source frame numbers on event thumbnails as**: Display frame, time, or timecode numbering on video event thumbnails.

**Preferred video capture application**: Browse for the application to be launched when the Open Video Capture button ( ) is clicked.

**Video Preview display options**:

- **Action Safe Area and Title Safe Area**: Sets the reference overlay safe areas in the Video Preview window. For more information, see Identifying safe areas on page 232.
- **Horizontal Grid Divisions and Vertical Grid Divisions**: Sets the spacing of the grid overlay in the Video Preview window used in aligning visual elements in a project. For more information, see Changing grid spacing on page 252.
- **Display at project size**: Sets the Video Preview window to always display the video at full project size.
- **Display square pixels**: Determines how the video is displayed in the Video Preview window. In short, televisions display rectangular pixels and computer monitors display square pixels. This can result in a distorted preview, although the source media and rendered video is unaffected.
- **Background color**: Sets the background color of the Preview window (black by default) that shows either when there is no visual content or when using a transparent overlay with no background visual content.
- **Default track fade colors**: Sets the default top and bottom colors when adding a Fade to Color envelope to a video track. For more information, see Working with track envelopes on page 137.

Audio tab

*Multiple audio busses are only available in Vegas Video.*

The Audio tab allows you to set preferences to optimize how Vegas uses your computer’s components to handle resource-intensive audio. This tab also allows you to configure Vegas to the equipment that is connected to your computer.

**Playback buffering (seconds)**: Sets the amount of memory Vegas uses during project playback. For more information, see Adjusting the playback buffering slider on page 259.

**Audio device type**: Sets the device type for audio routing. Select Windows Classic Wave Driver in order to route busses to hardware. For more information, see Routing busses to hardware on page 154.

**Default audio playback device**: Sets the default device for playback.

**Default audio recording device**: Sets the default device for recording into a track.

**Waveform display while recording**: Allows you to display or hide waveforms when recording into an audio track.

**Normalize peak level (dB)**: Sets the maximum level that Vegas uses when normalizing an event.

**Preferred audio editor**: Displays the path of the audio editor that you can start directly from Vegas to perform destructive edits to audio.

**Metronome**: Allows you to use a default metronome sound or to select custom sound files to be used as the metronome beats.
Advanced audio preferences

You may access advanced settings by clicking the Advanced button. The Advanced Audio Preferences dialog appears. This dialog contains two tabs: Hardware and Record Latency. The Hardware tab displays all of the audio devices that are installed on your computer and allows you to set the controls for each device. The Record Latency tab allows you to automatically or manually adjust for latency in sound cards. The following table describes each of the controls.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Interpolate position</td>
<td>During project playback, you may notice that the cursor position is different than what you are hearing. This problem stems from inaccuracies in some audio devices. Select this control’s check box to have Vegas attempt to compensate for the inaccuracies by interpolating the cursor’s correct position during playback or recording.</td>
</tr>
<tr>
<td></td>
<td>Position bias</td>
<td>The position bias control gives you additional cursor control when it is inaccurately displayed during project playback and recording. If you have enabled the Interpolate position control and are still experiencing cursor position inaccuracies, move the Position bias control forward or backward to compensate for the inaccuracies of the audio device.</td>
</tr>
<tr>
<td></td>
<td>Do not pre-roll buffers before starting playback</td>
<td>When this option is not selected, Vegas begins storing (buffering) project audio information prior to playback. This storing is very fast and unnoticeable in most cases. However, some audio devices stutter when you begin playback as a result of the buffering process. If your audio stutters when you start playback, select this check box to prevent Vegas from buffering audio information prior to playback.</td>
</tr>
<tr>
<td>Record Latency</td>
<td>Automatically detect and offset for hardware recording latency</td>
<td>Select this option to have Vegas automatically adjust for latency in sound cards. For sound cards that do not allow proper auto-detection of latency, clear the check box for this option to adjust record offset manually using the User recording latency offset slider.</td>
</tr>
</tbody>
</table>

Adjusting the playback buffering slider

The playback buffer controls how much memory is used by Vegas when playing back your project. This preference is useful but must be carefully adjusted. If you set the buffer size too high, you may experience gapping during playback.

Conversely, if you set the buffer size too low, you may experience gapping as well because Vegas has too little memory to work with during playback.

The playback buffer slider should be set to balance RAM usage and playback buffering. The rule is to set this slider as low as possible without introducing gapping.

1. Open a project that has multiple events.
2. On the Audio tab, click the Playback Buffer (seconds) slider and move it to 0.25.

![Playback buffering slider](image)

3. Start playing back the project.
4. If the playback still gaps, increase the Playback Buffer (seconds) slider slightly.

You may have to experiment to find the correct settings. If you continue to experience gapping, you can try the following to control the gapping within Vegas:

- Decrease the number of events you are trying to play back. This may mean muting tracks or soloing a couple of tracks. RAM is mostly affected by the number of unique events that are playing back simultaneously.
- Use the Render to New Track command to combine all the events into one event. For more information, see Rendering to a new track on page 141.
CD Settings tab

The CD Settings tab allows you to set preferences for burning CDs and extracting audio from CDs in Vegas.

**CD burning is only available in Vegas Video.**

**Burn drive:** Sets the device where you burn CD-R discs.

**Burn speed:** Sets the speed at which the device burns the CD-R disc.

**Extract optimization:** Sets the amount of buffering and “restitching” done to recover audio from older CD drives. Adjust this setting if your extracted CD audio has occasional gaps or glitches.

**Autoname extracted tracks:** Automatically names extracted CD tracks based on the ISRC number, the track number, and the number of times the track has been extracted.

Editing tab

**Enable looping on events by default:** Sets events that are trimmed longer than their source media to automatically loop. When this option is not selected, extended events repeat the final frame of a video file.

**Preserve pitch when stretching audio events:** Prevents pitch shifting when you stretch an audio event.

**Collapse loop region when no time selection is present:** When selected, a loop region does not persist when there is no time selection. This means that when you click the timeline and move the cursor (destroying the any previous time selection), the loop region is also reset to zero. By default, this option is not selected and loop regions persist until modified or until a new time selection is created.

**Fade edit edges of audio events (ms):** Sets a fast fade on the edges of audio events (10ms by default) to soften potentially harsh beginnings and endings.

**Fade edit edges of video events (ms):** Automatically fades a few frames in and out of inserted video events.

**New still image length:** Sets the default duration of inserted still image files (e.g., BMP, PNG).

**Default time between CD tracks:** Sets the default time Vegas creates between CD tracks when using the **Add Media as CD Tracks** command in the Media Pool window. For more information, see *Adding media as CD tracks to a new project* on page 171.

**Automatically overlap multiple selected media when added:** Creates automatic crossfades between events when multiple media files are added to the same track across time. When this check box is not selected, multiple media files are added end-to-end across time with no overlap. For more information, see *Creating a slide show* on page 182.

**Cut to overlap conversion:** Sets the behavior of the cut-to-overlap feature. The cut-to-overlap feature allows you to transform a cut from one event to another into a transition. For more information, see *Converting a cut to a transition* on page 213.

- **Amount:** Sets the duration of the extended overlap.
- **Alignment:** Determines the direction of the extension: To Cursor, Centered on Cursor, From Cursor.
Sync tab

These preferences are used to set up Vegas to generate or trigger from MIDI timecode from external MIDI devices. For more information, see Synchronizing MIDI timecode on page 160. More details of each preference are discussed later in this section.

**Generate MIDI Timecode settings:** Sets the output device and frame rate that Vegas uses when generating MIDI timecode.

**Generate MIDI Clock settings:** Sets the output device that Vegas uses when generating MIDI Clock information. This device may be set to the same one that you selected for Generate MIDI Timecode settings.

**Trigger from MIDI Timecode settings:** Sets the input software or device and frame rate that Vegas uses when triggering from MIDI timecode.

---

**Note:** When Sync is active (triggering from MTC), media files are not closed (i.e., cannot be edited outside of Vegas) when Vegas is not the active application. You will also not be prompted to rename or delete recorded takes as this may interrupt the synchronization.

---

Setting advanced Sync preferences

From the Sync tab, you may access advanced settings by clicking the Advanced button. The Advanced Sync Preferences dialog appears with three tabs for MTC Input, MTC Output, and MIDI Clock Output. The following sections display the selected tabs followed by definitions of the controls.

**MTC Input**

This tab contains controls for MTC input. It is displayed only if a device is selected for MTC input on the Sync tab.

**Free-wheel for timecode loss:** When selected, Vegas continues to play for a specified period of time without chasing if timecode is lost. Enabling this option can compensate for infrequent losses in timecode monitoring. If losses in timecode are frequent, troubleshooting should be done on your hardware to find the cause of the problem.

**Free-wheel slack time:** Specifies the amount of time that timecode can be lost before the Free-wheel playback time starts. A longer time is more tolerant of losses in the incoming timecode.

**Free-wheel playback time:** Specifies the amount of time that Vegas plays back after the Free-wheel slack time has been exceeded.

**Synchronization delay time:** Specifies the amount of time required for Vegas to synchronize itself to incoming timecode. On slower computers, this time should be set to around two seconds. On faster computers, it may be set lower.

**Offset adjust (quarter frames):** If Vegas is consistently behind or ahead of the MTC generator, enter a value to adjust a synchronization offset with quarter-frame accuracy.

- If Vegas is behind the MTC generator, enter a negative number such as -4.
- If Vegas is ahead of the MTC generator, enter a positive number such as 4.
MTC Output

This tab contains controls for MTC output. It is displayed only if a device is selected for MTC output on the Sync tab.

**Use internal timer for MTC generation:** When selected, the MIDI timecode that Vegas generates is based off of your computer's internal clock. Otherwise, Vegas generates MTC based on the sound card's clock.

**Internal timer resolution:** Allows you to control MTC resolution.

**Full-frame message generation:** Specifies when Vegas sends full-frame timecode messages (when the Sync tab’s Generate MIDI Timecode is used).

Full-frame messages are used by some external audio synchronizers to seek a proper location prior to synchronization. For example, tape-based recorders benefit from seeking to full-frame messages because of the time required to move the transport to the proper location. However, full-frame messages are ignored by some devices and may actually cause unexpected behavior in other devices. Check your hardware documentation to find out if it supports full-frame messages.

MIDI Clock Output

This tab contains controls for MIDI clock output. It is only displayed if a device is selected for MIDI clock output on the Sync tab.

**Send Start instead of Continue when beginning playback:** When selected, Vegas sends a Start command rather than a Continue command when Generate MIDI Clock is enabled on the Sync tab. Normally, Vegas sends a Continue command to allow the chasing device to start at a specific time. However, some older MIDI sequencers do not support the Continue command and must start from the beginning every time.

**Song Position Pointer generation:** Specifies when Vegas sends Song Position Pointer messages when Generate MIDI Clock is enabled on the Sync tab. Song Position Pointer messages are used by MIDI applications and devices to seek to a proper location prior to starting the synchronization process.

Video device tab

*External monitor support is only available in Vegas Video.*

This tab allows you to identify an external video device for Vegas to communicate with. The selected video device is used to display previews on an external monitor or to print directly from the timeline to DV tape. *For more information, see Printing to DV tape on page 246.*

The connection between Vegas and the video device works with OHCI compliant IEEE-1394 DV capture cards and some MJPEG capture cards. There are two cases where Vegas can play back to an external monitor. One is when you have special hardware that has both computer and television monitor outputs. The other is for (OHCI compliant) DV capture cards where DV data can be previewed out through your DV camcorder to an external monitor. *For more information, see Using an external monitor on page 235.*
Troubleshooting

Troubleshooting resources

Visit the Sonic Foundry Web site to access product updates, look for answers in the knowledge base, contact customer support, or participate in an online forum:

http://www.sonicfoundry.com

Common questions

**Why are some of my DirectX plug-ins not working correctly?**

Vegas is a nondestructive time-based editor. As a result, there are certain types of DirectX plug-ins that perform poorly in Vegas. These types of plug-ins are roughly classified as any plug-ins that output a different amount of time than what goes in. This includes all plug-ins such as time compress/expand, gapper/snipper and pitch shift without preserving duration. However, these types of effects plug-ins may perform suitably as bus effects, but only if just one bus is used in the project. Plug-ins that require a lot of pre-buffering (such as Sonic Foundry Acoustic Mirror when using long impulse files) may also perform poorly.

Also, make certain that the plug-ins you use in Vegas are DirectX plug-ins and not DXi plug-ins. DXi plug-ins are not supported in Vegas and do not perform properly.

**Why do I hear gaps in my audio playback?**

Check to see if any Vegas updates have been posted on the Sonic Foundry Web site:

http://www.sonicfoundry.com

Go to the Download page, and click Updates to access the Updates page. Any updates to Vegas are posted at this location.

If software updates do not address the playback problem, check these other reasons that your audio playback can gap:

- Playing back too many tracks simultaneously can overload your hard drives.
- Not enough physical RAM can cause Windows to use virtual memory, which is slower.
- Your CPU may not be able to process a complex mix of plug-ins.
- Problematic video card settings. For more information, see Trouble-free video: hardware solutions on page 265.

The following are some things you can check and do to make sure your system is optimized to prevent gapping.
RAM usage
You could be gapping because Windows virtual memory is being used. Virtual memory is a method used by Windows to write information to your hard drive to make room in physical RAM. This process uses a lot of your computer's resources. Try the following to optimize RAM usage:

- Exit all background applications not in use.
- Adjust the playback buffering slider on the Audio tab in the Preferences dialog. Adjust this slider as low as possible. However, be aware that setting it too low may cause gaps as well.
- Mute/Solo some of the events or tracks in the mix.
- Add more RAM to your computer.

Disk usage
You may experience gapping when data is not being read off the hard drive fast enough. Try the following to optimize disk usage:

- Fully defragment your audio hard drives regularly.
- Split audio usage between different physical hard drives, not just different partitions of the same drive.
- Run fewer events simultaneously. It is not how many tracks you have in the project, but how many different events are playing simultaneously that matters.
- Make sure that you trim out any silent sections of events to minimize the wasted disk access.
- Use hard drives with fast seek times and spindle speeds of 7200 RPM or greater. SCSI drives usually have better prolonged data transfer performance than IDE drives. Under Windows XP and 2000, Vegas can take advantage of SCSI asynchronous reads, which can be a big performance advantage.

CPU usage
If you have checked your RAM usage and disk usage and you are still experiencing gapping, you can try to adjust how Vegas utilizes the central processing unit (CPU). Try the following to optimize CPU usage:

- Zoom out (\[Ctrl\] + \[-Up\]) fully on the track view while playing so that the screen does not have to scroll to keep the cursor on it.
- Run fewer DirectX plug-ins.
- Make sure that the peak files are built for all of the audio data in the project before playing. Peaks are only built for those files on screen. You can get into the situation where the screen scrolls as it plays and Vegas ends up building peaks on the fly. You can play while peaks are being built, but gapping is a distinct possibility. Press \[F5\] before playback to rebuild peaks for all of the events, on or off of the screen.

Why do mono events increase 6 dB when panning a track hard?
In Vegas, all audio events are considered stereo. A mono audio event is interpreted as a stereo event with the same data in both channels. If you're using the Add Channels panning mode, this duplication doubles the amplitude and results in a 6 dB increase in volume when you pan a track hard left or right. Try using the Constant Power panning mode instead. Right-click the multipurpose slider and choose Constant Power from the shortcut menu. For more information, see Adjusting stereo panning on page 135.

Why do buffer underruns occur during a test or real write to a CD?
Buffer underruns occur when data transferred to the CD-R is too slow. This may be caused by a variety of factors relating to optimizing your system. Try writing the CD at a slower speed or prerendering the audio. For more information, see Burning a disc on page 175.

Why can’t I work with footage captured using an MJPEG card?
Vegas requires that you have the MJPEG codec (for the MJPEG card used to capture the video) installed locally on your workstation. Check to make sure that the appropriate MJPEG codec is installed on your PC.
Trouble-free video: software solutions

There are literally dozens of possible configurations of hardware for editing video on a PC. While it is impossible to go into detail for each and every system, the following explains some of the concepts behind the various settings in Vegas. Editing and playing back full-frame, 30 fps video is one of the most demanding activities for any computer. The hardware you use is an important part of the equation, but there are a number of things you can do to optimize your PC for video. The following list is arranged from the most to the least important.

- Close all other applications. When capturing video or playing it back, it is critical that no other applications interrupt this process. Close any applications that are not vital. This includes screen savers, task schedulers, and even virus-detection software. You can ensure that you have closed all unnecessary applications by pressing `Ctrl` + `Alt` + `Delete`, selecting the individual applications, and clicking the End Task button to close them. Certain processes are required and should not (cannot) be terminated (for example, Explorer).
- Check your virtual memory. Windows uses virtual memory when RAM is low. This is a method for Windows to use the hard disk to create more memory and is sometimes called a swap disk. If Windows tries to write to the swap disk during playback or capture, this can interrupt the video software and cause problems. Make sure that Windows is using a different disk drive for virtual memory other than the one from which you are capturing or playing your video. If you have enough space, force Windows to use C:\ for virtual memory and use a physically distinct drive for capturing and playing back video.
- Make sure you have the latest drivers for your video card and capture card and the latest updates and patches to all relevant software. One caveat to this is that you don't try to fix a program that is working correctly. Many times patches and updates fix relatively minor bugs that only affect a small number of users. If you are not experiencing any problems, it is probably best not to upgrade unless the manufacturer recommends it.
- Uncompressed video may be high quality, but it results in very large files with very high data rates. Selecting a more appropriate compression scheme (codec) will definitely improve the situation. If you are creating movies that need maximum quality, however, this may not be an option.

Trouble-free video: hardware solutions

Even with a fast computer, video is still a hardware challenge. On the other hand, it is definitely possible to properly configure a 400 MHz Pentium to work with large video files. There are three parts of your PC that are important and the speed of your CPU is not necessarily the most critical. The following list is arranged from the most to the least important.

Video subsystem

Many graphics cards (video boards, primary display cards) on a PC cannot handle full-screen, full-frame rate video. While this leads to jerky, hesitating playback, it may not actually be a serious problem. A common video configuration is to have a separate video capture card and a primary display card. In this case, the playback using the primary display on the computer may be jerky, but when you finally output the video to tape and view it on your television monitor there may not be any problems. If you are not creating movies to go back to the television or VCR and you are experiencing stuttering playback, you should consider using a smaller frame size (320X240) and frame rate (15 fps).
Hard disk

The second most common problem is slow hard disks. Until recently, fast, expensive SCSI AV hard disks were required to properly capture and play back video on a PC. Slow hard disk problems also manifest themselves with jerky video playback, although the stutters are less frequent and of longer duration than if the video subsystem is the problem. Slower hard disks (e.g., 5400 RPM IDE) can cause an occasional dropped frame. DV enthusiasts have fewer problems due to the low data rate (~3.6 MB/sec.) of that format. The following section outlines some recommendations arranged in order of importance.

- **Buy a dedicated video drive.** This is easily the most important piece of hardware advice. A dedicated, physically distinct hard drive is almost a requirement for any type of serious video work. This means that you have one primary C:\ drive (or wherever Windows is installed) and a separate drive for video. You can use your dedicated drive for other purposes, especially storage, but it is a good idea not to run any applications from it and to keep Windows virtual memory off of it. It is very important that the drive only be used for video when playing and capturing, and that other programs (including Windows) are not trying to access it. Since video files are so large, a dedicated drive is not an unreasonable item even if digital video is just a hobby. You can never have too much hard disk space.

- **Buy a faster hard drive.** Older 5400 RPM hard drives may not be fast enough for capturing and playing back video for any length of time, while newer 7200 RPM drives are almost always adequate. Be careful: manufacturers are usually talking about burst transfer rates when they talk about the speed of a drive. A drive that can transfer data at 80MB/sec is worthless for video if it cannot sustain a much slower rate of 8MB/sec for thirty minutes (or more) without dropping a frame. Look to other computer video enthusiasts for additional advice. Again, the RPMs are a very good indicator, because 7200 RPM IDE drives are usually newer (c.1998) and older 7200 RPM drives are usually SCSI, which are already higher quality drives to begin with.

- **IDE vs. SCSI.** While this was a big issue just a few years ago, it has fortunately faded in importance. Hard drives can be hooked up to your computer in a number of ways, with the two largest divisions being IDE and SCSI. This interface simply determines how much data can be transferred to and from the drive in a second. The interface almost always far outstrips the performance of even the best hard disks and even the slower interfaces exceed the transfer requirements of video data. SCSI hard disks are usually more expensive and require a special controller, and while SCSI-2 promises 80MB/sec transfer rates, this is overkill for most people. Newer IDE hard disks with designations of EIDE, DMA, Ultra-DMA, ATA-33, and ATA-66 (and newer drives that came out after this writing) can all handle most sustained video requirements.

CPU and RAM (memory)

While the CPU and the RAM are probably the most important overall aspects of a PC's speed and performance, these factors are only third on the list for video. For the most part, these critical components do not affect the capture or playback of video. This does not mean that a faster CPU or more RAM will not help, because bigger and faster is always better: CPU and RAM definitely impact rendering speeds. Creating a final AVI file, especially in a movie project that uses a lot of effects and transitions, can take a long time. A thirty-minute movie could easily take six or more hours to render, depending on the format and effects used. CPU speed is also important for more advanced compression codecs, such as MPEG and newer streaming formats.
Audio proxy files (.sfap0)

Working with certain types of media files with particular audio compression schemes can be inefficient and slow. To compensate for this, Vegas creates audio proxy files for formats that are known to dramatically impact performance. There are two cases where this occurs.

Multimedia video files often contain both video and audio information. In certain formats, these two streams can be packed together in such a way as to make editing slow and inefficient. Vegas therefore takes the audio stream from these files (e.g., type-1 DV, QuickTime 4) and saves it to a separate and more manageable audio proxy file.

QuickTime 4 audio-only files can also be compressed in a way that makes editing slower. Vegas also uses audio proxy files in this situation as well. While audio proxy files may be large (because they are uncompressed), the performance increase is significant.

The file is saved as a proprietary .sfap0 file, with the same name as the original media file and has the same characteristics as the original audio stream. So movie.avi yields a movie.avi.sfap0 audio proxy. Additional audio streams in the same file are saved as movie.avi.sfap1, movie.avi.sfap2, etc. This is a one-time process that greatly speeds up editing. The conversion happens automatically and does not result in a loss of quality or synchronization. The original source file remains unchanged (the entire process is nondestructive). Audio proxy files can be safely deleted at any time since Vegas recreates these files as needed.

Note: Audio proxy files are saved to the same folder as the source media. If the source media folder is read-only (e.g., a CD-ROM), the files are saved to a temporary directory.

Interlacing and field order

Field order in interlaced video is an important parameter that can severely impact the quality of video on a television monitor. While the concept is easy enough to understand, the lack of standards in both technology and terminology clouds the issue.

The path of the electron gun across the screen is fundamentally different between television monitors and computer monitors. Computer monitors scan every line in order, from left to right and top to bottom. This is known as progressive scanning. On a standard television monitor, the electron gun scans every other line from top to bottom, twice for every picture or frame. For example, the first scan from top to bottom might scan all of the odd numbered lines first, then jump back to the top of the screen and, in the second scan, draw all of the remaining even numbered lines, completing the frame. The two fields are said to be interlaced together to form a single frame.

The illustration that follows shows how two frames in a video are actually composed of two fields each, for a total of four fields. These fields can be referred to as field one (F1) and field two (F2). Obviously, it is critical that these two fields are paired together to create a whole frame. What may not be so obvious is that the actual order of these two fields is not particularly important. In other words, F1 could be scanned first and then F2, or F2 could be scanned first and then F1. Both situations would create a perfectly valid, error-free frame of video. While that may sound like good news, in reality this is the source of all of the problems associated with field order. Since both methods are technically correct, both methods have been used. It is important to use the correct order when rendering video files for your particular hardware (capture card).
The next illustration shows the effects of incorrectly interlacing a frame of video. In this case, F2 from frame one is combined with F1 from frame two. Remember that there is nothing inherently right or wrong with a field order of F2/F1; it just happens to be wrong in this case. At a minimum, this can create slightly blurry or hazy video. In most situations, the video is jumpy or jittery and is unwatchable. Interlacing problems can be especially noticeable when two adjacent frames are significantly different; for example, at a cut or in video with fast moving action. It can also manifest itself in certain computer-generated special effects; for example, in slow-motion sequences.

The basic problem is that there is no standard correct field order. Some capture cards use F1/F2 and some use F2/F1. If this were the extent of our troubles, we could check out our hardware manual, look up the correct field order and that would be that. Unfortunately (if this information is even available) the terminology used can be equally baffling. F1 may be called the odd, upper, or A field, or (more rarely) it may be called the even, lower, or B field. Add into the mix the fact that the first scan line might be numbered 0 or 1 (which changes whether the field is considered odd or even), and that cropping may change which line is ultimately scanned first, and you can see that this is not a very clear-cut problem. The remainder of this section deals with how to sort this out in Vegas. Fortunately, you only have to determine the correct settings once for any particular hardware setup.

**Identifying problems**

Vegas Video refers to the two fields as Upper field first and Lower field first. These are probably the most common terms used to distinguish the two fields, and you may find a page in your hardware's manual that says something like “Use a field order of lower first.” In many cases (but not all or even most), Upper=Odd=A and Lower=Even=B.
In Vegas, you can select the field order of a project by choosing Properties from the File menu and clicking the Video tab. The pre-configured templates should work for almost everyone (e.g., if you are editing and outputting DV video in the US, select the NTSC DV template). If you have problems, you can manually select a different field order on the Video tab: Upper field first or Lower field first. You can also override the project settings and set the field order when you render a video file. From the File menu, choose Render As. Then, click the Custom button and set the Field order on the Video tab of the dialog that opens. Field order can also be set at the level of the media file or event. Right-click a media file in the Media Pool or an event on the timeline and choose Properties. The field order is found on the Media tab. Vegas automatically detects the correct field order in most situations.

Interlacing problems only manifest themselves on television monitors. Video that is only going to be played back on a computer does not need to be interlaced, and you can select None (progressive scan) for the field order. Rendered video must be displayed on a television monitor to identify any problems. The only way to see interlacing problems is to record (print) a rendered video file out to tape and play back the tape on a television. Problems are most apparent in video that has a lot of motion or that has been modified in some way; for example, a slow-motion effect. (Some codecs force the correct field order during a render, making it difficult or impossible to create video with the wrong field order.)

Solving interlacing problems in Vegas Video

If your hardware's documentation does not contain any information about the proper field order, you must determine this information for yourself. It is not a difficult process, and involves rendering one video file with an upper first field order and another with a lower first field order. Source material that dramatically and clearly demonstrates the improperly interlaced video is important: use a media file with a lot of motion in it and then slow the event down with a velocity envelope or by time-stretching the event.

Timecode

Timecode is a method of labelling frames with a unique and searchable identifier. It is primarily important for synchronizing video (in frames per second) with time in the real world and, in the case of Vegas, with other media in a project.

Changing the timecode used to measure a video file does not alter the contents of the file. For example, no frames are ever "dropped" or removed when using SMPTE 29.97 drop frame timecode. Instead, specific frame numbers are periodically dropped to compensate for differences between timecode and time in the real world. Confusion between using drop versus non-drop timecode can cause synchronization problems between video and audio. For very short periods of time, the error would be unnoticeable. After about a half an hour, you might notice that mouths and words do not quite match in shots of people speaking. Longer stretches of time show larger discrepancies in synchronization.

Changing the timecode displayed on an event is not equivalent to converting a video to another format. You cannot convert NTSC video at 29.97 fps to PAL video at 25 fps by simply changing the timecode. To convert NTSC video to PAL video in Vegas, you need to re-render the video in the new format. In this situation, the conversion process necessarily results in some frames of video actually being removed from the original sequence.

SMPTE timecode types

The following are descriptions of each of the Society of Motion Picture and Television Engineers (SMPTE) timecode types.

**SMPTE 25 EBU (25 fps, Video)**

SMPTE 25 EBU timecode runs at 25 fps, and matches the frame rate used by European Broadcasting Union (EBU) television systems.

Use SMPTE 25 EBU format for PAL DV/D1 projects.
SMPTE Drop Frame (29.97 fps, Video)
SMPTE Drop Frame timecode runs at 29.97 fps, and matches the frame rate used by NTSC television systems (North America, Japan).

Use SMPTE Drop Frame format for NTSC DV/D1 projects.

Both SMPTE Drop and SMPTE Non-Drop run at 29.97 fps. In both formats, the actual frames are not discarded, but they are numbered differently. SMPTE Drop removes certain frame numbers from the counting system to keep the SMPTE clock from drifting from real (“wall clock”) time. The time is adjusted forward by two frames on every minute boundary except 0, 10, 20, 30, 40, and 50. For example, when SMPTE Drop time increments from 00:00:59.29, the next value is 00:01:00.02.

SMPTE Non-Drop Frame (29.97 fps, Video)
SMPTE Non-Drop Frame timecode runs at a rate of 29.97 fps. This leads to a discrepancy between real (“wall clock”) time and the SMPTE time, because there is no compensation in the counting system as there is in SMPTE Drop Frame.

Use SMPTE Non-Drop format for NTSC D1 projects that are recorded on master tapes striped with Non-Drop timecode.

SMPTE 30 (30 fps, Audio)
SMPTE 30 is an audio-only format and runs at exactly 30 fps. SMPTE 30 is commonly used when synchronizing audio applications such as multitrack recorders or MIDI sequencers. This format should not be used when working with video.

SMPTE Film Sync (24 fps)
The SMPTE Film Sync time format runs at 24 fps (frames per second). This frame rate matches the standard crystal-sync 16/33 mm film rate of 24 fps.

Timecode in Vegas
Video timecode crops up fairly frequently in Vegas. Being a multimedia production tool, time in Vegas can be measured in real-world time (hours, minutes, seconds), in video timecode (involving frames of video), or in musical time (measures and beats).

Ruler format and timecode
The ruler in Vegas can be set to measure time in any way that is convenient. This setting does not change how the final file is rendered, but does control the grid lines and how snapping behaves. Right-click the ruler and choose a time format from the shortcut list. For more information, see Changing the ruler format on page 251.

Preferences dialog timecode settings
From the Options menu, choose Preferences and click the Video tab to adjust the Show source frame numbers on event thumbnails as drop-down list. These settings take precedence over those found in the source media Properties dialog (see the next topic) and are displayed on events inserted into the timeline. None means that no numbers are displayed on events, Frame Numbers marks frames in the media file starting with 0, Time displays the time in seconds, and Timecode allows the source media's timecode to be detected or selected.
Source media timecode format
Right-click an event, choose Properties, and click the Media tab to view these properties. By default, Use timecode in file is selected.

Note: These settings may be overridden by the settings on the Video tab of the Preferences dialog. Select Timecode from the Source frame numbering list to allow event-level specification.

Render media file format
The timecode of a final rendered media file is determined by the specified format. The frame rate of the project ultimately determines the timecode and is often constrained by the type of media file being rendered or the codec being used for compression. For example, NTSC DV is typically limited to a frame rate of 29.97 fps and uses SMPTE drop frame timecode.

Time formats in Vegas
Vegas provides a variety of time formats. For more information, see Changing the ruler format on page 251.

Troubleshooting DV hardware issues
Vegas is designed to integrate seamlessly with OHCI compliant IEEE-1394 DV video capture hardware and DV camcorders. While most people never have any problems, the vast number of hardware configuration possibilities makes this a potentially complex issue. Although Sonic Foundry is exclusively a software company, there are a number of resources at Sonic Foundry’s Web site that may be able to assist you.

More detailed information is available at:
http://www.sonicfoundry.com/Support/Productinfo/OHCI.asp
You can also visit the Vegas Video updates Web page to access a troubleshooting document for OHCI compliant devices. From the Sonic Foundry home page, go to the Download page and click Updates. Click the Vegas Video update link to access the update page.
A-Law
A companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit format. The algorithm is commonly used in United States telecommunications. A-Law is very similar to μ-Law, however, each uses a slightly different coder and decoder.

Adaptive Delta Pulse Code Modulation (ADPCM)
A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many different algorithms employed. For example, Microsoft’s ADPCM algorithm is not compatible with the International Multimedia Association’s (IMA) approved ADPCM.

Aliasing
A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a motion picture, when a car’s wheels appear to slowly spin backward while the car is quickly moving forward, you are seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one-half of the sampling rate (the Nyquist Frequency), instead of hearing a high pitch, you may hear alias frequencies in the low end of the spectrum.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same anti-aliasing filter must be applied when resampling to a lower sample rate.

Amplitude Modulation (AM)
A process whereby the amplitude (loudness) of a sound is varied over time. When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies are created which can strongly alter the timbre of a sound.

Analog
When discussing audio, this term refers to a method of reproducing a sound wave with voltage fluctuations that are analogous to the pressure fluctuations of the sound wave. This is different from digital recording in that these fluctuations are infinitely varying rather than discrete changes at sample time (see Quantization).

Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a slow attack.

Audio Compression Manager (ACM)
The Audio Compression Manager, from Microsoft, is a standard interface for audio compression and signal processing for Windows. The ACM can be used by Windows programs to compress and decompress WAV files.
AVI
A file format of digital Video for Windows. Vegas allows you to open, edit and create new AVI files.

Bandwidth
Refers to the EQ plug-in that is built in. Each frequency band has a width associated with it that determines the range of frequencies that are affected by the EQ. An EQ band with a wide bandwidth affects a wider range of frequencies than one with a narrow bandwidth.

Bandwidth can also refer to the amount of data that can be transferred via a connection, such as a network or modem. For example, streaming media must be compressed due to the limited bandwidth of most Internet connections.

Beats Per Measure
In music theory, the time signature of a piece of music contains two pieces of information: the number of beats in each measure of music, and which note value gets one beat. Vegas uses this notion to determine the number of ticks to put on the ruler above the track view, and to determine the spacing when the ruler is displaying Measures & Beats.

Beats Per Minute (BPM)
In music theory, the tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, a single beat occurs once every second. Lower BPM’s equal slower tempo, and vice versa.

Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling (specifically the PCM format), a binary number is used to store individual sound levels, called samples.

Bit Depth
The number of bits used to represent a single sample. Vegas uses either 8, 16, or 24-bit samples. Higher values increase the quality of the playback and any recordings that you make. While 8-bit samples take up less memory (and hard disk space), they are inherently noisier than 16 or 24-bit samples.

Byte
Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of memory to store.

Clipboard
The Clipboard is where data that you have cut or copied in Vegas is stored. You can then paste the data back into Vegas at a different location, or paste it into other applications. Some data, such as audio, cannot be pasted into applications such as Microsoft Word or Notepad, but the text data from the Edit Details window can be pasted. This allows you to then print or format the data. The Video Preview window also lets you capture still frames to the Clipboard for use in any image editing program. For more information, see Understanding the Video Preview window on page 229.

Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to distort.
CODEC
An acronym for COmpressor/DECompressor. A codec is a computer algorithm that is used to compress video and audio data, shrinking file sizes and data rates.

Compositing
Compositing is the term used to describe the way separate video sources are mixed together. Overlay titles are composited onto a background video sequence.

Crossfade
Mixing two pieces of overlapping audio or video by fading one out as the other fades in.

Cutoff frequency
The cutoff frequency of a filter is the frequency at which the filter changes its response. For example, in a low-pass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than the cutoff frequency are not affected.

DC Offset
DC Offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current causes the audio signal to alternate around a point above or below the normal -infinity dB (center) line in the sound file. To see if you have a DC offset present, you can zoom all the way into a sound file and see if it appears to be floating over the center line.

Decibel (dB)
A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing two instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a logarithmic scale.

In Vegas, most measurements are given in decibels. For example, if you want to double the amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to having a value of -6 dB.

Device Driver
A program that enables Windows to connect different hardware and software. For example, a sound card device driver is used by Windows software to control sound card recording and playback.

Digital Signal Processing (DSP)
A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to perform many effects such as equalization and reverb simulation. Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer’s processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are optimized specifically for mathematical functions while your computer’s microprocessor is not. This results in a difference in processing speed.

Dithering
The practice of adding noise to a signal to mask quantization noise (see also Noise Shaping).
Drag and Drop
A quick way to perform certain operations using the mouse in Vegas. To drag and drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move the mouse) and drop it (let go of the mouse button) at another position on the screen.

Dynamic Range
The difference between the maximum and minimum signal levels. It can refer to a musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, while thrash metal has a very small (always loud) range.

Emphasis
A rudimentary noise reduction process that involves a boost in the high frequencies during the recording of the CD and a complimentary cut in the same frequencies during the playback of the CD. The result reduces high frequency noise without disrupting the natural frequency response of the source material. If the emphasis flag is set for a track, any CD player that has a de-emphasis circuit will impart the high frequency cut on the track. Be aware that Vegas cannot impart the pre-emphasis boost on a track; it can only set the emphasis flag.

Endian (Little and Big)
Little and Big Endian describe the ordering of multi-byte data that is used by a computer’s microprocessor. Little Endian specifies that data is stored in a low to high-byte format; this ordering is used by the Intel microprocessors. Big Endian specifies that data is stored in a high to low-byte format; this ordering is used by the Motorola microprocessors.

Envelopes (Audio and Video)
Envelopes, as used by Vegas, are a way of automating the change of a certain parameter over time. In the case of Volume, you can create a fade out (which requires a change over time) by adding an envelope and creating an extra point to the line that indicates where the fade starts. Next, you pull the end point of the envelope down to infinity. For more information, see Working with track envelopes on page 137.

Equalization (EQ)
The process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use in Vegas is to simply adjust the subjective timbral qualities of a sound.

Event
Media files that have been dragged onto the timeline in Vegas are referred to as events. An event is actually a window into a media file and is a reference, or pointer, to the file. It can display all or part of a media file and can be edited without altering the source media (nondestructive).

File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows for example, the most common audio file format is the Microsoft WAV format. However, Vegas can read and write to many other file formats so you can maintain compatibility with other software and hardware configurations.

Frame Rate (Audio)
Audio uses frame rates only for the purposes of synching to video or other audio.
Frame Rate (Video)
The speed at which individual images in the video are displayed on the screen. A faster frame rate results in smoother motion in the video. However, more times than not, frame rate is associated with SMPTE standard frame rates for video: 29.97 for NTSC, 25 for PAL, or 24 for film.

Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200 Hz) of the spectrum.

Hertz (Hz)
The unit of measurement for frequency or cycles per second (CPS).

Insertion Point
The insertion point (also referred to as the cursor position) is analogous to the cursor in a word processor. It is where pasted data is placed or other data is inserted, depending on the operation. The insertion point appears as a vertical flashing black line and can be moved by clicking the left mouse button anywhere in the timeline.

Markers
Saved locations in the sound file. Markers are stored in the Markers and Regions list and can be used for quick navigation.

Markers can be displayed in the Trimmer window for sound files that contain them, but more often, markers and regions are used at the project level to mark interesting places in the project.

Media Control Interface (MCI)
A standard way for Windows programs to communicate with multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can easily be controlled by most multimedia Windows software.

Media File
A media file, or multimedia file, is any image, audio or video file on a computer. In Vegas, you can browse for these files in the Explorer window. You can drag media files to the timeline or insert them into the Media Pool. Media files that have been dragged to the timeline are referred to as events.

Media Player
A Microsoft Windows program that can play digital sounds or videos using MCI devices. Media Player is useful for testing your sound card setup. For example, if you can’t hear sound when using Vegas, try using Media Player. If you can’t play sound using Media Player, check the sound card’s manual. Please contact your sound card manufacturer before calling Technical Support at Sonic Foundry.

MIDI Clock
A MIDI device specific timing reference. It is not absolute time like MIDI timecode (MTC); instead, it is a tempo-dependent number of “ticks” per quarter note. MIDI clock is convenient for synchronizing devices that need to do tempo changes mid-song.

MIDI Port
A MIDI Port is the physical MIDI connection on a piece of MIDI gear. This port can be a MIDI in, out or through. Your computer must have a MIDI port to output MIDI timecode to an external device or to receive MIDI timecode from an external device.
**MIDI Timecode (MTC)**
MTC is an addendum to the MIDI 1.0 Specification and provides a way to specify absolute time for synchronizing MIDI-capable applications. Basically, it is a MIDI representation of SMPTE timecode.

**Mix**
The process of combining multiple audio events and effects into a final output. The analogous process of combining video events together is called compositing.

**Musical Instrument Digital Interface (MIDI)**
A standard language of control messages that provides for communication between any MIDI compliant devices. Anything from synthesizers to lights to stage equipment can be controlled via MIDI. Vegas utilizes MIDI for synchronization purposes.

**Noise-shaping**
Noise-shaping is a technique that can minimize the audibility of quantization noise by shifting its frequency spectrum. For example, in 44,100 Hz audio, quantization noise is shifted towards the Nyquist Frequency of 22,050 Hz. See also Dithering.

**Nondestructive Editing**
A type of editing used by Vegas that involves a pointer-based system of keeping track of edits. When you delete a section of audio in a nondestructive system, the audio on disk is not actually deleted. Instead, a set of pointers is established to tell the program to play the active sections during playback.

**Nonlinear Editing (NLE)**
A method of editing video non-sequentially or in random order. Editing video in Vegas is nonlinear as opposed to editing video tape, which is linear.

**Normalize**
Refers to raising the volume so that the highest level sample in the file reaches a user-defined level. Use this function to make sure you are fully utilizing the dynamic range available to you.

**Nyquist Frequency**
The Nyquist Frequency (or Nyquist Rate) is one-half of the sample rate and represents the highest frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz produce aliasing distortion in the sample if an anti-aliasing filter is not used while recording.

**Pan**
To place a mono or stereo sound source perceptually between two or more speakers.

**Peak File (.sfk)**
Vegas displays the waveform of audio files graphically on a computer monitor. This visual information must be generated by Vegas when the audio file is opened and can take a few seconds. Vegas then saves this information as a peak file (.sfk). This file stores the information for displaying waveform information so that opening a file is almost instantaneous. The peak file is stored in the directory in which the file resides and has an .sfk extension. If the peak file is not in the same directory as the file, or is deleted, Vegas regenerates it the next time you open the file.
Plug-In
An effect that can be added to the product to enhance the feature set. Vegas supports DirectX compatible plug-ins. The built-in EQ, Compression and Dithering effects are also considered plug-ins because they work in other DirectX-compatible applications.

Plug-In Chain
Plug-ins can be strung together into a chain so that the output of one effect feeds into the input of another. This allows for complex effects that couldn’t otherwise be created.

Pre-roll/Post-roll
Pre-roll is the amount of time elapsed before an event occurs. Post-roll is the amount of time after the event. The time selection defines the pre- and post-roll when recording into a selected event.

Preset
A snapshot of the current settings in a plug-in. Presets are created and named so that you can easily get back to a sound or look that you have previously created.

A preset calls up a bulk setting of a function in Vegas. If you like the way you tweaked that EQ, but do not want to have to spend the time getting it back for later use, save it as a preset. Presets appear in the top of plug-in windows in Vegas.

Pulse Code Modulation (PCM)
PCM is the most common direct binary representation of a level of an uncompressed audio signal. This method of coding yields the highest fidelity possible when using digital storage.

Punch-In
Punching-in during recording means automatically starting and stopping recording at user-specified times. In Vegas, shorter events can be punched into longer ones.

Quadraphonic
A mixing implementation that allows for four discrete audio channels. These are usually routed to two front speakers and two back speakers to create immersive audio mixes.

Quantization
The process by which measurements are rounded to discrete values. Specifically with respect to audio, quantization is a function of the analog-to-digital conversion process. The continuous variation of the voltages of an analog audio signal are quantized to discrete amplitude values represented by digital, binary numbers. The number of bits available to describe these values determines the resolution or accuracy of quantization. For example, if you have 8-bit analog-to-digital converters, the varying analog voltage must be quantized to 1 of 256 discrete values; a 16-bit converter has 65,536 values. Quantization is to level as sampling rate is to time.

Quantization Noise
A result of describing an analog signal in discrete digital terms (see Quantization). This noise is most easily heard in low resolution digital sounds that have low bit depths and is similar to a “shhhhh” type sound while the audio is playing. It becomes more apparent when the signal is at low levels, such as when doing a fade out. See also Dithering.

Red Book specification
The Red Book defines the specifications of every audio compact disc in every music store throughout the world. Red Book specifications define not only the information within the disc (digital audio recorded at 44.1 kHz), but also the disc size itself and the way in which the audio is arranged.
Region
A subsection of a sound file denoted by a start and end point. You can define any number of regions in a sound file.

Resample
The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If an audio file is resampled at a lower rate, Vegas decreases sample points. As a result, the file size and the frequency range are reduced. When resampling to a higher sample rate, Vegas interpolates extra sample points in the sound file. This increases the size of the sound file but does not increase the quality. When down-sampling, one must be aware of aliasing (see Aliasing). Vegas automatically resamples all audio to the project’s sample rate.

Ripple; Ripple Editing
A type of editing where events are moved out of the way to make room for newly inserted events as opposed to simply being overwritten. When a one minute event is ripple inserted into a project, the duration of a project lengthens by one minute. If ripple editing is turned off, the same operation would not affect the overall duration of the project.

Roll
Originally, a conventional studio typically had two source decks that were used to play back video to a final destination or output deck. These two source decks were commonly referred to as the A and B rolls. In Vegas, a video track can be configured to display an A and a B roll, which appear as sub-tracks. The concept is extended further in Vegas to include a Transition roll between the A and B rolls. For more information, see Understanding track layers on page 212.

Ruler
The ruler is the area above the tracks that shows the horizontal axis units.

Sample
The word “sample” is used in many different (and often confusing) ways when talking about digital sound. Here are some of the different meanings:

- A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 44,100 samples per second. Each sample is really only a number that contains the amplitude value of a waveform measured over time.
- A sound that has been recorded in a digital format; used by musicians who make short recordings of musical instruments to be used for composition and performance of music or sound effects. These recordings are called samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.
- The act of recording sound digitally (i.e., to sample an instrument) means to digitize and store it.

Sample Rate
The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher sample rates. Sampling rate is to time as quantization is to level.

Sample Size
See Bit Depth.
Sample Value
The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is often referred to as 100% or 0 dB.

.sfap0
Sonic Foundry audio proxy file. For more information, see Audio proxy files (.sfap0) on page 267.

.sfk
See Peak File.

Shortcut Menu
A context-sensitive menu that appears when you right-click certain areas of the screen. The functions available in the shortcut menu depend on the object being clicked on as well as the state of the program. As with any menu, you can select an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in Vegas for quick access to many commands. An example of a shortcut menu can be found by right-clicking any event along the timeline.

Signal-to-Noise Ratio
The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR is always the goal.

The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the signal to noise ratio is 96 dB, while in 8-bit audio, the ratio is 48 dB. However, in practice, this SNR is never achieved, especially when using low-end electronics.

Small Computer Systems Interface (SCSI)
A standard interface protocol for connecting devices to your computer. The SCSI bus can accept up to seven devices at a time including CD-ROM drives, hard drives and samplers.

Society of Motion Picture and Television Engineers (SMPTE)
SMPTE timecode is used to synchronize time between devices. The timecode is calculated in Hours:Minutes:Seconds:Frames, where Frames are fractions of a second based on the frame rate. Typical frame rates for SMPTE timecode can be 24, 25, 29.97 or 30 frames per second, depending on your local standards.

SMPTE Drop Frame Timecode
A method of measuring time in video. Drop frame involves skipping two frame numbers (no frames are actually dropped) every ten minutes to compensate for the difference between NTSC 29.97 fps video and 30 frame counts per second.

Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).

Time Format
The format by which Vegas displays the ruler and selection times. These include: Time, Seconds, Frames and all Standard SMPTE frame rates.

Time Signature
See Beats per Measure.
Timecode

For more information, see Timecode on page 269.

Track
A discrete timeline for audio or video data. Events are placed on tracks and determine when sound or images start and stop. Multiple audio tracks are mixed together to give you a composite sound that you hear. Multiple video tracks are composited on top of each other to create the final video output.

µ-Law
µ-Law (mu-Law) is a compounded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit PCM signals into a nonlinear 8-bit format. The algorithm is commonly used in European and Asian telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and decoder.

Undo Buffer
This is the temporary file created before you do any processing to a project. This undo buffer allows the ability to revert to previous versions of the project if you decide you don't like changes you've made to the project. This undo buffer is erased when the file is closed or the Clear Undo History command is invoked.

Undo/Redo
These commands allow you to change a project back to a previous state when you don't like the changes you have made, or reapply the changes after you have undone them. The ability to Undo/Redo is only limited by the size of your hard drive. See Undo Buffer.

Undo/Redo History
A list of all of the functions that have been performed to a file that are available to be undone or redone. Undo/Redo History gives you the ability to undo or redo multiple functions. To display the history list, click the down-arrow button next to the Undo and Redo buttons.

Video for Windows (AVI)
See AVI.

Virtual MIDI Router (VMR)
A software-only router for MIDI data between programs. Vegas uses the VMR to receive MIDI timecode and send MIDI clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs running on the same PC. Sonic Foundry supplies a VMR with Vegas called the Sonic Foundry Virtual MIDI Router.

Waveform
A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform.

Waveform Display
A section inside of the Trimmer window that shows a graph of the sound data waveform. The vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 24-bit sounds, the range is -8,388,607 to +8,388,607. The horizontal axis corresponds to time, with the leftmost point being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of the sound file.
Zero-crossing
A zero-crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits at zero-crossings with the same slope, the chance of creating glitches is minimized. Vegas simulates zero crossings by applying short (10 mS default) fades to trimmed audio.

Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain does not change in small enough increments, zipper noise can become very noticeable. Vegas fades are accomplished using 64-bit arithmetic, thereby creating no zipper noise.
Index

A

A/B roll, See Tracks, Track layers
Add channels panning model, 135
Adding empty tracks, 131
Alpha channel, 207
in images, 180, 183
selecting type for media file, 180
Animation, 198
Arming tracks to record, 78, 161
ASR, See Envelopes
Assignable effects, 143, 156, 157
assigning tracks to, 157
routing to busses, 157
volume adjustment, 157
volume envelope, 137
Audio CD tab, 256
Audio channels, 124
Audio editor program, 106–107
opening from Trimmer, 118
opening from Vegas, 106
setting up, 106
Audio effects, 143–149
adding via Plug-in Chooser dialog, 144
adding via Plug-in Explorer window, 145
assignable effects, 156, 157
bypassing plug-ins, 147
creating a plug-in chain, 144
Plug-Ins window, 27
rearranging chain order, 146
removing plug-ins from chain, 147
Audio preferences, 258
advanced control settings, 259
playback buffering slider, 259
Audio property settings, 255
Audio proxy files, 267
Audio tab, 255
Auto-crossfades, converting to transitions, 212
Autosaving, 239
AVI
bit-depth, 245
channels, 245
creating a movie, 82
format, 240, 244
frame rate, 243
frame size, 243
sample rate, 245
template, 242, 243
video compression, 244

B

Balance panning model, 135
Blue screening, 208
Burning audio CDs, 169–175
adding pauses between tracks, 172
creating a CD layout, 171
disc-at-once burning, 169, 175
exporting a track list, 174
importing CD Architect files, 170
marking tracks and indices, 172
settings and preferences, 170
track-at-once burning, 169, 174
Busses, 152–155
adding to project, 153
adjusting for clipping, 155
adjusting volume, 154
assigning plug-ins to, 143
assigning tracks to, 78, 155
bus send volume envelopes, 137
controls, 153
deleting from project, 153
meter resolution, 154
muting, 155
naming/renaming, 155
routing to hardware, 154
soloing, 155
Bypassing
audio plug-ins, 147
video plug-ins, 196

C

Capturing images
from a scanner, 70
from the Video Preview window, 181
Capturing Video
recapturing offline clips, 70
Capturing video, 69

CD
  burning audio CDs, 169–175
  burning multimedia CDs, 249
  burning Video CDs, 248

CD Architect files, 170

CD layout bar, 21

CD Settings tab, 260

Channels, audio, 124

Child tracks (compositing), 199, 203

Chromakeying, 208
  multiple keys, 209

Clean up prerendered video, 231

Clearing the edit history, 99

Closed captioning, 184–186
  adding from a script, 184–186
  adding line-by-line, 184
  displaying, 186

Color
  Time Display window, 253
  track, 133

Color gradient event, 198

Color key, 208

Command markers, 103
  closed captioning, 184–186
  command bar, 20
  editing, 105
  inserting, 105
  Scott Studios, 104

Composite level envelope, 137

Composite level slider, 77, 135, 202

Compositing, 199–202
  compositing modes, 77, 200
  parent/child tracks, 199, 203

Constant power panning model, 135

Converting format, See Rendering

Copying events, 87
  time and events, 88
  time selections, 88

Creating a movie, 82, 239–245

Credit roll event, 198

Cropping video, 177–179

Crossfades, 97–98, 211
  automatic, 97
  curve types, 98
  curve types, changing, 98
  manually setting, 97
  overlapping files added to timeline, 182
  sliding, 98

video, 211

Cursor indications, 32

Customizing Vegas, 251–262
  frame number display, 251
  grid spacing, 252
  preferences, 256–262
  project properties, 254
  rendering settings, 241
  ruler, 251
  Time Display window, 253–254
  toolbar, 19
  Video Preview window, 229–234

Cuts, 211
  converting to transitions, 213

Cutting events, 88
  ripple mode, 88
  time and events, 89
  time selections, 89

D

Deleting
  busses, 153
  CD layout bar markers, 174
  command markers, 106
  envelope points, 138
  events, 96
  keyframes, 216
  markers, 101
  regions, 103
  takes, 114
  tracks, 132

Digital multitrack setup, 160

DirectX plug-ins, 143, 193

Disc-at-once CD burning, 169, 175

Docking Vegas windows, 22

Duplicating
  events, 92
  generated media events, 199
  keyframes, 216
  tracks, 131

DV capture cards, 262, 271

DV format, 189–190
  out-of-range colors, 189
  selecting source media for, 189
  setting project properties for, 189
  templates for, 189

Dynamic RAM video previews, 232

E

Edge trimming, 92

Edit Decision Lists (EDL), 188

Edit Details window, 24, 118
INDEX

audio CD track list category, 119
closed captioning, 184–186
customizing, 120
displaying, 119
edit functions, 118
editing a CD layout, 174
events category, 119
markers category, 120
regions category, 120
selected events category, 120
Edit history, clearing, 99
Editing audio in external editor, 106
Editing tools
   Envelope, 128
   Normal, 84
   Selection, 84
   Zoom, 75
Empty events, 92
Envelope Edit Tool, 128, 140
Envelopes, 125–128, 137–141
   adding, 137
   adding points, 138
   ASR, 125
   changing fade curves, 139
   deleting from track(s), 139
   deleting points, 138
   event envelopes, 125
   fade in and out, 125, 127
   fade types, 126, 127
   hiding on track(s), 139
   moving points, 138
   opacity, 126
   track envelopes, 137
   velocity, 127
   video, 126
   volume (event), 125
   volume (track), 137
Equipment setup, 159–160
   basic, 159
   mixer, 160
   with digital multitrack, 160
   with MIDI option, 160
Event editing, 87
Event properties
   displaying names, 114
   name, changing, 114
   pitch shifting, 111
Event switches, 121–123
   invert phase, 122
   lock, 121
   loop, 121
   maintain aspect ratio, 123
   mute, 121
   normalize, 122
   reduce interlace flicker, 123
   resample, 123
Event takes, 113
   adding files as, 113
   changing active, 113
   copying event attributes using, 114
   deleting, 114
   displaying names of, 114
   previewing, 114
   recording audio as new, 162
   renaming, 114
   selecting, 113
Events
   channels, 124
   copying, 87
   crossfading, 97, 182, 211
   cutting, 88
   defined, 67
   deleting, 96
   duplicating, 92
   editing, 41, 42
   empty, 92
   envelopes, 125–128
   grouping, 43, 128–129
   locking, 41
   moving by small increments, 74
   moving in time, 73
   moving multiple, 74
   moving single, 74
   name, changing, 115
   pasting, 90–91
   pitch shifting, 111
   placing, 39, 71, 72
   playback rate, 124
   recording into, 163
   ripple editing, 87
   selecting multiple, 84
   selecting with time, 86
   shifting the contents of, 95
   sliding, 96
   slipping, 95
   slip-trimming, 96
   snapping, 109
   splitting, 94
   splitting with time selection, 42
   switches, 121
   trimming, 92
   undersample rate, 124
Expand track keyframes, 77
Expand track layers, 77, 212
Explorer window, 23
   transport bar, 68
   using, 37
External monitor, 235–236, 262

F

Fade to color, 137
Fader
- assignale effects, 135
- bus send, 135, 156
- pan, 135
- track, 134
Field order, 190, 267
Filters, See Video effects
Focus, 83
Frame numbers, 251
Frame-by-frame cursor movement, 83

G
General editing, 83–107
- event vs. file, 73
General preferences, 256
Generator
- adding, 198
- duplicating, 199
- Text/Backgrounds window, 27
Glossary, 273–283
Glow, 225
Grid lines
- safe areas, 232
- snapping events to, 109
- spacing, 252
Grouping events, 43, 128–129
- adding to groups, 129
- clearing groups, 129
- creating new groups, 129
- disabling grouping, 129
- moving grouped events, 74
- removing events from groups, 129
- selecting events in groups, 129

H
Histograms, 233–234
Hold keyframe, 217

I
IEEE-1394 DV capture cards, 15, 69, 189, 235, 245, 246, 262, 271
Ignore event grouping, 129
Images
- automatically crossfading, 182
- capturing in Vegas, 181, 230
- correcting for DV pixel aspect ratios, 181
- creating for use in Vegas, 180
- creating masks from, 203
- creating titles from, 183
- default length, 182
- working with, 180
- zooming in on, 218
Importing
- audio CD tracks, 70
- CD architect files, 170
- media from other projects, 69
- scanned images, 70
- still image sequences, 71
Inserting
- command markers, 105
- empty events, 92
- markers, 100
- media, 71
- regions, 102
- time, 92
- video files with associated audio, 72
Installation, 17
- system requirements, 15
Interlace, 267
- deinterlacing, 191
- field order, 190, 243, 267
- reduce interlace flicker, 123
- troubleshooting, 269
Inverting
- audio event, 122
- audio track, 136
- Invert track phase, 78
Isolate channels, 205

K
Keyboard commands, 28–31
- cursor placement, 29, 83, 86
- edit, 28
- event, 30
- miscellaneous, 31
- playback, 28
- project file, 28
- selection, 29
- track view, 31
- Trimmer window, 31
- view, 29
- window view, 28
Keyframe animation, 198, 215
- event panning and cropping, 218
- generated text, 222
- track motion, 225
- video effects, 221
Keyframe controller, 215
- navigating, 216
Keyframes
- adding, 216
- changing relative spacing, 217
- deleting, 216
- in track view, 77, 217–218
- interpolation curves, 217
- modifying, 216
Keying, 208
INDEX

L
Labeling busses, See Naming busses
Labeling tracks, See Naming tracks
Level slider, See Composite level slider
Locking events, 121
to track envelopes, 141
to track keyframes, 218
Loop playback, 86
Looping events, 121
Luminance, 207

M
Main window, 19
Make compositing child, 77, 200, 203, 205
Marker bar, 20
Markers
CD layout markers, 106
command markers, 103
deleting, 101
inserting, 100
moving, 101
navigating, 101
renaming, 101
snapping, 109
Markers and regions, 100–106
snapping events to, 109
Masks, 203–209
fine tuning, 205
image, 203
mask generator, 206
video, 204
Match media settings, 66, 190
Media files
auto preview setting, 68
inserting, 71
previewing, 68
properties, 191
Media generator, 198–199
adding, 198
duplicating, 199
Text/Backgrounds window, 27
Media Pool, 25, 68
adding media, 69
adding still image sequences, 71
capturing video, 69
extracting CD audio, 70
getting images, 70
replacing media in events, 69
Metronome, 162, 258
MIDI clock output, 262
MIDI timecode
input devices, 261
output devices, 262
Time Display window, 254
triggering from, 165
Mixer, 24, 151
busses, 152
preview fader, 152
toolbar, 152
viewing/hiding, 151
Mixer setup (external), 160
Mixing
multiple tracks to a new track, 141
video tracks, 199
Mouse scroll-wheel shortcuts, 32, 75, 83
MTC, See MIDI timecode
Multimedia CDs, 249
Multiple takes
previewing, 114
recording, 165
selecting among, 113
Multipurpose slider, 78, 134
assignable effects send level, 135, 157
bus send level, 135, 156
panning, 135, 264
Muting
all audio or video tracks, 136
busses, 155
events, 121
mute button, 77, 78
tracks, 136

N
Naming
buses, 155
CD layout markers, 173
markers, 101
regions, 102
takes, 115
tracks, 132
Non-real-time event effects, 149
Normal Edit Tool, 84
Normalize audio event, 122

O
OHCI 1394-IEEE cards, 15, 69, 189, 236, 245, 246, 262, 271
Online help, 17
accessing, 17
icon, 17
via the web, 18
What’s This? help, 18
Optimizing previews, 230–234
Ordering of effects, 146, 196

INDEX
Organizing tracks, 132–133

Overlays
- animating, 226
- compositing modes, 200
- flipping, 227
- position, 225
- rotating, 227
- safe areas, 232
- shadow, 225
- transparency, 208

Panning, audio
- envelope, 137
- multipurpose slider, 135
- panning models, 135

Panning, video, 218
- pan-and-scan effect, 219
- still images, 61

Parent/child tracks, 199, 203

Pasting
- events, 90–91
- paste insert, 91
- paste repeat, 91

Perfect Clarity (.pca) audio format, 240

Phase inverting
- events, 122
- tracks, 136

Picture-in-picture effect, 225

Pitch shifting, 111

Pixel aspect ratio, 190
- custom stream properties, 192
- render settings, 244
- still images, 181

Placing media
- as takes, 72
- dragging/dropping, 71
- multiple files, 72
- same track, 72
- separate tracks, 72

Playback
- buffer control, 259
- event playback rate, 124
- interpolate cursor position control, 259
- keyboard shortcuts, 28
- position bias control, 259
- pre-roll buffer control, 259
- scrubbing, 80
- transport bar controls, 21
- video, 39

Plug-in chain
- audio hierarchy, 33
- changing order, 146, 147, 195, 196
- creating, 144, 194
- saving presets, 146, 197
- video hierarchy, 34

Plug-ins
- animating, 198
- audio, 143
- bypassing, 147, 196
- keyframes, 198
- masks, 203
- media generators, 198
- ordering, 146, 195
- removing, 147, 197
- transitioning into, 221
- transitions, 211
- video, 193
- window, 27

Post-roll, 164

PQ list, See Track list

Preference settings, 256–262
- Audio tab, 258
- Audio tab, advanced settings, 259
- CD Settings tab, 260
- Editing tab, 260
- General tab, 256
- Sync tab, 258, 261
- Sync tab, advanced settings, 261
- Video device tab, 262

Preparing video for broadcast
- out-of-range colors, 233
- safe areas, 232

Preparing video for television
- DV format guidelines, 189–190

Prerendering video, 231

Pre-roll, 165

Preset chains, 148–149
- editing, 148
- organizing, 149
- saving from existing chains, 148

Presets, saving, 146, 197, 214

Preview fader
- adjusting for clipping, 155
- adjusting volume, 152
- hiding/viewing, 152
- meter resolution, 152

Previews, 79
- in media players, 81
- optimizing, 230
- prerendering, 231
- resolution, 231
- transitions, 214

Printing video
- from the timeline, 246
- from Video Capture, 245

Project playback
- entire, 79
media player, 81
time selection, 79

Project property settings, 254–256
  Audio CD tab, 256
  Audio tab, 255
  matching video settings of existing file, 66, 190
  Ruler tab, 255
  Summary tab, 256
  Video tab, 254

Projects, 65
  creating, 65
  renaming, 67
  rendering, 239
  saving, 66, 237
  saving as EDLs, 188

Properties
  events, 124
  media file, 191
  project, 65, 254–256
  track defaults, 137

Proxy files, audio, 267

Punch-in, 91, 164

Q

Quantizing to frames, 109
Quick start, 65–82

R

RAM cache for previews, 232

RealMedia (.rm)
  commands, 104
  file format, 82, 240

Recapturing offline video clips, 70

Recording, 159–167
  arming tracks, 161
  into a time selection, 163
  into an event, 163
  into an event with time selection, 164
  multiple takes, 165
  previewing takes, 114
  selecting track input devices, 161
  specifying storage folder, 166–167
  starting and stopping, 162
  stereo, left, right channel options, 161, 162

Red book CD burning, 169, 175

Redo/Undo commands, 98–99
  clearing history, 99
  multiple, 99

Region, 101

Regions
  adding as takes, 118
  deleting, 103
  inserting, 102
  moving, 102
  naming, 102
  navigating to, 103
  selecting, 102

Registering Vegas, 17

Removing
  events from a group, 129
  plug-ins, 147, 197
  track envelopes, 139
  velocity envelopes, 128

Renaming
  busses, 155
  CD layout markers, 173
  markers, 101
  projects, 67, 238
  tracks, 132

Rendering, 82, 239–245
  controls and templates, 241
  custom settings, 241
  file formats, 82, 240
  to a new track, 141

Reordering tracks, 132

Resampling, 187–188
  at final render, 187, 243
  event, 123, 127, 187

Reversing a video event, 128

Ripple editing, 87–92
  across all tracks, 91
  cutting events, 88

Ruler, 20
  offset, setting, 252
  project property settings, 255
  time formats, 252, 271

Ruler tab, 255

S

Safe areas, 232

Saving a project, 40, 66, 237–239
  autosaving, 239
  using Save As, 67, 238
  with media files, 238

Scott Studio
  commands, 100, 104
  file format, 67, 240

Scribble strip, 38, 77, 78, 132

Scrolling, 75

Scrubbing, 80–81
  keyboard, 81
  scrub control, 22, 80
  timeline, 80

Selecting
  all members of a group, 129
INDEX

<table>
<thead>
<tr>
<th>Audio CD tracks</th>
<th>173</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope points</td>
<td>140</td>
</tr>
<tr>
<td>Events and a time range</td>
<td>86</td>
</tr>
<tr>
<td>Events to the end of the track</td>
<td>85</td>
</tr>
<tr>
<td>Grouped events</td>
<td>129</td>
</tr>
<tr>
<td>Media files</td>
<td>67</td>
</tr>
<tr>
<td>Multiple events</td>
<td>84</td>
</tr>
<tr>
<td>Range of events</td>
<td>84</td>
</tr>
<tr>
<td>Regions</td>
<td>102</td>
</tr>
<tr>
<td>Takes</td>
<td>113</td>
</tr>
<tr>
<td>Time range</td>
<td>85</td>
</tr>
<tr>
<td>SFAP files</td>
<td>267</td>
</tr>
<tr>
<td>Shadow</td>
<td>225</td>
</tr>
<tr>
<td>Signal flow</td>
<td>33–34</td>
</tr>
<tr>
<td>Simultaneous play and record</td>
<td>162</td>
</tr>
<tr>
<td>Single session CD burning</td>
<td>169</td>
</tr>
<tr>
<td>Slide show, creating</td>
<td>182</td>
</tr>
<tr>
<td>Sliding crossfades</td>
<td>98</td>
</tr>
<tr>
<td>Events</td>
<td>96</td>
</tr>
<tr>
<td>Slipping events</td>
<td>95</td>
</tr>
<tr>
<td>Slip-trimming events</td>
<td>96</td>
</tr>
<tr>
<td>SMPTE timecode</td>
<td>269</td>
</tr>
<tr>
<td>Changing</td>
<td>252</td>
</tr>
<tr>
<td>Snap offset</td>
<td>110</td>
</tr>
<tr>
<td>Snapping events</td>
<td>109–110</td>
</tr>
<tr>
<td>Quantizing to frames</td>
<td>109</td>
</tr>
<tr>
<td>Snap offset</td>
<td>110</td>
</tr>
<tr>
<td>To a selection</td>
<td>110</td>
</tr>
<tr>
<td>To grid lines</td>
<td>109</td>
</tr>
<tr>
<td>To marker lines</td>
<td>109</td>
</tr>
<tr>
<td>To the cursor</td>
<td>110</td>
</tr>
<tr>
<td>Solid color event</td>
<td>198</td>
</tr>
<tr>
<td>Soloing</td>
<td></td>
</tr>
<tr>
<td>Assignable effects chains</td>
<td>156</td>
</tr>
<tr>
<td>Busses</td>
<td>155</td>
</tr>
<tr>
<td>Solo button</td>
<td>77, 78</td>
</tr>
<tr>
<td>Tracks</td>
<td>136</td>
</tr>
<tr>
<td>Splitting</td>
<td>94–95</td>
</tr>
<tr>
<td>All events at cursor</td>
<td>94</td>
</tr>
<tr>
<td>Selected events</td>
<td>94</td>
</tr>
<tr>
<td>Time selection</td>
<td>42, 95</td>
</tr>
<tr>
<td>Square pixels</td>
<td>190</td>
</tr>
<tr>
<td>Status bar</td>
<td>22, 58, 142</td>
</tr>
<tr>
<td>Streaming media commands</td>
<td>104</td>
</tr>
<tr>
<td>For RealPlayer</td>
<td>104</td>
</tr>
<tr>
<td>For Windows Media</td>
<td>104, 184</td>
</tr>
<tr>
<td>Summary tab</td>
<td>256</td>
</tr>
<tr>
<td>Switches</td>
<td>121–123</td>
</tr>
<tr>
<td>Invert phase</td>
<td>122</td>
</tr>
<tr>
<td>Lock</td>
<td>121</td>
</tr>
<tr>
<td>Loop</td>
<td>121</td>
</tr>
<tr>
<td>Maintain aspect ratio</td>
<td>123</td>
</tr>
<tr>
<td>Mute</td>
<td>121</td>
</tr>
<tr>
<td>Normalize</td>
<td>122</td>
</tr>
<tr>
<td>Reduce interlace flicker</td>
<td>123</td>
</tr>
<tr>
<td>Resample</td>
<td>123</td>
</tr>
<tr>
<td>Sync tab</td>
<td>261</td>
</tr>
<tr>
<td>Advanced control settings</td>
<td>261</td>
</tr>
<tr>
<td>Synchronizing MIDI timecode</td>
<td>160, 165</td>
</tr>
<tr>
<td>System requirements</td>
<td>15</td>
</tr>
</tbody>
</table>

T

| Takes | 113 |
| Adding files as | 113 |
| Copying event attributes using | 114 |
| Deleting | 114 |
| Displaying names of | 114 |
| Previewing | 114 |
| Recording audio as new | 162 |
| Renaming | 114 |
| Selecting | 113 |
| Technical support | 16 |
| Test pattern | |
| Creating when printing to DV tape | 246 |
| Event | 198 |
| Text | |
| Credit roll event | 198 |
| Keyframing | 222 |
| Text event | 198 |
| Text/Backgrounds window | 27 |
| Titles | 182 |
| Time Display window | 20, 253–254 |
| Changing color | 253 |
| Changing time format | 253 |
| MIDI timecode settings | 254 |
| Time selection | 85 |
| Copying | 88 |
| Cutting | 89 |
| Editing | 41 |
| Recording into | 163 |
| With events | 86 |
| Timecode | |
| MIDI | 160, 165, 261–262 |
| Video | 269 |
| Timeline | |
| Adding media to | 71 |
| Moving events along | 73 |
| Playback on external monitor | 235 |
| Print to DV tape from | 246 |
| Titles | |
| Creating | 182 |
| Fading | 184 |
| Safe areas | 232 |
| Text generator | 198 |
Toolbar, 19

Track envelopes, 137
  adding, 137
  adding points, 138
  changing fade curves, 139
  colors, 137
  deleting points, 138
  Envelope Edit Tool, 140
  hiding on track(s), 139
  locking to events, 141
  moving points, 138
  removing from track(s), 139
  types, 137

Track FX button, 77, 78

Track header, 21, 77–78

Track list (audio CD)
  creating from events, 172
  editing in Edit Details window, 174
  exporting, 174

Track motion, 223–227
  button, 77
  flipping, 227
  glow, 225
  keyframes, 225
  picture-in-picture effect, 226
  position, 225
  rotating, 227
  shadow, 225
  shortcut menu, 224
  workspace, 224

Track name, 77, 78
  changing, 132

Track view, 21

Track-at-once CD burning, 169, 174

Tracks, 131–142
  adding empty, 131
  arming for recording, 78
  assigning plug-ins to, 143, 194
  assigning to a bus, 78, 155
  color, changing, 133
  compositing modes, 77, 200–202
  default properties, 137
  deleting, 132
  duplicating, 131
  height, changing, 133
  making compositing child, 77, 203
  mixing to a single track, 141
  multipurpose slider, 78
  muting, 77, 78, 136
  naming/renaming, 132
  number, 77, 78
  organizing, 132
  phase inverting, 78, 136
  reordering, 132
  resizing, 133
  scribble strip, 77, 78, 132
  soloing, 77, 78, 136
  track effects, 77, 143–149, 193–198
  Track FX button, 78
  track keyframes, 77, 217–218
  track layers, 77, 212
  track motion, 77, 223–227
  view buttons, 77, 78
  view options, 133
  volume fader, 78, 134

Transitions, 211
  adding, 212
  animating, 215
  from auto-crossfades, 212
  from cuts, 213
  modifying, 214
  using, 211
  window, 26

Transparency, 126
  and overlays, 208

Transport bar, 21, 79, 80
  keyboard shortcuts, 28

Triggering recording from MIDI timecode, 165

Trimmer window, 23, 115–118
  audio editor, opening from, 118
  events, placing on track, 116
  opening a file in, 115
  overview, 115
  regions and markers, adding, 118
  three-point editing, 116
  two-point editing, 117
  working with, 116

Trimming, 92–93
  adjacent events, 93
  beyond event edges, 93
  selected events, 92
  time and event selection, 93
  time selection, 93

Troubleshooting
  audio, 263–264
  video, 263–271

Tutorial, 35–58

U

Undersample rate, 124

Undo/Redo commands, 98–99
  clearing history, 99

V

Vegas
  installing, 17
  overview, 19–32
  registering, 17

Velocity envelope, 127

Version limitations, 16
Video Capture
  capturing video with, 69
  printing to tape with, 245
  recapturing offline clips with, 70

Video CDs, 248

Video compression, 58

Video effects, 193–198
  animating, 198
  keyframes, 198
  modifying, 197
  ordering, 195
  removing, 197
  window, 26

Video masks, 204

Video motion, See Track motion

Video previews
  capturing images from, 181, 230
  dynamic RAM previews, 232
  external monitor, 235
  histograms, 233
  optimizing, 230–234
  prerendering, 231
  previewing in a player, 234
  resolution, 231
  shortcut menu, 230
  window, 25

Video property settings, 254

View buttons, 77, 78

Volume
  assignable effects fader, 157
  bus send fader, 156
  event envelopes, 125
  track envelopes, 137
  track fader, 78, 134

W

Wave64 (.w64) audio format, 240

Web site
  accessing help, 18
  metadata examples, 100
  technical support, 16
  troubleshooting resources, 236, 263, 271

What’s This? help, using, 18

Window docking area, 22

Windows Media streaming commands, 104

Z

Zoom Edit Tool, 75

Zooming, 75